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Chapter 1
Getting Started with Wolf EMR
Wolf EMR is a comprehensive practice management system that integrates patient medical 
records (which includes medical history, visit notes, investigations, medical reports and other 
documents, referrals, rules (reminders), and more), appointment scheduling, clinical task 
management, intra-office communications, and billing functions. Wolf EMR does more than 
replace your filing cabinets; it allows you to perform patient searches, create reports, produce 
financial statements, view patient statistics, and perform complex billing analysis.

The seamless software integration allows you to navigate between patient records, tasks, 
billing, and appointments without losing your place.

About this guide
This guide documents Wolf EMR features and workflows from the perspective of a front end 
staff member. Content is specific to activities that most front end staff members perform on a 
regular basis. More advanced functionality (for example, around reporting) is documented in 
feature-specific guides and in Wolf EMR Online Help.

Getting help

There is an abundant amount of information that you will be trained on and there are further 
advanced functions that are not covered during your implementation training. For this reason, 
be sure to take advantage of the numerous learning resources available to Wolf EMR users.

View recorded webinar: Finding answers to your Wolf EMR questions
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Accessing Wolf EMR user guides and online help

To view the Wolf EMR Online Help, on the Wolf EMR Launch page, click Help ( ). 
Alternatively, if you need help while performing a particular task, on your keyboard, press F1. 
For some windows, the EMR opens the help topic specific to the window you are currently in.

You can also refer to the various role-based and feature-based Wolf EMR user guides, which 
you can access from the Wolf EMR Launch page, in the Documents drop-down list, or from 
the Guides Available topic of the online Help.

Accessing the Wolf EMR Community Portal

Through the Wolf EMR Community Portal you can access an extensive amount of free learning 
resources including articles, PDF user guides, handouts (work instructions), training videos, 
collaborative forums, and Q and A. To access the Community Portal, on the Wolf EMR Launch 
page, click Community Portal.
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You can also access the Community Portal from any device by going to:

https://telushealthcommunity.force.com/wolfcommunity

Note: The first time you log into the Community Portal, you will be required to set up a 
Community Portal account.

Contacting Wolf EMR Support

If you cannot find the answer to your question, contact the Wolf EMR support team:

 For issues requiring immediate assistance, call 1-866-879-9653 (Option 1)

 For less immediate issues, you can contact support via email to 
WolfEMR.support@telus.com or via the Cases page of the Wolf EMR Community Portal 

 For general how-to questions, you can post a question on the Q&A page of the Wolf EMR 
Community Portal

Requesting additional instructor led training

Even for the most computer-savvy person, there is a lot of information to absorb during EMR 
implementation training. You may find it helpful to have a Learning Specialist return to your office 
several months after go-live to:

 Re-assess your workflow and provide tips and tricks for using the system more efficiently

 Train you on how to perform more advanced tasks

 Work with each staff member to ensure everyone has a thorough grasp of the Wolf EMR 
functionality necessary to do their job with ease
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Getting Started with Wolf EMR
TELUS Health also offers many 1-4 hour training courses that cover intermediate and advanced 
functionality. Once you are comfortable with the basics, take advantage of these courses to 
raise your EMR use to the next level. These courses are offered onsite or via webinar.

 To arrange further training, contact the Client Care Team at 1-866-879-9653 (Option 4), via 
e-mail at Accounts.WolfEMR@telus.com, or Create a Case on the Cases page of the 
Wolf EMR Community Portal.

TELUS Health EMR User Conference

Each year TELUS Health hosts a user conference, where you learn how to make the most of 
your EMR and gain insight into the advances being made to Wolf EMR. The conference offers a 
series of presentations, workshops, and peer networking opportunities.

Keep an eye on the Wolf EMR Launch page for information about the User Conference.
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Wolf EMR basics

To access Wolf EMR, your workstation links to a remote system on the Wolf EMR data center. 
The data center hosts the Wolf EMR program and your patient database. Your clinic computers 
do not contain any patient information. Your workstation simply acts as a window into a system 
that contains your EMR data.

A Wolf EMR data center link is installed on all computers in your clinic. If your computer does 
not have the Wolf EMR data center link, please talk to a user at your site who has Wolf EMR 
administrative authority. Your system administrator can make arrangements to have the link 
added.

If you are accessing Wolf EMR for the first time, your temporary password is pre-set in the 
system and is provided to you, along with your username, by your system administrator or your 
TELUS Health learning specialist. You secure your password by changing it. Going forward you 
should never disclose your password to anyone.

View video tutorial:

 Signing into and out of Wolf EMR
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Logging into Wolf EMR

How you log into Wolf EMR depends on if you are logging in from a PC or from a Sunray 
computer. When you log in, Wolf EMR opens in a remote desktop. Keep in mind that in this 
view, the Windows Start menu and toolbar is for the remote desktop (not your workstation).

PC

To log into Wolf EMR from a PC:

1. On your desktop, double-click the Wolf EMR data center link ( ). A Microsoft 
Windows login window displays.

2. In the User name field, enter your username. 

Note: If another user's name is already populated, click Use another account. You can now 
enter your own username.

3. In the Password field enter your temporary password, and then press Enter. You are now 
logged into the data center with Wolf EMR open.

Sunray

To log into Wolf EMR from a Sunray:

1. Slide your card into the Sunray card reader with the chip end inserted first. Your computer 
activates automatically.

2. Enter your username and password. The remote desktop opens with Wolf EMR open.

Changing your Password

If this is your first time accessing Wolf EMR, using a temporary password, you should change 
your password immediately. Wolf EMR prompts you to change your password regularly. How 
often you are required to change your password depends on current provincial guidelines, and 
on custom settings programmed by your system administrator.

If your password is compromised, you can manually change your Wolf EMR password at any 
time.

To change your password:

1. On the data center, click Start ( ) and then, in the Start menu, click Windows 
Security.

2. In the list of Windows Security options, click Change a Password. 
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3. In the Old password field, enter your current (or temporary) password.

4. In the New password field, enter your new password, and then in the Confirm password 
field, enter your new password again.

5. Press Enter.

Setting up TELUS Wolf EMR self-service password reset

Are you notorious for forgetting passwords? If so, now is the time to enrol for TELUS Wolf EMR 
self service password reset (free). If you forget your password, you will be able to reset your 
password by answering 3 personalized questions.

To enrol for TELUS Wolf EMR self service password reset:

1. On the data center desktop, click Start ( ) and then, in the Start menu, click All 

Programs > Tools4ever > SSRPM > Enrollment Wizard > Enrollment Wizard ( ). 
The TELUS WolfEMR Password Reset Enrollment Wizard opens.

2. Click Next.

Note: Your password must:

 Be at least 8 characters in length

 Contain at least one number

 Contain at least one upper case letter

You can use special characters such as #, *, or _
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3. In the Question 1 area, select a question and provide an answer.

4. Click Next.

5. In the Question 2 area, select a question and provide an answer.

6. In the Question 3 area, create a custom question and answer, and then confirm your 
answer.

7. Click Next. A dialog box displays with the following message: "Congratulations! You have 
enrolled successfully into the Self Service Reset Password Management program!"

Help! I forgot my password

If you have forgotten your password, or have been locked out of the EMR due to too many 
failed login attempts, you can reset your password, without contacting the TELUS Health Wolf 
EMR support team, only if you have enrolled in TELUS Wolf EMR self service password reset. 
See “Setting up TELUS Wolf EMR self-service password reset” on page 7.

Note: If you have not set yourself up for TELUS Wolf EMR self service password 
reset and you have forgotten your password, you must contact the TELUS Health 
Wolf EMR support team to have your password reset. See “Contacting Wolf EMR 
Support” on page 3.
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The steps to reset your password depend on the type of workstation you are on. Click an 
option below to view the applicable steps:

 I'm a Sunray user (I insert a card to log into Wolf EMR)

 I'm a PC user

Locking Wolf EMR

If you leave your computer for more than a few moments, you should lock Wolf EMR. This way, 
no unauthorized users can access patient data, and other staff members cannot mistakenly 
enter data under your name. How you lock Wolf EMR depends on if you are using a PC or a 
Sunray computer.

PC

To lock Wolf EMR from a PC workstation:

1. On the data center, click Start ( ) and then, in the Start menu, click Windows 
Security.

2. Click Lock this computer.

Sunray

To lock Wolf EMR from a Sunray workstation, simply slide your card out of the card reader. The 
computer logs out automatically.

Shutting down your computer

When you shut down your computer, you should manually close Wolf EMR before you log out 
of the remote desktop.

To shut down your computer:

1. Close Wolf EMR using one of the following procedures: 

Caution: Locking the Wolf EMR remote computer does not lock your entire 
workstation. If you have other files or applications running on your workstation, 
those may still be accessible. To lock your PC workstation:

1. Minimize the Wolf EMR remote desktop window.

2. On your keyboard, press Ctrl + Alt + Delete, and then select Lock 
Computer.

Note: You can also use the keyboard shortcut: Press the Microsoft key + L.
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Getting Started with Wolf EMR
 If you have the Wolf EMR Launch page open, click , and then select Close all 
Wolf EMR Applications.

 If you have another Wolf EMR window open, on the task bar at the bottom of the 

desktop, right-click , and then select Close Window.

2. Close the remote computer: On the remote computer’s task bar, click Start ( ), and 
then click Log off.

3. Shut down your workstation.
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Chapter 2
Patient maintenance
This chapter introduces you to the Patient Maintenance area of Wolf EMR where you view and 
enter patient demographic information. You use the Patient Maintenance area to enter, store, 
and view all non-medical data about a patient. Examples of non-medical patient data include 
patient address, phone numbers, Personal Health Number (PHN), chart number, and next of 
kin. You can also register individuals for the Patient Portal from the Patient Maintenance area.

Adding a new patient 

To add a new patient:

1. Open the Scheduler: On the Wolf EMR Launch page, click Scheduling ( ).

2. In the Patient Search area, in the Family Name / Portion field, enter the patient's last 
name, and then on your keyboard press Enter. Your cursor moves to the Given (first name) 
field.

Best Practice: Before you add a new patient, search for the patient to ensure that 
the patient is not already in the system.
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3. In the Given field, enter the patient’s first name or initial, if known, and then on your keyboard 
press Enter.

4. Perform one of the following actions:

 If you find the patient in the search results, the patient is already in the system. If needed, 
you can modify the patient’s demographic information. See “Adding additional patient 
information” on page 16.

 If the EMR displays a search results message stating “No patient found”, complete the 
following steps to add the new patient to the system.
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5. On your keyboard, press F9. The EMR displays the Patient Maintenance window with the 
Name/Addr/Phone tab open. The patient’s last name and first name is populated in the 
Name area.   

6. In the Name area, enter the patient name information in Middle, and Chosen fields. 

7. Enter the patient’s primary address:

a) In the Address area, enter the patient’s address details.

b) In the Type drop-down list, click what this address is for. Your choices are: Home, 
Business, Mailing, Other, or Unknown.

8. If you want to add an additional address (for example, if the patient has a summer home in 
another province):

Note: When you add a patient, the only required fields for Wolf EMR are Family 
(surname) and Gender.

Note: The patient's chosen name is the name the patient prefers to use as a first 
name. Wolf EMR displays the chosen name in brackets whenever the patient 
name is displayed.
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a) Click Add another address. The EMR clears the address area, enabling you to enter 
the new address. The EMR also displays a green squares to the right of the address 
area, indicating how many addresses are entered for the patient and what address you 
are currently editing.

b) Enter the address details, and then in the Type drop-down list, click what this address is 
for.

c) If this address is the patient’s primary address, select the Primary Address check box.
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9. In the Communications area:

a) In the Home, Work, and Cell fields, enter the patient’s phone numbers.

b) In the eMail field, enter the patient’s email address.

c) In the Reminder Preference drop-down list, select the patient’s preferred method for 
receiving confirmations and other notifications from the clinic.

10.In the Primary Service Provider drop-down list, click the patient’s primary health care 
service provider.

11. If applicable, in the Alternate Service Provider drop-down list, click the patient’s alternate 
health care service provider. 

Tip: If the patient has multiple addresses entered:

 The EMR indicates what address you are currently viewing by displaying:

  The sequence number.

  An indicator ( ) beside the address you are viewing. 

 To view the previous address, click the up arrow ( ).

 To view the next address, click the down arrow ( ).

 The patient’s primary address is indicated by an X ( ).

 If you enter an address in error and want to remove it, click Delete address.

Note: A patient must have an email address entered in the Patient Maintenance 
window before you can register them for the Patient Portal.

If you think it is likely that a patient will access the Patient Portal (for example, a 
patient with a chronic disease), record their email address.
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12. If the patient is an infant who does not yet have a PHN, select the Infant / Dependant 
check box. 

13. Click PHN. The EMR displays the PHN Editor window. In the PHN Editor window, enter the 
following information:

a) In the PHN field, enter the patient's Provincial Health Number. Enter just the numbers. Do 
not include spaces or hyphens.

Note: If the patient is an infant who does not yet have a PHN, enter the mother’s PHN.

b) If the ProvinceCode field is not populated, in the ProvinceCode drop-down list, click 
the appropriate province code.

c) Click Save ( ) and then click Exit. The EMR records the patient’s PHN number and 
populates the Billing Prov field with the province you selected in the PHN Editor 
window.

14. In the Birthdate field, enter patient’s birthdate in the following format: day/month/year and 
then, on your keyboard, press Enter. The EMR calculates and displays the patient’s age in 
the Age field.  

15. In the Gender area, select the patient’s gender.

16. Click Save ( ). 

Adding additional patient information

The following sections describe how to add additional patient information. You can enter this 
information when you add the new patient to the EMR, or you can enter this information later. If 
you enter information later, you will have to open the Patient Maintenance window for the 
patient. 

Note: When an infant is first born, usually the patient is allowed to be submitted 
under the mother's PHN for a short period of time until the baby gets its own PHN. 
Selecting this check box ensures that electronically submitted billing is designated 
with the mother's PHN.

As soon as the infant receives its own PHN, enter that number in the infant’s PHN 
field and clear the Infant / Dependant check box to remove this designation.

Tip: Use the drop-down list beside the Age field to view the patients age in 
months, weeks, or days.
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Opening the Patient Maintenance window

To open the Patient Maintenance window:

1. Open the Appointment Scheduler, and then search for the patient. See “Searching for a 
patient” on page 23.

2. In the search results list, click the patient name, and then, on your keyboard, press F9. The 
EMR displays the Patient Maintenance window with the Name/Addr/Phone tab open.

Adding an additional address

You can add multiple addresses for a patient. For example, you can add a business or 
alternative mailing address for a patient.

To add an additional address:

1. Open the Patient Maintenance window for the patient. See “Opening the Patient 
Maintenance window” on page 17.

2. In the Address area, click New.

3. Enter the patient address details in the appropriate fields.

4. In the Type drop-down list, click what this address is for. Your choices are: Home, 
Business, Mailing, Other, or Unknown. 

5. Click Save ( ). The EMR saves the address and displays a Next button in the Address 
area. You can click Next to view the different addresses you added.

Assigning a patient to a care team

If your clinic works in “teams” or “pods” of practitioners and/or employees to manage groups of 
patients, your clinic can create care teams in Wolf EMR. In the Patient Maintenance window, 
you can then assign a patient to a specific care team.

To assign a patient to a care team:

1. Open the Patient Maintenance window for the patient. See “Opening the Patient 
Maintenance window” on page 17.

2. In the second column, in the Care Team drop-down list, click the care team to which you 
want to assign the patient.

3. Click Save ( ).

Before you begin: 
Ensure that your Administrator has set up care teams.
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Indicating a patient’s chart number

Administrators can program the EMR to generate a patient chart number each time a patient is 
added to the database. However, if the chart number is not populated, or you need to enter a 
paper chart number, you can manually enter the patient chart number. 

For example, you might have to enter a paper chart number if your clinic recently moved from 
paper charting to using an EMR. You must continue to pull paper charts of previous patients 
until they are scanned or entered into the EMR. If you currently use a number system for 
organizing charts, you need to be able to easily find this number when confirming and arriving a 
patient.

To indicate a patient’s chart number: 

1. Open the Patient Maintenance window for the patient. See “Opening the Patient 
Maintenance window” on page 17.

2. In the second column, in the Chart field, enter the patient’s chart number.

Note: If you want the EMR to populate the Chart field with the next available chart number 
in the system, click Get Next (if available).

3. Click Save ( ).

Entering other identification information for a patient

If your clinic requires you to enter other identification (ID) for the patient, you can record this 
information in the EMR. For example, you can enter a Hospital ID.

To enter other identification information for a patient:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the second column, in the Other ID field, enter the required ID. For example, you can 
enter a Hospital ID.

3. Click Save ( ).

Indicating a patient’s main pharmacy

If pharmacies are set up in your EMR, then you can indicate the main pharmacy that the patient 
uses.

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the second column, in the Main Pharmacy drop-down list, click the main pharmacy that 
the patient uses.
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3. Click Save ( ).

Indicating the patient’s default preferred clinic location

If your clinic has multiple locations, you can indicate the patient’s preferred clinic location.

Note: If your clinic has only one location, the EMR automatically populates the Default 
Location field with your clinic’s location and you cannot edit this field.

To indicate the patient’s default preferred clinic location:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. At the bottom of the second column, in the Default Location drop-down list, click the 
patient’s preferred clinic location. (If there is only one location available, this field is greyed 
out.)

3. Click Save ( ).

Identifying the referring practitioner (for specialist's office)

If you work in a specialist's office, you can identify the practitioner who is referring this patient to 
your clinic.

To identify a referring practitioner:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the third column, in the Referred By area, perform one of the following actions: 

 If the patient is referred by a consultant (specialist), in the Consultant On File area, in 
the Search By field, start typing the consultant’s last name and then press Enter.

Note: If the consultant is not on file, in the Consultant Not on File area, enter the 
consultant information in the Name and Phone fields.

 If the patient is referred by a family practice physician, in the Family Practice Referral 
area, in the Search By field, start typing the physician’s last name and then press Enter.

3. In the appropriate drop-down list click the Consultant Physician or the Family Practice 
Physician.

4. If you want to use the consultant physician or the family practice physician in billing as the 
default referring physician, ensure that you select the Use in Billing as Default check box. 

Note: If you do not select the Use in Billing as Default check box, your billing will 
be refused.
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5. Click Save ( ).

Adding patient custody information

To add patient custody information:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the Custody Agreement area (located in the last column), in the Notes field, enter any 
patient custody information. For example, “Mother has custody.”

3. Click Save ( ).

Verifying patient data 

To verify patient data:

Note: If the consultant or family practice physician is not on file, add them to the 
consultant list in the EMR: 

1. On the Wolf EMR Launch page, click Configuration ( ).

2. On the Configuration menu, click View > Physicians / Service Providers > 
External Consultants. The EMR displays the Consultant Maintenance 
window.

3. Click .

4. In the Data tab, enter the consultant’s details, and then click Save ( ).

You can now, return to the Referred by area and select the referring practitioner’s 
name from the appropriate drop-down list. 

Best Practice:

Mark that your have verified a patient’s data each time you enter or change the 
patient’s information on the Name/Addr/Phone tab in the Patient Maintenance 
window.

You also verify a patient’s data when the patient arrives for an appointment.
20 Wolf Front End Staff User Guide - Issue 02.05



Patient maintenance
1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. At the bottom of the last column, select the Patient Data Verified check box, and then 
enter the date it was verified in the Last recording text box (if it is not already populated).

3. Click Save ( ). 

Verifying the patient’s PHN with MSP

You can verify the patient's PHN with Medical Services Plan (MSP) BC to ensure payment for 
the services provided to the patient. 

To verify the patient’s PHN with MSP:

In the upper left area of the Patient Maintenance window, click Verify with MSP ( ).

If validation fails, the EMR displays an error message that indicates the reason it failed. 

If an error is displayed, arrange an alternate form of payment from the patient (for example, cash 
or credit card), and advise the patient to obtain or verify their MSP coverage.

If validation is successful

If validation passes:

 There is no need to verify the patient’s PHN again during the same calendar month. 

 The date and time that the patient's PHN was last successfully verified are displayed (as 
read-only) in Patient Maintenance (on the Other Demographics tab, in the Provincial 
Payment Coverage are in the Coverage Last Checked field).
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Adding next of kin contact information

To add next of kin contact information:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the Patient Maintenance window, click the Other Demographics tab.

3. In the Next of Kin / Contact area, enter any of the following information in the following 
fields:

 Name

 Phone

 Notes

 Mother's Maiden Name (Next of Kin's)

 Mother’s height 

 Father’s height

4. Click Save ( ).

Adding a prefix or suffix to display with a patient name

You can customize how the EMR displays a patient's name by entering text to display before or 
after a patient’s name.

To add a prefix or suffix to display with the patient name:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the Patient Maintenance window, click the Other Demographics tab.

3. In the Display with Patient Name area, in the Before field, enter the text to display before 
the patient's name.

4. In the Display with Patient Name area, in the After field, enter the text to display after the 
patient's name.

5. Click Save ( ). The EMR displays the text you entered in front of and/or after the patient’s 
name on the schedule, as well as in the patient banner. 

Note: The Primary Caregiver field displays the name of the patient's primary 
caregiver if applicable. The Primary Caregiver is assigned under the Name/Addr/
Phone tab in the Relationship area
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Adding general patient notes

You can enter general patient notes for other front end staff members to see.

To add general notes:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. In the Patient Maintenance window, click the Notes tab.

3. In the General Notes area, enter your patient notes. The General Notes area can fit an 
unlimited amount of data.

4. Click Save ( ).   

Searching for a patient
You need to search for patients to perform many day-to-day tasks including adding family 
members to the EMR, updating demographics, and booking appointments. The following 
sections explain the different ways you can search for and find a patient in the EMR.

Searching for a patient

To search for a patient:

1. Open the Appointment Scheduler. The Patient Search area is located on the right side of 
the Scheduler. 

Note: General notes are visible in the patient’s medical chart as a yellow note pad 
icon in the SMART banner.
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2. Using the following table, in the Patient Search area, enter your search criteria:

3. Perform one of the following actions:

 If you entered only the Family Name, on your keyboard, press Enter twice.

Search criteria Description

Only My Location If your clinic has multiple clinic locations, select this check box if 
you want to include only patients whose default location is the 
same as your primary location.

Note: The EMR displays this check box only if your clinic has 
more than one location set up in Wolf EMR.

Use Soundex If you do not know the proper spelling of the patient’s name, 
select this check box to search for first and last names that 
sound like the name you enter, regardless of spelling.

For example, if you select the Use Soundex check box and 
then enter “Barbra” (note the missing “A”) for the First Name, the 
EMR returns “Barbara” in the search results.

Family Name/
Portion

Enter part or all of the patient’s last name. 

The patient search is more concise if you enter more letters of 
the name; however, if you do not know the proper spelling of a 
name, you can enter the portion of the name you know. 

Given Enter part or all of the patient's first name. If you enter a Given 
name with a Family Name/Portion name, you can narrow 
down your selection criteria. 

PHN Enter the patient’s Personal Health Number (PHN). 

Note: Enter only numbers. Do not include spaces or hyphens. 
The search does not accept a partial entry.

Chart Enter the patient’s chart number. 

Note: The search does not accept a partial entry.

Phone Enter the patient’s phone number. Enter only the numbers. Do 
not include the area code. The EMR Searches for all phone 
numbers: Home, Mobile, Work, and International.

DOB Enter the patient’s date of birth (DOB) in the following format: 
DDMMYYY. 

Note: The DOB field is available only if you have set up the 
Appointment Scheduler to display patient DOBs in the 
Patient Search area. See “Displaying date of birth (DOB) 
in patient searches” on page 25.
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 If you entered other fields as well, on your keyboard, press Enter once.

The EMR displays the search results in the in the pane below the search fields. 

Customizing the Patient Search area

You can customize the Patient Search area to increase the efficiency of your patient searches. It 
is easier to determine that you are selecting the correct patient, when you can see more 
information in your search results.

Displaying date of birth (DOB) in patient searches

If you want to see the DOB for patients listed in the Patient Search area, you can choose to 
see patient DOB’s. Seeing patient DOBs can help you choose the correct patient when a 
patient search produces a large number of patients with the same name. If you are searching 
for a common name, you can also add patient DOB to your search criteria.

To display patient DOB in patient searches:

Note: A name shown in brackets is the patient's chosen name (as entered in 
Patient Maintenance). For example, Jason Brown may prefer to be called Jake. His 
name would then appear as “Brown, Jason (Jake)”.

Tip: If the patient you are searching for does not appear in the box, use the scroll 
bar (the up/down arrows) to view more names.

If you still can’t fine the patient you are looking for, use the Advanced Search 
option. See “Searching for hard-to-find patients using Advanced Search” on page 
26.
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In the Appointment Scheduler window, click User Preferences > Booking Display Settings 
> Display DOB in Patient Search.

Displaying a patient's primary practitioner in patient searches

Another way you can determine that you are selecting the correct patient is to view a patient’s 
primary practitioner in patient searches. 

To set the EMR to display a patient’s primary practitioner in patient searches:

On the Scheduler menu, click User Preferences > Booking Display Settings > Display 
Service Provider.

Including inactive patients in patient searches

In certain situations, you need to include inactive patients in your searches. For example, if the 
patient is listed as a long term care patient, you need to include inactive patients in your search 
to find the patient. Another example of when you need to include inactive patients in your 
search is if a patient has deceased in the last month, but you still need to attach a document to 
the patient’s file in the EMR.

To include inactive patients in patient searches:

On the Scheduler menu, click User Preferences > Booking Display Settings > Include 
Inactive Patients in Search and click one of the following options:

 All

 Left Practice (LP) Only

 Deceased (D) Only

When you perform a patient search, the EMR displays inactive or archived patients. 

Searching for hard-to-find patients using Advanced Search

Sometimes your search results list contains too many patients, and it is difficult to find the 
patient you are looking for. Or, you need to search for a specific search criteria (for example, 
only inactive patients). The Advanced Search option provides more search criteria to help you 

Best Practice: 

To see the patient’s DOB beside their name on search lists, use Advanced 
Search. See “Searching for hard-to-find patients using Advanced Search” on page 
26.

It is easier to view patient names and DOBs in the Advanced Search window.

Tip: You can find this Inactive/Archive information on the Other Demographics 
tab in the Patient Maintenance window.
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filter your results and quickly find the patient you are looking for. The additional search criteria 
and filters that the Advanced Patient Search provides include:

 Middle name

 Birth Date (You can search for a specific birth date.)

 Other ID

 Street

 Postal Code

 Male

 Female

 Only Inactive 

To use Advanced Search:

1. In the Patient Search area, on the right side of the Scheduler, click Advanced. The EMR 
displays the Advanced Patient Search window.  

2. In the Advanced Search area, enter your search criteria.

Note: You can also use SMART Search in an Advanced Search. SMART Search 
is a single text input search field and works similarly to a web search. When you 
enter your search criteria in the Search for field. The EMR then searches the 
criteria throughout all patient records.

Tips for entering patient search criteria

 If you do not know how to spell a patient’s last name, but want to use last name 
as a search criteria, select the Last Name sounds like check box. The EMR 
includes patients with last names similar to the entered name.

 To include patients who have a status of Inactive, select the Include Inactive 
check box.
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3. On the Actions menu bar, click Search (or, on your keyboard, press Enter). The EMR 
displays the search results in the Search Results tab. The number of results are listed in 
the bottom corner of the results list. 

4. To select a patient, in the search results list, double-click the patient’s name. 

Finding a patient who you recently selected from the Advanced search results list

If you recently selected a patient from the Advanced search results list, you can quickly find that 
patient again using the Recent Patients pane. The Recent Patients pane contains a list of 
the last 10 patients you selected, with the most recently selected patients on the top.   

To find a patient who you was recently seen in the clinic:

1. In the Patient Search area, on the right side of the Scheduler, click Advanced. The EMR 
displays the Advanced Patient Search window. 

2. Click the Search History tab. The Recent Patients pane on the right side of the tab 
contains a list of recently selected patients with the most recently selected patients on the 
top. 

 Adding a family member
If you want to add a family member of a patient in the EMR, you can save time by copying some 
of the patient’s information. After you copy the patient’s information, the EMR displays a Patient 
Maintenance window for the family member populated with the with the same last name, 
address, home phone number, primary service provider, and default location as the patient you 
copied. 

To add a family member:

Note: The Recent Patients list is shared between applications and is saved across 
application sessions. If you log out and then log back in the next day, the EMR 
restores the Recent Patients list.
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1. Search for the patient whose information you want to copy to add a family member. See 
“Searching for a patient” on page 23.

2. In the search results list, click the patient name, and on your keyboard, press F9. The EMR 
displays the Patient Maintenance window.

3. On the Patient Maintenance menu, click File > Copy Patient. The EMR displays a Patient 
Maintenance window for the family member populated with the with the same last name, 
address, home phone number, primary service provider, and default location as the patient 
you copied.

4. Continue adding patient information for the family member. See “Adding a new patient” on 
page 11.

Entering patient relationships
You can enter relationships to a patient using the Relationships area in the Patient 
Maintenance window. You can use the Relationships area to do the following:

 Link family members

 Define a patient's primary caregiver

 Note other important patient contacts (for example, a social worker)

Linking family members using relationships

If a patient’s family members are in the EMR, you can link those family members to the patient to 
link their family history. 

To link family members using relationships:

1. Search for the patient who you want to link a family member to. See “Searching for a patient” 
on page 23.

2. In the search results list, click the patient name, and then, on your keyboard, press F9. The 
EMR displays the Patient Maintenance window. 

Note:

  If a patient’s family member is not in the EMR, but is going to be a patient of the 
clinic, you must first add the family member to the system (see “Adding a family 
member” on page 28), then come back to the Patient Maintenance window, 
and link the family member to the patient.

 If the patient’s family member is not in the EMR and is not going to be a patient 
of the clinic, enter the family member’s name in the Other field. See “Adding 
other important patient contacts using relationships” on page 30.
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3. In the Patient Maintenance window, in the Relationships area, click Add/Edit. The EMR 
displays the Patient Relations window.

4. Perform one of the following actions:

 If this is the first relationship you are adding, in the Related Patients area, click Search. 

 If the patient already has relations entered, click New and then, in the Related Patients 
area, click Search.

The EMR displays the Patient Search window.

5. To search for the family member you want to link to the patient, in the Patient Search 
window, enter your search criteria and on the menu bar, click Search.

6. In the search results list, double-click the family member’s name. The EMR displays the 
family member’s name in the Related Patients area.

7. In the Relationship to area, in the Relation drop-down list, click the appropriate relation.

8. Click Save.

Defining a patient's primary caregiver using relationships

To define a patient’s primary caregiver using relationships:

1. Follow Step 1  to Step 7  in “Linking family members using relationships” on page 29. 

2. In the Relationship to area, in the Caregiver drop-down list, click Primary.

3. Click Save. 

Adding other important patient contacts using relationships

You can record other important patient contacts using relationships. For example, you can add 
a social worker as a patient contact.

To add other important patient contacts using relationships:

1. Search for the patient for whom you want to add a contact. See “Searching for a patient” on 
page 23.

Tips:

 If the primary caregiver is not entered as a patient in the EMR (is not in the 
search results list), then in the Related Patients area, in the Other field, enter 
the primary caregiver’s name.

 If you enter a name in the Other field, it is not listed in the Relationship table. 
You must click Add/Edit to see the names of contacts who are not in the EMR 
system.
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2. In the search results list, click the patient name, and then, on your keyboard, press F9. The 
EMR displays the Patient Maintenance window. 

3. In the Patient Maintenance window, in the Relationships area, click Add/Edit. The EMR 
displays the Patient Relations window.

4. Perform one of the following actions:

 If this is the first relationship you are adding, in the Related Patients area, in the Other 
field, enter the contact’s name. 

 If the patient already has relations entered, click New and then in the Related Patients 
area, in the Other field, enter the contact’s name.

5. In the Relationship to area, in the Relation drop-down list, click the appropriate relation 
(for example, Social Worker).

6. Click Save.

Registering patients for the Patient Portal

The Patient Portal is a web site that patients access to view certain areas of their medical chart 
online, including their:

 Medical summary

 Current medications and vaccinations

 Lab results

 Medical reports (documents)

Patients can also use the Patient Portal to:

 View and book appointments online

 Receive messages from your clinic

 Receive notifications (for example, to book appointments or to come in for overdue tests)

 Print medical summary reports, medication reports, and vaccination reports

Tips:

 If you enter a name in the Other field, it is not listed in the Relationship table. 

 You must click Add/Edit to see the names of contacts who are not in the EMR 
system.

View video tutorial: Registering patients for the Patient Portal
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Your clinic can control the type of health information a patient can see and the actions a patient 
can perform in the Patient Portal. 

You can register any patient for the Patient Portal as long as they have an email address and 
date of birth entered in the Patient Maintenance window. You register patients one at a time, 
enabling you to choose which patients can access the Patient Portal and which features each 
can use in the Portal.

You can also register relations of a patient to access that patient’s Patient Portal. You must 
obtain legal consent from the patient to allow a relation to access the patient’s Patient Portal 
information. See “Giving other people access to a patient’s data” on page 37.

Other Front End staff Patient Portal tasks can include:

 “Setting up practitioners’ schedules for online appointment booking (via the Patient Portal)” 
on page 99

 “Publishing documents to the Patient Portal from the Medical Summary” on page 385 

To register a patient for the Patient Portal:

1. Open the Patient Maintenance window for the patient. See “Opening the Patient 
Maintenance window” on page 17. The EMR displays the Patient Maintenance window with 
the Name/Addr/Phone tab open. 

2. In the Communications area, ensure that the patient’s e-mail address is entered in the 
eMail field.

3. To save the patient’s email information, click Save ( ). 

4. Click the Other Demographics tab. The EMR displays the Other Demographics tab with 
the Patient Portal area on the right side of the window.
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5. In the Patient Portal area, click Settings. The EMR displays the Wolf Patient Portal 
Settings window.
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6. In the Enable the following features for this user area, use the following table to select 
which features the patient can access in the Patient Portal.

Option Description

Web 
Appointment 
Booking

To enable the patient to book appointments online, select this 
check box.

Rule Alerts To enable the patient to receive automated notifications when they 
are flagged by a Patient Portal Rule, select this check box.

Health 
Information Tab

To enable the patient to view their health information (Medical 
Summary), select this check box.
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7. Click Generate/Reset PIN. The EMR opens a PDF letter in the PDF-XChange Viewer. The 
body of the letter contains a message similar to the following example: 

Messaging To enable the patient to send messages to the clinic:

1. In the Patient is allowed to compose field, enter the number of 
messages the patient can send over a defined period of time.

2. In the messages in a rolling x month period field, enter the 
number of months that constitutes the defined period of time.

Option Description
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The EMR also sends an e-mail message to the patient similar to the following example: 

The patient needs both the printed letter and the e-mail to sign up for the Patient Portal.

8. To print the letter, in the PDF-XChange Viewer window, click Print ( ), or on your 
keyboard, press Ctrl + P.

9. Give the letter to the patient. The patient requires the Personal Identification Number (PIN) in 
the letter to sign up for the Patient Portal. 

Note: 

 The portal user should get their PIN in person. 
Do not fax or e-mail the letter containing the PIN.

 The PIN generated in the letter is valid for 72 hours after the letter is printed. If 
the patient does not access the Patient Portal in time, they must return to the 
office to receive a new letter.
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10. On the Wolf Patient Portal Settings window, click Save and Close ( ). Once the 
patient completes the registration process, the EMR displays a globe icon in the Patient's 
Patient Banner.

Giving other people access to a patient’s data

Patients can grant family members and other relations access to their Patient Portal. For 
example:

 An elderly patient with mild dementia can allow Patient Portal access to her daughter.

 A young adult with a chronic condition can allow Patient Portal access to his mother. 

To grant a mother access to view her son’s Patient’s Portal information:

1. In the Patient Maintenance window, add the Mother as a patient in your Wolf EMR (if she is 
not already added as one of your patients). See “Adding a new patient” on page 11. 

2. Link the mother and her son using Patient Relations:

a) Open the Patient Maintenance window for either the Mother or Son. See “Opening the 
Patient Maintenance window” on page 17. 

b) Click the Name/Addr/Phone tab.

Tip: Ensure that you enter the Mother’s e-mail address into the Communication 
area on the Name/Addr/Phone tab.
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c) In the Relationship area, click Add/Edit. The EMR displays the Patient Relations for 
<patient name> window. 

d) Perform one of the following actions:

  If this is the first relationship you are adding, in the Related Patients area, click 
Search.

  If the patient already has relations entered, click New and then, in the Related 
Patients area, click Search.

The EMR displays the Patient Search window.

e) )To search for the family member you want to link to the patient, in the Patient Search 
window, enter your search criteria and then click Search.
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f) In the search results list, double-click the family member’s name. The EMR displays the 
family member’s name in the Related Patients area. 

g) In the Relation drop-down list, click the relationship the family member has to the 
patient.

h) In the Relation Status drop-down list, click the appropriate status for the relationship.

i) If the family member is the primary caregiver for the patient, in the Caregiver drop-down 
list, click Primary.
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j) Click Save. The EMR displays the relation in the Existing Relations area at the top of 
the Patient Relations window. 

k) Click Close ( ).

3. Set up the mother with access to her son’s Patient Portal:

a) Open the Patient Maintenance window for the Mother. See “Opening the Patient 
Maintenance window” on page 17.

b) Click the Other Demographics tab.
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c) In the Patient Portal area, click Settings. The EMR displays the Wolf Patient Portal 
Settings window, with the mother’s family members and other linked relations listed in the 
Proxy Access area. 

d) In the Proxy Access area, click the son’s name. 

e) Click Print Consent Form. The EMR opens a PDF Consent Form in PDF-XChange 
Viewer. The body of the form contains a message similar to the following example.
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Note:

 The patient can sign the Consent Form out of office if the form is appropriately 
witnessed. For example, if the patient is traveling, or is away at school.

 Children do not have to sign a Consent Form for their parents or legal 
guardians, as consent is implied in this case. However, once the child reaches 
the age of consent, the child must then sign a Consent Form to enable their 
parent(s) to continue to access their Patient Portal.

 The Age of consent is determined and configured by your clinic.
42 Wolf Front End Staff User Guide - Issue 02.05



Patient maintenance
f) To print the consent form, in the PDF-XChange Viewer window, click Print ( ), or on 
your keyboard, press Control + P.

g) Have the son sign the Consent Form. 

h) Beside the son’s name, in the Proxy Access area of the Wolf Patient Portal Settings 
window, select the Consent Obtained and the Access Portal check boxes.

i) If the Mother is not currently signed up for the Patient Portal herself, click Generate/
Reset PIN. The EMR opens a PDF letter in the PDF-XChange Viewer.

j) Print and hand the letter to the mother. See Step 8  to Step 10  in “Registering patients 
for the Patient Portal” on page 31.

Printing a patient label
You can print a patient label from the Patient Maintenance window, from a patient appointment, 
or from the patient’s medical record. By default, the following types of labels are available to be 
printed: 

Tip: To keep the signed consent form on file, scan the signed consent form and 
import it into the Document’s area of the son’s Medical Summary. For more 
information, see “Scanning documents (using Fujitsu ScanSnap scanners)” on 
page 372 and “Linking documents” on page 374.

Label name Description

Address You can print address labels to attach to envelops of letters sent to 
patients. By default, the address label displays the patient’s:

 Name

 Address line 1

 Address line 2

 City, province, and postal code 
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To print a patient label:

1. Complete one of the following actions:

 If you are viewing the Patient Maintenance window for the patient, in the menu, click 
Labels and then click the type of label you want to print. 

 If the patient has an appointment booked, in the Appointment Scheduler, right-click the 
patient’s appointment, and then click Print Label.

Chart You can print Chart labels to attach to paper charts. By default, the Chart 
label displays the patient’s:

 Birthdate

 Name

Lab You can print Lab labels to attach to requisition forms and lab specimens. 
By default, the Lab label displays the patient’s:

 Name

 Date of service (DOS)

 Provincial health number

 Date of birth (DOB)

 Age

 Home and Work phone numbers

 Practitioner name and number

Note: User’s with administrative authority can configure what patient 
phone numbers display on the label. For example, you can 
choose to display only home and cell numbers.

Tip: Users with administrative authority can modify label fonts and formats.

Label name Description
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 If you are viewing the patient’s medical record, for example, the Vital Entry area, or the 
Medical Summary, right-click and then, in the SMART menu, click Print Label.

The EMR displays the Print Label window.

2. In the Label drop-down list, click the type of label you want to print.

3. In the Printer drop-down list, click the printer you want to use.

4. If the selected label contains information about the patients practitioner, in the Provider 
drop-down list, click the practitioner’s name.

5. In the Copies field, enter the number of copies you want.

6. Click OK and follow the prompts in the windows.

Updating patient information
Most of the patient’s basic demographic information in the Patient maintenance window is on 
the Name/Addr/Phone tab and the Other Demographics tab. You can also enter and 
update a patient’s status on the Patient Status tab.

Updating a patient’s demographic information

To update a patient’s basic demographic information:

1. Search for the patient. See “Searching for a patient” on page 23.

2. In the search results list, click the patient name and then on your keyboard, press F9. The 
EMR displays the Patient Maintenance window with the Name/Addr/Phone tab open.

3. On the Name/Addr/Phone tab, edit information as necessary.

4. Click the Other Demographics tab and edit information as necessary.

5. Click Save ( ).

Entering or changing a patient’s status

To enter or change a patient’s status:

1. Search for the patient. See “Searching for a patient” on page 23.
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2. In the search results list, click the patient name and then on your keyboard, press F9. The 
EMR displays the Patient Maintenance window with the Name/Addr/Phone tab open.

3. Click the Patient Status tab. 

4. From the row of buttons at the bottom of the Patient Status tab, click New Status.

5. In the Status drop-down list, click a status. Your choices can include:

 New Patient

 Office Patient

 Acute Care Patient

 Housebound

 Long Term Care Patient

 Left Practice 

 Deceased

6. If you selected a status of New Patient Office Patient, or Left Practice, enter information 
in the following fields:

 Start Date

 End Date

 Notes

7. If you selected a status of Acute Care Patient, Housebound, or Long Term Care 
Patient, enter or select information in the following fields:

 Physician: The patient's primary Physician

 Facility: The type of facility where the patient is being seen or treated. 

Note: Your Administrator can add other Status types if necessary.

Note: When you mark a patient as inactive (Left Practice) and the patient has 
follow-ups and notifications for a date that is after the date the patient became 
inactive, the EMR displays a message window “Patient marked as Left Practice. 
Would you like to remove all future follow-ups and notifications?” If you click Yes, 
the EMR:

 Marks all of the patient’s incomplete follow ups of type “Patient TCI For Follow 
Up” as completed

 Removes the patient from the Patients To Notify list
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 Location: The location where this patient is being treated or seen. The EMR displays the 
selected location in the billing reminder under the column for appointment length titled 
LEN in the Billing program. 

 Admission Date: The date that the patient was admitted to the location.

 Discharge Date: The date that the patient was discharged from the location.

 Notes: Any relevant patient notes.

 Default Fee Code: The patient's default fee code for billing.

 Default ICD Code: The patient's default ICD code for billing.

 Reset Final Billing Date: If applicable, select this check box this box to reset the final 
billing date for this patient.

8. If you selected a status of Deceased, enter or select the information in the following fields:

 Location: Specify the location of the patient's death.

 Deceased Date: Enter the date of death.

 Autopsy: If an autopsy was performed, select this check box.

 Notes: Enter the patient's cause of death or any other relevant patient information. 

9. Click Save Status.

Merging duplicate patient information
You can merge one patient's records (excluding demographic data) to another patient. Use this 
function when duplicate patients exist.

To merge a patient:

1. Search for the patient. See “Searching for a patient” on page 23.

Note: The list of Locations depends on the Service Facilities that your 
Administrator entered in the EMR.

Note: If the patient has follow-ups and notifications for a date that is after the 
Deceased Date, the EMR displays a message window “Patient marked as 
Deceased. Would you like to remove all future follow-ups and notifications?” If you 
click Yes, the EMR:

 Marks all of the patient’s incomplete follow ups of type “Patient TCI For Follow 
Up” as completed

 Removes the patient from the Patients To Notify list
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2. In the search results list, click the patient name with the bad information, and then on your 
keyboard, press F9. The EMR displays the Patient Maintenance window with the Name/
Addr/Phone tab open.

3. Click the Other Demographics tab.

4. In the Internal Data area of the Other Demographics tab, click Merge Patient. The EMR 
displays the Patient Merge window.

5. In the Merge To (Target) area click Search. The EMR displays the Patient Search window.

6. To find the patient who you want to merge the other patient to, enter search parameters and 
click Search.

7. In the search results list, double-click the patient’s name with the good information. 

The right pane displays information related to the Patient you entered in the Merge To 
(Target) field.

8. To choose which Status to retain for the merged patient, perform one of the following 
actions:

 Select the Merged From Patient Status check box. 

 Select the Merged To Patient Status check box.

Note: If you accidently choose to merge the same patient record together, the 
EMR displays a prompt saying “Same patient detected. Please select a different 
patient.” If so, go back and select the correct Merge To (Target) patient.
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9. Select Field Names in the left pane and click merge one (>) or merge all (>>) to overwrite the 
fields in the right pane which you want as the information for the merged patient. To move 
fields to the left pane, click merge one (<) or merge all (<<) to merge them with the left-hand 
patient. 

 Red highlights means that the data is different from the source patient.

 White highlights means that the data is the same as the source patient.

 Green highlights means that the data has been merged into the target patient

10. When you finish merging the fields, in the upper right hand corner of the Patient Merge 
window, click Merge.
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Chapter 3
Appointments
If you are a front end staff member, you perform most of your day-to-day tasks in the 
Appointment Scheduler. From the Appointment Scheduler, you can:

 Book appointments

 Confirm and update appointments

 Manage clinic traffic (for example, to manage rooms patients are in)

 Verify patient demographic information

 View and manage patients on waiting lists

 Perform numerous other actions on booked patients (for example, open patient records 
(charts), or enter vitals and other visit notes)

The Wolf EMR Appointment Scheduler layout and flow is versatile, enabling you to customize it 
to suit your clinic and personal workflows.

Opening the Appointment Scheduler
To open the Appointment Scheduler:

1. If your clinic supports multiple locations, on the Wolf EMR Launch page, in the Location 
drop-down list, click your current clinic location. 

2. On the Wolf EMR Launch page, click Scheduling ( ). The EMR displays the 
Appointment Scheduler for today.
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Viewing and navigating the Scheduler
You can view and navigate the Scheduler to best meet your workflow needs. You can view 
schedules by day, week, or month. You can also quickly navigate the Scheduler to a specific 
date, or forward and backward through the clinic schedule by day, week or month. 

Viewing the schedule by day, week, or month

You can view the schedule by day, week, or month. You can simultaneously view multiple 
practitioner schedules for a single day or you can view daily, weekly, and monthly schedules for 
each practitioner. If you are working with appointments for today, the day view is best. If you 

Note: If your clinic supports multiple-locations, your current location is selected in 
the Filter drop-down list by default.

Tips for selecting locations

 To display the schedule for another clinic location, in the Filter drop-down list, 
click the location.

 To display the schedules for all clinic locations, in the Filter drop-down list, click 
<All Locations>.
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want to book an appointment in the future, you may want to see what a practitioner schedule 
looks like for the week or month to help you plan and book appointments.   

Viewing a practitioner schedule in week view

To view one week of a practitioner schedule:

1. Click in the practitioner schedule that you want to view.

2. On the View menu bar, click Week.

Viewing a practitioner schedule in month view

To view one month of a practitioner schedule:

1. Click in the practitioner schedule that you want to view.

2. On the View menu bar, click Month.

Viewing all default practitioners’ schedules in day view

To view one day of all default practitioner schedules:

On the View menu bar, click Day.

Viewing a specific date in the Scheduler

To navigate to a specific date in the Scheduler:

1. On the View menu bar, click Calendar. The EMR displays the calendar.

2. Click the month date between the two arrows. The calendar displays a window with the 
months of the year. 

3. Click the month you want to display. The calendar displays the month you selected.

4. In the calendar, click the date you want to display. The Scheduler displays that date. 

Navigating the schedule by day

To move forward or backward in the schedule one day at a time:

Note: The schedule defaults to the day view every time it is opened. The day view 
displays the practitioner's schedules that were selected to be the default. (See 
“Selecting default practitioner schedules to display” on page 75.) You can only 
view one practitioner at a time when viewing their schedule in week or month view.

Tip: To close the calendar without choosing a date, press the Escape key on your 
keyboard.
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Click the forward arrow (>) or back arrow (<) beside the displayed date.

Navigating the schedule by a specific number of days

You can navigate forward and backward in the schedule by a specific number of days. This 
navigation method is useful if you need to book a follow-up appointment for a patient for a 
specific number of days in the future. 

To navigate the schedule by a specific number of days:

1. On your keyboard, press Ctrl + U. The EMR displays a dialog box with the following prompt: 
“Enter the number of days to jump to”.

2. Perform one of the following actions:

 To move forward, enter the number of days you want to move forward. 

 To move backward, enter a minus sign - and then the number of days you want to move 
backward. For example -3.

3. Click OK.

Navigating the schedule by weeks

To move forward or backward in the schedule a week at a time:

1. Open a practitioner schedule in week view. See “Viewing a practitioner schedule in week 
view” on page 53.

2. Click the forward arrow (>) or back arrow (<) beside Week of <Date>.

Navigating the schedule by months

To move forward or backward in the schedule a month at a time:

1. Open a practitioner schedule in month view. See “Viewing a practitioner schedule in month 
view” on page 53.

2. Click the forward arrow (>) or back arrow (<) beside the displayed month.

Navigating back to today’s schedule

Sometimes you are busy scheduling appointments days, weeks, and months in advance, but 
then you need to see today’s schedule to book a walk-in patient.

To quickly navigate back to today’s schedule:

On the View menu bar, click Today.
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Booking patient appointments
To book a patient appointment:

1. Open the Appointment Scheduler: on the Wolf EMR Launch page, click Scheduling 

( ). The EMR opens the Appointment Scheduler.

2. If your clinic has multiple locations set up, at the top of the Appointment Scheduler, in the 
Filter Location drop-down list, click the location you want to book the appointment at. The 
available practitioner schedules change to reflect the practitioners who work out of that 
location. 

3. Search for and select the patient. See “Searching for a patient” on page 23.

Note: You can book appointments only for locations that you are assigned to. If 
you need access to book at a specific location, ask your Administrator to grant you 
this access.
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4. If the patient is new and you cannot find the patient, add the patient (see “Adding a new 
patient” on page 11), and then search for the patient again. 

The selected patient displays on the Appointment Scheduler window in the Patient Search 
area.

Tip: If you want to enter only basic information about a new patient, add the patient 
using Quick Add:

1. In the Appointment Scheduler menu, click Patient > New Patient (Quick 
Add) or, on your keyboard, press Ctrl + Q. The EMR displays the Patient Quick 
Add window.

2. Enter the patient’s demographic information, and then click Save. 
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5. On the patient’s practitioner’s schedule, right-click an empty appointment slot, and then click 
Book or, on your keyboard, press Ctrl + B. If configured to do so, the EMR displays the 
Appointment Detail window;

otherwise, the EMR adds the appointment with the default appointment reason and length 
(you can skip the remainder of the steps).

6. In the Appointment Detail window, use the following table to enter appointment details.
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7. Click Save ( ).

Field Description

Service Provider area

Referred By

(used by 
specialists clinics)

If you are booking an appointment for a patient who has seen the 
practitioner on several occasions, but on each occasion the patient 
was referred by a different practitioner, you can indicate who the 
referring practitioner is for this appointment:

1. In the Referred By field, enter part or all of the referring 
practitioners name.

2. In the drop-down list below, select the practitioner.

Note: The referring practitioner you select for the appointment is 
populated by default in the associated bill.

Tip: If the referring practitioner is not in the system, you can quickly 
add the referring practitioner to your consultants list from the 
Appointment Scheduler:

1. On the Appointment Scheduler menu, click Configure > New 
Referral Consultant (Quick Add). 

2. In the Referral Consultant Quick-Add window, enter the referring 
practitioner’s information, and then click Save.

Appointment for area

Reason In the drop-down list, select the reason for the appointment.

Length If the appointment is to be longer than the default length, in the drop-
down list, select the appointment length.

Notes To add additional notes about the appointment, in the Notes area, 
enter your notes. For example, if the patient has more than one 
appointment reason, you can enter the additional reason(s) in the 
Notes area.

Non Billable If the appointment is not to be billed, select this check box.
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Booking a patient for a walk-in appointment

You can quickly book a patient for a walk-in appointment using the Walk-in Quick Book option 
in Scheduling.  

Before you begin, ensure you have set up your Scheduler to easily book walk-in patients. See 
“Setting up your Scheduler to book walk-in patients” on page 80.

To book a patient for a walk-in appointment:

1. On the right side of the Scheduler, use the Patient Search area to search for the patient:

Tips for booking appointments

 If your EMR is not configured to show the Appointment Detail window, and you 
want to modify the appointment’s details from the Appointment Detail window 
(for example, to modify both the appointment’s length and reason), right-click 
the appointment, and then click Edit.

 If the appointment length is too long, you can quickly reduce the appointment 
length by one time slot. Right-click the appointment, and then click Shorten 
Appointment.

 To quickly change the reason for an appointment, right-click the appointment, 
and then click Change Appointment Reason.

 To quickly view or add appointment notes, right-click the appointment, and then 
click Appointment Notes.

 If open time slots are difficult to find, you can perform a search for the next 
available appointment: On the Appointment Scheduler menu, click 
Appointments > Time Search. 

 If you want to book an appointment for a patient without entering the patient in 
the EMR first (for example, to book a meet-and-greet appointment), you can 
book the appointment as a non-patient appointment. See “Booking an 
appointment without adding the patient in the EMR” on page 66.

Note: Your Administrator must create a walk-in practitioner in the EMR for the 
Walk-in Quick Book feature to work.

Note: If you do not have walk-in practitioners set up in the system, book the 
appointment as you normally would, then right-click the appointment and click 
Edit. In the Appointment Detail window, select the Walk-In check box to indicate 
that the current appointment is a walk-in appointment, rather than a scheduled 
appointment.
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a) In the Family Name /Portion field, enter the patient’s last name.

b) In the Given field, enter the patient’s first name, and then on your keyboard press Enter.

2. In the search results list, click the patient name, then, on your keyboard, press Ctrl+ Insert. 
(You can also click Appointments > Walk-in (Quick Book) on the Scheduler menu). If 
configured, the EMR displays Appointment Detail window.

3. If the EMR displayed the Appointment Detail window, click Exit. 

The EMR adds the patient to the Walk-in schedule.

 

Booking an appointment for a patient assigned to a care team

If you book an appointment for a patient assigned to a care team, you must first find out who 
the patient's care team members are. See “Viewing a patient’s care team members” on page 
60. After you find the patient’s care team members, you can book the patient in the appropriate 
practitioner schedules. See “Booking an appointment in two or more practitioner schedules 
simultaneously” on page 60. 

Viewing a patient’s care team members

To view a patient’s care team members:

1. From the Appointment Scheduler, search for the patient, and then open the Patient 
Maintenance window. See “Opening the Patient Maintenance window” on page 17.

2. In the Name/Addr/Phone tab, in the Care Team area (located in the second column), click 
View.

Booking an appointment in two or more practitioner schedules simultaneously

When you book multiple practitioners, you usually book one after another, sometimes with a 
small bit of overlap. Practitioners are not usually scheduled at the same time. However, in some 
situations, you may need to book care team members together at the same time with a patient. 

Note: When you use the Walk-in (Quick Book) method to book the patient, the 
patient automatically appears in the schedule as Arrived. (The EMR displays "A-" in 
front of the patient's name in the appointment time slot to indicate a patient as 
arrived.)

Note: Depending on your clinic’s workflow, you might manually move the walk-in 
patient appointment to a practitioner’s schedule. In other workflows, a practitioner 
must claim the patient from the Walk-In list on their WorkDesk. After a practitioner 
claims a patient, the EMR automatically moves the walk-in patient appointment to 
their schedule.
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To book an appointment in two or more practitioner schedules simultaneously:

1. Ensure that both of the practitioner’s schedules are visible in the Scheduler. 

2. Find an appointment slot that is free in both of the practitioner’s schedules at a reasonable 
distance apart.

3. Book the appointment in one of the practitioner’s schedule.

4. Right-click the appointment you booked with the first practitioner and click Copy. Your 
cursor changes to a large plus sign. 

5. In the other practitioner's schedule, click an empty time slot. The EMR displays a dialog box 
asking “Provider is different - continue?”. Click Yes. The EMR adds the copied appointment 
to the second practitioner’s schedule and displays a dialog box asking “Are you going to 
make another copy of this appointment?”

6. Perform one of the following actions:

 If you want to copy this appointment into another practitioner’s schedule, click Yes, and 
then click an empty time slot in the next practitioner’s schedule.

 If you are finished copying the appointment into other practitioner’s schedules, click No. 

Booking an appointment for a practitioner and a resource simultaneously

You can book an appointment for a practitioner and a resource at the same time. Some 
examples of a resource include a nurse, a room, or even piece of equipment required for the 
appointment. 

To book an appointment for a practitioner and a resource simultaneously:

1. Book an appointment as you normally would. See “Using patient lists (waiting lists)” on page 
108 or “Booking appointments that are not linked to patients” on page 65.

Tip: If you want to change any details in the appointment you copied into another 
practitioner’s schedule, right-click the copied appointment and click Edit to open 
the Appointment Detail window. 

Note: For this feature to work, your Administrator must configure the EMR to Use 
Multi-Resource. Your Administrator must also assign specific Resource Types in 
the EMR and associate these resources with specific Appointment Types. For 
example, your Administrator might add a nurse as a resource, and associate the 
Resource Type of Nurse, with an Appointment Type of PAP.
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2. In the Appointment Detail window, in the Appointment for section, in the Type drop-down 
list, click an appointment type. The EMR displays all of the resource types associated with 
this type of appointment in the Resources area. 

3. In the drop-down list beside each resource type, click the resource that you want to book 
with this appointment. For example, in the drop-down list beside the resource type Nurse, 
click a nurse’s name.

4. When you finish selecting resources, click Save ( ).

Booking multiple patients in one time slot

You can book an unlimited number of patients in one time slot. This feature is useful for group 
bookings. 

To book multiple patients in one time slot:

1. Book the first patient. See “Using patient lists (waiting lists)” on page 108.

2. In the Scheduler, click the booked time slot and then, on the Appt: menu bar, click Add 
Line. (You can also press Ctrl + I on your keyboard.) The EMR inserts a new line below the 
current time slot.

3. Book the next patient as usual in the new slot. See “Using patient lists (waiting lists)” on page 
108.

4. Repeat Step 2  to Step 3 for each patient you want to book in this time slot. 

Finding the next available time slot with a defined set of criteria

Often, when you book appointments, you need to meet a specific set of criteria. For example, 
you may need to book a specific type of appointment at a specific location, on a specific day. If 
you work in a busy clinic, it can be very difficult to find open time slots that meet your criteria. 
Appointment time searches can save you a lot of time and frustration. You can perform an 
appointment time search to quickly find the next available time slot that meets all of your 
booking requirements.

To perform an appointment time search:

1. On the Scheduler menu, click Appointments > Time Search. The EMR displays the 
Available Time Slot Search window.

Tip: The EMR displays the Appointment Detail window only if your Administrator 
has configured the EMR to open the window during booking.

If the EMR does not display the Appointment Detail window during booking, after 
you make the appointment, right click the appointment and click Edit. The EMR 
opens the Appointment Detail window. You can now select an appointment Type.
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2. In the Practitioner area:

a) Select the check box beside the practitioner(s) you want to book the patient with.

b) If you select more than one practitioner, click one of the following options:

 All Selected: to find an available appointment slot for all of the selected practitioners

 Any Selected: to find an available appointment slot for any of the selected practitioners

3. To book a room (or rooms) for appointment, in the Rooms area:

a) Select the check box beside the room(s) you want to book the patient in.

b) If you select more than one room, click one of the following options:

 All: to find an available appointment slot for all of the selected rooms

 Any: to find an available appointment slot for any of the selected rooms

4. Use the following table to enter your search criteria. 

Field Description

Location If your clinic has multiple clinic locations, in the drop-down list, 
click the location you want to book the appointment, or click 
All.

Note: If the patient list is assigned to a specific location, then 
that location is selected by default.

Day of Week  To search for available appointment slots on a specific day 
of the week, in the drop-down list, click the day.

 To search for available appointment slots on any day of the 
week, in the drop-down list, click Any day.

Note: You cannot click multiple days (for example, Monday 
and Friday).

Time Type To find an available appointment slot in a time put aside for 
specific types of appointments (using Time Types), in the drop-
down list, click the appointment reason.

Look in # of Days Enter the number of days from the Start From date to search 
for available appointment slots. For example, to view available 
appointment slots for the next week, enter 7.

Get # of Time Slots Enter the number of time slots you require. 

Start From Enter the date and time from which to start looking for the 
appointment. This field defaults to the current date.

Minutes Between 
Time Slots

Enter the number of minutes you want between any time slots. 
The default is 30.
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5. Click Search. The EMR lists time slots matching your criteria for the next 10 day period in 
the Resulting Time Slots area.

6. In the Resulting Time Slots area, click the time slot that you want to book. The EMR 
displays the practitioner(s) name(s) at the bottom of the window.

7. Perform one of the following actions:

 To book the appointment, click Book. The EMR books the patient and removes the 
patient from the waiting list.

 To view the time slot on the Appointment Scheduler first, click Go To Time Slot. The 
EMR opens the Appointment Scheduler for the selected date. The appointment slot is 
highlighted and the patient’s name is selected n the Patient Search area. 

Booking repeat visits for a patient with the same appointment reason

There may be times when you need to book repeat visits for a patient with the same 
appointment reason. For example, you may have a diabetic patient who is notorious for 
forgetting to book her regular diabetic check-ups. You might encourages her to book all of her 
diabetic visits for the year all at the same time. You can easily book these repeat visits by 
repeatedly copying one appointment and then adding each copied appointment to empty time 
slots in the Schedule.

To book repeat visits for a patient with the same appointment reason:

1. Book the first appointment as usual. See “Using patient lists (waiting lists)” on page 108 or 
“Booking appointments that are not linked to patients” on page 65.

Minimum Time Slot 
Length

Click the minimum length you want for a time slot. Your choices 
are: <Any>, 5, 6, 7.5, 10, 12, 15, 20, 30, or 60 min.

Specific Time area 

Use this area to limit the time of day for available appointments slots displayed.

After this time Enter the minimum start time in hours and minutes (using the 
24 hour clock). The appointment search finds appointments 
after the time you enter here.

Before this time Enter the maximum end time in hours and minutes (using the 
24 hour clock). The appointment search finds appointments 
before the time you enter here.

Important:

If you book the patient from the Appointment Scheduler, and that patient was on 
the waiting list, you must manually remove the patient’s name from the waiting list. 
See “Printing an appointment list (day sheet)” on page 151.

Field Description
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2. Right-click the first appointment you booked for the patient and click Copy. Your cursor 
changes to a large plus sign.

3. Navigate to the day you want to book the next appointment, and click an empty time slot. 
The EMR adds the copied appointment to the schedule and displays a dialog box asking 
“Are you going to make another copy of this appointment?”

4. Perform one of the following actions:

 If you want to copy this appointment to add it to another day in the schedule, click Yes, 
and then repeat step Step 3 .

 If you are finished adding copied appointments to the schedule, click No. 

Viewing the appointment history for a patient

You can view the appointment history for a patient to ensure that you do not book them too 
early or too late for a specific type of appointment. You can also see, in general, when they 
prefer to be booked. For example, some patients prefer appointments first thing in the morning, 
while others prefer to have appointments after they are done work.

To view the appointment history for a patient:

1. Perform one of the following actions:

a) In the Schedule, click a patient’s booked appointment. 

b) Use the Patient Search area to search for the patient, then click the patient’s name.

2. On your keyboard press F9. The EMR displays the Patient Maintenance window. 

3. Click the Appointments tab. You can see a list of the patient’s previous appointments with 
details including the dates and times they were booked, the practitioners they saw, and the 
reasons for the appointments.

Booking appointments that are not linked to patients
There are times when you need to book appointments that are not linked to a patient. 

For example, you may need to book a meet-and-greet appointment for a new patient. However, 
the practitioner has not yet confirmed that they want to accept this patient into their practice, so 
you do not want to add the patient in your EMR system until after the meet and greet 
appointment. See “Booking an appointment without adding the patient in the EMR” on page 66.

Other examples of appointments that are not linked to a patient are meetings with sales 
representatives, or staff meetings. See “Booking a non-patient appointment” on page 66. 
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Booking an appointment without adding the patient in the EMR 

To book an appointment without adding the patient to the EMR:

1. On the right side of the Scheduler, in the Patient Search area:

a) In the Family Name /Portion field, enter the patient’s last name.

b) In the Given field, enter the patient’s first name. 

2. On the lower right side of the Scheduler, in the Appointment Reason drop-down list, click 
a reason for the appointment.

3. On the Scheduler, right-click an empty appointment slot and click Book. The EMR opens a 
a dialog box prompting you to enter a contact phone number.

4. Enter the patient’s phone number and click OK. (If you don’t want to enter a number, click 
Cancel.) 

5. If the EMR displays the Appointment Detail window, perform one of the following actions:

 If you need to change the appointment details, make your changes, click Save ( ) 
and then click Exit. 

 If you do not need to change the appointment details, click Exit.

The appointment appears in the Scheduler with an asterisk (*) before the patient’s name. For 
example * Fred Smith. 

Booking a non-patient appointment 

Examples of non-patient appointments are meetings with sales representatives, or staff 
meetings.

To book a non-patient appointment:

1. On the right side of the Scheduler, in the Patient Search area:

a) In the Family Name field, enter a description of the appointment (for example, Pharma 
Rep).

Note: Do not press Enter.

Tip: The asterisk (*) indicates the appointment is not linked to a patient.

Note: Do not press Enter.
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2. On the Scheduler, right-click an empty appointment slot and click Book. The EMR opens a 
a dialog box prompting you to enter a contact phone number.

3. Enter the contact phone number and click OK. (If you don’t want to enter a number, click 
Cancel.) 

4. If the EMR displays the Appointment Detail window, perform one of the following actions:

 If you need to change the appointment details, make your changes, click Save ( ) 
and then click Exit. 

 If you do not need to change any of the appointment details, click Exit.

The appointment appears in the Scheduler with an asterisk (*) before the description you 
entered in the Family Name field. For example * Pharma rep.  

Viewing the phone number of a non-patient

To view the phone number of a non-patient:

1. In the Scheduler, click the non-patient appointment.

2. Perform one of the following actions:

 Hover your cursor over the non-patient appointment. The EMR displays the reason for 
the appointment and the non-patient phone number.

 On the Scheduler menu, click Appointments > Non Patient Phone Number. The 
EMR displays the phone number in the NON Patient Contact Phone Number dialog box. 
Click OK. 

Indicating that an appointment should not be billed 

When you book non-patient appointments (for example, staff meetings) you need to indicate 
that the appointment should not be billed.

To indicate that an appointment should not be billed:

1. In the Scheduler, right-click the non-patient appointment and click Memo (Non-Billable). 
The EMR displays a dialog box with the message “Disable billing for this appointment?”

2. Click Yes. The EMR displays a dialog box with the message “Memo Designation added.”

Tip: The asterisk (*) indicates the appointment is not linked to a patient.

Best Practice: After you book a non-patient appointment, ensure that you 
indicate that the appointment should not be billed. See “Indicating that an 
appointment should not be billed” on page 67.
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3. Click OK. The non-patient appointment appears in the Scheduler with MEMO after the 
asterisk. For example, * MEMO Staff Meeting.  

Changing an appointment before the appointment date
You work in a busy clinic and patients have busy lives, so things can change. You may need to 
make changes to a patient’s appointment. The following sections describe some of the ways to 
change an appointment before the appointment date. 

Changing the appointment reason, length, and other details

To change appointment details:

1. In the Appointment Scheduler, right-click the appointment and click Edit.

2. Edit the appointment details as necessary.

3. Click Save ( ) and then click Exit. 

Moving an appointment to a new time, day, or practitioner

To move an appointment:

1. In the Scheduler, right-click the appointment and click Move. The EMR displays a dialog 
box asking you to confirm the move information.

2. Click Yes. Your cursor changes to a plus sign with arrows on the ends.

3. Navigate to the day where want to move appointment, and click an empty time slot. The 
EMR moves appointment. 

Note: If you moved the appointment to a different practitioner’s schedule, The EMR 
displays a dialog box asking “Provider is different - continue?”. Click Yes. 

Cancelling an appointment before the appointment date

To cancel an appointment before the appointment date:

1. In the Scheduler, right-click the appointment and click Cancel and then click one of the 
following options:

Note: This memo flags to the billing staff that they do not need to create a bill for 
this appointment.

When you add the memo designation, the appointment does not appear in the 
Billing list in the Billing program.
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 Cancel (less than 24 hours): Click this option if the patient cancels with less than 24 
hours notice.

 Cancel (greater than 24 hours): Click this option if the patient cancels with more than 
24 hours notice.

 Remove: Click this option to remove an appointment you made in error. (You can only 
Remove an appointment that is not yet Arrived.)

The EMR displays a dialog box asking you if you want to cancel this appointment.

2. Click Yes. If you chose one of the Cancel options, the EMR displays the following prompt: 
“Do you want to create a bill for this cancellation?”.

3. Perform one of the following actions:

 If you want to create a bill, click Yes.

 If you do not want to create a bill, click No. 

Managing and tracking patient appointments
The following sections provide and effective workflow to help you manage and track patient 
appointments from confirmation, to arrival, and departure. 

About the Appointment Confirmations list

Some clinics like to confirm their appointments with their patients to maintain their schedules 
and to remind the patient of their appointments. 

You can use the Appointment Confirmations list to view a list appointments that need to be 
confirmed. You can see which patients you need to contact to remind them of their 
appointment and to get them to confirm their appointment.

Tip: The EMR tracks cancelled appointments for each patient, including the 
cancellation type. You can use this information to bill for late cancellations, or to 
know which patients to stop booking. 

You can find a list of cancelled appointments in the Patient Maintenance window, 
on the Appointments tab.
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Enabling a patient’s name to appear on the Appointment Confirmations list  

Viewing the Appointment Confirmation list

To view the Appointment Confirmation list:

On the Scheduler menu, click Patients > O/S Appt Confirmations - 5 Days.

Confirming an appointment

To confirm an appointment:

1. In the Scheduler, right-click the appointment and click Confirm. The EMR displays a dialog 
asking you if you want to “Update Appointment as CONFIRMED?”

2. Click Yes. The EMR inserts a C before the patient name, to indicate that the patient has 
confirmed their appointment. 

Indicating that a patient did not show up for their appointment

When a patient doesn’t show up for an appointment, you need to cancel the appointment, and 
indicate that the patient was a “no show”. 

To indicate that a patient did not show up for their appointment:

1. In the Scheduler, right-click the appointment and click Cancel > Cancel (No Show). The 
EMR displays a dialog box asking you if you want to cancel this appointment.

2. Click Yes. The EMR displays the following prompt: “Do you want to create a bill for this 
cancellation?”.

3. Perform one of the following actions:

 If you want to create a bill, click Yes.

 If you do not want to create a bill, click No.

Important: 

For a patient’s name to appear on the Appointments Confirmations list, you 
must select the Confirm Appointments check box for the patient on the 
Appointments tab in the Patient Maintenance window.

The next time you make an appointment for this patient, the EMR adds their name 
to the Appointments Confirmations list.

Tip: To view the appointment reason and patient phone number for a confirmed 
appointment, hover your cursor over the appointment.
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The EMR displays the following prompt “Set ‘Confirm Appointment’ indicator for this 
patient?”.

4. Perform one of the following actions:

 If you want to set a “Confirm Appointment” indicator for this patient, click Yes. 

 If you do not want to display the patient's name and phone number in the Appointment 
Confirmation list, click No. 

Indicating that a patient has arrived

To indicate that a patient has arrived:

In the Scheduler, right-click the appointment and click Arrive. The EMR inserts an A before the 
patient name, to indicate that the patient has arrived, and displays the Verify Patient Details 
window.

Validating a patient's demographic information

After you mark a patient as Arrived, the EMR displays the Verify Patient Details window.

Tips: 

 If you click Yes, the EMR selects the Confirm Appointments check box on 
the Appointments tab in the Patient Maintenance window.

 When the Confirm Appointments check box is selected, the next time you 
make an appointment for the patient, the EMR displays the patient's name and 
phone number in the Appointment Confirmations list. You use the 
Appointment Confirmations list to view appointments that need to be 
confirmed. You can see which patients you need to contact to remind them of 
their appointment and to get them to confirm their appointment.

 To view the Appointment Confirmations list: On the Scheduler menu, click 
Patients > O/S Appt Confirmations - 5 Days.

Best practice: Always use the Cancel (No Show) option when you cancel an 
appointment for a patient who does not show up. 

(Do not cancel the appointment with the Cancel (less than 24 hours) option or the 
Cancel (greater than 24 hours) option.)

Tip: If your Administrator configured No Show Warnings, the next time you book 
a patient who did not show up for an appointment, the EMR displays a message 
indicating the number of no shows the patient has had in a set number of months. 
For example, “Patient had 2 no shows in last 6 months.”
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To validate a patient’s demographic information:

1. In the Verify Patient Details window, verify that all of the information is correct.

2. Perform one of the following actions:

 If the information is correct, click Close.

 If you want to verify the patient’s PHN with MSP, click Verify with MSP. 

 If you need to update the information, click Open Patient Maintenance, and then do 
the following:

a)   Update the information as necessary, and then select the Patient Data Verified 
check box.

b)   Click Save ( ) and then click Exit.

Monitoring clinic traffic

You can monitor clinic traffic to keep track of: patients who have appointments for today, but 
have not yet Arrived, patients who are waiting for a room, and which exam rooms are occupied, 
and by whom.

To monitor clinic traffic: 

Ensure the Scheduler is open, then on your keyboard, press Control + J. The EMR displays 
the Clinic Day View window. 

The Clinic Day View window contains three main areas:

 Appointments: The Appointments area displays all patients who have appointments for the 
current day and have not yet Arrived.

 Patients Waiting: The Patients Waiting area displays all patients that have Arrived for their 
appointment, but have not moved to an exam room yet.

 Exam Rooms: The Exam Rooms area displays all patients in Exam rooms. You can see 
which room the patient is in, when they moved to the room, and which practitioner the 
patient is booked with.

Note: The Clinic Day View window contains read-only information.
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Indicating that a patient has moved to an exam room

You can indicate that a patient has moved to an exam room and, if rooms are configured, you 
can also indicate the room number. 

Indicating a patient has moved to an exam room (if rooms are not configured)

To indicate that a patient has moved to an exam room (If rooms are not configured):

In the Scheduler, right-click the appointment and click In Exam Room. The EMR inserts an E 
before the patient name, to indicate that the patient has moved to an exam room.

Indicating a patient has moved to an exam room (if rooms are configured)

To indicate that a patient has moved to an exam room (If rooms are configured):

1. Ensure the Scheduler is open, then on your keyboard, press Control + J. The EMR 
displays the Clinic Day View window.

2. In the Exam Rooms area, check to see which rooms are available, and then click Exit.

3. In the Scheduler, click the appointment, and then on the Appt menu bar, in the Exam 
Room drop-down list (beside the Arrived button), click a room. The EMR inserts the room 
number before the patient name, to indicate that the patient has moved to that exam room.

Marking an appointment as finished

To mark an appointment as finished:

In the Scheduler, right-click the appointment and click Finished. The EMR inserts an F before 
the patient name, to indicate that the appointment is finished.  

Note: A practitioner can mark the appointment as finished when they close their 
notes.

Tip: If you unintentionally change the appointment status (Confirmed, Arrived, In 
exam room, or Finished) and want to revert back to the previous status, right-click 
the appointment and click Reset Appointment Status. 

For example: You confirmed an appointment, and set the status to Arrived when 
the patient came in. However, you then set the status to In Exam Room, but you 
hadn’t assigned an exam room and the patient was still in the waiting room. To fix 
this, you would right-click the appointment and click Reset Appointment Status. 
The status would revert to Arrived.
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Reminding a patient of upcoming appointments

When a patient is finished with their appointment, you may want to remind them of any 
upcoming appointments. You need a way to easily view a patient’s future appointments.

Viewing a patient’s future appointments

To view a patient’s future appointments:

1. In the Scheduler, click the patient’s current appointment. The Future Appointments field, 
near the bottom of the Patient Search panel, displays the patient’s next appointment.

2. To view other future appointments for this patient, click the down arrow to the right of the 
Future Appointments field. 

Viewing more information about a patient’s future appointment

You may want to view more information about a patient’s future appointment. You can set the 
EMR to display an Appointment Information window when you click a future appointment. The 
Appointment Information window contains more information about the patient’s future 
appointment. 

To view more information about a patient’s future appointment:

1. On the Scheduler menu, click User Preferences > Appointment Display Settings > 
Show Next Appointment Data. 

2. In the Scheduler, click the patient’s current appointment.

3. Near the bottom of the Patient Search panel, in the Future Appointments drop-down list, 
click an appointment. The EMR displays an Appointment Information window with more 
information about the patient’s future appointment. The future appointment information 
includes:

 Date and time

 Practitioner

 Length

 Location

 Reason 

Printing a list of future appointments for a patient

If a patient has a series of upcoming appointments, you may want to print this list for the patient.

Tip: After you enable the Show Next Appointment Data option, you can view 
additional information about any patient’s future appointments.
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To print a list of future appointments for a patient:

1. In the Scheduler, click the patient’s current appointment.

2. On the Scheduler menu, click Reports > Future Appointments. 

The EMR displays the Printer Options window.

3. If you want to print the report for a specific provider, in the Provider drop-down list, click a 
provider.

4. Click OK.

Setting up practitioner schedules
There are several ways to set up practitioner schedules to customize your Scheduler 
workspace and to help you work as efficiently and comfortably as possible. You can select the 
number of practitioner schedules to display, and choose to display only a default set of 
practitioners working today. You can also create groups of practitioners to display at the same 
time.

Setting the number of practitioner schedules to display

You can choose the number of practitioners you want to display in the Scheduler for optimal 
viewing. Each practitioner schedule appears as a column in the Scheduler.

1. On the Scheduler menu, click User Preferences > Schedule Display Settings > Set 
Max Displayed. The EMR displays a dialog box.

2. In the dialog box, enter the maximum number of practitioners (columns in the scheduler) you 
want to display at once and click OK.

Selecting default practitioner schedules to display

You can select specific practitioners to display by default. This feature is useful if you want the 
Scheduler to only display the practitioners who are working today.

To select default practitioner schedules to display:

1. Select the number of practitioner schedules to display. See “Setting the number of 
practitioner schedules to display” on page 75.

Note: If the patient does not have any future appointments, you can not select the 
Future Appointments option. The Future Appointments option is greyed out. 

Tip: You can display up to eight practitioner schedules at once, however, four 
tends to facilitate optimal viewing (depends on screen size).
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2. At the top of each schedule column, in the practitioner drop-down list, click the practitioner 
whose schedule you want displayed. (This also sets the order that the practitioner 
schedules appear across the Scheduler.) 

3. When you are finished selecting practitioner schedules, on the Scheduler menu, click User 
preferences > Schedule Display Settings > Save Service Providers Selected to save 
this view. 

Creating a practitioner group

Creating practitioner groups is particularly useful for large clinics because it allows you to create 
groups of practitioners that you can view at the same time. For instance, on any given day only 
certain practitioners may be in the office. You can create a practitioner group for every day of 
the week. 

To create a practitioner group:

1. Ensure you have set the maximum number of columns to display in the scheduler. See 
“Setting the number of practitioner schedules to display” on page 75. 

2. On the Scheduler menu, click User Preferences > Schedule Display Settings > Add 
group. The EMR displays the Add Physician Group dialog box.

3. In the New Physician Group field, enter a name for your practitioner group.

Note: If you do not save this view, the practitioners you selected are not saved and 
your Scheduler reverts to the original Scheduler layout before you changed the 
columns.

Note: Before you begin this process, select a date when you are sure there are no 
locums scheduled to work. They will replace the practitioner in this group.
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4. Click OK. The EMR displays a dialog box with the following message: “Screen Initialized - 
select desired Service Providers for each appointment list - DO NOT select locums, they will 
automatically replace Office Service Providers”

5. Click OK. The EMR displays a dialog box with the following message: “Physician group 
added”. 

6. Click OK. A drop-down list appears beside the Filter field, displaying the group you just 
created. All practitioner schedules are removed from the screen and are replaced with blank 
schedules. 

7. At the top of each schedule column, in the practitioner drop-down list, click the practitioners 
you want to add to the group. 

8. On the Scheduler menu, click User Preferences > Schedule Display Settings > Define 
group. The EMR displays a dialog box with the following message: “<group name> 
defined”.

9. Click OK.

Viewing a practitioner group

To view a practitioner group: 

In the practitioner group drop-down list beside the Filter field, click the group of practitioners 
you want to display. The Scheduler displays the practitioner group.

Deleting a practitioner group

If you no longer require a practitioner group, you need a way to delete it.

To delete a practitioner group:

1. In the practitioner group drop-down list beside the Filter field, click the practitioner group 
that you want to delete. The Scheduler displays the practitioner group.

2. On the Scheduler menu, click User Preferences > Schedule Display Settings > 
Remove group. The EMR displays a dialog box with the following message: “Remove 
Physician Group: <group name>?”. 

Note: Ensure that your practitioner selections are correct and appear in the order 
you want. The practitioner selections on your screen will become the practitioner 
group.

Note: Practitioners can be a member of more than one group. 

Important: Groups are user-specific, so they are not visible to other users in the 
clinic.
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3. Click Yes. The EMR displays a dialog box with the following message: “Physician Group 
removed”.

4. Click OK.

Changing a practitioner group

You work in a busy clinic with schedules that can change, and often do. You need a way to 
change practitioner groups to adapt to these changes. 

The changes you need to make to the group determine which method you use: 

 If you want to change the members in a group, see “Changing practitioner group members” 
on page 78.

 If you want to change the name of a practitioner group, see “Changing the name of a 
practitioner group” on page 78.

Changing practitioner group members

To change practitioner group members:

1. In the practitioner group drop-down list beside the Filter field, click the practitioner group 
that you want to change. 

2. In the Scheduler, at the top of each schedule column, in the practitioner drop-down list, click 
the practitioners you want in the group.

3. When you finish selecting the practitioners and their order, on the Scheduler menu, click 
User Preferences > Schedule Display Settings > Define group.

Changing the name of a practitioner group

If you want to change the name of a practitioner group, you must first delete the group and then 
recreate the group with the new name.

To change the name of a practitioner group:

1. Delete the practitioner group that you want to rename. See “Deleting a practitioner group” on 
page 77. 

Note:

 If you are removing members, you must initialize the screen to clear the 
practitioners names: On the Scheduler menu, click User Preferences > 
Schedule Display Settings > Initialize Screen.

 If you are adding a members, increase the Set Max Displayed number to the 
number of practitioners who will be in the group: On the Scheduler menu, click 
User Preferences > Schedule Display Settings > Set Max Displayed.
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2. Recreate that group with the new name. See “Creating a practitioner group” on page 76. 

Customizing the Scheduler to facilitate booking
You can set up user-specific Scheduler configurations to increase the efficiency of your patient 
searches and to facilitate your booking workflow. For example, you can set the EMR to display 
a patient’s primary practitioner when you are booking them. This helps facilitate your booking 
workflow, as you can verify the patient’s practitioner at a glance.

To customize the Scheduler display options: 

1. Open the Scheduler: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click Scheduling.

2. On the Scheduler menu, click User Preferences > Booking Display Settings. 

3. Use the following table to customize your Schedule display using the Booking Display 
Settings:  

Booking Display Setting Description

Display Confirmation 
Method

Creates a Confirmation Method field in the lower right-
hand portion of the screen. Use this field to indicate the 
method of communication you used to confirm the 
appointment with the patient. If the appointment is already 
confirmed, this field indicates the method used to confirm 
the appointment.

To remove this field, click Display Confirmation Method a 
second time to toggle it off again and the field disappears 
from the screen.

Display Priority Displays the Priority of the patient’s appointment in the 
Patient Search area. You use the Priority drop-drop 
down list to change the priority status. Examples of 
appointment priorities are High or Low.

Display Service 
Provider

Creates a box in the lower right-hand portion of the screen 
where the primary service provider of the patient is 
displayed when the patient is selected from the Patient 
Search or the appointment is selected in the Scheduler.

Display Referral 
Physician

Creates a Referred By field in the lower right-hand portion 
of the screen where the referring Physician of the patient is 
displayed when the patient is selected from the Patient 
Search or the appointment is selected in the Scheduler.
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Setting up your Scheduler to book walk-in patients
To set up your Scheduler to easily book walk-in patients:

1. On the Scheduler menu, click User Preferences > Schedule Display Settings > Set 
Max Displayed. The EMR displays a dialog box.

2. In the dialog box, enter the maximum number columns to display in the scheduler to one 
more than the number of practitioners working that day. For example, if there are four 
practitioners working that day, set the maximum columns to display as five.

Display DOB in Patient 
Search

 Displays the patient date of birth (DOB) beside their 
name on search lists

 Creates a DOB field for you to enter the patient's Date of 
Birth when doing a patient search.

Double Booked Sort By 
Booked

Sort double-booked appointments by the booked time 
rather than the arrived time. This is not the default setting, 
meaning that double booked appointments sort by arrival 
time until you select this option.

Display Appointment 
Reasons

Creates an Appointment Reason field in the lower right-
hand portion of the screen where you can select an 
appointment reason when booking a patient appointment.

Appointment Reason 
Settings

Select one of the following options for viewing the reason of 
an appointment:

 Load Reasons at Startup

 Clear Reason after booking

 Prompt if No Appointment Reason

Include Inactive 
Patients in Search

Displays Inactive or Archived patients. You can find this 
Inactive/Archive information on the Other Demographics tab 
in Patient Maintenance. Valid options are:

 All

 Left Practice (LP) Only

 Deceased (D) Only 

 Inactive (I) Only 

Booking Display Setting Description
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3. Set the far right column to be the Walk in column: In the far right schedule column, in the 
practitioner drop-down list, click Walk in.

Your instructor will explain how to use this column later in the module when they cover “Booking 
a patient for a walk-in appointment” on page 59.

About schedule priorities
Schedule priorities determine how background colour and text are layered on the schedule. 
When you set up your appointment schedule layouts, you apply priority levels to blocks of time 
to provide a more visual stacking of the schedule and to define how the schedule is going to 
look. 

The priority level you use matters.The lower the priority level number, the higher the priority, 
which means that a priority of 1 overrides almost everything else and appears on the top layer 
of the schedule. You can use priority levels to make certain blocks of time stand out on the 
schedule, or override other blocks of time. For example, when you block off time in the 
schedule for a practitioner's lunch, you set the Priority to level 4. Then when you block off 
vacation time for that practitioner, you set the Priority level to 3. This layers the vacation notice 
on top of the lunch notice.

Another example is that a Holiday (Priority level 2), for example Canada Day, takes precedence 
over a Lunch/Meeting (Priority level 4). 

Note: This set up requires that your Administrator has created a generic walk-in 
practitioner in the EMR. If you do not see Walk in the practitioner drop-down list, 
ask your Administrator to create a generic walk-in practitioner in the EMR with the 
following data:

Name/Address tab:

 Family name = Walk in

 Resource Type = Practitioner 

 Primary Location = <<Your location>>

 Provider Label Name = Walk in

Other Data tab:

 Select the Walk-in Physician check box
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Schedule Priority codes

The following table describes the default schedule Priority codes. 

Setting up appointment schedule layouts
The following sections explain how to do the following:

 Set practitioner booking hours

 Add new Schedule Type options

 Configure appointment reasons

 Block off time in the schedule for breaks and vacation days

 Specify days when a practitioner works at another facility

 Assign specific types of appointments to days or time slots 

 Quickly block off (and unblock) an appointment slots or an entire day

 Add a note to a day on a practitioner’s schedule

Setting a practitioner’s booking hours 

To set a practitioner’s booking hours:

Priority code Definition / Description

1 (Reserved) Highest priority (top layer in the schedule)

Doctor’s Exception

2 Holiday entries

3 Do Not Book / Off / Vacation

4 Lunch / Meeting 

5 Peak Hours

6 to 8 Service Provider - Services: Clinic visits, Complete Physical Exams (CPX), 
Prenatal exams

9 Clinic Hours

Lowest priority (bottom layer in the schedule)
82 Wolf Front End Staff User Guide - Issue 02.05



Appointments
1. On the Scheduler menu, click Configure > Physician and Clinic Hours (Schedule 
Setup). The EMR displays the Time Definition Maintenance window.

2. If your clinic has multiple locations, in the Location drop-down list, click the location where 
you want to set the hours.

3. In the Service Provider drop-down list, click a practitioner’s name. 

Tips:

 If you want to set hours that apply to the entire clinic (for example, statutory 
holidays), click <Entire Office> in the Service Provider drop-down list.

 The Schedule Type drop-down list contains a list of holidays and other clinic-
wide schedule types to choose from.
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4. In the top left area of the Time Definition Maintenance window, click New ( ). The EMR 
displays the Schedule Definition tab. 

5. In the Schedule Type drop-down list, click Clinic Hours. 

6. In the Day of the Week drop-down list, click Monday and, then in the From and Up To 
areas, in the Hour and Min fields, enter the practitioner start and end times for Monday. For 
example, if If the practitioner only works 10 AM to 2 PM on Mondays, then you would enter 
10 in the From Hour field and 00 in the From Min field. You would then enter 14 in the Up 
to Hour field and 00 in the Up to Min field. 

Tip: If you are defining web-bookable day or time slot, click a Schedule Time Type 
that is configured to be “web bookable”.

Tip: If you do not see the schedule type that you want in the Schedule Type drop-
down list, you can add a new type. See “Adding new Schedule Type options” on 
page 86.
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7. For clinic hours, ensure the Priority field is set to 9. (The Priority code for clinic hours is 9.)  

8. In the Appointment Definition area, in the Reason drop-down box, click to select a 
default appointment reason. (This field is usually set to Office Visit.) 

9. In the Appointment Definition area, in the Length drop-down list, click the default length 
for appointments booked on these time slots. 

10. To indicate that patients can book online appointments only with the practitioner defined as 
their primary care provider, in the Web Booking area, select the Own Patients Only check 
box.

11. In the Time Definition Time Period area, in the From and Up To (Not including) fields, 
enter the Date Range you want the hours you defined to be in effect. 

12. Click Save ( ).

13. Repeat steps Step 6  to Step 12  for each day of the week that the practitioner works.

Tip: When setting web-bookable Time Definitions, set the Priority to be a higher 
than the number you use for holidays and practitioner Out of Office Time 
Definitions.

Appointment slots are only web bookable if a web-bookable Time Type is visible on 
the schedule. If you “hide” a web-bookable Time Type with another Time Type, for 
example “Out of Office”, then that appointment slot is no longer web-bookable. 

Tips:

 The From field defaults to today’s date. If you leave the Up To field blank, the 
time period is forever, or until you change the Up To field at a later date.

 If this time definition is only relevant for one day, enter the date in the Specific 
Date (1 Day Only) field.

Web-bookable slots are covered by
“out-of-office”, therefore the slots 
are no longer web-bookable.
Wolf Front End Staff User Guide - Issue 02.05 85



Appointments
  

Adding new Schedule Type options

Schedule Time Types are the individual blocks of time you can book on the clinic schedule. 
Some time types are pre-defined, but you may add as many as you like.

If office hours are defined for a practitioner (as opposed to out-of-office hours), examples of 
time types might be CPX (Complete Physical Exam) or Drug Representative. If out-of-office 
hours are defined, examples of time types might be vacation, conference, lunch, or rounds. 
Other clinic-wide time types include holidays. You can set the time type to appear on the 
Scheduler with a certain color in the background.

To add a new Schedule Time Type option when creating a time definition:

Tips:

 When booking practitioner hours, consider the earliest possible time and the 
latest possible time that a practitioner may need to be booked for an 
appointment.

 A leeway of 30 to 60 minutes both before and after normal booking hours is a 
good starting point. 

 Don't forget to consider nights when practitioners may work with walk-ins.

 The Up To field sets the schedule Up To that time. For example, if you have 15 
minute appointments and you set the Up To time to 14:00, your last 
appointment time will be 13:45. If the you want to have an appointment time at 
14:00 you must set the Up To time to 14:15.
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1. On the Scheduler menu, click Configure > Time Types. The EMR displays the Schedule 
Time Type Maintenance window. 

2. In the top left area of the Schedule Time Type Maintenance window, click New ( ).

3. Use the following table to enter the Schedule Time Type information.  

Field Description

Type Enter the word or phrase that you want to display on the Scheduler.
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Days before 
Appt

To display a warning if a staff member books an appointment on 
these time slots more than a certain number of days prior to the 
appointment, enter the number of days here.

To display no warnings, leave this field blank.

Level In the Level drop-down list, perform one of the following actions:

 To make this Time Type available when defining each 
Practitioner’s schedule, click Service Provider.

 To make this Time Type available only when defining clinic 
schedules (for example, holidays or office closed), click Clinic.

Reason In the Reason drop-down list, click the default appointment reason 
to display on appointments booked in these time slots. Examples of 
appointment reasons are None, Office Visit, CPX, Office Visit - 
Online, and CPX- Online.

Note: The Reason drop-down list contains the list of appointment 
reasons that were defined in the Appointment Reason 
Maintenance window. To add or edit an appointment 
reason, on the Scheduler menu, click Configure > 
Appointment Reasons. See “Configuring appointment 
reasons” on page 90.

Bookable To enable appointments to be booked on these time slots, select the 
Bookable check box.

To prevent appointments being booked on these time slots, leave 
the Bookable check box clear.

Non-Billable To ensure that appointments booked on these time slots are billed, 
leave the Non-billable check box clear.

If you do not want to bill for appointments booked on these time 
slots, select the Non-Billable check box; it is not added to billing 
when used.

Default Appt 
Length

In the Default Appt Length drop-down list, click the default length for 
appointments booked on these time slots.

Note: This appointment length should match the practitioner’s 
time slot intervals. For example, if a practitioner’s schedule 
is set to 10 minutes intervals, then the Time Type Default 
Appt Length should be set to 10 minutes.

Field Description
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Set Color To display a background color on these time slots, click Set Color. 
The EMR displays a color panel. Click the color you want, and then 
click OK.

Print on 
Daysheet

To print the Schedule Time Type on your Daysheets, select the Print 
on Daysheet check box.

Note: Most clinics leave this check box clear as they want only 
appointments displaying on their Daysheets.

Exclude From 
Reports

Leave the Exclude from Reports check box clear.

Warn if appts 
are within new 
definition

If you do not want users to receive warnings when they try to book 
an appointment on the time slot, leave the Warn if appts are within 
new definition check box clear.

If you want users to receive warnings when they try to book an 
appointment on the time slot, select the Warn if appts are within 
new definition check box

Priority area

Priority Enter the default priority level for the Time Type.

Note: The priority determines what layer on the schedule that a 
Time Definition displays. The larger the priority number, the 
lower the layer on the appointment schedule.

 9 = lowest layer (displays behind all other layers)

 1 = highest layer (displays in front of all other layers)

Click the question mark icon ( ) to see recommendations for 
assigning Priorities.

From In the From and To fields, define the range of priority levels you can 
apply to the time type. 

For example, if you want the default priority level to be 7, but you 
want to be able to customize it between 5 and 9 you would set the 
Priority field as 7, the From field as 5, and the To field as 9.

To

Web Booking area

Web Bookable Select this check box to make the Time Type “Web Bookable”.

Bookable from Enter the minimum number of minutes, hours, or days ahead of time 
a patient can book an online appointment.

Prior to Enter the minimum number of minutes, hours, or days ahead of time 
a patient can book an online appointment for. 

Field Description
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4. Click Save ( ) and then click Exit. 

Configuring appointment reasons

To edit or add appointment reasons:

1. On the Scheduler menu, click Configure > Appointment Reasons. The EMR displays the 
Appointment Reason Maintenance window, with a list of your current appointment reasons 
displayed. 

2. Perform one of the following actions:

 To edit an appointment reason: In the list of appointment reasons, click the Internal ID of 
an appointment reason you want to edit. The EMR displays the Data tab for the 
Appointment Reason.

Appt Type 
Label

Enter a label for the appointment type. This will typically match the 
name entered in the Type field.

Web Booking 
instructions

Enter any booking instructions for the patient.

Field Description
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 To add an Appointment Reason: Click Add New ( ). The EMR displays the Data tab 
for the new appointment reason.

 

3. Use the following table to edit or add appointment reason information on the Data tab. 

Field Description

Internal ID 
(read-only)

The Internal ID field is read-only. The EMR automatically 
assigns a number to this field.
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Default Visit 
Template

When a practitioner opens a SOAP Note for a visit with a 
specific appointment reason, a specific SOAP Template can 
open automatically. For example, if a patient has an 
appointment with the appointment reason “Diabetes checkup”, 
you can set the CDM Diabetes SOAP Template to open 
automatically.

To set a default SOAP Template, in the Default Visit Template 
drop-down list, click the SOAP Template that you want to open 
automatically for visits with this appointment reason.

Complete 
Description

Enter a descriptive name for the appointment reason.

Short Description 
appearing on 
screen

Enter a short description of the appointment reason. This short 
description displays in the appointment slot on the scheduler.

Include in 
Continuity Count

To include appointments with this appointment reason in the 
Continuity Count Reports, select the Include in Continuity 
Count check box.

Color To display a specific background color in appointments with this 
appointment reason:

1. Click Set Color. The EMR displays a color panel.

2. Click the colour you want, and then click OK. The EMR 
displays your selected color in the Color field.

Default Fee Code When a bill is created for a visit with a specific appointment 
reason, you can set a specific service code to automatically 
populate the bill.

To set a default service code, in the Default Fee Code field, 
enter the service code you want to populate the bill with.

Default ICD9 Code When a bill is created for a visit with a specific appointment 
reason, you can set a specific ICD9 diagnosis code to 
automatically populate the bill.

To set a default diagnosis code, in the Default ICD9 Code 
field, enter the diagnosis code you want to populate the bill with.

Default Length In the Default Length drop-down list, click the length of time 
the appointment is automatically booked for.

Field Description
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Default Demand If your clinic uses Advanced Access Scheduling, perform one of 
the following actions:

 To set the default demand to External, in the Default Demand 
drop-down list, click External.

 To set the default demand to Internal, in the Default Demand 
drop-down list, click Internal.

Web Booking area 

Display in Web 
Appointment 
Reasons

To to display the appointment reason on the Patient Portal 
reason for appointment list, select the Display in Web 
Appointment Reasons check box.

Web Appt Reason 
Label

Enter the appointment reason text that you want to display on 
the Patient Portal reason for appointment list.

Note: Your patients will see the Web Appt Reason Label. 
Avoid using abbreviations or words that a patient may 
not understand. For example, use “Complete Physical” 
instead of “CPX”.

Field Description
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4. To save the appointment reason, click Save ( ).

5. To close the Appointment Reason Maintenance window, click Close ( ).

Select Time Types

(The EMR displays the 
Select Time Types 
button only when you 
select the Display in 
Web Appointment 
Reasons check box.)

To associate the reason with “web bookable” Time Types:

1. Click Select Time Types. The EMR displays the Select Time 
Types window, with a list of “web bookable” Schedule Time 
Types. 

2. Select the check box beside the Time Type(s) you want 
patients to be able to book this type of appointment on, and 
then click Save.

Tip: Ensure that you select a Time Type(s) that matches the 
appointment length required for the Appointment Reason. For 
example, if the appointment reason is “Complete Physical”, and 
physicals require a 20 minute appointment, ensure you 
associate the “Complete Physical” with the Web Appt – 20 Time 
Type.

Tip: If one practitioner spends a longer amount of time with their 
patients than other practitioners in the clinic, you can associate 
an appointment reason with multiple Time Types that are set for 
different appointment lengths.

Field Description
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Blocking off regular lunch or other breaks

Lunch is a pre-defined schedule time type that appears with a coloured background in the 
Schedule.

To block off regular lunch or other breaks: 

1. On the Scheduler menu, click Configure > Physician and Clinic Hours (Schedule 
Setup). The EMR displays the Time Definition Maintenance window.

2. In the Service Provider drop-down list, click a practitioner’s name.

3. In the top left area of the Time Definition Maintenance window, click New ( ). The EMR 
displays the Schedule Definition tab.

4. If your clinic has multiple locations, in the Office Location drop-down list, click the location 
where you want to set the hours.

5. In the Schedule Type drop-down list, click Lunch. 

6. In the Day of the Week drop-down list, perform one of the following actions:

 If lunch times are the same every day of the week, click All and then in the From and Up 
To areas, in the Hour and Min fields, enter the lunch time.

 If lunch times vary on different days, click a day and then in the From and Up To areas, 
in the Hour and Min fields, enter the lunch time. Repeat this process for each day of the 
week.

7. Ensure the Priority field is set to 4.

8. Click Save ( ). 

Tip: If you are assigning the same time type set up multiple times, click Save as a 

New Time Definition ( ). The EMR saves the time definition and creates a 
new time definition with the same settings. You can then edit only the settings you 
need to change.

This saves you from the repetitive task of entering the same information over and 
over. The basic information is there, and you just have to make minor changes.

For example, if you are setting up CPX from 10 to 12 each day, you can set up the 
first time definition, click Save as a New Time Definition, and then just change 
the days you want to assign it to.
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Blocking off vacations and other out-of-office days

Vacation is a pre-defined schedule time type that appears with a coloured background in the 
Schedule.

To book off vacation and other out-of-office days:

1. On the Scheduler menu, click Configure > Physician and Clinic Hours (Schedule 
Setup). The EMR displays the Time Definition Maintenance window.

2. In the Service Provider drop-down list, click a practitioner's name.

3. In the top left area of the Time Definition Maintenance window, click New ( ). The EMR 
displays the Schedule Definition tab.

4. In the Office Location drop-down list, click the location where you want to set the hours.

5. In the Schedule Type drop-down list, click Vacation.

6. In the Time Definition Time Period area, perform one of the following actions:

 If the vacation is more than one day, in the Date Range area, in the From and Up To 
fields, enter the start and end date for the vacation.

 If the vacation is for only one day, in the Specific Date field, enter the vacation date.

7. Ensure the Priority field is set to 3 (this layers the vacation notice on top of lunch). 

8. Click Save ( ). 

Specifying days when a practitioner works at another location within your facility

You can specify days when a practitioner works at another location within your facility, for 
example at an Emergency clinic.

To specify days when a practitioner works at another facility:

1. On the Scheduler menu, click Configure > Physician and Clinic Hours (Schedule 
Setup). The EMR displays the Time Definition Maintenance window.

2. In the Service Provider drop-down list, click a practitioner's name.

3. In the top left area of the Time Definition Maintenance window, click New ( ). The EMR 
displays the Schedule Definition tab.

Note: For some time types, the priority is already set and you cannot change the 
priority. For other time types, you can adjust the priority depending on the range set 
up for the time type.
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4. In the Office Location drop-down list, click the location where the practitioner will be 
working.

5. In the Schedule Type drop-down list, click the appropriate schedule type.

6. If applicable, in the Clinic Time Definition Category drop-down list, click the appropriate 
Clinic Time Definition Category.  

7. Perform one of the following actions:

 If a provider does not work at this other location on a repetitive basis (at the same time 
intervals on same days of the week), then in the Specific Date field, enter the date.

 If a provider works at this location on a repetitive basis, in the Day / Time area, enter the 
Day of the Week and Time information.

8. In the Priority field, enter a priority level of 6, 7, or 8. (Priority codes 6 to 8 are for Service 
Provider - Services.)

9. Click Save ( ).

Assigning specific types of appointments to days or time slots

Sometimes a practitioner prefers to have specific types of appointments on certain days or time 
slots. For example, a practitioner may prefer to have their CPX exams every day from 9 AM until 
noon.

To assign specific types of appointments in the schedule:

1. On the Scheduler menu, click Configure > Physician and Clinic Hours (Schedule 
Setup). The EMR displays the Time Definition Maintenance window.

2. In the Service Provider drop-down list, click a practitioner's name.

3. In the top left area of the Time Definition Maintenance window, click New ( ). The EMR 
displays the Schedule Definition tab.

4. In the Office Location drop-down list, click the location where you want to set the hours.

5. In the Schedule Type drop-down list, click, the type of appointment you want to assign (In 
our example, you would click CPX).

Note: If you do not see the Clinic Time Definition Category drop-down list, it is 
because your Administrator has not configured this option.

Tip: You can use time definition categories to enhance billing reports. When you 
define a separate Time Definition Category on certain days, any bills made for 
appointments booked during that time are separated on the Service Summary 
report.
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6. Specify when you want to assign this specific type of appointment in the schedule: In the 
Day / Time area, enter the Day of the Week and Time information. In our example, to 
assign the CPX appointment every day from 9 AM until noon, you would click All in the Day 
of the Week drop-down list, then enter 9 in the From Hour field and then enter 12 in the 
Up to Hour field. 

7. In the Priority field, enter a priority level of 6, 7, 8, or 9. (Priority codes 6 to 9 are for Service 
Provider - Services.)

8. Click Save ( ).

Quickly blocking off appointment slots

To quickly block off appointment slots: 

1. In the Appointment Scheduler window, in the Filter Location drop-down list, click the 
location where you want to block off the appointment slots.

2. On the Scheduler, perform one of the following actions:

 If you want to block off an individual time slot, click an empty time slot.

 If you want to block off more than one time slot, click and drag to select the slots to block 
off.

3. On your keyboard, press Control + L. The schedule displays “**DoNotBook” in the time 
slots that you selected.

Quickly blocking off a single day 

To quickly block off a single day:

1. Ensure the Scheduler is in Day view: In the Appointment Scheduler window, on the View 
menu bar, click Day.

2. In the Appointment Scheduler window, in the Filter Location drop-down list, click the 
location where you want to block off the day.

3. Go to the day you want to block off and click any time slot in a provider’s schedule.

Note: The Scheduler must be in Day view for this procedure to work.
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4. On your keyboard, press Ctrl + K. The EMR displays a dialog box with the message “Block 
appointment booking for this day at this location?

5. Click Yes. The schedule displays “**DoNotBook” in all of the time slots for that day.

Unblocking appointment slots that were blocked off

To unblock appointment slots that were blocked off:

1. In the Appointment Scheduler window, in the Filter Location drop-down list, click the 
location where you blocked off the appointment slots.

2. Click the blocked off time slot.

3. On the Scheduler menu click Providers > Block/Unblock > Undo Block for 
<Practitioner’s name>. The EMR unblocks the schedule.

Adding a note to a day on a practitioner’s schedule

To add a note to a day on a practitioner's schedule:

1. On the practitioner’s schedule, click any time slot and then, on your keyboard, press F3. 
The EMR displays the Notes for <Practitioner’s name> window.

2. Enter your note, and then close the window. The provider's name at the top of the column is 
highlighted in blue to indicate that there is a schedule note for that day.

Viewing or editing a note on a practitioner's schedule

To view or edit a note on a practitioner's schedule: 

1. On the practitioner’s schedule, click any time slot and then, on your keyboard, press F3.

2. View or edit the note as necessary.

Setting up practitioners’ schedules for online appointment booking (via 
the Patient Portal)

Your clinic has complete control over how and when patients can book appointments online. 
Plan how to best configure online appointment booking to meet the needs of your clinic. 
Consider the following questions:

 Which types of appointments do you want patients to be able to book online? (For example, 
should patients be able to book appointments such as physicals or prenatal visits online?)

 Can patients book last minute appointments online? Or must they book a certain number of 
days in advance?
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 How far in advance do you want a patient to be able to book an appointment online?

 Are there specific days in the week or certain time slots in a day when you do not want 
patients to be able to book an appointment online? (For example, you can restrict online 
bookings for days of the week your clinic tends to receive more walk-ins.)

To set up your practitioners’ schedules for online booking, you must:

1. Create “web bookable” Schedule Time Types.

2. Enable specific types of appointments to be booked online.

3. Enable specific days and time slots to be booked online.

Creating a “web bookable” Schedule Time Type

Creating a “web bookable” Schedule Time Type is similar to creating a regular Schedule Time 
Type. However, when you create a “web bookable” Schedule Time Type, you must make the 
time slot web-bookable, and set other web booking details. You should also create a specific 
Schedule Time Type for the purpose of defining web bookable time slots only. 
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Consider the following tips when creating “web bookable” Schedule Time Types: 

To create a “web bookable” Schedule Time Type:

1. Create a new Time Type as normal. See “Adding new Schedule Type options” on page 86.

Tip: Create a specific Schedule Time Type for the purpose of defining web 
bookable time slots. Name this Schedule Time Type “Web Appt”, “Online Appt”, 
or something similar.

 Clinics with multiple practitioners on different time intervals: 
If you have multiple practitioners on different schedule intervals, create a 
separate Schedule Time Type for each interval.

For example, in a multi-practitioner clinic, Practitioner A has 10 minute appointment 
slots and Practitioner B has 15 minute appointment slots. The clinic creates two 
Schedule Time Types to define “Web Bookable” appointments for each 
practitioner:

• Web Appt 10 – To define “Web Bookable” appointments for Practitioner A.

• Web Appt 15 – To define “Web Bookable” appointments for Practitioner B.

 Practitioners who have multiple types of appointments at different time 
intervals:
If one of your practitioners books several types of appointments that require 
different lengths of time, create a separate Schedule Time Type for each length.

For example, a practitioner requires 10 minute appointments for most of their 
general clinic visits, however they require 20 minute appointments for complete 
physicals. You could then create the following Time Types to accommodate each 
appointment length:

• Web Appt 10 – To define “Web Bookable” appointments for general clinic visits.

• Web Appt 20 – To define “Web Bookable” appointments for complete 
physicals.

Tip: In the Reason drop-down list, click the default appointment reason to display 
on appointments booked in these time slots. For example, you may want the 
appointment reason to default to Office Visit - Online.

Note: The Reason drop-down list contains the list of appointment reasons that 
are defined in the Appointment Reason Maintenance window. To add or 
edit an appointment reason, on the Scheduler menu, click Configure > 
Appointment Reasons. See “Configuring appointment reasons” on page 
90.
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2. When you enter information for the Time Type, consider the following tips:  

3. In the Web Booking area, make the time slot web-bookable, and set other web booking 
details. Use the following table to enter information in the Web Booking area. 

4. To save your new “web-bookable” Time Type, click Save ( ).

5. To close the Schedule Time Type Maintenance window, click Close ( ).

Tip: In the Type field, enter the word or phrase that you want to display on the 
Scheduler. For example, “Web Appt 10” (for 10 minute “Web bookable” slots).

Tip: In the Reason drop-down list, click the default appointment reason to display 
on appointments booked in these time slots. For example, you may want the 
appointment reason to default to Office Visit - Online.

Field Description

Web Bookable Select this check box to make the Time Type “Web Bookable”.

Bookable from Enter the minimum number of minutes, hours, or days ahead of 
time a patient can book an online appointment.

Prior to Enter the minimum number of minutes, hours, or days ahead of 
time a patient can book an online appointment for. 

Appt Type Label Enter a label for the appointment type. This will typically match the 
name entered in the Type field.

Web Booking 
instructions

Enter any booking instructions for the patient.
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Enabling specific types of appointments to be booked online

When a patient books an appointment online, they are asked to select a reason for the 
appointment. 

You can customize this list of reasons, thereby specifying which types of appointments patients 
can book online.

You can enable specific types of appointments to be booked online when you are “Configuring 
appointment reasons”. To enable specific types of appointments to be booked online you must 
you must perform the following actions on the Data tab of the Appointment Reason 
Maintenance window, in the Web Booking area: 

 Select the Display in Web Appointment Reasons check box to display the appointment 
reason on the Patient Portal reason for appointment list.

 In the Web Appt Reason Label field, enter the appointment reason text that you want to 
display on the reason for appointment list.

 Click the Select Time Types button and then select the check boxes beside the “web-
bookable” Time Types you want patients to be able to book this type of appointment on.
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To add an appointment reason to the Patient Portal reason for appointment list:

1. Edit or add an appointment reason as normal. See Step 1  to Step 3  in “Configuring 
appointment reasons” on page 90. 

2. To to display the appointment reason on the Patient Portal reason for appointment list, on the 
Data tab, in the Web Booking area, select the Display in Web Appointment Reasons 
check box. 

3. In the Web Appt Reason Label field, enter the appointment reason text that you want to 
display on the reason for appointment list. 

Tip: To enhance the user experience, enable as many appointment types for web 
booking as possible.

Note: Your patients will see the Web Appt Reason Label. Avoid using 
abbreviations or words that a patient may not understand. For example, use 
“Complete Physical” instead of “CPX”.
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4. Click Select Time Types. The EMR displays the Select Time Types window, with a list of 
“web bookable” Schedule Time Types.  

5. Select the check box beside the Time Type(s) you want patients to be able to book this type 
of appointment on, and then click Save. 

6. To save the appointment reason, click Save ( ).

7. To close the Appointment Reason Maintenance window, click Close ( ).

Note: The EMR displays the Select Time Types button only when you select the 
Display in Web Appointment Reasons check box.

Tip: Select Time Types that match the appointment length required for the 
Appointment Reason. For example, if the appointment reason is “Complete 
Physical”, and physical appointments require 20 minutes, associate the “Complete 
Physical” with the Web Appt – 20 Time Type.

If one practitioner spends a longer amount of time with their patients than other 
practitioners in the clinic, you can associate an appointment reason with multiple 
Time Types that are set for different appointment lengths.
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Enabling specific days and time slots for online booking

You can specify which time slots in the clinic’s schedule are available for online booking. For 
example, you may want to allow online appointment bookings only for times slots where your 
clinic typically sees fewer walk-in patients. 

You can define which time slots are “web bookable” by:

a) Creating Scheduling Time Types that are defined as “web bookable”. See “Creating a 
“web bookable” Schedule Time Type” on page 100.

b) Applying the “web bookable” Time Types to a single practitioner’s schedule, or to the 
entire clinic’s practitioner schedules at once in the Time Definition Maintenance window.

Enabling specific days and or time slots for online booking is similar to “Setting a practitioner’s 
booking hours” on page 82. Consider the following tips when enabling specific days and time 
slots for online booking:

 Select a Schedule Time Type that is configured to be “web bookable”.

 Set the Priority to be a higher than the number you use for holidays, and practitioner Out of 
Office Time Definitions.

 In the Reason field, select an appointment reason that is configured to “display in web 
appointment reasons”. For example, you may want the appointment reason to default to 
Office Visit – Online.

To enable specific days and time slots for online booking:

1. Set a practitioner’s hours (or the entire clinic’s practitioner hours) as normal. See “Setting a 
practitioner’s booking hours” on page 82. 

2. When you enter information on the Schedule Definition tab in the Time Definition 
Maintenance window, consider the following tips:   

Tip: To encourage your patients to book their appointments online, consider 
making as many of your appointment slots “web bookable” as possible. This will 
make it easier for patients to find appointment times that work for them.

Tip: In the Schedule Type drop-down list, click a Schedule Time Type that is 
configured to be “web bookable”.
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3. To indicate that patients can book online appointments only with the practitioner defined as 
their primary care provider, in the Web Booking area, click Own Patients Only.

4. To save the Time Definition, click Save ( ).

5. If you are adding Time Definitions for each day of the week individually, repeat Step 1  to 
Step 4  for each day of the week you want to add “Web Bookable” time slots for.

Creating appointment alerts
The EMR can display an alert when a particular patient is: 

 Booked and confirmed for an appointment

 Marked as Arrived

For example, a booking alert can read “Patient is often late. Book them 10 minutes earlier than 
Scheduled appointment time.” An arrival note can read “Patient is hearing impaired, please 
make eye contact when speaking to patient.” 

Tip: When setting web-bookable Time Definitions, set the Priority to be a higher 
than the number you use for holidays and practitioner Out of Office Time 
Definitions.

Appointment slots are only web bookable if a web-bookable Time Type is visible on 
the schedule. If you “hide” a web-bookable Time Type with another Time Type, for 
example “Out of Office”, then that appointment slot is no longer web-bookable. 

Tip: In the Reason field, select an appointment reason that is configured to 
“display in web appointment reasons”. For example, you may want the 
appointment reason to default to Office Visit – Online. For more information, see 
“Configuring appointment reasons” on page 90.

Web-bookable slots are covered by
“out-of-office”, therefore the slots 
are no longer web-bookable.
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Creating an alert to display when a patient is booked and confirmed 

You can create a booking note that the EMR displays in a pop-up message when you select 
the patient name in Scheduling. These notes also appear as Booking Notes on the Patient 
Information screen. 

To create a note to display when you select the patient name in Scheduling:

1. On the right side of the Scheduler, use the Patient Search area to search for the patient.

a) In the Family Name /Portion field, enter the patient’s last name.

b) In the Given field, enter the patient’s first name, and then on your keyboard press Enter.

2. In the search results list, click the patient name, and then, on your keyboard, press F9. The 
EMR displays the Patient Maintenance window. 

3. Click the Notes tab.

4. In Active Notes area, in the Display at Booking and Confirmation field, enter the note 
you want to see when you select the patient name in Scheduling. 

Creating an alert to display when a patient is marked as Arrived 

You can create an arrival note that EMR displays in a pop-up message when a patient status is 
set as Arrived in Scheduling. These notes also appear as Active Notes to Display at Arrival on 
the Patient Information screen.

To create a note to display when a patient is status is set to Arrived in Scheduling:

1. On the right side of the Scheduler, use the Patient Search area to search for the patient.

a) In the Family Name /Portion field, enter the patient’s last name.

b) In the Given field, enter the patient’s first name, and then on your keyboard press Enter.

2. In the search results list, click the patient name, and then, on your keyboard, press F9. The 
EMR displays the Patient Maintenance window. 

3. Click the Notes tab.

4. In Active Notes area, in the Display at Arrival field, enter the note you want to see when 
the patient is Arrived. 

Using patient lists (waiting lists)

Patient lists are running lists of patients. You can manually add, remove, and restore patients to 
patient lists as needed. Using Wolf EMR patient lists, you can:

View video tutorial: Introduction to patient lists
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 Track patients waiting for an available appointment slot (waiting lists)

 Manage participants for courses and group sessions (course lists)

 Track patient populations, such as complex care patients

 Track incoming referrals (specialists)

You can create as many patient lists as you want, and tailor patient lists to suit your clinic’s 
workflow. For example, you can have an appointment waiting list for Priority 2 patients, an 
appointment waiting list for Priority 3 patients, a cancellations list, a list tracking patients who 
have been called (with no answer), and so on. 

For listed patients, you can:

 Enter notes

 Assign a category and priority

 Book an appointment

 View the appointment status of an appointment booked from the list

 View if the patient is overdue or near-due for an appointment booking

 View patient information

 Book a course

You can view patient lists (for example, your clinic’s appointment waiting list) from the 
Appointment Scheduler or from the Maintenance tab (Manage Lists).

If your clinic has multiple locations:

You can view only patient lists that belong to locations you are assigned to.
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Adding patients to patient lists

To add a patient to a patient list: In the Appointment Scheduler, perform one of the following 
actions:

 If the patient has an appointment booked, but wants to be put on the waiting list to fill a 
sooner canceled appointment, click the patient’s appointment.

 If the patient does not have an appointment booked, in the Patient Search area, search 
for and select the patient.

1. On the Scheduler menu click Patients > Add Patient to List or, on your keyboard, press 
Ctrl+ G. The EMR displays the Assigned Lists window for the patient.  

2. In the List name drop-down list, select the list you want to add the patient to.

View video tutorial: Adding and modifying patients on lists

Note: If the patient is currently on one or more patient lists, the list information is 
displayed in the bottom pane.
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3. Use the following table to enter the patient’s list information. 

Entry field Description

Provider The Provider field defaults to Any Provider. This means the patient will 
see the next available practitioner, no matter who that practitioner is.

If the patient must see a specific practitioner, in the Provider drop-
down list, click the practitioner’s name.

Note: The practitioner you select does not have to be the patient’s 
primary practitioner; you can add the patient to a waiting list to 
see another practitioner who is not their normal practitioner.

Category

(Optional)

In the drop-down list, select a list category. 

Categories differ form clinic to clinic. For example, an appointment 
waiting list for an orthopedic surgeon may categorize each patient as 
Shoulder, Hip, Knee, etc. 

Note: If the category you want is not listed, ask your administrator to 
add the category you need.

Priority The Priority field defaults to Routine. 

If you want to set a different priority level, in the Priority drop-down list, 
select Semi-Urgent or Urgent.

From The From field defaults to today’s date.

You can also enter the date that you want the patient to appear on the 
patient list.

Up to

(Optional)

If you want the patient to automatically drop off the list on a certain date, 
enter the date in the Up to field. 

For example, if the patient has an appointment booked, but you are 
adding them to the waiting list for an earlier appointment, you can enter 
the patient’s current appointment date. This way, the patient 
automatically drops off the waiting list when their scheduled 
appointment is completed.

Notes

(Optional)

Enter any notes for the patient. 

For example, if you are adding the patient to the appointment waiting list 
and the patient is only available for Monday or Friday appointments, you 
can enter “Mon, Fri only”.
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4. Click Save and Close ( ).  

The EMR displays a dialog box with the message “Patient Added to List.”

5. Click OK.

Viewing patient lists

You view your clinic’s patient lists from the Appointment Scheduler. You can sort lists by any 
column. You can also narrow the list using a number of filter options.

To display the Patients on List window:

1. On the Appointment Scheduler menu, click Patients > Patient Lists. The EMR displays 
the Patients on List window with the general Waiting List displayed.  

Note: If you try to book a patient who is already on the list, the EMR displays a 
dialog box with the following message “Patient Already Exists in List - do you wish 
to continue?” 

 To add the patient to the list a second time (for example, if the patient is on the 
waiting list for a different practitioner, click Yes).

 To cancel the patient add, click No.

Note: 

 By default, listed patients are sorted first by priority (with Urgent patients 
displaying at the top), and second by the date patients were added to the list 
(with patients who have been on the list longer, displaying higher on the list)

 The Threshold Status column indicates if patients are Near Due or Overdue 
for appointments
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The list contains the following columns:    

Column Description

Previous Appointment Date and time of the patient’s last completed 
appointment

Next Appointment Date and time of the patient’s next appointment

Phone numbers Patient’s phone number(s). This information is pulled 
from the Patient Maintenance window.

Notes Any notes that are entered on the list for a patient

Category (configurable) The selected category for the patient

Priority The selected priority for the patient

Threshold Status The number of days until the patient is considered to be 
“overdue”

# Days on List Number of days the patient has been on the list.

Provider The selected practitioner for the patient

Status Patient’s status

Start Date Date the patient was added to the list

End Date Date the patient will be removed from the list; usually the 
same date as their Next appointment date

PHN Patient’s provincial health care number

Chart Patient’s Wolf EMR chart number

Birth Date Patient’s birth date

Patient ID Patient’s Wolf EMR patient ID

Tips for viewing patient list column information

 To sort the list by the contents of a column, click the column header.

 You can filter the list to display only patients with certain information in a specific 
column. For example, you can filter the list to display only patients with a Priority 
of Semi-Urgent. See “Filtering the contents of a patient list using column filters”.

 To move a column, click a column header and then drag the column to where 
you want it situated.

Note: When you close the Appointment Scheduler or the Patients on List window, 
the columns revert back to their default positions.
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2. If your clinic has multiple patient lists, in the List drop-down list, click the patient list you want 
to view.  

3. To display only patients assigned to a specific provider, in the Providers drop-down list, 
click the provider’s name.

4. To view detailed information about a listed patient, click the patient's name, and then perform 
one of the following actions:

 To view the patient's demographic information, press F9. The EMR displays the Patient 
Maintenance window for the patient.

 To view the patient's Medical Summary, press F7.

 To view or enter the patient's vitals for today, press F6.

5. From the Patients on List window, you can also:

 Filter the contents of a patient list. See “Filtering the contents of a patient list” on page 
115.

 Add patients to the list. See “Adding a patient to a list from the Patients on List window” 
on page 116.

Tip: If your clinic has numerous patient lists, and you are having trouble finding the 
patient list you want, you can filter the List drop-down list:

1. Click the List drop-down list.

2. In the field to the left of the Clear button, enter part of the list name or list type. 
The EMR filters the list to display only patient lists containing that word or 
phrase. 

3. In the list of filtered results, click a patient list you want.
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 Copy a selected patient to another list. See “Copying a patient to another list” on page 
117.

 Book an appointment for a patient. See “Booking an appointment for a patient on a 
patient list” on page 118.

 Book a patient to a course. See “Managing courses” on page 144.

 Export the patient list to a CSV file. See “Printing an appointment list (day sheet)” on page 
151.

 Print a patient list. See “Printing a patient list” on page 128.

 Remove a patient from a list. See “Printing an appointment list (day sheet)” on page 151.

 Restore a patient to a list. See “Restoring a patient to a list” on page 122.

Filtering the contents of a patient list

You can filter the contents of a patient list using column filters or by entering search text. For 
example, if you are searching for a patient to fill a cancelled appointment for today, you can filter 
the list to display only patients with a status of Urgent.

Filtering the contents of a patient list using column filters

To filter the contents of a patient list using column filters:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. Hover your curser over the column header. The EMR displays a  icon for the column. 

3. Click Filter ( ). The EMR displays a popup. 

4. Click the value you want to filter the list by. 

Note: You cannot filter the contents of every column. If the  icon does not 
display, you cannot filter the contents of the selected column.
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5. Optionally, repeat the above steps with other columns you want to filter by. The list shows 
only entries that have the value(s) you selected. 

6. To filter the list by the Start Date column (or the date that patients were added to the list), 
above the list, in the Start Date From field and the To fields, enter the date limit you want to 
include.

Removing a filter

To remove a filter, for each of the columns you filtered the list by, click Filter ( ) to display the 
popup, and then click (All). 

Filtering the contents of a patient list by entering search text

To filter the contents of a patient list by entering search text:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. In the field to the left of the Clear button, enter a word or phrase. The EMR filters the list to 
display only patients who contain that word or phrase. 

Adding a patient to a list from the Patients on List window

If you are viewing a patient list and want to add a patient to the list, from the Patients on List 
window, you can add a patient.
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To add a patient to a list from the Patients on List window:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. Click Add Patient ( ). The EMR displays the Patient Search window. 

3. Search for the patient and then double-click the patient’s name. The EMR displays the 
Assigned Lists window for the patient with the List name field populated.  

4. Enter information in the Assigned Lists window. See Step 3  in “Adding patients to patient 
lists” on page 110.

5. Click Save and Close ( ). The EMR displays a dialog box with the message “Patient 
Added to List.”

6. Click OK.

Copying a patient to another list

If a patient is on a patient list, you can:

 Copy the patient to the same list again. (For example, if your clinic has a general waiting list 
for all practitioners, and you want to add the patient to the waiting list for an appointment with 
their GP, and then add the patient again for an appointment with the nurse practitioner.)

 Copy the patient to another patient list.

To copy a patient:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. In the patient list, click the patient’s name. If the list is extensive and you cannot find the 
patient you want, filter the list. See “Filtering the contents of a patient list” on page 115.
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3. Click Copy Patient ( ). The EMR displays the Assigned Lists window for the patient, 
with the Category, Priority, and Notes fields populated with the same information that was 
entered for the copied list entry. 

4. In the List drop-down list, select the list you want to add the patient to.

5. Modify or enter list details as needed See Step 3  in “Adding patients to patient lists” on 
page 110.

6. Perform one of the following actions:

 To add the patient to another list, click Save ( ) and then click Add List ( ). 
Repeat Step 4  to Step 6 .

 To save the entry and close the window, click Save and Close ( ).

Booking an appointment for a patient on a patient list

If you want to book an appointment for a patient on a patient list, you can:

 Book an appointment from the list itself. For example, if a patient on an orthopedic waiting list 
is accepted as a patient, you can search for and book the patient for an appointment from 
the patient list.

View video tutorial: Booking appointments from patient lists
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 Book an appointment from the appointment scheduler. For example, if a patient cancels 
their appointment, you can search the waiting list for a patient to fill the slot and then, on the 
Appointment scheduler, book the appointment.

Booking appointments from patient lists

You can book patients for appointments directly from patient lists. After you book a patient for 
an appointment, the EMR removes the patient from the patient list (with history) and notes the 
booking date/time on the patient list.

To book an appointment for a patient on the waiting list:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. In the patient list, click the patient’s name. If the list is extensive and you cannot find the 
patient you want, filter the list. See “Filtering the contents of a patient list” on page 115.

3. Click Book Appointment ( ) or, on your keyboard, press Ctrl +T. The EMR displays the 
Available Time Slot Search window.  

Note: If you later cancel, remove, or mark the appointment as a "no show", the 
EMR displays a dialog box with the following prompt: "This appointment was linked 
to <waiting list name>, Waiting List. Would you like to add this patient back to the 
list?"

To reinstate the patient back to the list, click Yes.
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4. In the Practitioner area select the check box beside the practitioner(s) you want to book 
the patient with.

5. In the Available Time Slot Search window:

a) Select the practitioner(s) you want to book the patient with.

b) Select the room(s) you want to book the patient in, if applicable.

c) Enter your search criteria, and then click Search.

d) In the Resulting Time Slots area, click the appointment slot you want and then click 
Book to book the appointment.

For detailed instructions, see Step 2  to Step 7  in “Finding the next available time slot with a 
defined set of criteria” on page 62.

Booking waiting list patients from the Appointment Scheduler

When you book an appointment for a patient who is on a patient list, the EMR prompts you to 
remove the patient from the patient list. You do not have to manually remove the patient from 
the waiting list.

To book an appointment a waiting list patient from the appointment scheduler:

1. When an appointment slot becomes available, open the waiting list and search for a patient 
to fill the empty slot. See “Viewing patient lists” on page 112.

2. On the Appointment Scheduler, double-click the available appointment slot, and then in the 
Patient Search window, search for and select the patient you want (patient you found on the 
waiting list).

3. Click Book. The EMR displays a dialog box with the following prompt: "Patient is on waiting 
list - remove the patient now?"

4. To remove the patient from the patient list (with History), click Yes.

Tracking patients who have been booked for appointments from patient lists

When you book a waiting list patient for an appointment, and choose to remove the patient from 
the waiting list, the EMR removes the patient “with History”. From the waiting list, you can then 
view all patients who have been booked for an appointment and the date of the appointment, 
by choosing to Include removed with history patients.

To view waiting list patients who have been booked for an appointment:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

Note: The patient's Provider (selected for the list) is selected by default.
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2. Select the Include removed with history patients check box. The EMR displays:

 Patients who have been removed with history (including booked patients) in the patient 
list.

 Columns for appointment Booked Date and Appointment Status.

3. To find patients who have been booked for appointments, click the Booked Date header. 
The EMR sorts the list to display patients with booked dates at the top of the list.

Removing a patient from a list

When you remove a patient from a list you can choose to delete the patient completely, or to 
remove the patient "with history". If you remove a patient "with history", you can:

 Restore the patient to the list with the original list notes and other list settings.

 View the patient on the list as an "inactive" entry (by selecting the Include removed with 
history patients check box).

To remove a patient from a list:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. In the patient list, click the patient. If the list is long and you cannot find the patient you want, 
filter the list. See “Filtering the contents of a patient list” on page 115.

3. Perform one of the following actions:

 Click Remove no History ( ): This acton permanently removes the patient from the 
patient list. You cannot restore this patient to the list and you do not have any history of 
the patient being added to the list.

View video tutorial: Adding and modifying patients on lists
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 Click Remove with History ( ): This action removes the patient from the list, but you 
can view the history of the patient in the list by clicking the Include removed with 
history patients check box. You can restore this patient on the list in the future. 

Restoring a patient to a list 

To restore a patient to a list:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. Select the Include removed with history patients check box. The EMR adds patients 
who were removed with history to the list.

3. In the patient list, click the patient. If the list is long and you cannot find the patient you want, 
filter the list. See “Filtering the contents of a patient list” on page 115. 

4. Click Restore Patient ( ). The EMR restores the patient to the list.

Modifying a patient’s list details

If you want to change a patient's list details (for example, if you want to update the patient's 
category, priority, or list notes), you can edit this information from the list itself or from Patient 
Maintenance. 

To modify a patient's list details:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. In the patient list, click the patient. If the list is long and you cannot find the patient you want, 
filter the list. See “Filtering the contents of a patient list” on page 115.

Tip: If there is a chance that the patient will be restored to the list at a later time, 
select Remove with History. You can restore only patients that were removed 
with history.

Note: You can restore only patients who were removed with history.

View video tutorial: Adding and modifying patients on lists
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3. Click Edit Patient ( ) or, on your keyboard, press Ctrl + G. The EMR displays the 
patient's Assigned Lists window.

4. Enter or modify the patient's list information as needed. 

5. Perform one of the following actions:

 To save the modifications and close the window, click Save and Close ( ).

 To save the modifications and change the patients list details on another list, click Save 

( ) and then, in the bottom pane, click the next list.

Adding groups of patients to lists using Practice Search

Using Practice Search, you can add groups of patients to a patient list.

For example, if you use a patient list to track your complex care patients, you can perform a 
search for all patients who have been billed for complex care management, and then add the 
patients to your "Complex Care" patient list.

If your clinic hosts courses for specialized populations, such as "Living with Diabetes" or 
"Smoking cessation" informational sessions, you can perform a search for patients who would 
benefit from such courses, and then add the matching patients to the course list.

To add a group of patients to a patient list using Practice Search:

View video tutorial: Adding groups of patients to lists using Practice Search
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1. Produce a practice search report for the patient group:

a) On the Wolf EMR Launch page, click Practice Search ( ). The EMR displays the 
Practice Search window.

Note: The following steps describe how to run a saved Practice Search (a search 
that is already created). To learn how to create a new Practice Search, see Wolf 
EMR Help.
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b) On the top left of the window, click Open a Previously Saved Search ( ). The EMR 
displays the Open Saved Search or Rule window.

c) In the list of saved searches, click the search you want, and then click Open Selected. 
The EMR displays the Practice Search window, with the search criteria for the selected 
search displayed.

d) Click Show Search Results as a Patient List ( ). The EMR displays a Practice 
Search results window containing a list of matching patients.

2. In the practice search report, select the check box beside the patients you want to add to 
the patient list, or to select all patients, click Selection > Select All.

3. To create a new patient list to add the selected patients to:

a) At the top of the window, click Selection > User Defined Patient List > Add New 
List. The EMR displays the Patient List Management window.

b) Add the patient list. See “Adding and modifying patient lists” on page 130.

c) To close the Patient List Management Window, click .
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4. On the Practice Search results window, click Selection > User Defined Patient List > 
Add to Existing...

The EMR displays the Select a patient list window.

5. Enter information in the Select a patient list window, using the following table as a reference.

Field Description

Select a patient list to 
assign to the 
selected patients

In the drop-down list, click the list you want to add the 
selected patients to.
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6. Click OK. The EMR displays a dialog box with the following message: "The 'Patient List' has 
been successfully set for the selected patients. If this list is filtered by the 'Patient List' you 
may want to refresh the list."

7. Click OK.

Exporting a patient list to a CSV file

If you want to view a patient list in a spreadsheet application such as Microsoft Excel (for 
example, to perform statistical analysis on the data), you can export a patient list as a .csv 
(Comma Separated Values) file. 

To export a patient list to a CSV file:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

Provider In the drop-down list, click the practitioner you want assigned 
to these list entries, or:

 To leave the provider blank, click <None>. 

 To assign each patient's Primary Provider, click Patient 
Primary Provider.

 To assign all patients the same provider, click the provider's 
name.

Priority In the drop-down list, click the priority level for these list entries.

Category

(Optional)

In the drop-down list, click the category for these list entries.

Note: If the category you want is not available, you can add 
new categories as needed. See “Managing list 
categories” on page 141.

Behaviour for 
existing entries

Click one of the following options:

 Add: If one of the selected patients is already in the patient 
list, the EMR adds the patient again as a new entry.

 Update: If one of the selected patients is already in the 
patient list, the EMR updates the list entry with the new 
information. The patient is not added a second time.

Note: If you open an exported file from the data center (your remote computer), 
you can use only the LibreOffice Calc application to open and analyze the data. If 
you want to use another application, Copy the file from the data center, and then 
Paste the file onto your local computer.

Field Description
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2. If you want to export list information for patients assigned to a specific practitioner, in the 
Providers drop-down list, click a practitioner name.

3. Click Export to CSV ( ). The EMR displays the Save As window.

4. Search for and select the location on your remote computer where you want to store the 
exported .csv file.

5. In the File Name field, enter a name for list and then click Save.

Printing a patient list

To print a patient list:

1. Open the patient list. See Step 1 to Step 2 in “Viewing patient lists” on page 112.

2. If you want to print list information for patients assigned to a specific practitioner, in the 
Providers drop-down list, click a practitioner name.

3. Click Print ( ). The EMR displays the Print window.

4. In the Select Printer area, click the printer you want to use and then click Print.
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Managing patient lists
In Wolf EMR, you can create as many patient lists as you want. You can also create customized 
list types to distinguish your lists. For example, you can have patient lists defined as waiting 
lists, course lists, or patient population lists.

By default, a general Waiting List is already available. You can create additional waiting lists to 
accommodate specific care teams, or specialized services. If your clinic is a specialist clinic, 
you can also create waiting lists for each priority level. For example, you can have a P2 waiting 
list to track your Priority 2 patients.
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You can create customized categories to assign to listed patients. Categories enable you to 
group and find patients on a list by factors other than priority or provider. For example, a waiting 
list for an orthopedic surgeon can categorize patients by the type of surgery they need. 

Adding and modifying patient lists

You can create as many patients lists as you want, and modify, deactivate, or restore patient 
lists as needed. 

By default, a general Waiting List is already available in your patient lists. You cannot edit or 
remove this Waiting List.

To add or modify a patient list:

1. Perform one of the following actions:

If your clinic has multiple locations:

 You can make patient lists location-specific, or available to all locations.

 You can create, access, and assign patients to patient lists for only locations 
that you are assigned to.

View video tutorials: 

 Creating patient lists

 Modifying patient lists

Restricting users from modifying your clinic's lists:

By default, any user can add or modify patient lists. Using security rules, users with 
administrative authority can restrict specific users from accessing the Patient List 
Management window.
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 To manage patient lists from the Wolf EMR Maintenance tab, on the Wolf EMR Launch 

page, click the Maintenance tab, and then click Manage Lists ( ).

 To manage patient lists from the Appointment Scheduler, on the Appointment Scheduler 
menu, click Patients > Patient Lists, and then on the Patients on List window, click 

Manage Lists ( ).

The EMR displays the Patient List Management window, with your clinic's current patient lists 
displayed. 

2. Perform one of the following actions:

 To create a patient list, click New List ( ). 

 To modify a patient list, click the patient list.

Note: If Manage Lists is not available as an option, you have been restricted 
access to Patient List Management. Ask a user with administrative authority to 
remove the security rule preventing you from accessing patient lists.
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The EMR displays the Details area for the selected patient list.

3. In the Details area, enter information using the following table as a reference. 

Tip: If your clinic has numerous patient lists and you cannot find the list you want, 
in the Search field, enter part or all of the list name, location, or list type. The EMR 
filters the list to display only patient lists that contain your search criteria.

Field Description

Name Enter a descriptive name for the patient list.

Location If you have multiple clinic locations, in the drop-down list, select the 
location the patient list is for.

To enable all locations to use the patient list, leave this field blank.

Note:

 This field is visible only if you have multiple clinic locations set up in 
Wolf EMR.

 Only users assigned to a specific location can view patient lists for 
that location.

List Type In the drop-down list, select the type of list. For example, Waiting List.

If the option you want is not available, you can add List Type options. 
See “Managing list types” on page 139.

Status If you are creating a list, the Status is set to Active automatically.

From date The EMR enters today's date. You cannot modify the date displayed 
here.
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Category From the patient list Details area, you can enable specific category 
options for the patient list (for example, to enable users to assign 
patients on a course list the category of Confirmed, or Declined).

Note: Before you can enable categories for a list, the categories 
must be added first. See “Adding and modifying patient list 
categories” on page 142.

To enable categories for the list:

1. Click Category. The EMR displays the Assigned Categories window.

2. In the All Categories list, click a category you want to enable, and 
then click Add >. The EMR adds the category to the Assigned 
Categories list.

Note: If you want to enable a category that has been deactivated, 
select the Include inactive check box. The EMR includes all 
deactivated categories in the All Categories list.

3. Repeat step 1 and step 2 for each category you want to enable.

4. When you are finished adding categories, click Save.

Field Description
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4. Click Save.

Deactivating patient lists

To remove a patient list, you must change the status of the list to Inactive. If needed, you can 
restore a deactivated patient list by changing the status to Active. 

To deactivate a patient list:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. Click the patient list. The EMR displays the Details area for the selected patient list.

Use 
Thresholds

If you want to view if listed patients are over due and/or near due for an 
appointment booking:

1. Select the Use Thresholds check box.

2. Beside Routine, Semi-Urgent, and Urgent, in the Overdue # of 
days drop-down list, select the amount of time that constitutes 
overdue.

 3. Optionally, beside Routine, Semi-Urgent, and Urgent, in the Near 
due # of days drop-down list, select the amount of time that 
constitutes near overdue, or enter a number (in days).

Note: If you are modifying a list and the Name, Location, and Status fields are 
unavailable for editing, this indicates that there are currently patients on the list. You 
cannot modify a list if there are patients on the list, including "inactive patients" 
(patients removed "with history").

View video tutorial: Deactivating and restoring patient lists

Note: You can deactivate a patient list only if all patients on the list have been 
removed without history.

Field Description
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3. In the Details area, in the Status drop-down list, click Inactive. The EMR populates the Up 
to date field with today's date.

4. Click Save.

Restoring patient lists

If you remove a patient list, but later want to view and/or use the list again, you can restore the 
list.

To restore a patient list:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

Note: If the Status drop-down list is unavailable, this indicates that there are 
currently patients on the list. You cannot remove a list if there are patients on the 
list, including "inactive patients" (patients removed "with history").

Remove all patients from the list before you remove the list itself. See “Removing a 
patient from a list” on page 121.

View video tutorial: Deactivating and restoring patient lists
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2. Select the Include Inactive check box. The EMR displays your inactive lists with your active 
lists. 

3. Click the patient list you want to restore. The EMR displays the Details area for the selected 
patient list.

4. In the Status drop-down list, click Active. The EMR clears the Up to date field.

5. Click Save. The EMR restores the patient list.

Tips for viewing inactive lists

 Inactive patient lists have a status of "Inactive". 

 To re-sort the patient lists so that inactive lists display together: Click the header 
of the Status column.
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Managing favourite patient lists

If your clinic has a large number of patient lists, you can define which patient lists are your 
favourites. When you use or manage patient lists, your favourites display at the top. 

Adding favourites

To add a patient list to your favourites:

1. On the Appointment Scheduler menu, click Patient > Patient Lists. The EMR displays the 
Patients on List window.

2. Perform one of the following actions:

 If you have access to manage patient lists, click Manage Lists ( ). The EMR displays 
the Patient List Management window.

View video tutorial: Favourite patient lists

Note: Patient list favourites are user-specific. You cannot set favourites for other 
users.
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 If you do not have access to manage patient lists, click Manage My Favourites ( ). 
The EMR displays the Favourites List Management window.

3. Click the patient list, and then at the top of the window, click Add to Favourites ( ).

Removing favourites

To remove a patient list from the favourites list:

1. On the Appointment Scheduler menu, click Patient > Patient Lists. The EMR displays the 
Patients on List window.

2. Perform one of the following actions:

 If you have access to manage patient lists, click Manage Lists ( ). The EMR displays 
the Patient List Management window.

 If you do not have access to manage patient lists, click Manage My Favourites ( ). 
The EMR displays the Favourites List Management window.

3. Click the patient list you want to remove from your favourites.

4. Click Remove from Favourites ( ). 
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Managing list types

When you access patient lists, you can choose the type of patient lists you want to view. For 
example, you can choose to view only "Waiting Lists". As you create numerous types of patient 
lists, you can create customized list types to effectively group patient lists in an easy-to-find 
manner. Common list types include:

 Waiting list (available by default)

 Course (available by default)

 Patient population

Adding and modifying list types

To add, or modify a list type:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. At the top of the window, click Manage List Types ( ). The EMR displays the Manage 
List Types window with your current list types shown in the left pane.

3. Perform one of the following actions:

 To add a list type, click New ( ).

 To modify a list type, in the left pane, click the list type.

The EMR displays the Details area for the selected list type.

View video tutorial: Customizing list types
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4. Using the following table, enter or modify the list type information.

5. Perform one of the following actions:

 To save your changes and close the Manage List Types window, click Save and Close 

( ). 

 To save your changes, and to add, edit, or remove another list type, click Save ( ). 
The EMR saves your changes and keeps the Manage List Types window open.

Deactivating patient list types

If you want to remove a list type, you can deactivate the list type. You can later restore the list 
type if needed. 

To deactivate a a list type:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. At the top of the window, click Manage List Types ( ). The EMR displays the Manage 
List Types window, with your current list types displayed in the left pane.

3. Click the list type and then, in the Details area, select the Inactive check box.

4. Perform one of the following actions:

 To save your changes and close the Manage List Types window, click Save and Close 

( ).

 To save your changes, and add or modify another list type, click Save ( ). The EMR 
saves your changes and keeps the Manage List Types window open.

Restoring list types

To restore an inactive list type:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

Field Description

List type Enter the list type name as you want it to display in the List Type drop-
down list on the Patient List Maintenance window.

Description Enter a detailed description for the purpose of the list type.
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2. At the top of the window, click Manage List Types ( ). The EMR displays the Manage 
List Types window, with your current list types displayed in the left pane.

3. Above the list type list, select the Include inactive check box. The EMR displays any 
inactive list types. 

4. Click the inactive list type you want to restore and then, in the Details area, clear the 
Inactive check box.

5. Perform one of the following actions:

 To save your changes and close the Manage List Types window, click Save and Close 

( ).

 To save your changes, and add or modify another list type, click Save ( ). The EMR 
saves your changes and keeps the Manage List Types window open.

Managing list categories

Patient lists contain a column displaying each patient's "Category". The category column 
enables you to sort and find patients by factors unique to your clinic and to the list. You can 
configure categories to meet the specific workflow needs of your clinic. 

For example, an appointment waiting list for an orthopedic surgeon can categorize each patient 
by the type of surgery they are waiting for. When a patient cancels their appointment, the front 
end staff can then find a patient with a similar issue (that requires a similar appointment length) 
to take the open appointment slot.

View video tutorial: Customizing list categories
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You can create, modify, remove, and restore category options as needed.

Adding and modifying patient list categories

To add or modify a patient list category:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. At the top of the window, click Manage Categories ( ). The EMR displays the Manage 
List Categories window, with a list of your current categories in the left pane.

3. Perform one of the following actions:

 To add a category, click New ( ).

 To modify a category, click the category.

The EMR displays the Details area for the selected category. 

4. To add or modify a category, use the following table to enter information in the Details area.

5. Perform one of the following actions:

Note: Categories can be unique to each list, or they can be shared by multiple 
patient lists.

Field Description

Category name Enter the category name as you want it to display on the 
patient list.

Category description

(Optional)

Enter a detailed description of the category and/or any notes 
regarding the category. 
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 To save your changes and close the Manage List Categories window, click Save and 

Close ( ).

 To save your changes, and add or modify another category, click Save ( ). The EMR 
saves your changes and keeps the Manage List Categories window open.

6. For each list you want the category to be available on, enable the category. See “Adding and 
modifying patient lists” on page 130.

Deactivating patient list categories

If you want to remove a category from your list of category options, you can deactivate the 
category. You can later restore the category if needed. 

To deactivate a category:

1. Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. At the top of the window, click Manage Categories ( ). The EMR displays the Manage 
List Categories window, with a list of your current categories in the left pane.

3. Click the category and then, in the Details area, select the Inactive check box.

4. Perform one of the following actions:

 To save your changes and close the Manage List Categories window, click Save and 

Close ( ).

 To save your changes, and add or modify another category, click Save ( ). The EMR 
saves your changes and keeps the Manage List Categories window open.

Note: If the category name matches an existing category (even if it is inactive), you 
receive the following message.

Rename the category, or restore the category (if it is inactive). See “Restoring 
patient list categories” on page 144.
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Restoring patient list categories

To restore an inactive category to a patient list:

1. 1.Open the Patient List Management window. See Step 1  in “Adding and modifying patient 
lists” on page 130.

2. At the top of the window, click Manage Categories ( ). The EMR displays the Manage 
List Categories window, with a list of your current categories.

3. Above the category list, select the Include inactive check box. The EMR extends the 
category list to include categories that have been set as inactive.

4. Click the inactive category you want to restore and then, in the Details area, clear the 
Inactive check box.

5. Perform one of the following actions:

 To save your changes and close the Manage List Categories window, click Save and 

Close ( ).

 To save your changes, and add or modify another category, click Save ( ). The EMR 
saves your changes and keeps the Manage List Categories window open.

Managing courses
If your clinic hosts courses or other informational events, you can track and manage participants 
in Wolf EMR. Using the various course features, you can:

 Create and manage participant lists.

 Book a course on the lecturer's appointment schedule.

 Book patients to a course.
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To schedule a course, you must first create a patient list (participant list) for the course. From 
the course list, you can then manage the course schedule and book individual patients to the 
course.

Creating a course participant list

To create a course participant list:

1. Create a patient list as described in “Adding and modifying patient lists” on page 130. Use 
the following table to enter information in the patient list Details area: 

2. Add patients to the list. You can add patients to the list:

 From the appointment schedule. See “Adding patients to patient lists” on page 110.

 From the patient list. See “Adding a patient to a list from the Patients on List window” on 
page 116.

 As a group, using practice search. See “Adding groups of patients to lists using Practice 
Search” on page 123.

Scheduling a course

You schedule a course in the appointment scheduler of the practitioner who will be delivering 
the course.

To book a course in a practitioner’s schedule:

1. On the Scheduler menu click Patients > Patient Lists. The EMR displays the Patients on 
List window.

2. In the Lists drop-down list, click the course participant list. 

Field Description

Name Enter the course name. For example, Living with Diabetes.

Location If you have multiple clinic locations, in the drop-down list, click the location 
the course is to be hosted at.

To enable users from all locations to book patients to the course, leave this 
field blank.

Note: This field is visible only if you have multiple clinic locations set up 
in Wolf EMR.

List Type In the drop-down list, select Course. If Course is not available in the list, 
add Course as a list type. See “Managing list types” on page 139.
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3. Click Manage Course Schedule ( ). The EMR displays the Manage Course Schedule 
window. 

4. In the Provider drop-down list, click the practitioner.

5. In the Start Date area, in the Date field, enter the date of the course or, to select the date 
on a calendar, click the down arrow. 

6. In the Time field, enter the start time for the course.

7. In the Length drop-down list, click the number of minutes the course is to be scheduled for.

8. If the course is to occur on multiple dates for the same practitioner (on the same 
appointment schedule), in the Frequency area, perform one of the following actions:

 If the course is to take place on a regular schedule:

a)   Click Daily, Weekly, or Monthly.

b)   In the Number of Additional <Days/Weeks/Months> field, enter the number of 
days, weeks, or months the course is to be held, and then click OK. The EMR 
displays a list of appointment dates corresponding to your frequency selection in the 
Scheduled Dates area.

Note: If this is a recurrent course, ensure you enter the first date of the course.

Tip: To delete one of the reoccurring appointment dates, in the Scheduled Dates 
area, click the date, and then click Delete Date.
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 If the course is to take place on multiple random dates, click Custom, and then on the 
calendar, click the course dates. As you click each date, the EMR displays the date in the 
Scheduled Dates area. 

9. To ensure that the course date(s) do not overlap any booked appointments on the 
practitioner’s schedule, in the Scheduled Dates area, click Check Availability.

 If no overlap is identified, the EMR displays a dialog box with the following message: “No 
conflicts found.”

Best practice: Book a course as a reoccurring course only if you will be 
scheduling patients for multiple dates and require patients to attend on the first 
date. When you book patients for reoccurring courses, you must book them for 
the first course date.

If you want patients to choose only one of multiple course dates to attend, do not 
add multiple dates using the Recurrence area. Instead, schedule each course 
date one at-a-time by repeating Step 1  to Step 7 .
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 If overlap is identified, the EMR displays a dialog box with the following message: “To 
avoid double booking review dates. An appointment is already booked for <patient 
name> on <appointment date> at <appointment time>. 

10. When you finish scheduling the course, click Save and Close ( ). If an appointment 
conflicts with the selected course dates, the EMR displays a dialog box with the following 
message: “To avoid double booking review dates. An appointment is already booked for 
<patient name> on <appointment date> at <appointment time>. Do you want to double 
book?”

11. To enable the EMR to double-book course dates, click Yes.

Booking a patient to a course

Once a course is added to a practitioner's schedule, from the course list, you can book 
patients to the course.

To book a patient to a course:

1. On the Scheduler menu click Patients > Patient Lists. The EMR displays the Patients on 
List window. 

2. In the Lists drop-down list, click the course list. 

3. Perform one of the following actions:

 To book a single patient to the course, click the patient.

 To book several (but not all) of the listed patients to the course, on your keyboard, hold 
down the Ctrl key, and then click the patients. The EMR highlights each patient you 
select.
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 To book all listed patients to the course, click the patient at the top of the list, hold down 
the Shift key, and then click the patient at the bottom of the list. The EMR highlights all 
listed patients.

4. Click Book to Course ( ). The EMR displays the Course Booking window with:

 The course name and lecturer displayed.

 A list of dates the course is scheduled for. 

5. If the course is scheduled as a reoccurring course, perform one of the following actions:

 To register the patient(s) for one or several course dates, but not all dates, clear the 
check boxes beside the dates you do not want to book the patient(s) for. 

Note: If the Book to Course icon is unavailable, this indicates that the course has 
not been booked in a practitioners schedule. See “Scheduling a course” on page 
145.

For reoccurring courses:

 All course dates are selected by default.

 The patients must be booked for the start date. If you clear the start date, the 
EMR clears all associated dates.
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 To register the patient(s) for all course dates, leave the check boxes beside the dates 
selected.

6. Click Book to Course ( ). The EMR:

 Displays a dialog box with the following message: “Selected patients have been booked 
to the course.”

 Removes the patients from the course patient list (with history).

 Displays the patient(s) on the course appointment on the lecturer’s appointment schedule 

Tracking patients who have been booked to courses

You can view the patients who have been booked to a course from the course list.

To view the patients who have been booked to a course:

1. On the Scheduler menu click Patients > Patient Lists. The EMR displays the Patients on 
List window.

2. In the Lists drop-down list, click the course list.

3. Select the Include removed with history patients check box. The EMR displays all 
patients who have been removed with history (including booked patients) in the patient list.
150 Wolf Front End Staff User Guide - Issue 02.05



Appointments
4. To find patients who have been booked to a course, click the Booked Date header two 
times. The EMR sorts the list to display patients with booked dates at the top of the list. 

Printing an appointment list (day sheet)
You can print a practitioner’s appointment list for the day. The appointment list includes the 
following information: Length of Appointment, Patient Name, Age, and Chart Number.

To print an appointment list: 

1. On the Scheduler menu click Reports > Day Sheet.

2. In the Service Provider Selection drop-down list, click a practitioner’s name. (You can also 
print appointments for all providers who are scheduled for today by selecting All on 
screen.)

3. In the Daysheet to be Sorted by drop-down list, click an option to select how you want to 
sort the appointment list. The default setting is by Appointment Time.

4. In the Daysheet Format drop-down list, click the format for the appointment list.

5. In the Time Selection area, select which part of day’s appointments you want to print. You 
can also enter a specific time period in hours and minutes in the From and Up to area. 

6. Click Print.
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Moving groups of appointments from one practitioner’s schedule to 
another

There may be times when you need to move groups of appointments from one practitioner’s 
schedule to another. For example, you may be in a new clinic and you are entering all upcoming 
appointments into the EMR. After entering a month's worth of appointments, you realize that 
you entered the appointments under the wrong practitioner’s schedule. You need an easy way 
to shift all of these appointments to the appropriate schedule.

To move groups of appointments from one practitioner’s schedule to another:

1. In the Scheduler, click and drag to select a group of appointments.

2. On your keyboard, press Ctrl + V. The EMR displays a dialog box, prompting you to confirm 
the move information.

3. Click Yes.

4. Navigate to the appropriate day and practitioner’s schedule, and click the time slot for the 
first appointment on the list being moved. The EMR displays a dialog box with the message 
“Provider is different - continue?”

5. Click Yes. The EMR moves the appointments at the same intervals apart as they were on 
the original day.

Locking your workstation from the Scheduler
To lock your workstation from the Scheduler:

On the Scheduler menu, click Appointments > Lock Applications. 

The Wolf EMR login screen is displayed. All of your applications (for example, the WorkDesk 
and the Scheduler) are still running, they are just locked. When you enter your password, your 
applications are unlocked and appear as they were when you left them. 

Note: Locking applications is different from choosing Close All Wolf EMR 
Applications from the Wolf EMR Launch page. When you Close All Wolf EMR 
Applications, all of your applications are shut down. You must sign back in and 
relaunch all of your applications.

Best practice: If you have to step away from your workstation, click 
Appointments > Lock Applications instead of closing all Wolf EMR 
applications.
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WorkDesk overview
This chapter introduces you to the WorkDesk. The WorkDesk acts as the communication 
centre between practitioners and the Front End Staff. From the WorkDesk you can send, 
receive, and track messages, medication refills, referrals, follow-ups and other tasks.

You also use the WorkDesk to access and manage patient medical records. You can find, view, 
and enter patient clinical data on any patient’s record.

Opening the WorkDesk
To open the WorkDesk:

1. On the Wolf EMR Launch page, click WorkDesk . The EMR opens the WorkDesk. 
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Viewing your to-do list
The following sections describe the different areas of your WorkDesk you use to view and track 
items on your to-do list. 

Viewing your active messages

You can view and create messages from the Messages area, which is located on the top left 
of the Workdesk  

When the WorkDesk opens, the EMR displays the WorkDesk icon  in the 
toolbar at the bottom of your screen. 

Tip: When the WorkDesk and the Scheduler are both open, you can click the 

WorkDesk icon  and the Scheduler icon  to quickly move back and 
forth between the programs. 
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Viewing your active patient follow-ups

You can view and create follow-up tasks from the Follow Up Tasks area, which is located 
below the Messages area. Follow-up tasks are reminders to call a patient or to schedule a 
return appointment.  

Viewing your referrals summary

You can create, track, and manage referrals from the Referrals area, which is located in the top 
right hand corner of the WorkDesk window.   
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Viewing your general clinic tasks

You can view a list of your clinical tasks in the Clinic Tasks area, located on the bottom right of 
the WorkDesk.  

The Clinic Tasks area contains three main sections:

 Incoming Results

 Clinical Queues

 Telephone/Fax Refills

The following table lists the information you can review in the three main sections in the Clinical 
Tasks area. 

Clinic Task section You can review:

Incoming Results  Incoming investigation (Lab) results

 Incoming documents

Clinical Queues  Patients you need to notify for a follow-up appointment

 Patient rule matches

 Incomplete WCB reports

 Charts you need to pull

 Patients who are overdue for a PAP/Mammogram procedures 
outside of guidelines

 Clinical finding notifications
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Filtering the WorkDesk by practitioner

You can filter the WorkDesk by practitioner(s) so that the notifications in the Clinic Tasks and 
Referrals areas relate to only the practitioner(s) you select. If your clinic supports multiple 
locations, you can also choose to see notifications relating to only the practitioners in your 
current location.

The default Filter Option setting for a single location clinic is all providers.

The default Filter Option setting for a multi-location clinic is Providers in all my assigned 
locations.  

To filter the WorkDesk by practitioner:

1. In the lower right corner of your WorkDesk, click Filter Options. The EMR displays the Front 
Office WorkDesk Queue Filter Options window.

2. Perform one of the following actions:

Telephone/Fax 
Refills

 Pharmacies you need to call

 Prescription refill log

Note: The following notifications are not filtered:

 Patients Overdue for PAP / Mammograms outside guidelines

 Clinical Findings Notifications

Clinic Task section You can review:
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 If you are in a single location clinic: Select the Selected Providers option and then 
select one or more practitioners. 

 If you are in a multi-location clinic: Select Providers in my current location or select 
Selected providers and then select one or more practitioners. 
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3. (Optional) If you want to include inactive practitioners, select the Include Inactive check 
box. The EMR adds all inactive practitioners to the list, shaded in grey. 

4. Click Save. Red text to the left of the Filter Options button shows the filter option in use. 
For example, if you filtered your WorkDesk to show notifications relating only to specific 
practitioners, you would see “Filtered by: Selected providers”. 

Viewing and entering patient clinical data
The following sections provide an overview of the various ways that you can view and enter 
patient clinical data from your WorkDesk. Your instructor will cover these topics in detail later in 
the course.

Opening and viewing a patient’s chart from your WorkDesk

You can open and view a patient’s medical summary from your WorkDesk. The Medical 
Summary is essentially a patient’s medical chart, and contains all of the patient’s medical 
information. 

To open a patient’s medical summary from your WorkDesk:
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1. At the top of your WorkDesk, click Medical Summary. The EMR displays the Patient 
Search window.

2. Search for the patient and then, in the search results list, double-click the patient’s name. 
The EMR opens the Medical Summary window

Opening the Quick Entry Form from your WorkDesk

You can open the Quick Entry Form from your workDesk. You use the Quick Entry Form to enter 
a patient's history including social information, medical problem list, medications, allergies, and 
surgeries.

To access the Quick Entry Form from your WorkDesk:

1. At the top of your WorkDesk, click Quick Entry. The EMR displays the Patient Search 
window.

2. Search for the patient and then, in the search results list, double-click the patient’s name. 
The EMR displays the Quick Entry Form window.

Opening the Patient Maintenance window from your WorkDesk

You can open the Patient Maintenance window from your WorkDesk. You use the Patient 
Maintenance window to view, enter, and store, most non-medical data about a patient. 
Examples of non-medical patient data include patient address, phone numbers, Personal 
Health Number (PHN), chart number, and next of kin.

To access the Patient Maintenance window from your WorkDesk:

1. At the top of your WorkDesk, click Demographics. The EMR displays the Patient Search 
window.

2. Search for the patient and then, in the search results list, double-click the patient’s name. 
The EMR displays the Patient Maintenance window.
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Adding data or performing actions on patient charts using the Data Entry area on 
your WorkDesk

The Data Entry area of the WorkDesk provides various ways for you to enter patient data or 
perform actions on patient charts. The Data Entry area consists of a column of buttons in the 
middle of the WorkDesk window. 

The following table describes the buttons in the Data Entry area: 

Data Entry button Use this button to:

Vitals Entry Enter patient vitals and other measurements, for example pre-visit 
measurements, vital signs, and basic chart notes

Tip: You can also enter vitals from the Scheduler.

To enter vitals from the Scheduler:

1. In the Scheduler, click a patient name, and then on your keyboard 
press F6.

2. The Vital Entry window opens with the patient selected.

New Manual 
Result

 Enter, view or modify a patient's manual lab results

Vaccination  Record vaccinations administered to the patient

 Record that a patient refused or declined a recommended 
vaccination
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Using WorkDesk menu options 

Along the top of the WorkDesk window, there are a series of menu options. Here, you can 
perform a variety of actions, including customizations to the way your WorkDesk acts and looks.

When you click a menu, the EMR displays the menu options in a horizontal ribbon. 

Group 
Vaccination

Record the administration of a vaccination to a group of patients. The 
EMR automatically creates multiple vaccination records for each 
individual patient. You can use this feature to enter vaccination 
information after a vaccination clinic session has occurred.

WBC e-Forms  Access WCB e-Forms

Refill Request  Create a medication refill request

New Preventive 
Care

 Create a Preventative Care Procedure result for PAPs and 
mammograms

Video demonstration: Wolf EMR 2016.1 WorkDesk enhancements

Tip: If you are unsure of what a menu option is for, hover your cursor over the icon 
and a description pops up.

Data Entry button Use this button to:
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Chapter 5
Viewing and recording patient medical history 
(Medical Summary)
This chapter introduces you to the Medical Summary. The Medical Summary represents a 
patient’s “medical chart” and contains a patient’s entire medical history. The SMART patient 
banner is located at the top of the Medical Summary (as with other windows that contain patient 
information) and contains a summary of important patient information that you can view, at-a-
glance, in one convenient area. 

In this chapter, you learn how to enter, view, and modify patient medical information from the 
Medical Summary, the SMART patient banner, and the SMART menu.

 Opening a patient’s Medical Summary
The method you use to open a patient’s Medical Summary depends on whether the patient is 
booked for an appointment or not.

To open a patient’s Medical Summary, perform one of the following actions:

 If the patient has an appointment booked today, on the Appointment Scheduler, click the 
appointment, and then press F7.

 If the patient does not have an appointment booked, in the Appointment Scheduler, search 
for the patient and then, from the search window, open the patient’s Medical Summary. See 
“Searching for a patient” on page 23.

 If you are working in the WorkDesk, click Medical Summary. See “Opening and viewing a 
patient’s chart from your WorkDesk” on page 159.

Tip: If You are in a patient’s medical summary window and want to view another 

patient’s medical summary, on the top right corner of the window, click  
(Search).
Wolf Front End Staff User Guide - Issue 02.05 163
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SMART Patient Banner overview
The EMR displays the SMART Patient Banner at the top of most windows relating to a patient, 
including the patient’s:

 Medical Summary

 Vital Entry form

 Messages

 Tasks 

The EMR also displays the SMART Patient Banner on the Verify Patient Details window when 
you mark a patient as Arrived in the Scheduler. 

Information on the SMART Patient Banner

The SMART Patient Banner contains a variety of patient information that you can view, at-a-
glance in one convenient area. You can easily edit some of the patient information, for example 
patient demographics. You can also perform a variety of actions from the Medical Summary 
toolbar.  

The main areas of the SMART Patient Banner include:

 Name

 Demographics

 Patient Resources

 Contact Information

 Smoking Status

 Vitals

 Care Team

 Notification bar

 Medical Summary toolbar

 Navigation buttons
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The following sections describe the main areas of the SMART Patient Banner.

Name

The Name area is in the top left corner of the SMART Patient Banner. The Name area displays 
the patient’s last name and first name separated with a comma. For example “Smith, Barbara. 

Demographics

The Demographics area is in the top right corner of the SMART Patient Banner. 

The Demographics area displays the following information:

 Born: The patient's date of birth. The age is shown in brackets beside the date.

 Sex: M/F

 PHN: Patient's PHN

 Pregnant: Displays if a patient is pregnant and how many weeks the patient is along in the 
patient's pregnancy.

 Status: Displays a patient's active Patient Status. For example, Homebound, Acute Care 
Patient, or Left Practice.

Patient Resources

The Patient Resources area is below the patient name in the SMART patient banner. The 
Patient Resources area of the SMART Patient Banner gives you easy access to more 
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information about the patient. Some of the information is view-only; for example patient visit 
records or the patient photo. Other icons link you to other areas of the EMR where you can view 
and edit the information if necessary. For example, you can view and edit information in the 
Patient Maintenance window. 

The following table describes the icons you may see in the Patient Resources area. 

Note: The Patient Resources area only displays the icons that apply to the patient. 
For example, if there are no alerts for the patient, you will not see the Alerts icon. 
Similarly, if no notes exist for the patient, you will not see the Patient Notes icon.

Icon Item Description

View Patient 
Demographics 
Information

Opens the Name/Addr/Phone tab in the 
Patient Maintenance window

View Paper Chart Opens a scanned version of the patient’s 
previous paper chart information or 
previous medical summary (if available). 
This icon displays if the keyword Medical 
Summary was associated with the 
document. 

View Patient Visits Opens all summarized Visit Records for 
the Patient

Search Patient Visits Opens the Visit Record History window 
with a list of encounters to choose from or 
you can use the Search function

Patient Notes Opens the Notes tab in the Patient 
Maintenance window (if available)

Patient Photo Opens patient photo (if available). This 
icon displays if the keyword IDPhoto was 
associated with the photo. 

Alerts Opens alerts for the patient (if available)
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Contact Information

The Contact Information area is below the Patience Resources area in the SMART Patient 
Banner.  

The Contact Information area displays the following information:

 Home Address: Patient's address

 Phone Number(s): Home, Cell, Work

Custody information The icon's ToolTip displays custody-
related text when you hover your cursor 
over the icon. 

This icon displays if the Note field in the 
Custody Agreement area on the Name/
Addr/Phone tab in the Patient 
Maintenance window is populated, and 
the patient is under the legal majority age 
for the province.

Indicates that the 
patient is connected 
to the Patient Portal 

Opens Patient Maintenance to Portal 
Settings (if set up)

Icon Item Description
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Smoking Status

The Smoking Status area is beside the Contact information area in the SMART Patient Banner. 

If the smoking status has been set, the smoking status appears as one of the following icons:

 Non-Smoker 

 Smoker 

Note: 

 If available, caregiver information is displayed above the phone number. 

 If the patient does not have an appointment today, or the appointment is 
finished, the next encounter date is displayed above the phone number. If the 
patient has a current appointment, the patient status, room number, and wait 
time is displayed. 
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Vitals

The Vitals area is beside the Smoking Status area, and below the Demographics area in the 
SMART Patient Banner. 

The vital information displayed depends on the age of the patient. 

If a patient's age is 0 to 2 years old, the Vitals area displays the following fields, together with 
percentiles, if available:

 HC: Head Circumference 

 Weight

 Height 

If a patient's age is 2 to 19 years old, the Vitals area displays the following fields, together with 
percentiles, if available:

 BMI: Body Mass Index

 Weight
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 Height 

If a patient's age is 20+ years old, the following fields are listed:

 BMI

 Weight

 BP: Blood Pressure 

 

Note: Percentiles are based on the Canadian Dietitian (WHO) growth charts.

Note: The time frame displays with each of the above measures. 
For example, a patient's BP is displayed as: BP 120/80   1y3m ago
170 Wolf Front End Staff User Guide - Issue 02.05



Viewing and recording patient medical history (Medical Summary)
Care Team

The Care Team area is beside the Vitals area, and below the Demographics area in the SMART 
Patient Banner. 

The Care Team area displays the following information:

 Primary MD: Displays default practitioner 

 Family MD: Displays if the patient has a family practitioner who is not the primary 
practitioner

 Referral MD: Displays if the referring incoming practitioner has been noted in Patient 
Maintenance.

 Care Team: Displays if the patient is assigned to a care team. 

Tip: You can set your WorkDesk preferences to disable or enable the display of 
the above items:

On the WorkDesk menu, click Configure > Configure WorkDesk > 
Miscellaneous tab.
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Notification bar

The Notification bar is below the Contact Information area in the SMART Patient Banner. 

The Notification bar indicates how many investigations, rules, documents, and messages are 
available for the patient. The Notification bar also indicates how many follow ups and 
vaccinations the patient is due for. Pending, un-reviewed, and recent items appear in red text. 
You can click any icon in the Notification bar to open the related area in the EMR. For example 
you can click the Investigations icon to open the Investigation In Basket window for the 
patient. 

The following table describes the icons on the Notification bar. 

Icon Description 

Investigations

 Can indicate how many pending investigations (Pending Inv.) or recent 
investigations (Recent Inv.) are that are available for the patient. Also indicates if 
there are no recent investigations for the patient (No Inv.).

 Investigations are Electronic Lab or Report Submissions in Wolf.

 You can view Excelleris text reports such as an Operative Report, or a 
Procedures Report from the Investigation In Basket. The EMR saves Excelleris 
text reports under the Documents tab in the patient’s Medical Summary.

 Click to open the Investigation In Basket

Documents

 Can indicate how many un-reviewed documents (Unrev. Docs.), or recent 
documents (Recent Docs) are that are available for the patient. Also indicates if 
there are no recent documents for the patient (No Docs).

 Documents are generally items scanned in by the staff, or they are printed 
from the system. You may have some documents from certain regions come 
electronically into this area as well. 

 Click to open the Documents In Basket
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Medical Summary toolbar

The Medical Summary toolbar is below the Notification bar in the in the SMART Patient Banner. 

You can perform a variety of actions from the Medical Summary toolbar. You can click any icon 
in the Medical Summary toolbar bar to open the related area in the EMR and perform a specific 
action. For example, you can click the Print Chart icon to open the Wolf Clinical Records 
window, where you can choose clinical documents to print.

The following table describes the icons on the Medical Summary toolbar. 

Rules

 Indicates how many Rule Matches are available for that patient. A rule is a 
search or an automated reminder. which runs over night.

 Click to open the Rule Matches screen

Messages

 Indicates how many unread Messages are available for that patient

 Click to open the Message Viewer screen

Follow Ups

 Indicates how many outstanding Follow-Ups the patient is due for

 Click to open the Follow-Ups screen

Vaccinations

 Indicates how many Vaccinations the patient is due for

 Click to open the Vaccination Schedule screen.

Icon Description 

Print Chart

Opens the Wolf Clinical Records window, where you can choose to print 
various parts of the medical record.

Icon Description 
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Deceased patient banner

The SMART Patient banner of a deceased patient has a dark grey background and white text. 

The banner contains the following additional fields:

 Died: The Date the patient died. This field is displayed in the Demographics area under the 
Born field.

 Age at Death: The age is displayed in brackets beside the Born date

 Status: Displays as Deceased.

 Next of Kin: The Vitals area disappears and is replaced with the patient's next of kin and 
their phone number. 

Custom Report

Opens a Custom Report Form, where you can print Visits, Prescriptions, and 
Referrals and title the report.

Request Chart

Opens a Chart Request window, where you select the practitioner's name who 
is requesting the chart. The chart request appears as an item in the Clinical 
Queues area on your WorkDesk as a chart to pull.

Note: If practitioner clicks the Request Chart icon, the Chart Request 
window opens with the practitioner’s name automatically populated.

Change Log

Opens the Change Log window, where you can review all change activity that 
occurred in this patient's medical summary

Icon Description 
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Medical Summary window overview
The following sections provide an overview of the tabs and navigation buttons on the Medical 
Summary window. 

Medical Summary window tabs

The following table provides an overview of the information available on each of the tabs in the 
Medical Summary window. 

Tab Information available 

Current Hx: Current History  Problems

 Current medications

 Encounter records

 Allergies

 Vaccinations

 Blood type

Past Hx: Past History  Inactive problems

 Previous medications

 Procedures and surgeries

 Refuted and terminated allergies

Personal Hx: Personal 
History

 Social history

 Harmful substances (For example, smoking history and 
alcohol history) 

 Family history

 Other risks

Communication  Messages

 Follow ups

Investigations  Lab results

 Manual results

 Preventive care procedures (for female patients)

Documents  SMART Forms and documents attached to the patient 
record

Referrals  Referral records made for the patient

Obstetrics  Pregnancy history information (for female patients if 
applicable)
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Medical Summary window navigation buttons

The navigation buttons are on the top right side of the Medical Summary window. 

Click Close ( ) to close the Medical Summary window.

Click Search ( ) to search for another patient's Medical Summary. 

Viewing and modifying current medical history
The following sections describe how to add, view, and edit a patient’s current medical history 
information.

Adding a problem

You can add a problem to a patient’s Problems list. Examples of patient problems include 
hypertension, diabetes type II, and asthma.

To add a problem to a patient’s Problems list:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open.

Tip: When you add a problem, the only required information is the problem name.

It is good practice to enter the year of onset for tracking purposes.
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2. In the Problems area, double-click <<Add New Problem>>. The EMR opens the 
Problems List window. 

3. In the Select Diagnosis field, enter part or all of the name, or the diagnostic code of the 
problem, and then on your keyboard, press Enter. The EMR searches the list of registered 
problems and displays a list of results. 

Note: If the problem is not in the registered list, then the EMR displays a dialog box 
with the following message: “The value “<word entered>” cannot be found in the 
Problems list. Please make another selection, or see your Administrator to create 
this value.”

CAUTION: Do not request a user with administrator authority to add a new 
problem to the problem list, until:

 you are sure that the problem is not already in the registered list.

 everyone in the clinic agrees that the added problem name is appropriate and 
necessary.

Otherwise, you risk creating duplicate entries for the same problem. Duplicates of 
listed problems can hinder your ability to track and manage patients with specific 
problems.

Note: If your clinic is using the new problem list that includes the Canadian 
Institute for Health Information (CIHI) list, you cannot edit the problem list.

Note: The new Problem list includes a CIHI quick pick list that acts as your 
clinic’s default list of Favourites. CIHI problems are those that have been 
identified by the CIHI as the most commonly used by general 
practitioners.
Wolf Front End Staff User Guide - Issue 02.05 177



Viewing and recording patient medical history (Medical Summary)
4. In the list of results, click the problem, and then click Update. The Select Diagnosis field 
changes to the Active Problem field and displays the problem you selected in red text. 

5. Enter information into the remainder of the window, using the following table as a reference:

Field Description

Date of Current 
Diagnosis

Enter the date of diagnosis.

Note: Field defaults to today’s date.

Qualifier In the drop-down list, click the position (for example, right, left, front) 
or other qualifier information about the problem. If the option you 
want is not available, enter the qualifier.

Note: Users with administrative authority in Wolf EMR can add 
options to the drop-down list.

Location In the drop-down list, click the body part where the problem is 
located. If the option you want is not available, enter a location.

Note: Users with administrative authority in Wolf EMR can add 
options to the drop-down list.

Consultant If an external consultant is managing this problem:

1. In the field, enter the consultants last name, first name, or 
specialty, and then press ENTER. The EMR displays a list of 
matching consultants. 

2. Click the consultant you want.

Note: If the consultant you want is not available on the list, you 
can add a consultant to the list. 
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6. Perform one of the following actions:

 To add another problem, click Add ( ), and then repeat steps Step 3  to Step 6 . 

Indicators Enter information about the stability, status, and significance of the 
problem:

 Stability: Click either Stable or Unstable.

 Activity: Click either Active (for a current problem) or Inactive 
(for a previous problem)

 Temporary?: Click either Temporary or Lifelong. 

Note: If you click Temporary, the EMR displays a Duration area. 
In the drop-down list, click the duration. The EMR calculates 
a date based on today's date and displays the date in the 
Duration field.

 Certainty Enter the certainty that the current diagnosis is 
correct. For example, NYD (Not Yet Determined).

 Chronicity: Enter the chronicity of the diagnosis. For example, 
Acute or Chronic.

Notes Enter any notes or explanations about the problem.

Problem History Enter or view information in the following fields:

 Initial Dx: When you first enter a New Problem, it automatically 
appears as the Initial Dx. The EMR displays the Onset date to 
the right. You can also enter the date manually. In the Onset 
field, enter the year when the problem started.

 Prior Dx: When you change the current Diagnosis, the EMR 
automatically enters the Prior Diagnosis and records the Prior 
Diagnosis. The EMR displays the Onset date to the right. You 
can also enter the date manually. Although you must enter the 
entire date, the EMR only displays the year.

 Current Dx: The EMR automatically enters the Current 
Diagnosis when you first enter the Diagnosis or when you 
change the diagnosis. The EMR displays the Onset date to the 
right. You can also enter the date manually. The EMR only 
displays the year, although the Date of Current Diagnosis field 
displays the complete date.

Field Description
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 To save the problem(s), and close the Problems List window, click Save & Close ( ).

Using problem favourites  

When you search for a problem to add to a patient’s problem list, favourite problems display at 
the top of your search results list. You can also choose a favourite problem directly from your 
favourites list.

The CIHI problem list acts as your clinic’s default list of Favourites. CIHI problems are those that 
have been identified by the Canadian Institute for Health Information (CIHI) as the most 
commonly used by General Practitioners.

Problem favourites can be customized for the clinic (accessible by all users), or individual users. 
You can add or remove problems only on your user-specific favourites list.

Adding problems using favourites  

To add a problem to a patient’s problem list using problem favourites:

1. Open the Problem List window. See Step 1 to Step 2 of “Adding a problem” on page 176.

2. In the Select Diagnosis field, enter part or all of the problem name or diagnostic code, and 
then press Enter. The EMR displays a list of matching problems, with matching favourites 
displayed at the top of the list. Favourite problems are indicated by an asterisk (*) in the 
Favourites column.

Note: Only clinics using the new problem list that includes the CIHI list can use 
problem favourites.

Note: Only users with administrative privileges can add clinic-wide favourites.

Note: This procedure applies to clinics using the new problem list that includes the 
Canadian Institute for Health Information (CIHI) list.
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3. In the list of matching problems, click the problem favourite you want, and then click 
Update. The EMR displays the selected problem favourite in the Active Problem.

4. If the problem you want does not display:

a) In the Select Diagnosis area, click Advanced. The EMR displays the Problem List 
window.

b) In the Search Code field, enter part or all of the problem name, or the diagnostic code.

c) Under the Search Code field, select Contains.

d) Press Enter. The EMR displays matching problems that contain (in the problem name, 
ICD-9 code, or tag) the Search Code entry. Matching problems display in the following 
order:

 Problem Favourites (displayed at the top of the list)

 CIHI problems

 General problems

e) In the list of matching favourites, click the problem you want, and then click Add 

Selected to Patient ( ). The EMR displays the selected problem favourite in the 
Active Problem field on the Problem List window.

5. Finish adding the selected problem to the patient’s problem list. See Step 4 to Step 6 in 
“Adding a problem” on page 176.
Wolf Front End Staff User Guide - Issue 02.05 181



Viewing and recording patient medical history (Medical Summary)
Adding problems to your favourites list   

To add a problem to your favourites list:

1. GOpen the Problem List window. See Step 1 to Step 2 of “Adding a problem” on page 176.

2. In the Select Diagnosis area, click Advanced.

The EMR opens the Problem List window, with:

 Your user-specific and clinic-wide problem favourites displayed at the top of the problem 
list, under Favourites.

 CIHI problems displayed below your Favourites list.

Note: This procedure applies to clinics using the new problem list that includes the 
Canadian Institute for Health Information (CIHI) list.

Note: Only users with administrative authority can add clinic-wide problem 
Favourites. (Favourites that can be viewed by all clinic users.)

Note: The CIHI problem list acts as your clinic’s default list of Favourites. CIHI 
problems are those that have been identified by the Canadian Institute for Health 
Information (CIHI) as the most commonly used by general practitioners.
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3. In the Search Code field, enter part or all of the problem name or ICD-9 diagnosis code.

4. Below the Search Code field, select one of the following options:

 Starts with: To display matching problems that start with the term you entered in the 
Search Code field.

 Contains: To display matching problems that contain, (anywhere in the problem name, 
ICD-9 code, or tag) the term you entered in the Search Code field.

5. Press Enter. The EMR filters your problem list to display matching favourites, CIHI items, and 
general problems.

6. In the list of problems, click the problem you want to make into a favourite.

Note: Wolf EMR contains a database of over 40,000 problems that you can 
search from. Because the database is so large, you must perform a search to 
choose a problem from the general problem list. 

The list of problems displayed when you first open the Problem List window, 
includes only your personal and clinic-wide Favourite problems, and the CIHI list of 
problems.
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7. Click Add to Favourites ( ). The EMR displays the Add to Favourite window. 

8. Click OK. The EMR adds the problem to your favourites list.

Using problem tags

When you add a problem to a patient’s problem list, you can search for a problem using 
alternative search terms, called tags. For example, you may prefer to enter “DM1” to search for 
the problem “Type 1 Diabetes”. 

Because each user may use different abbreviations to search for a problem, multiple tags can 
be assigned to a problem. Tags can be clinic-wide (can be used by all users), or user-specific.

Using tags to add problems 

To add a problem to a patient’s problem list using a tag:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open.

2. In the Problems area, double-click <<Add New Problem>>. The EMR displays the 
Problems List window.

Note: Only users with administrative authority can add clinic-wide favourites and 
tags. The EMR displays a Clinic-wide Favourite and Tag check box for users 
with administrative authority. 

Note: Only clinics using the new problem list that includes the Canadian Institute 
for Health Information (CIHI) list can use problem tags.

Note: This procedure applies to clinics using the new problem list that includes the 
Canadian Institute for Health Information (CIHI) list.
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3. In the Select Diagnosis field, enter a tag that is assigned to the problem you want. The 
EMR displays a list of matching problems.

4. Finish adding the selected problem to the patient’s problem list. See Step 4 to Step 6 in 
“Adding a problem” on page 176.

Assigning tags to problems (some clinics only) 

If there are no tags assigned to a problem, or if you want to use a tag that is different than the 
tags currently assigned to a problem, you can assign your own tag(s).

Tags you assign to a problem are user-specific. No other users can view or use your tags.

To assign a tag to a problem:

1. Open the Manage Problem List window, and search for the problem you want to assign tags 
to. See Step 1 to Step 6 of “Adding problems to your favourites list” on page 182.

2. If the problem you want to assign a tag to is not on your favourites list or CIHI list:

a) In the list of problems, click the problem you want to add assign a tag to.

Note: The far right column in the problem search results list displays all tags 
assigned to each problem.

Note: This procedure applies to clinics using the new problem list that includes the 
Canadian Institute for Health Information (CIHI) list.

Note: Only users with administrative authority can assign clinic-wide Tags to 
problems (Tags that can be used by all clinic users).

Note: A problem must first be on the favourites list or CIHI list before you can 
assign a tag to it.
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b) Click Add to Favourites ( ). The EMR displays the Add to Favourite window.

c) In the Tag field, enter the tag you want. 

d) Click OK. The EMR displays the assigned tags in the Tag column of the problem list.

3. If the problem you want to assign a tag to is on your Favourites list:

a) In the filtered list of problems, click the problem you want to assign a Tag to.

b) Click Edit ( ).

c) The EMR displays the Edit Tags window.

d) In the Tag field, enter the tag you want. 

e) Click OK. The EMR displays the assigned tags in the Tag column of the problem list. 

Tip: If you want to add multiple tags, separate each tag name with a comma. (For 
example, if you want the tags “DM2” and “Diab2” to both work for Type 2 diabetes, 
enter “DM2,Diab2”.)

You are limited to 50 characters for all tags combined.

Tip: If there is a Tag entered already, or if you want to add multiple tags, separate 
each tag name with a comma. (For example, if you want the tags “DM2” and 
“Diab2” to both work for Type 2 diabetes, enter “DM2,Diab2”.)

You are limited to 50 characters for all tags combined.
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Viewing a patient’s medical problems

To view a patient’s medical problems:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. 
The Problems area lists the patient’s current problems. 

2. In the Problems area, double-click a problem to view more details. The EMR opens the 
Problems List window where you can view details about the problem. You can also view any 
linked lab results, linked pending labs, related medications, and any surgical procedures that 
were performed for the problem.

Editing a problem on the patient’s Problems list

To edit a problem on the patient’s Problems list:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open.

2. In the Problems area, double-click the problem you want to edit. The EMR opens the 
Problems List window.

3. To change the diagnosis description, click Change Diagnosis. The Current Diagnosis 
field clears and changes to the Select Diagnosis field.

4. Edit fields as necessary. See Step 3  to Step 6 in “Adding a problem” on page 176.
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Viewing patient medications

To view a patient’s medications:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. 

2. Complete one of the following actions:

 To view a patient’s current medications, leave the Current Hx tab open. The Current 
Medications area lists the patient’s current medications. 
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 To view a patient’s previous medications, click the Previous Hx tab. The Previous 
Medications area lists the patient’s previous (inactive) medications.

3. In the Current Medications area or the Previous Medications area, double-click a 
medication to view the patient’s medication profile. The EMR opens the patient’s 
Medication Profile window with the following information displayed:

 Prescription details for the selected medication

 Lab results linked to the selected medication

 Refill history for the selected medication
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 A complete list of the patient’s current medications, previous medications, and allergies.

4. To view details for another medication, in the Medications area or the Previous 
Medications area, click the medication. The EMR displays the medication details to the 
right. 

Associating a medication with a problem

You can associate a medication with a problem to specify which problem the mediation is 
treating. For example, if a patient is taking Coversyl Plus, you can associate this medication with 
the patient’s problem of hypertension.

To associate a medication with a problem:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. 

2. In the Current Medications area, double-click the medication you want to associate with a 
problem. The EMR opens the Medication Profile window. 

3. In the Current Medication area, in the Problem drop-down list, click the problem that you 
want to associate with the medication.

Note: We will cover adding medications later in the course, in the Medications and 
Prescriptions module.
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4. If you want to add a new problem to the patient’s current problems, in the Problem drop-
down list, click <<Add New>> and add the problem. The EMR adds the problem to the 
patient's list of current problems. 

Viewing a patient’s encounter notes

In the Encounters area, you can view a complete list of the patient’s encounter notes and 
messages. You can also open and view a specific visit note.

To view a patient’s encounter notes:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. The 
Encounters area displays a list of the patient's encounter notes arranged by date. 

2. To filter the patient’s encounter list to display encounters with only specific providers, or 
encounters with only providers belonging to a specific security group:

a) Below the patient’s encounter list, click Filter Options. The EMR displays the Encounter 
Filter Options window.

Note: 

 A C beside the date indicates the encounter is complete.

 An I beside the date indicates the encounter is incomplete.

If an encounter is incomplete, you cannot view the encounter notes for that visit.
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b) Perform one of the following actions:

  To view visits for a specific security group, click Security Group and then, in the drop-
down list, select the security group you want.

  To view visits for specific providers, click Selected providers and then, in the list of 
providers, select the check box beside the provider(s) you want.

c) Click Save. The EMR filters the list and displays the filter criteria at the bottom of the 
encounter list. The EMR saves your filter selection and applies it to other patients you 
view going forward.

Note: If you want to filter encounters, the Encounter filtering feature must be 
enabled for your clinic. For more information, contact the Wolf EMR Support 
Team. See “Contacting Wolf EMR Support” on page 3.
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3. To view visit notes entered for a particular encounter, in the Encounters area, double-click a 
completed (C) encounter. The EMR displays the encounter’s visit notes in a read-only 
window.

4. To view to the next encounter’s visit notes, click Go to Next Visit Record ( ), or to view 

to the previous encounter’s visit notes, click Go to Previous Visit Record ( ).To view a 
searchable history of all a patient’s encounter visit notes and messages. On the top of the 

read-only window of an encounter visit note, click View Encounter History ( ). The 
EMR displays the Visit Record History window.
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Adding a new allergy or intolerance 

To add a new allergy or intolerance:

Tip: You can view a patient’s visit notes from any window of the patient’s record via 
the SMART patient banner.

 To open all summarized Visit Records for the patient, on the SMART patient 

banner, click View Patient Visits ( ). You can filter and sort the visit records.

 To search and/or filter the encounter list, on the SMART patient banner, click 

Search Patient Visits ( ). The EMR opens the Visit Record History window 
with a list of encounters to choose from or you can use the Search function to 
search any word typed into an encounter.

Tip: When you add an allergy or intolerance, the only required information is the 
allergy name and the Clinical Status of the allergy.
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1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. 

2. In the Allergies area, double-click <<Add New Allergy>>. 

The EMR displays the Clinical Records window. 

3. In the Allergy To area:

a) Select an option to indicate if the allergy is to a Medication (e.g. codeine), part of a 
Category (e.g. sulfa drugs, penicillins) Vaccine Type (e.g. flu), or Other (e.g. latex).

b) In the drop-down list, click an allergy. If you cannot find an appropriate item in the drop-
down list, or you selected Other, enter the allergy in the text field.

4. In the Clinical Status drop-down list, click one of the following options: Active, Resolved, 
Refuted or Terminated and Reclassified.

5. In the Certainty drop-down list, click either Confirmed or Suspected.

6. In the Reaction drop-down list, click an option to indicate the type of reaction the patient 
experiences. Your options are: Allergy, Allergy Severe, Allergy Mild, Adverse Reaction, 
or Anaphylaxis reaction.
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7. In the Symptoms drop-down list, click to select the patient’s symptom. If you cannot find 
the symptom in the drop-down list, or if you want to add more symptoms, enter the 
symptom(s) in the text field. 

8. In the Notes field, enter any additional notes, as required.

9. The EMR populates the Date Noted field with today’s date. You can change this field if 
required, by entering the date in the format of DD-Mmm-YYYY. If you do not know the exact 
day, you can enter the date in the format of Mmm-YYYY, for example, “Dec 2013”. The EMR 
uses the first day of the month to complete the date, for example, “Dec 01 2013”. You can 
also select a date using the calendar icon.

10. Perform one of the following actions:

 To add another allergy click Add ( ) and repeat steps Step 3 to Step 10 .

 If you are finished adding allergies, click Save & Close ( ) to save the allergy and to 
close the Clinical records window.

Viewing and editing a patient’s allergies

To view a patient’s allergies:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window with the Current Hx tab open. The 
Allergies area displays a list of the patient's allergies. 

Note: Be careful when adding symptoms as they are added clinic-wide and 
spelling mistakes cannot be corrected.
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2. In the Allergies area, double-click an allergy. The EMR opens the Allergy List window. You 
can view a list of the patient's allergies on the left side of the window, and details on the right. 

3. In the Allergy List window, in the Active Allergies area, click an allergy to view details about 
the status, certainty, reaction, symptoms. 

4. Edit the fields as required. See “Adding a new allergy or intolerance” on page 194 for a 
description of the fields.

Vaccinations
When you record a patient’s vaccinations, you can note:

 Who administered the vaccination.

 If the vaccination was administered at another facility and at which facility it was 
administered at. 

 If a patient refused or declined a recommended vaccination.

If you enter patient vaccination information appropriately, you can make use of the reminder and 
reporting tools available for vaccinations. Using the Wolf EMR vaccination recommendation tool, 
you to track what vaccinations your patients are due for. Using the Immunization report, you can 
produce reports of vaccinations administered over a defined period of time.
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Recording vaccinations

You can record vaccinations that were administered at your clinic, and vaccinations that were 
administered at other facilities. You can also record that a patient refused a vaccination.

To record a vaccination administered to a patient:

1. Perform one of the following actions:

 If you have the patient’s Medical Summary open, on the Current Hx tab, in the 
Vaccinations area, click <<Add Vaccination>>.

 If you have another window of the patient's medical record open (for example, the Vitals 
Entry window), right-click and then, in the SMART menu, click New Vaccination. 

The EMR displays the Vaccination window.

2. In the Vaccination Date area, perform one of the following actions:

 If you know the date the vaccination was administered, in the Date field, enter a date, or 

to select a date on a calendar, click .
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 If you are recording a previous vaccination and are unsure of the administration date, in 
the Approx field, enter an approximate date. EMR translates the approximate date into a 
full date and displays the date in the Date field.

3. If your clinic has multiple locations, in the *Location drop-down list, select the location the 
vaccination was administered at.

4. In the Administration Facility field, perform one of the following actions:

 If the vaccination was administered in your clinic, in the drop-down list, select Clinic.

 If the vaccination was administered at a facility outside of your clinic, in the drop-down list 
click the facility. If the facility you want is not available in the list, enter the facility in the 
field.

Tip: Entering an approximate date

You can enter the approximate date as:

 Month only: The EMR records the date as the first day of this month in the 
current year.

 Year only: The EMR records the date as January 1 of the selected year.

 Month and Year: The EMR records the date as the first day of the entered 
month in the entered year.

You can enter the month in full or as an abbreviation. The year must be a four-digit 
year.
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5. In the Administered By area, perform one of the following actions:

 If the individual who administered the vaccination was a provider in your clinic, in the 
drop-down list, select Physician/Nurse Prac, and then in the lower drop-down list, 
click the provider.

 If the individual who administered the vaccination was a front end staff member, in the 
drop-down list, select Staff, and then in the lower drop-down list, click the staff member.

 If the individual who administered the vaccination was from a facility outside of your clinic, 
in the drop-down list, select Public Health, and then in the field enter the name of the 
provider, pharmacy, or clinic.

6. In the Vaccine field, enter all or part of the vaccination name (for example, flu or dpt), and 
then on your keyboard, press Enter. The EMR displays a list of matching vaccinations.

Best practice: If you enter a new Administration Facility, you can choose to 
add the facility to the list. Add facilities to the list only if you or other users will be 
selecting the location often.

To modify or delete Administration Facility drop-down list options (for example, to 
“clean-up” duplicate or miss-spelled list items):

1. Double-click the Administration Facility field tag. The EMR displays the 
Administration Facility Field List window.

2. Perform one of the following actions:

  To add a facility name, in the bottom row, enter the name.

  To edit a facility name, click the line, and then modify the text as needed.

  To delete a location, click the location line, and then on your keyboard, press 
Delete.

5. When you finish, click .
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7. In the list of vaccinations, click the vaccination you want. The EMR displays the full 
vaccination name in the Vaccine field. 

8. In the Series field, enter the series number of the vaccine, if applicable.

9. In the Lot # field, perform one of the following actions:

 To select a lot number that has previously been entered on the computer you are 
currently using, in the drop-down list, click the vaccine's lot number. The EMR displays 
the Expiry date for the selected lot.

 To enter a new lot number that has not been entered previously for another patient, in the 
Lot # field, enter the lot number, and then in the Expiry field, enter the lot’s expiry date.

10.In the Route drop-down list, select the vaccination route.

11. In the Dosage field, enter the vaccination dose.

12. In the Vaccination Injection Site drop-down list, select the site where the vaccination was 
administered. If the injection site you want is not available, then manually enter the value.

Tip: If you want to edit the Expiry date, click Edit Lot, change the date, and then 
close the window.

Note: A particular lot number is not available in the drop-down list if it has expired 
or if the lot has been marked as “Finished”

Note: If the route you want is not on the list, you cannot enter the value. Users with 
administrative authority can add options to the Route list if needed via 
Configuration:

1. On the Wolf EMR Launch page, click Configuration ( ).

2. On the Configuration menu, click View > Patient Data Codes > Vaccination 
Types > Route Maintenance.
Wolf Front End Staff User Guide - Issue 02.05 201



Viewing and recording patient medical history (Medical Summary)
 

13. To review possible contraindication for the vaccination, at the top of the window, click the 

Multum ( ). For more information on viewing drug interaction warnings, see 
“Reviewing drug interaction warnings” on page 235.

14. To record a reaction to the vaccination:

Best practice: If you enter a new injection site, you are prompted to add the 
injection site to the drop-down list. Add injection sites to the list only if:

 You or other users will be selecting the option often

 You can confirm that the option is not already available on the list (perhaps as a 
different name?)

 You can confirm that you have spelled the injection site correctly

To modify or delete Vaccination Injection Site drop-down list options (for 
example, to “clean-up” duplicate or miss-spelled list items):

1. Double-click the Vaccination Injection Site field tag. The EMR displays the 
Vaccination Injection Site Field List window.

2. Perform one of the following actions:

  To add an injection site, in the bottom row, enter the site.

  To edit a injection site name, click the injection site line, and then modify the 
text as needed.

  To delete a site, click the injection site line, and then on your keyboard, press 
Delete.

4. Click .
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a) In the Reaction drop-down list, click the type of reaction the patient had, or if the 
reaction type you want is not on the list, in the Reaction field, enter the reaction. 

When you save the vaccination entry, the EMR displays the allergy entry window with the 
vaccination and reaction type populated.

b)  If the patient has an adverse reaction that should be reported to the Public Health 
Agency of Canada, click the AEFI Report (Public Health Canada) link. The EMR 
opens the Report of Adverse Events Following Immunization (AEFI) SMART form for the 
patient. Complete, save, and optionally print or fax the form.

15. In the Notes area, enter any notes regarding the patient's vaccination.

16. To view details on any interaction warning override(s), click Drug Interaction Overrides. 
The EMR displays the Drug Interaction Override History window.

17. If all of the patient’s primary immunizations are completed, at the top of the window, select 
the Primary Immunizations have been Completed for this Patient check box. The 
EMR indicates the completion of Primary Immunizations on the Current History tab in the 
Medical Summary window.

18. Perform one of the following actions:

 To record another vaccination click Add ( ) and repeat steps Step 2  to Step 18 .
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 If you are finished recording vaccinations, click  to save the vaccination entry and to 
close the Vaccinations window.

Recording refused vaccinations

If a patient refuses a vaccination, you can record and reference the refusal. This way, you know:

 Not to offer the vaccination again, or

 To provide the patient with more information

To record a refusal to a vaccination:

1. Start to record the refused vaccination as you would for an administered vaccination. See 
Step 1 to Step 7 of “Recording vaccinations that you administer” on page 512.

2. In the Vaccinations window, select the Refused check box.

3. If the patient refused the vaccination on a date other than today, in the Date Refused field, 

enter the date, or to select a date on a calendar, click .

4. Click Close Form ( ).

Recording group vaccinations

If your clinic administers the same vaccination to a group of people (for example, if you 
administer a vaccine to a family, or if you host a flu shot clinic), you can record the vaccination 
for all patients at once.

To record a vaccination for a group of patients:

Note: If you record refused vaccinations, you can produce practice search reports 
detailing patients who refused certain vaccinations. In Practice Search, use the 
search parameter: Refused Vaccinations.

Note: You can record group vaccinations only for patients who have appointments 
booked on the date the vaccinations took place.
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1. On the WorkDesk, under Data Entry, click Group Vaccination. The EMR displays the 
Group Vaccination window.

2. Using the following table, under 1. Select a Vaccination, enter the vaccination information.

Field Description

Vaccine Enter all or part of the vaccination name (for example, flu or dpt), and 
then on your keyboard, press Enter. The EMR displays a list of 
matching vaccinations.

Click the vaccination you want. The EMR displays the full 
vaccination name in the Vaccine field. 

Series # Enter the series number of the vaccine, if applicable.

Lot # Perform one of the following actions:

 To select a lot number that has previously been entered on the 
computer you are currently using, in the drop-down list, click the 
vaccine's lot number. The EMR displays the Expiry date for the 
selected lot.

 To enter a new lot number that has not been entered previously 
for another patient, in the Lot # field, enter the lot number.

Expiry Enter the lot’s expiry date.

Route In drop-down list, select the vaccination route.

Dosage Enter the vaccination dose.
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3. Under 2. Select Patient, perform the following steps:

a) In the *Appointment Date field, select the date the vaccinations took place.

b) In the Practitioner Filter drop-down list, select the provider whose patient’s were 
vaccinated, or if patient’s from multiple providers were vaccinated, select <ANY>.

c) If the patients whom were vaccinated had a common appointment reason (for example, 
“injection”, or “vaccination”), in the Appointment Reason drop-down list, select the 
reason, otherwise, leave <ANY> selected.

The EMR displays a list of patients whom meet the criteria outlined in this step.

4. In the list of patients, click a patient whom you want to record the vaccination for, and then 

click . The EMR adds the patient to the Vaccination Records Created for Following 
Patients area.

5. Repeat Step 4 for all patients you want to record the vaccination for.

Vaccination 
injection Site

In the drop-down list, select the site where the vaccination was 
administered. If the injection site you want is not available, then 
manually enter the value.

Location If your clinic has multiple locations, in the drop-down list, select the 
location the vaccination was administered at.

Administration 
Facility

perform one of the following actions:

 If the vaccination was administered in your clinic, in the drop-
down list, select Clinic.

 If the vaccination was administered at a facility outside of your 
clinic, in the drop-down list click the facility. If the facility you want 
is not available in the list, enter the facility in the field.

Administered By Perform one of the following actions:

 If the individual who administered the vaccination was a provider 
in your clinic, in the drop-down list, select Physician/Nurse 
Prac, and then in the lower drop-down list, click the provider.

 If the individual who administered the vaccination was a front end 
staff member, in the drop-down list, select Staff, and then in the 
lower drop-down list, click the staff member.

 If the individual who administered the vaccination was from a 
facility outside of your clinic, in the drop-down list, select Public 
Health, and then in the field enter the name of the provider, 
pharmacy, or clinic.

Field Description
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6. When you finish, click Close Form ( ). The EMR records the vaccination in the Medical 
Summary of all selected patients.

Viewing and modifying vaccinations

To view or edit a patient’s vaccinations:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. On the Current Hx tab, the Vaccinations area displays: 

 The patient's administered vaccinations

 The patient’s refused vaccinations

 The Primary Immunizes Completed check box   

2. To view more detailed information about a vaccination, in the Vaccinations area, double-
click the vaccination. The EMR displays the vaccination entry in the Vaccinations window.

3. In the Vaccinations window modify information as needed. For information on how to input 
vaccination details, see “Recording vaccinations” on page 198.

Creating vaccination recommendations

Because there are numerous vaccinations that patients are recommended to take throughout 
their lifetime, it can be hard to track if a patient is due for, or missing a vaccination. 

Note: To indicate that a patient (no matter what age) has received all required 
Primary Immunizations, select the Primary Immunizations Completed check 
box.
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In Wolf EMR, you can create automatic notifications that displays for patients who are due for 
vaccinations. Using vaccination schedules you can create automatic vaccination notifications 
for patients who meet criteria for specific vaccinations.

To create a vaccination schedule:

1. On the WorkDesk menu, click Configure > Vaccination Schedules ( ). The EMR 
displays the Vaccination Schedule Editor window.

2. In the Vaccine drop-down list, select a vaccine. The EMR displays the vaccine name in the 
Vaccine field.

Tip: If you are having trouble finding the vaccination you want, in the Vaccine field, 
begin to enter the vaccine name. The EMR takes you to the appropriate place in 
the list.
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3. Using the following table, enter the schedule for the vaccine.

4. When you are finished, click Close Form ( ).

Stopping vaccination recommendations

If a vaccination is taken off the market, or if clinical guidelines for a vaccination changes, you 
can halt automated recommendations for that vaccination.

To stop a vaccination recommendation:

1. On your WorkDesk, click Configure > Vaccination Schedules ( ). The EMR displays 
the Vaccination Schedule Editor window.

Note: There should never be more than one instance of the same vaccine the 
drop-down list. If you see multiple instances, inform a staff member with 
administrative privileges. Users with Administrative privileges can remove the 
redundant option.

Column Description

Age to Administer (Days) Enter the recommended age, in days.

Age to Administer Display 
Text

Enter the recommended age in the format you want the 
age to display on the Vaccination Schedule (for 
example, 12 months.)

Days Required Between 
Series

If the vaccination is a series, enter the number of days 
required between each vaccination in a series. For 
example, if two months is required between each 
vaccination in the series, enter "60" to indicate “60 
days.”

Notes Enter any notes you want regarding the recommended 
vaccination.

Effective From DOB If the vaccine is new for infants/children, enter a starting 
date. The EMR displays the vaccination 
recommendation only on the Vaccination Schedule of 
patients who’s date of birth is AFTER the date specified.

Display To activate the vaccination schedule, select this check 
box.

Tip: Use the horizontal scroll bar at the bottom of the Vaccine Schedule Editor 
window to view the last few columns.
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2. On the Vaccine drop-down list, select the vaccination you want to stop recommendations 
for. The EMR displays the recommendations associated with the selected vaccine in the 
table below.

3. In the Effective To DOB column, enter an end date (Typically today’s date or an earlier 
date). The EMR removes the recommendation for any patient born after the date specified.

Recognizing when a patient is due for vaccinations

When a patient is due for a vaccination, a notification is displayed in the SMART patient banner 
on the patient’s record.

To recognize when a patient is due for a vaccination:

1. On any window of the patient’s record (including the Medical Summary), in the SMART 

patient banner, click  # Vaccinations (where # = the number of vaccinations the patient 
is due for). The EMR displays the patient’s Vaccination Schedule, with:

 Upcoming vaccinations highlighted in blue

 Outstanding vaccinations highlighted in orange. 

Note: As soon as you record an administered vaccine for a patient, the associated 
vaccination recommendation no longer displays as "outstanding" on the patient's 
Vaccination Schedule.
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Producing an immunization report

In Wolf EMR you can produce a report of immunizations performed over a defined period of 
time. The report can detail administrations for a specific vaccine, and/or for vaccines 
administered by a specific person.

To produce an immunization report:

1. On the WorkDesk menu, click Reports > Immunization Records ( ). The EMR 
displays the Immunization Report window.

2. Using the following table, enter criteria for what immunizations should display in the report.

Field Description

From Enter the start date from which administered immunizations are to 

be included, or to select a date from a calendar, click .

To Enter the end date to which administered immunizations are to be 

included, or to select a date from a calendar, click .
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3. Click one of the following options:

 Create CSV Extract File ( ): To save the report as a CSV file that can be opened in 
various spreadsheet and statistical analysis applications (for example, Microsoft Excel).

 Print to Default Printer ( ): To print the prenatal record to your default printer.

 Print ( ): To print or fax the report on a selected printer or fax machine.

Viewing or adding a patient’s blood type

To view or add a patient’s blood type:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. On the Current Hx tab, you can view the patient’s blood type in the lower left corner.

2. To record a patient’s blood type, in the Blood Type field, enter the letter(s) (for example, O, 
A, or B), and then in the drop-down list, select + (positive) or - (negative).

Administered By 

(Optional)

To include only vaccinations administered by a specific person, in 
the drop-down list select the person.

Vaccine

(Optional)

To produce a report for only a specific vaccine, in the Vaccine 
drop-down list, select the vaccine.

Field Description
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Adding, viewing, and editing a patient’s past medical history information
The following sections describe how to add, view, and edit a patient’s past medical history 
information.

Adding a new inactive problem

To add a new inactive problem:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab. 

3. In the Inactive Problems area, double-click <<Add New Problem>>. The EMR opens 
the Problems List window with the Activity field set to Inactive. 

4. In the Select Problem field, enter part or all of the name, or the diagnostic code of the 
problem, and then on your keyboard, press Enter. The EMR searches the list of registered 
problems and displays a list of results.

5. In the list of results, click the problem, and then click Update. The Select Problem field 
changes to the Inactive Problem field and displays the problem you selected in red text. 

6. Follow Step 5.  to Step 6  in “Adding a problem” on page 176.  

Tip: If the problem you want in not is the search results list, you can use Favourites 
or Tags to add the problem. See:

 “Adding problems using favourites” on page 180.

 “Using tags to add problems” on page 184.

Note: Only clinics using the new problem list that includes the CIHI list can use 
problem favourites and tags.

Note: Keep the Activity field set to Inactive.
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Viewing and editing a patient's inactive problems

When you set the Activity of a problem to Inactive, the EMR lists the problem on the Past 
History tab, in the Inactive Problems area.

To view and edit a patient’s inactive problems:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab. The Inactive Problems area lists the patient’s inactive problems. 

3. In the Inactive Problems area, double-click a problem to view more details. The EMR 
opens the Problems List window where you can view details about the problem. You can 
also view any linked lab results, linked pending labs, related medications, and any surgical 
procedures that were performed for the problem.

4. To edit a problem on the patient’s Inactive Problems list:

a) To change the diagnosis description, click Change Diagnosis. The Inactive Problem 
field clears and changes to the Select Diagnosis field.

b) Edit fields as necessary. See “Adding a problem” on page 176 for a description of the 
fields.

Viewing a patient's previous medications

To view a patient’s previous medications:
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1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab. The Previous Medications area lists the patient’s previous 
medications. 

3. In the Previous Medications area, double-click a medication to view more details. The 
EMR displays the Medication Profile window. You can view a list of the patient's Previous 
Medications on the left side of the window, and details in the Discontinued Medication area 
on the right.

Adding a new procedure or surgery

To add a new procedure or surgery:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab.

3. In the Procedures and Surgeries area, double-click <<Add New Procedure>>. The 
EMR displays the Record New Procedure (Surgery) window.

4. In the Procedure field, enter the name of the procedure or surgery and then on your 
keyboard, press Enter. The EMR displays a results list under the Procedure field.

5. In the results list, click the procedure or surgery that you want to add, (for example Aortocor 
Bypass 1 Coronary Art or Appendectomy) and then click Update. The Procedure field 
displays the procedure or surgery you selected.

6. In the Date field, enter the date of the procedure. If you do not know the exact date, you can 
enter a partial date (for example, month/year, or just year).

7. (Optional) Enter the name or specialty of the surgeon:
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a) In the Surgeon field, start entering the name or specialty of the surgeon performing the 
procedure, and then on your keyboard, press Enter. The EMR displays a results list 
under the Surgeon field. 

b) In the results list, click the surgeon performing the procedure.

8. In the Problem drop-down list, click the reason why the procedure is being performed. 

9.  The Notes field, enter any notes about the procedure or surgery.

10. In the Follow-up field, enter any notes to reference when following up with the patient.

11. Perform one of the following actions:

 To add another procedure, click Add ( ) and repeat steps Step 4  to Step 11 .

 If you are finished adding procedures, click Save & Close ( ) to save the procedure 
entry and to close the Record New Procedure (Surgery) window.

Using Procedure favourites (some clinics only) 

When adding procedures or surgeries to a patient’s procedure list, favourites display at the top 
of the Procedure List. You can also choose a favourite procedure directly from your favourites 
list.

Procedure favourites can be clinic-wide (can be used by all users), or user-specific (can be 
used by you only). You can add or remove procedures in your user-specific favourites list only.

Adding a procedure or surgery to a patient’s record using procedure favourites (some clinics 
only) 

To add a procedure or surgery to a patient’s record using procedure favourites:

Tip: If you do not see the appropriate problem, click <<Add New>>. 
In the Problem List window, add the new problem. See “Adding a problem” on 
page 176.

Note: Only clinics using the new problem list that includes the CIHI list can use 
Procedure favourites.

Note: Only users with administrative privileges can add clinic-wide favourites.

Note: This procedure applies to clinics using the new problem list that includes the 
CIHI list.
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1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab.

3. In the Procedures and Surgeries area, double-click <<Add New Procedure>>. The 
EMR displays the Record New Procedure (Surgery) window.

4. In the Procedure field, enter the name of the procedure or surgery and then on your 
keyboard, press Enter. The EMR displays a results list under the Procedure field. Matching 
procedure favourites display at the top of the list and are indicated by an asterisk (*) in the 
Favourites column.

5. In the list of matching procedures, click the procedure favourite you want, and then click 
Update. The Procedure field displays the procedure or surgery you selected.

6. If the procedure or surgery you want does not display, use the following procedure:

Favourites indicated with
an asterisk (*).
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a) In the Record New Procedure (Surgery) window, click Advanced. 

The EMR displays the Procedure List window. Procedure Favourites display at the top of the 
list. General procedures display below the list of favourite procedures. 

b) In the Search Code field, enter part or all of the name, or the diagnostic code for the 
procedure.

c) Under the Search Code field, select Contains.
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d) On your keyboard, press Enter. The EMR displays matching procedures that contain (in 
the procedure name, ICD-9 code, or tag) the Search Code entry. 

e) In the list of matching favourites, click the procedure you want, and then click Add 

Selected to Patient ( ). The EMR displays the selected procedure favourite in the 
Procedure field.

7. Finish adding the selected procedure to the patient’s procedure list. See Step 6 to Step 
11 in “Adding a new procedure or surgery” on page 215.

Adding procedures to your procedure favourites list (some clinics only)   

To add a procedure to your favourites list:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab.

3. In the Procedures and Surgeries area, double-click <<Add New Procedure>>. The 
EMR displays the Record New Procedure (Surgery) window.

Note: This procedure applies to clinics using the new problem list that includes the 
CIHI list.

Note: Only users with administrative authority can add clinic-wide procedure 
Favourites. (Favourites that can be viewed by all clinic users.)
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4. Click Advanced. 

The EMR displays the Procedure List window. Procedure Favourites display at the top of the 
list. General procedures display below the list of favourite procedures. 

5. In the Search Code field, enter part or all of the procedure or surgery name or ICD-9 code.
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6. Below the Search Code field, select one of the following options:

 Starts with: To display matching procedures that start with the term you entered in the 
Search Code field.

 Contains: To display matching procedures that contain the term you entered in the 
Search Code field anywhere within the name.

7. On your keyboard, press Enter. The EMR filters your procedure list to display matching 
favourites, and general procedures.

8. In the list of procedures, click the procedure you want to make into a favourite.

9. Click Add to Favourites ( ). The EMR displays the Add to Favourite window. 

10. Click OK. The EMR adds the procedure to your favourites list.

Using Procedure tags (some clinics only) 

When adding a procedure to a patient’s procedure list, you can search for a procedure using 
alternative search terms, called Tags. For example, you may prefer to enter “App” to search for 
the “Appendectomy”. 

Because each user may use different abbreviations to search for a procedure, multiple Tags 
can be assigned to a procedure. Tags can be clinic-wide (can be used by all users), or user-
specific (can be used by you only).

Note: Only users with administrative authority can add clinic-wide favourites and 
tags. The EMR displays a Clinic-wide Favourite and Tag check box for users 
with administrative authority. 

Note: Only clinics using the new problem list that includes the CIHI list can use 
Procedure tags.
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Adding a procedure to a patient’s procedure list using a tag (some clinics only) 

To add a procedure to a patient’s procedure list using a tag:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab.

3. In the Procedures and Surgeries area, double-click <<Add New Procedure>>. The 
EMR displays the Record New Procedure (Surgery) window.

4. In the Procedure field, enter a Tag that is assigned to the procedure you want. The EMR 
displays a list of matching procedures.

5. Finish adding the selected procedure to the patient’s procedure list. See Step 5 to Step 
11 in “Adding a new procedure or surgery” on page 215.

Assigning tags to procedures (some clinics only) 

Note: This procedure applies to clinics using the new problem list that includes the 
CIHI list.

Note: The far right column in the procedure search results list displays all tags 
assigned to each procedure.

Note: This procedure applies to clinics using the new problem list that includes the 
CIHI list.
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If there are no tags assigned to a procedure, or if you want to use a tag that is different than the 
tags currently assigned to a procedure, you can assign your own tag(s).

Tags you assign to a procedure are user-specific. No other users can see use your tags.

To assign a tag to a procedure:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab.

3. In the Procedures and Surgeries area, double-click <<Add New Procedure>>. The 
EMR displays the Record New Procedure (Surgery) window.

4. Click Advanced. 

Note: Only users with administrative authority can assign clinic-wide Tags to 
procedures. (Tags that can be used by all clinic users.)
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The EMR displays the Procedure List window. Procedure Favourites display at the top of the 
list. General procedures display below the list of favourite procedures. 

5. In the Search Code field, enter part or all of the procedure or surgery name or ICD-9 code.

6. Below the Search Code field, select one of the following options:

 Starts with: To display matching procedures that start with the term you entered in the 
Search Code field.

 Contains: To display matching procedures that contain the term you entered in the 
Search Code field anywhere within the name.

7. On your keyboard, press Enter. The EMR filters your procedure list to display matching 
favourites, and general procedures.

8. If the Procedure you want to assign a tag to is not on your favourites list, use the following 
procedure:

a) In the list of procedures, click the procedure you want to add assign a tag to.

Note: A procedure must first be on the favourites list before you can assign a tag 
to it.
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b) Click Add to Favourites ( ). The EMR displays the Add to Favourite window.

c) In the Tag field, enter the tag you want. 

d) Click OK. The EMR displays the assigned tags in the Tag column of the procedure list.

9. If the procedure you want to assign a tag to is on your Favourites list, complete the following 
procedure:

a) In the filtered list of procedures, click the procedure you want to assign a Tag to.

b) Click Edit ( ).

c) The EMR displays the Edit Tags window.

d) In the Tag field, enter the tag you want. 

Tip: If you want to add multiple tags, separate each tag name with a comma. 

You are limited to 50 characters for all tags combined.

Tip: If there is a Tag entered already, or if you want to add multiple tags, separate 
each tag name with a comma. 

You are limited to 50 characters for all tags combined.
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e) Click OK. The EMR displays the assigned tags in the Tag column of the procedure list.

Viewing and editing a patient's procedures and surgeries

To view and edit a patient’s procedures and surgeries:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Past Hx tab. The Procedures and Surgeries area lists the patient’s procedures 
and surgeries. 

3. In the Procedures and Surgeries area, double-click a procedure or surgery to view more 
details. The EMR opens the Edit Procedural/Surgical History window. 

4. View and edit the fields as required. See “Adding a new procedure or surgery” on page 215 
for a description of the fields.
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Viewing a patient's refuted or terminated allergies 

The Refuted and Terminated Allergies area lists any Allergies that were classified as 
Refuted or Terminated and Reclassified.

To view a patient’s refuted or terminated allergies:

1.  Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163. The EMR displays the Medical Summary window.

2. Click the Past Hx tab. The Refuted and Terminated Allergies area lists any Refuted or 
Terminated and Reclassified allergies. 

3. In the Refuted and Terminated Allergies area, double-click a refuted or terminated allergy 
to see more details. The EMR displays the Allergy List window. You can view a list of the 
patient's allergies on the left side of the window, and details on the right.

Adding, viewing, and editing a patient’s personal medical history 
information

The following sections describe how to add, view, and edit a patient’s personal medical history 
information.

Viewing and entering a patient's social history

A patient’s social history can include the following information:

 Ethnic origin

 Preferred language

 Marital status

 Significant other information

 Occupation
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 Income type

 Education

 Contraception method

 Next of kin contact information 

To view and enter a patient’s social history:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Personal Hx tab. The Social History area displays a patient's social history 
information. 

Tip: You can set the following Social History values in Patient Maintenance, on the 
Other Demographics tab:

 Ethnic Origin

 Preferred Language

 Language

 Occupation

 Maiden Name

 Next of Kin

When you change the above fields on the Other Demographics tab, the 
changes are reflected in the Social History window. Conversely, when you change 
the above fields in the Social History window, the changes are reflected on the 
Other Demographics tab. 
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3. In the Social History area, click any field. The EMR displays the Social History window.

 

4. Use the following table to enter patient information. 

Tip: Several fields in the Social History window are drop-down combo boxes. To 
use a drop-down combo box, you either click a value in the drop-down list or enter 
text in the field. 

If you enter new text, the EMR displays a dialog box asking you if you want to add 
the new text to the master list. The master list is for all users. If you click Yes, the 
EMR adds the new text to the drop-down list to make future data entry easier for 
everyone.

Field Description

Ethnic Origin Enter the patient’s ethnic origin. Click a value in the 
drop-down list or enter a value in the text field.
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5. Use the following table to enter information about the patient's significant other. 

6. Use the following table to enter information about the patient's occupation and education:

7. Use the following table to enter patient information. 

Preferred Language Enter the patient’s preferred language. Click a value in 
the drop-down list or enter a value in the text field.

Language Enter the patient’s language. If the language is not 
known, select <Unknown>.

Marital Status Indicate the patient’s marital status. In the in the drop-
down list, click one of the following options: Single; 
Married; Common Law; Separated; Divorced; 
Widowed.

Field Description

Significant Other Enter the name of the patient’s significant other.

SO Ethnic Origin Enter the ethnic origin of the patient's significant other. 
Click a value in the drop-down list or enter a value in the 
text field.

SO Date of Birth Enter the date of birth of the patient's significant other. 
Enter the date in the format DD-Mmm-YYYY or use the 
calendar icon to choose a date. 

SO Occupation Enter the occupation of the patient's significant other.

Field Description

Occupation Enter the patient’s occupation.

Income Type Indicate the patient’s income type. In the in the drop-
down list, click one of the following options: None, 
Employed, Self-Employed, Social Assistance, UIC, 
Disability Insurance, or Other. The EMR only accepts 
the options in the drop-down list.

Education Indicate the patient’s level of education. In the in the 
drop-down list, click one of the following options: High 
School, College, University, Professional Degree, 
Trade School or Technical College. The EMR only 
accepts the options in the drop-down list.

Field Description

Contraception Method Enter the patient's method of contraception.

Notes Enter any additional information or explanations.

Field Description
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8. Use the following table to enter the patient's maiden name and next of kin contact 
information. 

9. Click Save & Close ( ) to save your changes and to close the Social History window.

Viewing, editing, and verifying a patient’s smoking history

To view, edit, and verify a patient’s smoking history:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

Student? If the patient is a student, select this check box.

CareGiver If the patient is a caregiver, select this check box.

Home Care? If the patient is receiving home care, select this check 
box.

Institution If the patient is a caregiver, enter the name of the 
institution where the patient is a caregiver.

Name of Care Recipient If the patient is a caregiver, enter the name of the client 
receiving care from the patient.

Field Description

Maiden Name Enter the patient's maiden name.

Next of Kin Enter the name of a close relative of the patient.

Phone Enter next of kin's telephone number.

Note Enter any additional information or explanations.

DateChecked The EMR displays the current date in this field.

Field Description
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2. Click the Personal Hx tab. The Harmful Substances area displays the patient’s smoking 
history. 

3. To edit or verify a patient’s smoking status, click anywhere in the Harmful Substances 
area. The EMR opens the Personal Risks window. 
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4. In the Smoking area, view or edit the fields. See the following table for a description of the 
fields. 

5. Click Save & Close ( ) to save your changes and to close the Personal Risks window. 

Field Description

Smoking status drop-down 
box

Click one of the following options based on the patient's 
smoking history:

 ?? Not Known ?? (This is the default.)

 Non-Smoker

 Quit < 1 year

 Quit > year

 Smoker

Year Onset If the patient has a smoking history, enter the year that 
the patient started smoking. You can also use the 
calendar icon to select a date.

Pack(s)/Day Enter the average amount of packs a day the patient 
smokes or used to smoke.

Date Quit If the patient has quit smoking on a certain date, then 
enter the date. You can also use the calendar icon to 
select a date.

PackYrs Smoked If the Year of Onset, Pack(s)/Day and the Date Quit 
fields are all filled out, then the EMR automatically 
calculates and populates the PackYrs Smoked field. 
You can edit the PackYrs Smoked field if required.

Target Date If the patient is currently smoking but plans to quit on a 
certain date, enter the patient's target quit date in the 
format of DD/MM/YY. 

Verified Smoking Status 
check box:

If you make any changes to the above fields, the EMR 
automatically selects the Click to indicate that you 
verified status check box and adds the current date 
as the last time you checked with the patient on their 
Smoking History. You can also manually select this 
check box which adds today's date as a confirmation 
that the patient's current smoking status has not 
changed. You can select this check box each time you 
go back into the Personal Risks window.
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Viewing, editing, and verifying a patient’s alcohol history

To view, edit, and verify a patient’s alcohol history:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Personal Hx tab. The Harmful Substances area displays the patient’s alcohol 
history.

3. To edit or verify a patient’s alcohol status, click anywhere in the Harmful Substances area. 
The EMR opens the Personal Risks window. 

4. In the Alcohol area, view or edit the fields. See the following table for a description of the 
fields. 

Field Description

Alcohol status 
drop-down box

Click one of the following options based on the patient's alcohol 
history:

 Non Drinker

 Ex Drinker

 Light: < 6 Drinks/Week

 Moderate: 7-24 Drinks/Week

 Heavy: > 24 Drinks/Week

 ?? Not Known ?? (This is the default.)

Tolerance Enter the number of drinks to reach Tolerance.

Annoyance Enter 1 if patient reports ever being Annoyed when asked about 
their drinking.

Cut Down Enter 1 if patient reports ever having thought about cutting down 
their drinking.
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5. Click Save & Close ( ) to save your changes and to close the Personal Risks window. 

Adding a new family history problem

To add a new family history problem for the patient:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Personal Hx tab. 

3. In the Family History area, double-click <<Add New Family History>>. 

Eye Opener Enter 1 if patient reports ever having had a drink in the morning to 
offset a hangover.

T-ACE Score After you enter the above four fields, the EMR automatically 
calculates and displays the T-ACE Score value. You can edit the T-
ACE Score value if required.

Verified Alcohol 
Status check box

If you make any changes to the above fields, the EMR automatically 
selects the Click to indicate that you verified status check box 
and adds the current date as the last time you checked with the 
patient on their Alcohol History. You can also manually select this 
check box which adds today's date as a confirmation that the 
patient's current alcohol status has not changed. You can select 
this check box each time you go back into the Personal Risks 
window.

Field Description
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The EMR displays the Family History Input window. 

4. In the list under the Select Diagnosis area, click the appropriate problem for the family 
member, for example alcoholism, or breast cancer. 

5. (Optional) If you want to link the diagnosis or problem to a family member, in the Link to 
Family Member area, click a family member type (for example, Mother). 

Tip: If the appropriate option is not available, select Problem List, enter the 
problem name, and then click <Enter Assessment>. You can now search from a 
more detailed list.

Tips:

 If the Show Biological Family Only option is selected, the EMR displays 
only relations with the status Biological (in the “Patient Relations for” 
window in the Relationships area in Patient Maintenance).

 Double-click <<Add New Family Member>> to enter a new family 
member or double-click a family member to edit their information such as 
Name, Year of Birth, Deceased, Year of Death, Note, or Date Checked.
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6. (Optional) In the Add Details area, enter the following details:

 Age of Onset: Enter the age when the family member was diagnosed.

 Cause of Death?: Select this check box if the selected problem was the cause of 
death.

 Problem Notes: Enter any further notes or explanations here.

 Date Noted: Enter the date the Family History was modified in the format of: DD/ Mmm/
YYYY. The default value is today’s date.

7. Click the check mark ( ) to save the entry. The EMR displays the diagnosis and the 
family member under the All Listed Family History area in the Family History Input window.

8. Click Close ( ). 

Viewing and editing family history details

To view and edit family history details:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Personal Hx tab. The Family History area lists the patient’s family member’s 
problems. 

3. To view or edit the detailed information for a family member’s problems, in the Family 
History area, double-click a family history entry. The EMR opens the Family History Records 
window. The Family History Records window displays the family member’s significant 
medical history details including: a list of their problems, age of onset, date of birth, date of 
death, and any notes.

4. Edit the fields as required. See “Adding a new family history problem” on page 235 for a 
description of the fields.
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Using the SMART Menu
You can quickly add medical history information using the SMART Menu (also known as the 
right-click menu). 

Opening the SMART Menu 

You can open the SMART Menu by right-clicking anywhere in a patient’s medical record (for 
example, the Medical Summary window or the Vital Entry window). The SMART Menu provides 
easy access to numerous view and action items. 

To open the SMART Menu:

1. Open the WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. Open a patient record.

3. Right-click the patient record, and then click Show All Menu Items. The SMART Menu 
opens. 

Adding or viewing medical history information using the SMART Menu

To add or view medical history information using the SMART Menu:

1. Open the SMART Menu. See “Opening the SMART Menu” on page 238.

2. Click an appropriate option. See the following table. 

Note: The next time you right-click the patient record, the SMART menu will open 
automatically. You will not have to click Show All Menu Items.

If you want to: Click:

Add current and past 
problems

New Problem

View current and past 
medications

View Medication List

Add a drug allergy New Allergy

Add a non-drug allergy (when 
PIN/EHER is enabled) 

New Non Drug Allergy

Record a new vaccination New Vaccination

Add procedures and surgeries New Procedure

Add social history View Social History

View or edit smoking, alcohol, 
or drug history

Smoking/Alcohol/Drugs History
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3. Use the procedures in this module to continue to add or view the medical information.

Add a new family history 
problem

New Family Hx

Open PharmaNet to Open Pharmanet (near the bottom of the list)

If you want to: Click:
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Chapter 6
Vitals and visit encounter notes
This chapter describes how to enter a patient’s vitals and other measurements, and how to 
enter visit encounter notes for various types of visits. You enter a patient’s vitals and SOAP 
notes via the Vital Entry window. Any information you enter is automatically transferred to the 
practitioner’s SOAP note. The practitioner can then add to or modify your notes as needed.

For specialized visits that require encounter notes to be entered in a specialized form (For 
example, prenatal visits, pediatric visits, and WCB visits), you enter visit notes in a visit-specific 
template.

Using the Vital Entry window
As a front end staff member, you use the Vital Entry window to enter a patient’s vitals and 
measurements, and visit notes. Through the Vital Entry window you can also access all of a 
patient’s medical information via the SMART patient Banner, and can perform numerous actions 
via the SMART menu.

Opening and viewing the Vital Entry window

To open the Vital Entry window:

1. On the Appointment Scheduler, click the patient’s appointment and then, on your keyboard, 
press F6. 

The EMR displays the Vital Entry window, with:

 A list of all patients with appointments today displayed in the left pane.

 The Vitals tab displayed in the right pane.

 The selected patient’s Appointment Reason and Appointment notes displayed 
above the Vitals tab.

Note: You can open the Vital Entry window only if the patient has an appointment 
booked.
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 The selected patient’s SMART patient banner displayed at the top of the window.

2. To view the Vital Entry window for another patient, in the list of patients, click the patient.

Entering patient vitals and other measurements

To enter a patient’s vitals and other measurements:

1. Open the Vital Entry window. See “Using the Vital Entry window” on page 241.

Tips for viewing the Vital Entry window

 Use the SMART Patient Banner to view additional information for the selected 
patient. For example, you can view a patient’s vitals from a previous visit or see 
how long a patient has been at the clinic or in the exam room. See “Information 
on the SMART Patient Banner” on page 164.

 You can perform numerous actions on any of the patients listed in the left pane 
using the SMART menu. To open the SMART menu for a patient, in the list of 
patients, right-click the patient.

Note: If the SMART menu does not display, click Show All Menu Items.
242 Wolf Front End Staff User Guide - Issue 02.05



Vitals and visit encounter notes
In the Vitals tab, enter the patient's vitals and other measurements. 

2. To save your changes and close the window, click Close Form ( ) or, on your 
keyboard, press Alt + C.

Entering visit notes using a SOAP note 

You use the SOAP tab in the Vital Entry window to enter Subjective, Objective, Assessment 
and Plan (SOAP) information. The definitions of the four components of a SOAP note are:

 Subjective: What the patient’s concerns or complaints are

Note: After you enter the Height and Weight and press Tab or Enter, the EMR 
automatically calculates the body mass index (BMI) value.

If configured, you do not have to enter an adult’s height every time to get a BMI 
reading. The EMR uses the last recorded height instead. 
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 Objective: What the practitioner observes or measures during the exam

 Assessment: The practitioner’s assessment or diagnosis.

 Plan: The practitioner’s plans to treat the patient’s concerns

The information you enter on the SOAP tab appears when the practitioner opens a SOAP note 
or Consult Letter Examination (specialists) for the same visit. The practitioner can then edit or 
add to your information as needed.

To enter information in a SOAP note:

1. Open the Vital Entry window. See “Using the Vital Entry window” on page 241.

2. Click the SOAP tab.

3. (Optional) In the Chief Complaint field, enter the patient’s primary reason for seeing the 
practitioner or, in the drop-down list, click a complaint.
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4. Enter information in the Subjective, Objective, Assessment and Plan fields.

5. To save your changes and close the window, click Close Form ( ) or, on your 
keyboard, press Alt + C.

Using structured examination templates

Structured examination templates contain fields specific to a particular problem or type of 
examination. For example, a Back structured examination template contains fields such as 
back flexion, back extension, and leg strength. 

Wolf EMR contains numerous disease-specific Chronic Disease Management (CDM) 
structured examination templates that you can use to enter data. The CDM structured 
examination templates help you to understand your patient base and focus on prevention when 
monitoring chronic disease patients. If you enter CDM visit data using the appropriate 
templates, you can:

 Track patient trends, disease progress, and compliance for entire groups of patients 
diagnosed with a specific chronic disease (using Practice Search reports).

 Track a patient's treatment plan, disease progression, and compliance (using disease-
specific flowsheets).

 Receive automated reminders for chronic disease patients who are due for specific tests, 
follow-up appointments, lifestyle advice, and treatments (using Rules). 

To enter information using a structured examination:

1. Open the Vital Entry window. See “Using the Vital Entry window” on page 241.

2. On the bottom of the Vitals tab, in the Structured Examinations drop-down list, select an 
exam. 

Best Practice: At the end of each of your notes, enter your initials. This way, the 
practitioner can differentiate what notes were entered by you.

Note: The information you enter in the structured examination template appears 
when the practitioner opens the same structured examination for the patient. The 
practitioner can edit or add to the information you entered in the structured 
examination template.
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The EMR displays a structured examination window for the selected examination type.

3. Enter data into the various text fields, drop-down lists, and check boxes.

4. When you are finished entering data, click Close ( ).The EMR returns you to the Vital 
Entry window.
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5. To save your changes and close the window, click Close Form ( ) or, on your 
keyboard, press Alt + C. 

Using SMART exams

For questionnaire-type diagnostic tools (such as mental health assessments) and for complex 
visit documentation (such as the Pain Management Functional Goals & Summary), you can 
enter data using specialized SMART forms called SMART exams. When you enter data using 
SMART exams:

 The EMR automatically calculates questionnaire scores. 

 For questionnaire scores and other exam data: You can graph values and perform patient 
searches based on values. 

Most Wolf EMR SMART exams also contain links to patient handouts and other physician 
resources related to specific diagnostic tools. 

Tips for entering and viewing data in structured examinations

 To view values that were previously entered in a specific field, double-click the 
field. The EMR displays a summary of values previously entered for the patient 
and the corresponding exam dates.

 To view a patient’s Medical Summary (chart) while entering information into an 
exam, click back to the Vital Entry window and then, on your keyboard, press 
F7.

 If, after you close the structured examination, you want to modify or enter 
additional information, simply open the structured examination again, and then 
add or modify information as needed.

 You can enter information into more than one structured examination during a 
visit.
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The following table lists and describes the SMART exams available in Wolf EMR.

Name Description

Adult Mental Health Assessment SMART exams

The Adult Mental Health SMART Exams are designed to support the British Columbia 
Practice Support Program (PSP) for mental health, however, these forms can also be used 
by providers from other provinces. The Adult Mental Health Assessment SMART exams 
incorporate the PSP mental health algorithm, questionnaires, patient handouts, and other 
physician resources.

Adult Mental Health 
Assessments

Combines content from all other mental health SMART 
exams, and includes

 Generalized Anxiety Disorder Questionnaire (GAD-7)

 Patient Health Questionnaire-9 (PHQ-9)

 Diagnostic Assessment Interview Questions

 Self-Assessment Questionnaire

 Montreal Cognitive Assessment Questionnaire (MoCA)

 Standardized Mini-Mental State Exam (sMMSE)

 Mood Disorder Questionnaire (MDQ)

 Global Assessment of Functioning (GAF) Scale

 Problem and Resource Lists

 Problem List Action Plan

 Mental Health Care Plan

 Brief Action Plan - Self Management

 Psychotherapeutic Supports Used

 References

Note: Use this SMART exam if you are managing several 
mental health disorders for a patient. Complete 
only the exam sections that apply to the patient.
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Adult Mental Health 
Assessments - Anxiety

Contains mental health diagnostic tools and resources for 
anxiety, and includes:

 Generalized Anxiety Disorder Questionnaire (GAD-7)

 Self-Assessment Questionnaire

 Montreal Cognitive Assessment Questionnaire (MoCA)

 Problem and Resource Lists

 Problem List Action Plan

 Mental Health Care Plan

 Brief Action Plan - Self Management

 Psychotherapeutic Supports Used

 References

Adult Mental Health 
Assessments - Cognitive 
Function

Contains mental health diagnostic tools and resources for 
cognitive function, and includes:

 Montreal Cognitive Assessment Questionnaire (MoCA)

 Standardized Mini-Mental State Exam (sMMSE)

 Mood Disorder Questionnaire (MDQ)

 Global Assessment of Functioning (GAF) Scale

 Problem and Resource Lists

 Problem List Action Plan

 Mental Health Care Plan

 Brief Action Plan - Self Management

 Psychotherapeutic Supports Used

 References

Name Description
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Adult Mental Health 
Assessments - Depression

Contains mental health diagnostic tools and resources for 
depression, and includes:

 Patient Health Questionnaire-9 (PHQ-9)

 Diagnostic Assessment Interview Questions

 Problem and Resource Lists

 Problem List Action Plan

 Mental Health Care Plan

 Brief Action Plan - Self Management

 Psychotherapeutic Supports Used

 References

Child and Youth Mental Health SMART exams

The Child and Youth Mental Health SMART Exams are designed to support the British 
Columbia Practice Support Program (PSP) for child and youth mental health, however, these 
forms can also be used by providers from other provinces. The Child and Youth Mental 
Health SMART exams incorporate the PSP mental health algorithm, questionnaires, patient 
handouts, and other physician resources.

Child & Youth Mental 
Health Visit

Designed for the screening of mental health conditions, and 
includes:

 CYMH Historical Questions

 Current Situations

 6 Item Kutcher Adolescent Depression Scale (KADS)

 Screen for Child Anxiety Related Disorders

 SNAP-IV (Parent & Teacher Versions)

Name Description
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Child and Youth Mental 
Health Screening

Designed for documenting ongoing mental health care, and 
includes:

 Teen & Child Functional Assessments

 6 Item Kutcher Adolescent Depression Scale (KADS)

 Tool for Assessment of Suicide Risk (TASR-Am)

 Anxiety, Depression Medication Side-Effect Scale 
(sCKS)

 Kutcher Side Effect Scale for ADHD Medications 
(KSES-A)

 Clinical Global Impression - Improvement Scale (CGI)

 Worry Reducing Prescription (WRP)

 Mood Enhancing Prescription (MEP)

 CYMH Support Plan

 Family Mental Health Care Plan

 Professional Mental Health Care Plan

 CYMH Historical Questions

 Instructions for accessing the Confident Parents Thriving 
Kids (BC) form

 Psychotherapeutic Supports Used

 Team-based Care Resources & Tools

 References

Pain Management SMART exam

The Pain Management SMART Exam is designed to support the British Columbia Practice 
Support Program (PSP) for the management of patients with chronic pain, however, these 
forms can also be used by providers from other provinces. The Pain Management SMART 
exam incorporates PSP tools, questionnaires, patient handouts, and other physician 
resources related to the management of pain.

Name Description
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To use a SMART exam:

1. Open the Vitals Entry window for the visit: See “Opening and viewing the Vital Entry window” 
on page 241. 

Pain Management Includes:

 Brief Pain Inventory

 Urine Drug Screen

 Red & Yellow Flags

 Brief Pain Inventory (BPI) Questionnaire

 Pain Disability Index (PDI) Questionnaire

 Generic Body Exam

 PHQ-9 & Gad-7 Questionnaires

 Sleep Questionnaire

 DN4 Screening Questionnaire

 Pain Catastrophizing Scale (PCS) Questionnaire

 Initiation Checklist

 Opioid Risk Tool

 D.I.R.E. Score

 Initiation Trial Chart

 PharmaNet Search confirmation

 Opioid Switching Tool

 Patient Termination Letter (Opioid Use)

 Pain Management Functional Goals & Summary 
Handout

 Brief Action Plan - Self Management

 Pain Management Education Done confirmation

 PSP Pain Management Algorithm

 References and Additional Handouts

Note: You should access SMART exams from the Vitals Entry window, as the 
exam must be connected to a patient visit.

Name Description
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2. Right-click anywhere on the window and then, in the SMART menu, click SMART Forms. 
The EMR displays the Send to SMART form window.

3. In the left pane, expand the Exam Forms category, and then click the SMART exam you 
want. 

The EMR previews the exam.

4. Click Send and Close ( ), or in the list of SMART exams, double-click the exam. The 
EMR opens the SMART exam in Microsoft Word.

Tip: If you want to complete a number of mental health assessments from one 
window, select the Mental Health Assessments exam. This exam combines the 
anxiety, cognitive function, and depression exams.
Wolf Front End Staff User Guide - Issue 02.05 253



Vitals and visit encounter notes
5. Enter data in the applicable area(s) of the SMART exam.
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6. Click Save ( ), and then close the window. 

Recording clinical notes for prenatal visits
The following sections describe how to record clinical notes for prenatal visits. The topics 
include viewing the obstetrical history for a patient, recording notes in the Prenatal Record, 

Tips for entering data in SMART exams: 

 To calculate a questionnaire score, click Click for Result.

 If the exam has numerous sections, you can use the Navigation pane (left 
pane) to jump to specific sections.

 You do not have to enter data in every section of the SMART exam. Complete 
only the exam sections that apply to this visit

FAQ: After I save and close the SMART exam can I go back and make 
edits?

After you save and close a SMART exam, you cannot open and edit the original 
exam. Instead, start a new version of the SMART exam (see Step 1.  to Step 4. ), 
and then re-enter data in the fields and questionnaires you want to modify. When 
you save the new SMART exam, the EMR overwrites the areas of the form where 
you entered data.
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linking a document to the Prenatal Record, and accessing a document linked to the Prenatal 
Record. 

Viewing a patient’s pregnancy status

If a patient is pregnant, the patient’s SMART patient banner displays the word “pregnant” and 
indicates how far along she is in her pregnancy.  

Viewing and editing a patient's obstetrical history

You can view and edit a patient’s obstetrical history in the patients Medical Summary, in the 
Obstetrics tab  

To view and edit a patient’s obstetrical history:

1. Open the Medical Summary window. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Obstetrics tab. The EMR displays a list of the patient’s previous and current 
pregnancies.

3. To view more detailed information for a pregnancy, double-click the pregnancy entry.

4. To add a pregnancy to the list:

Note: The SMART patient banner displays pregnancy information only if a Prenatal 
Record has been started for the patient.

Note: The pregnancy information you add on the Obstetrics tab automatically 
populates the Prenatal Record. Alternatively, if you enter obstetrical history 
information in the Prenatal Record, that information is reflected on the Obstetrics 
tab. 
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a) Click Enter New Obstetrical Hx (  ). The EMR displays the Obstetrical History 
window.

b) Use the following table to enter information in the Obstetrical History window:

c) Perform one of the following actions:

 To save and close the obstetrical history entry, click Close Form ( ).

Field Description

Delivery date Enter the date of delivery or termination.

Hospital Enter the hospital in which the delivery took place.

Gest Age (wks) Enter the gestational age of the baby at the time of delivery in wks 
and days.

Labour Time Enter the number of hours the mother was in labour for.

Delivery Type In the drop-down list, click the type of delivery.

Complications Enter any complications that occurred during the pregnancy or 
delivery.

Sex Enter the sex of the baby.

Birthweight Enter the birth weight of the baby.

Present Health Enter the present health of the baby/child.
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 To save the current entry, and to start a new entry, click Add New Obstetrical History 

to Patient Record ( ).

Opening the Prenatal Record 

You can enter all prenatal visit notes in the Wolf EMR Prenatal Record template. Each time the 
patient returns for a prenatal visit, you add notes to the same Prenatal Record until the 
pregnancy is finished. You can then print or fax the entire prenatal record to the hospital or mid 
wife. 

To open the Prenatal Record:

1. Open the Vital Entry window for the patient. See “Using the Vital Entry window” on page 241.

2. At the bottom of the Vitals tab, click Antenatal Record. The EMR opens the Prenatal 
window.

Note: The prenatal form includes all information entered for previous visits for this 
pregnancy.
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Calculating an estimated due date and gestational age based on LMP

When you enter the last menstrual period (LMP) date and Menses Cycle duration in the 
patient’s Prenatal Record, the EMR automatically calculates an estimated due date (EDD). If you 
select EDD BY DATE, the EMR also calculates the gestational age.

Accessing prenatal handouts

If your clinic has linked patient handouts to the prenatal record (for example, 
prenatal nutrition information handouts), you can access patient handouts on the 
Part 1 tab. On the lower right side of the window, click the blue Patient 
Handouts link.

Note: For more information, see “Linking documents” on page 374 and 
“Accessing a patient handout that is linked to the Prenatal Record” on page 
276.
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To calculate an estimated due date and gestational age by LMP:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

2. In the Obstetrics History area, in the LMP field, enter the patient’s last menstrual period 
date or select the date from the calendar.  

3. In the Menses Cycle area, enter the average duration (in days) of the patient's cycle.

4. (Optional) If the patient has an irregular cycle, in the Menses Cycle area, select the 
Irregular Cycle check box.

5. In the EDD Calculation area, select EDD BY Date. The EMR displays the EDD and 
gestational age at the top of the Prenatal form in the Pregnancy Summary area.
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Recording gestational age based on ultrasound and calculating EDD 

When you receive the patient's first ultrasound results, enter the first ultrasound date and 
gestational age by ultrasound in the patient’s Prenatal Record. You can then calculate the 
estimated due date (EDD) by ultrasound (US), by selecting EDD BY US in the EDD 
Calculation area.

To record gestational age based on ultrasound and to calculate the EDD:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

2. In the Obstetrical History area, enter information in the following fields:

 1st Ultrasound date: Enter the date of the first ultrasound.

 Gest. Age by US: Enter the Gestational Age by Ultrasound in weeks and days.  

3. To calculate an EDD by ultrasound, in the EDD Calculation area, select EDD BY US. The 
EMR uses the ultrasound date to calculate the EDD BY US date and the Gestational Age. 

Recording Prenatal Record notes on the first visit

A patient’s first prenatal visit can include a review of their medical history, adding family and 
medical history, a physical exam, and several discussion topics. The Part 1 tab of the Prenatal 
Record contains fields specific to a first visit, so you can easily enter first visit information in one 
convenient area.    

To record Prenatal Record notes on the first visit:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

Tip: You can link ultrasound images and reports to the Prenatal Record. see 
“Linking documents” on page 374 and “Accessing an ultrasound image that is 
linked to the Prenatal Record” on page 277.

To access linked ultrasound images on the Part 2 tab of the Prenatal Record; click 
the blue Ultrasound Images link

Note: You can also enter the first ultrasound date and gestational age on the Part 
2 tab in the Other Investigations & Comments area. 

Tip: To enter a different estimated due date, use the Override feature:

1. Click the calendar icon (to the right of the Override field) and select the due 
date. 

2. Double-click the due date to close the calendar. The value you selected gets 
copied to the EDD field (near the top of the window).
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2. Use the following table to enter, modify, or view the information on the Part 1 tab of the 
Prenatal Record.   

Field Description

Pregnancy Summary (top of window)

LMP Displays the date of the patient's Last Menstrual Period entered in 
the LMP field in the Obstetrical History area.

EDD BY Dates Displays the estimated due date based on calculations from the 
LMP date and Menses Cycle duration.

EDD BY US Displays the estimated due date based on calculations from the 1st 
Ultrasound date.

EDD Displays the estimated due date based on the calculations 
determined by the EDD Calculation information specified.

Gest. Age The EMR calculates the gestation age based on the EDD date.

Search Enter the search criteria for the physician/midwife name (the next 
field), and press Enter.

Physician/
midwife name

After entering the search criteria and pressing Enter, in the 
Physician/midwife name drop-down list, click the name that you 
want.

General Information

Note: Some general information fields may be pre-populated with information entered 
in the Patient Maintenance window.

Hospital Enter the name of the hospital where the patient plans to give birth.

Attending 
physician/
midwife

Displays the attending physician or midwife for the patient. If you 
want to change this field, enter the name of the attending physician 
or midwife in the Search field and then select a name from the 
search results in the drop-down list.

Family 
Physician

Displays the primary care giver for the patient.

Age at EDD Displays the age at Estimated Due Date.

Mother's 
maiden name

Displays the Mother's Maiden Name.

Ethnic origin Displays the patient's ethnic origins.

Language 
preferred

Displays the preferred language for the patient.

Occupation Displays the patient's occupation.

Work hrs./day Enter the number of hours the patient works per day.
262 Wolf Front End Staff User Guide - Issue 02.05



Vitals and visit encounter notes
No. of school 
years competed

Enter the number of school years completed.

Partner’s Name Displays the partner's name.

Age Displays the age of the partner listed under Partner's Name.

Partner’s work Enter the occupation of the patient’s partner.

Ethnic origin of 
newborn's 
father

Displays the ethnic origins of the newborn's Father.

Allergies Displays any current allergies. 

Click <<Add New Allergy>> to include any allergies suffered by the 
Mother.

Note: When you add a new allergy or medication through the 
prenatal record, the EMR automatically updates the 
patient's Medical Summary with the new information.

Medications/
herbals

Displays any current medications.

Note: We will cover adding medications later in the course, in the 
Medications and Prescriptions module.

Beliefs & 
Practices

Enter any beliefs or practices required by the Mother or Father

Obstetrical 
History (high-
level history)

 Gravida: Enter the number of times the patient has been 
pregnant.

 Para: Enter the number of successful pregnancies but the infant 
is now deceased.

 Term: Enter the number pregnancies brought to term.

 Preterm: Enter the number of pre-term pregnancies.

 Abortion: Enter the number of abortions. 

 Induced: Enter the number of induced abortions.

 Spontaneous: Enter the number of spontaneous abortions.

 Living: Enter the number of successful pregnancies and the 
infant is still alive.

Field Description
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Obstetrical 
History (detailed 
list of 
obstetrical 
history entries)

 To add an obstetrical history, in the Obstetrical History area, 

click .

 To edit an obstetrical history, double-click an entry in the 
Obstetrical History section.

LMP Enter the date of the patient's Last Menstrual Period or select the 
date from the calendar button.

Menses Cycle Enter the patient's menstrual cycle in number of days. If no value is 
entered, then 28 days is the default value.

Irregular Cycle Select this check box if the menstrual cycle is irregular.

Contraceptives Enter the contraceptive type used by the patient.

When Stopped Click to insert a date when the contraceptive type entered was last 
used.

1st Ultrasound 
Date

Enter the date of the first ultrasound. 

Note: If you entered the first ultrasound date on Part 2 of the 
prenatal record, then that date appears in this field.

Gest. Age by US Enter the Gestational Age by Ultrasound in weeks and days. 

Note: If you entered the Gestational Age by Ultrasound on Part 2 
of the prenatal record, then that date appears in this field.

EDD Calculation Select how you want to calculate the EDD. 

 EDD BY US: If selected, the EMR displays the EDD based on 
based on calculations from the 1st Ultrasound date.

 EDD BY DATE: If selected, the EMR displays the EDD based on 
calculations from the LMP date and Menses Cycle duration.

Note: You can use the Override feature to enter your own 
estimate of the due date:
1. Click the calendar icon (to the right of the Override field) 
and select the due date. 
2. Double-click the due date to close the calendar. The 
value you selected gets copied to the EDD field (near the 
top of the window).

Present 
Pregnancy

Click any check box and enter information relevant to the current 
pregnancy.

Field Description
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Recording Prenatal Record notes on subsequent prenatal visits

After the first visit, a patient’s subsequent prenatal visits can include recording lab test results, 
other investigation results, and discussion topics. The Part 2 tab of the Prenatal Record 
contains fields specific to second subsequent visits.  

To record Prenatal Record notes on subsequent visits:

1. Open the patient’s prenatal record. See “Opening the Prenatal Record” on page 258.

2. Click the Part 2 tab. The EMR displays the Part 2 tab of the Prenatal record. 

Family History Enter any information regarding the patient's family history.

Specify the diseases or conditions in the patient's family history by 
selecting the applicable check boxes. A gray check box indicates 
that the patient has not yet been asked about their family history for 
this item.

Medical History Enter any information regarding the patient's medical history. 

Specify the diseases or conditions in the patient's medical history by 
selecting the applicable check boxes. A gray check box indicates 
that the patient has not yet been asked about their medical history 
for this item.

Lifestyle & 
social

Click or enter the information in this section as required when getting 
the data from the patient. Includes topic such as Smoking, Drug 
Use, Alcohol Use, Environmental/Occupational Concerns, Social 
Issues and Referrals. 

Draw Picture Click Draw Picture to include a diagram with the printed record.

Physical 
Examination

Displays information from the Prenatal CPX appointment.

First Trimester 
Topics 
Discussed

Select the check boxes in this section to indicate which topics were 
discussed with the patient.

Tip: The EMR does not automatically populate electronic lab values, however, the 
prenatal form identifies if certain lab values are available in the patient’s record 
(displays these lab names in blue text).

You can click labs with blue text to view the lab result, and then choose to have the 
EMR populate the information into the Prenatal form.

Field Description
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3. Use the following table to modify or view the information on the Part 2 tab of the Prenatal 
Record.    

Field Description

Intended place of birth Enter the desired place of birth, or click a value in the 
drop-down list.

Alternate Place of Birth 
(Hospital)

Enter the alternate desired place of birth, or click a value 
in the drop-down list.

Investigations/Results area
Displays the various investigations and results for the patient.

ABO Group Enter the patient's blood type by clicking O, AB, A or B 
in the drop-down list.

Rh Factor Enter the Rh of the patient's blood type by clicking + or - 
in the drop-down list.
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Antibody titre  DMY: Enter the date of the Rh Antibodies test in 
the format DD-Mmm-YYYY or select a date using 
the calendar icon. 

 Results: Enter the results of the Rh Antibodies 
test.

RhIg given  Results: Enter the results of the RhIg test given.

 DMY: Enter the date of the RhIg test given in the 
format DD-Mmm-YYYY or select a date using the 
calendar icon. 

Hemoglobin Enter the 1st and 3rd Hemoglobin results.

Urine C&S Enter the details of the Urine Culture and Sensitivity 
testing.

Rubella titre  PP vaccination indicated: Select this check box if 
the PP vaccination has been taken.

 Results drop-down list: Click the result of the 
Rubella test. The result can be Immune or Non-
Immune. 

STS Enter the results of the Serologic Test for Syphilis (STS).

HIV test done Select the Yes or No check box to indicate if an HIV test 
has been completed. If you selected Yes, enter the 
results in the text box.

HBsAg Done  Select the Yes or No check box to indicate if an 
HBsAg test (for Hepatitis B) has been completed. 

 Results: Select the Positive or Negative check 
box.

 DMY: Enter the date of the HBsAg test in the format 
DD-Mmm-YYYY or select a date using the calendar 
icon. 

Select the following check boxes, if applicable:

 Partner/household contact

 NB vaccination indicated

Other tests Enter the results of any other tests such as Hepatitis C 
or Varicella.

Prenatal Genetic Screening  Type: Enter the type of Prenatal Genetic Screening

 Result: Enter the result.

Field Description
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Gest. diabetes screen 
(24 - 28 wks)

 DMY: Enter the date when the patient was last 
screened for Gestational Diabetes or select a date 
using the calendar icon. 

 Results: Enter the results for the Gest. diabetes 
screen.

GBS screen 
(35-37 wks)

  Select the Yes or No check box to indicate if the 
patient has completed a Group B Streptococcus 
(GBS) screening.

 DMY: Enter the date when the patient was last 
screened for GBS or select a date using the 
calendar icon. 

 Result: Click a result in the drop-down list. The 
result can be Positive, Negative, or Present in 
urine.

 Copy to Hospital: Select this check box if the 
results should be sent to the hospital.

Edinburgh Postnatal 
Depression Scale  Score: Click the  button (next to the Score field) 

to open the Edinburgh Postnatal Depression Scale 
calculator. Click the check boxes to record the 
patient’s answers to the questions, and then click 

Save ( ). The EMR displays the patient's score 
in the Score field. 

 DMY: Enter the date when the patient answered the 
questions, or select a date using the calendar icon. 

 Follow-up: Select the Yes or No check box to 
indicate if a follow-up is required.

Potential or Actual 
Concerns area

Enter any potential or actual concerns for various 
aspects of the patient's life into these fields. Each 
aspect has its own text box: Lifestyle, Pregnancy, 
Labour, Breastfeeding, Postpartum, and Newborn.

Second and Third Trimester 
Topics Discussed area

Select the check boxes of any topics discussed for the 
second and third trimester.

Field Description
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Calculating a patient's Prenatal Risk Score

You can use the Prenatal Risk Assessment Calculator on the Risk Assessment tab to 
calculate a patient’s Prenatal Risk Score. You calculate the Prenatal Risk Score by selecting 
check boxes regarding Past Obstetrical History, Problems in Current Pregnancy, Medical 
History, and Other Risk Factors.

You can use the patient’s Prenatal Risk Assessment to assist in counseling, scheduling of 
prenatal visits, and in management decisions (for example, diagnostic tests and specialist 
referrals).

To calculate a patient’s Prenatal Risk Score:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

Other Investigations & 
Comments

 1st US: Enter the 1st Ultrasound date.

 GA by US: Enter the Gestational Age by Ultrasound 
in weeks and days

 If maternal prenatal screen above cut off, 
amnio: If the prenatal screening results were above 
the cut off limits, select Yes or No check box to 
indicate if amniocentesis should be offered to the 
patient.

 Comments: Enter any comments.

Field Description
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2. Click the Risk Assessment tab. The EMR displays the Risk Assessment tab. 

3. Using the check boxes, answer the Prenatal Risk Assessment questions associated with 
each section. The following table provides an overview of each section.  

Section Description

Past Obstetrical 
History

Displays questions related to previous pregnancy outcomes.

Problems in Current 
Pregnancy

Displays questions related to the current pregnancy, for example, 
Substance Abuse, Depression, Bleeding, Antibodies, or Anemia.
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Recording prenatal visit notes

The Part 2 - Visits tab of the Prenatal Record lists all current Visit Records for a patient and 
allows you to enter a new Visit Record or to edit and delete existing ones. Use the Part 2 - 
Visits tab to record prenatal visit notes for each prenatal visit. 

To record prenatal visit notes:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

2. Click the Part 2 - Visits tab. The EMR displays the Part 2 tab of the Prenatal record.  

3. On the right side of the Part 2 - Visits tab. click Add  to enter a Prenatal visit record for 
today. The EMR displays the Prenatal Visit Record window.

Medical History Displays questions relating to:

 Diabetes

 Heart Disease

 Hypertension

 Obesity

 Other risk factors, for example age, alcohol, BMI, depression, 
height, history of breastfeeding difficulties, smoking, and other 
medical and surgical disorders.

Section Description
Wolf Front End Staff User Guide - Issue 02.05 271



Vitals and visit encounter notes
   

4. Enter information in the following fields to complete a Prenatal Visit Record: 

 Appointment Date

 Weight (and select Kg or Lbs to indicate the units of weight)

 Urine Protein

 Urine glucose

 BP Systolic

 BP Diastolic

 Gestational Age in weeks and days

 Fundal Height

 F.H. (Fundus Height)

 FHR

 Activity

 Presentation

 Position

 Return in date

 Payee Number

 Insurer 

Note: If a patient's vitals were entered in the Vital Entry window, those vital entries 
are automatically populated in the Prenatal Visit Record window.
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 Fee Code

 Service Units / Service Time

 Notes

5. To close the Prenatal Visit Record, click Save & Close ( ). 

Viewing a Fundus Height Growth chart

Fundal height is a measure of the size of the uterus and is used to assess fetal growth and 
development during pregnancy. It is measured from the top of the mother's uterus to the top of 
the mother's pubic bone in centimeters. Fundal height roughly corresponds to gestational age 
in weeks between 16 to 36 weeks for a vertex fetus. Most practitioners record their patient's 
fundal height on every prenatal visit. Measuring the fundal height can be an indicator of proper 
fetal growth and amniotic fluid development.

To view a Fundus Height Growth Chart:

1. Open the Prenatal Record for the patient. See “Opening the Prenatal Record” on page 258.

2. Click the Part 2 - Visits tab. The EMR displays the Part 2 tab of the Prenatal record.

3. On the bottom right corner of the Part 2 - Visits tab, click SYMPHYSIS - FUNDUS 
HEIGHT GROWTH CHART.

Linking documents to the Prenatal Record 

You can link documents such as patient handouts or ultrasound images, to the Prenatal 
Record. Once linked, you can easily access these documents by clicking the appropriate link 
on the Prenatal Record. 

When you link a document and choose Prenatal Form as the keyword, the document 
becomes available through the Patient Handouts link on the Prenatal Record. 

When you link a document to a patient, and choose Prenatal US as a keyword, the document 
becomes available through the Ultrasound Images link on the Prenatal Record. You can also 
view the document from the Documents tab on the Medical Summary.

You will learn how to link documents in a later module. For more information, see “Linking 
documents” on page 374.

Important: Documents you link with the keyword Prenatal Form are available 
through the Patient Handouts link on the Prenatal Record for all patients. Make 
sure the document does not contain any patient-specific or other confidential 
information.
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Linking a document to the Prenatal Record as a patient handout 

When you link a document and choose Prenatal Form as the keyword, the document 
becomes available through the Patient Handouts link on the Prenatal Record. 

To link a document to the Prenatal Record as a patient handout:

1. On the Wolf EMR Launch page, on the Wolf Programs menu bar, click Documents. The 
EMR displays the Documents window.

2. In the Source pane, navigate to the location of the folder containing the handout. In most 
cases the location is: Wolf Lair/Data/Unlinked documents, however this can vary 
depending on your clinic.

3. On the left side of the window, click a document. The EMR displays a preview of the 
document in the middle of the window.

4. In the top right corner of the window, in the Attach Options area, select Attach to Patient.

5. On the right hand side pane, in the Patient Search area, search for and select a test 
patient. 

6. In the Attach these Keywords drop-down list, click Prenatal Form. 
You can select up to two other keywords to further describe the document.

7. In the bottom right corner of the window, click Link and Reviewed.

Linking a document to the Prenatal Record as an ultrasound image

When you link a document to a patient, and choose Prenatal US as a keyword, the document 
becomes available through the Ultrasound Images link on the Prenatal Record. You can also 
view the document from the Documents tab on the Medical Summary.

To link a document to the Prenatal Record as an ultrasound image:

1. On the Wolf EMR Launch page, click Documents ( ). The EMR displays the 
Documents window.

2. In the Source pane, navigate to the location of the folder containing the ultrasound image. In 
most cases the location is: Wolf Lair/Data/Unlinked documents, however this can vary 
depending on your clinic.

Note: If the keyword Prenatal Form is not in the current list, then your 
administrator must enter this document keyword in Configuration.

Important: Documents you link with the keyword Prenatal Form are available 
through the Patient Handouts link on the Prenatal Record for all patients. Make 
sure the document does not contain any patient-specific or other confidential 
information.
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3. In the left pane, click a document. The EMR displays a preview of the document.

4. In the top right corner of the window, in the Attach Options area, select Attach to Patient.

5. On the right hand side pane, in the Patient Search area, enter the Patient's Name, PHN, 
Chart #, or date of birth.

6. In the search results, click the patient’s name.

7. In the Attach these Keywords drop-down list, click Prenatal US. 
You can select up to two other keywords to further describe the document.

8. In the bottom right corner of the window, click Link and Reviewed.

Note: If the keyword Prenatal US is not in the current list, then your administrator 
must enter this document keyword in Configuration.
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Accessing documents linked to the Prenatal Record

Documents that are linked to the Prenatal Record appear as blue links on the Prenatal Record. 
Examples of document links include Patient Handouts or Ultrasound Images. Simply click 
the document link to access the document. 

Accessing a patient handout that is linked to the Prenatal Record

You can access linked patient handouts on the lower right side of the Part 1 tab of the Prenatal 
Record; simply click the Patient Handouts link.  

To Access a patient handout that is linked to the Prenatal Record:

1. Open the patient’s prenatal record See “Opening the Prenatal Record” on page 258.

2. On the lower right side of the Part 1 tab, click Patient Handouts.   
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If your clinic has more than one prenatal handout, the EMR displays the Linked Documents 
window.

3. In the list of documents, click the handout you want. The EMR opens the handout in the 
PDF-XChange Viewer.

4.  To print the handout, click Print ( ) or, on your keyboard, press Ctrl + P.

Accessing an ultrasound image that is linked to the Prenatal Record

You can access linked ultrasound images on the Part 2 tab of the prenatal record; simply click 
the Ultrasound Images link.

To access an ultrasound image that is linked to a patient’s prenatal record:

1. Open the patient’s prenatal record. See “Opening the Prenatal Record” on page 258.

2. Click the Part 2 tab and then, in the Other Investigations & Comments area, click 
Ultrasound Images.   
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If your clinic has more than one prenatal handout, the EMR displays the Linked Documents 
window.

3. In the list of documents, click the ultrasound you want. The EMR opens the ultrasound 
image in the PDF-XChange Viewer.

4.  To print the handout, click Print ( ) or, on your keyboard, press Ctrl + P.

Printing and faxing the prenatal record

When the prenatal record is to be sent to a hospital or consultant you can print or fax the record 
from Wolf EMR. 

To print or fax a patient’s prenatal record:

1. Open the patient’s prenatal record. See “Opening the Prenatal Record” on page 258.

2. At the top of the window, click one of the following options:

 Collate and Print Prenatal Record ( ):To print or fax the entire prenatal record as 
one document on a selected printer or fax machine

 Print to Default Printer ( ): To print the prenatal record to your default printer

 Print Prenatal Record ( ): To print or fax each tab of the prenatal record as separate 
documents on a selected printer or fax machine

Attaching the prenatal record to a referral

Before you can attach the prenatal record to a referral, you must save the prenatal record as a 
document in the patient’s Medical Summary. You can then attach the prenatal record to the 
referral as you do other documents. 
278 Wolf Front End Staff User Guide - Issue 02.05



Vitals and visit encounter notes
To attach the prenatal record to a referral:

1. Open the patient’s prenatal record. See “Opening the Prenatal Record” on page 258.

2. At the top of the window, click Attach Prenatal Form to patient’s chart ( ). The EMR 
displays the Print pregnancy form window. 

3. Select the prenatal tabs you want to include in the attachment, and then click Print. The 
EMR saves the prenatal record in the patient’s Medical Summary, in the Documents tab.

4. Attach the prenatal record to the referral as you do other documents. See “Creating a referral 
letter using the Referral Letter Composer” on page 409.

Noting delivery details and closing the prenatal record 

To note delivery details and close the prenatal record:

1. Open the patient’s prenatal record. See “Opening the Prenatal Record” on page 258.

2. Click the Delivery tab.

Important: When the patient’s pregnancy is complete, always note the delivery 
details and lock the prenatal record. The EMR then recognizes the patient as no 
longer pregnant. Also, if the patient has future pregnancies, the EMR will know to 
start a new prenatal record.
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3. Use the following table to enter the delivery details: 

4. Click Save & Close ( ) to save and close the prenatal record. 

After you enter the delivery date, and close the Prenatal Record, the EMR locks the Prenatal 
Record.

Recording clinical notes for WCB visits

For WCB visits, you enter visit notes into the appropriate WCB forms. You can then submit the 
forms electronically to WCB through the Wolf EMR eBill program. 

You access and manage WCB forms from the WCB Report Manager.

Filed Description

Delivery Date Enter the delivery date or the date the pregnancy was terminated.

Weeks at Delivery Enter the number of weeks and days for the gestational age of 
the newborn.

Hrs. in Active 
Labour

Enter the number of hours the patient was in labour.

Delivery Type In the drop-down list, click the delivery type. Examples of delivery 
type options include Natural, Breech and C-section. 

Complications Enter any complications from the delivery.

Sex In the drop-down list, click the sex of the newborn.

Birth Weight Enter the weight of the newborn at birth.

Present Health Enter the present health of the patient.
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WCB forms  

WCB report types and tabs

The WCB report types include Form 8: First Report and Form 11: Progress Report. Both 
report types contain the following tabs:

 Interview

 Clinical Information

 Return to Work Planning

 Billing Status

Printing forms

You can print a practitioner’s copy for all of the WCB e-forms. You would use this option for a 
print chart request, a referral, or medical-legal reasons.

Opening the WCB Report Manager

The WCB Report Manager is where you access and manage WCB forms. From the WCB 
Report Manager, you can:

 Start a new WCB Report for a patient

 View, edit, and complete a patient's incomplete WCB Reports

 View a patient's historical WCB Reports

The method you use to open the WCB Report Manager depends on whether the patient is 
booked for an appointment or not. 

Note: 

If your clinic is not on the data centre, use the WCB forms on the WorkSafeBC site 
http://www.worksafebc.com/forms/. 

Most forms are PDFs designed to be printed out and completed. Others can be 
completed and submitted online, and some are available as an online application. 
You can also order printed forms at WorkSafeBC Store.

For support and WCB-related questions, contact WorkSafeBC:

 Phone: 604-276-3135, or toll-free: 1-888-855-2477

 Email: ehelp@worksafebc.com
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Opening the WCB Report Manager for a patient who has an appointment booked

If a patient has a booked appointment, you can use the SMART Menu from the Vital Entry 
window to open the WCB Report Manager.

To open the WCB Report Manager for a patient who has an appointment booked:

1. Open the Vital Entry window using the F6 keyboard shortcut method. See “Using the Vital 
Entry window” on page 241.

2. Right-click anywhere in the Vital Entry window and then click View WCB Reports. The EMR 
displays the WCB Report Manager window.

 

Opening the WCB Report Manager for a patient who does not have an appointment booked

If a patient does not have an appointment booked, you can click the WCB e-Forms button on 
the WorkDesk to open the WCB Report Manager.

To open the WCB Report Manager for a patient who does not have an appointment booked:

1. Open the Workdesk. See “Opening the WorkDesk” on page 153.

2. In the Data Entry area, click WCB e-Forms. The EMR displays the following prompt: 
“Select WCB E-form for an Individual Patient?”

3. Click Yes. The EMR displays the Patient Search window.

4. Search for the patient and then double-click the patient’s name. The EMR displays the WCB 
Report Manager window. 

Starting and completing a WCB First Report 

Complete a WCB First Report for the first visit associated with a claim involving a 
comprehensive consultation, a time loss claim, or a modified duty claim. 

To start and complete a WCB First Report:
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1. Open the WCB Report Manager for the patient. See “Opening the WCB Report Manager” 
on page 281.

2. Click the New Reports tab. The EMR displays the New Reports tab.

3. In the Select Report area, select Form 8: First Report. 

4. In the Select Appointment area, perform one of the following actions:

 If the patient was seen in clinic, click the associated appointment.

 If the patient was not seen at your clinic (for example, if the patient was visited in the 
hospital), scroll to the bottom of the appointment list and select Service Not in Clinic, 
and then in the Select Physician drop-down list, select a physician. 

5. Click New Report 8. The EMR displays the WCB First Report form with the Interview tab 
open and the SMART Patient Banner at the top.
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6. If you selected (in the Select Appointment area) an appointment that has SOAP 
information, the EMR displays a prompt asking you if you want to use the exam data to 
create a new WCB encounter record. Click Yes. The window now has a Copy from 
existing exam tab which displays the SOAP information.
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7.  Enter information on the Interview tab. Use the following table as a reference. 

Tip: The information on the Copy form existing exam tab does not get sent to 
WCB. 

To get this information into the WCB form(s):

 Select text on the Copy form existing exam tab, press Ctrl + C, then move 
to the appropriate tab of the WCB form, and paste the text (Ctrl + V) into the 
appropriate field.

Note: The original SOAP encounter is not automatically deleted. 
You have the option to keep it or delete it.

Field Description

Report Type 
check boxes

 Physicians First Report: Select this check box if you are 
creating a new WCB First Report (form 8). This form should be 
completed for first visits involving a comprehensive 
consultation, a time loss claim, or a modified duty claim.

 Worker's condition of treatment has changed: please 
describe in Clinical Information Area: Select this check box 
if you are creating a WCB Progress Report (Form 11). This 
report should be submitted if the worker's condition or 
treatment has changed since last report or if the worker is 
ready for Return to Work.

A report is not necessary or desired if the worker's condition is 
stable and there will be a planned follow up at an appropriate 
future date.

A report is also not necessary if the worker is enrolled in a 
WorkSafeBC sponsored rehabilitation program. Payment of 
benefits to a worker is not contingent on follow-up every two 
weeks if the above conditions are met.

 WCB Claim 
Number 

Enter the WCB Claim Number if known. This claim number is 
provided by WCB after a First Report has been processed.

Note: The WCB Claim number is mandatory when creating a 
Progress Report.
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Date of Injury Enter the date when the WorkSafeBC related injury occurred. In 
the case of occupational diseases, enter the date when medical 
attention was first sought.

You can type the date into the text box or click the Calendar 
button and double-click the date.

Date of Service The date of service is the date when the service described on this 
report was performed. It is automatically entered here depending 
on the appointment the WCB Report was linked to when first 
creating the report. 

Employer’s 
Information

To select a previously entered global employer (an employer 
entered for any patient in the EMR):

a) Click the binoculars icon ( ). The EMR displays a list of 
previously entered employers.

b) Click an employer in the list.

To enter a new employer:

a) Click the binoculars icon ( ), and then click <<Add New>>.

b) Enter the following Employer Information:

  Employer Name: Enter the employers name or company 
name. This name is then available from the employer drop-
down list for future use.

  Address: Enter the address of the employer.

  City: Click the drop-down arrow to select a city or type in the 
name of a city.

  Postal Code: Enter the postal code.

  Telephone: Enter the area code in the first box and the local 
telephone number in the second box.

To set an employer as inactive if the employer is not the current 
employer:

1. Click Inactive. The EMR displays the following message “Do 
you wish to set the current employer as inactive and enter a 
new employer for this patient?”

2. Click Yes. The EMR clears the employer information fields.

3. Enter the new employer information.

Field Description
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8.  Click the Clinical Information tab and then enter information in the fields. Use the following 
table as a reference. 

Employee 
information

Employee information pre-populated from the information in 
Patient Maintenance, although you can also edit it here.

The worker’s first name, last name, and PHN should match the 
information on the worker’s British Columbia CareCard.

Are you the 
worker’s regular 
physician?

If you are the patient's regular practitioner, select this check box. 
WorkSafeBC may contact you for medical history or to discuss 
claims issues.

How long has the 
worker been your 
patient?

If you selected the Are you the worker’s regular physician? 
check box, select one of the radio buttons to indicate how long 
you have been the patient's Physician (0-6 months, 7-12 
months, or > 12 months). This information is useful for claims 
information.

Who rendered 
first treatment?

Enter the medical practitioner (name) or facility (emergency 
department, clinic, hospital, and so on) who provided the first 
treatment. This does not include first aid at the work site.

E-Form Fee Click the drop-down arrow and select the E-Form Fee to display in 
Billing for this WCB report.

Visit Fee Click the drop-down arrow and select the Visit Fee to display in 
Billing for this WCB report.

Service Time Start Enter the service start time using the 24 hour clock (for example, 
1600).

Service Time End Enter the service end time using the 24 hour clock (for example, 
1800).

Call Time Enter the call time using the 24 hour clock (for example, 1500).

Field Description

*Prior/Other 
Problems 
Affecting Injury, 
Recovery and 
Disability (160 
char max)

Enter details about pre-existing or new non-occupational 
conditions that may affect injury, recovery or disability. You can 
enter a maximum of 160 characters.

If insufficient space, add remaining information to the Clinical 
Information box (at the bottom of the window). For example an 
MVA while receiving care for WorkSafeBC claim.

Field Description
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ICD9 (x) Search Enter an ICD9 code or keyword and press Enter, and then in the 
drop-down list, click a code.

This is the ICD9 diagnosis code and is entered on the invoice 
(claim record). The full set of codes is available at 
health.gov.bc.ca/msp/infoprac/diagcodes/index.html.

*Diagnosis Enter a text description of the injury diagnosis.

Note: The Diagnosis entered here will be displayed in a second 
encounter entry to display the diagnosis in the patient's 
list of Encounter Records found on the Medical Summary 
as well as other locations.

Primary Injury 
Codes and 
Diagnosis area

Enter the following information to describe the injury codes and 
diagnosis:

 *Position: In the drop-down list, click the position. This is a 
code for the anatomical position code (side) of the injury from 
the WorkSafeBC subset of CSA codes (80/80 list).

 *Body Part: Enter a body part or its code and then press 
Enter. In the drop-down list, click one of the results displayed.

Note: This is a 5-character (numeric) code for the area of injury 
(body part) from the WorkSafeBC subset of CSA codes 
(80/80 list). The full set of codes is available at 
worksafebc.com/health_care_providers/Assets/PDF/
body_parts_complete.pdf 

 *Nature: Enter the nature of the injury or its code and then 
press Enter. In the drop-down list, click one of the results 
displayed.

Note: This is the 5-character (numeric) code for the nature of 
injury from the WorkSafeBC subset of CSA codes (80/80 
list). The full set of codes is available at worksafebc.com/
health_care_providers/Assets/PDF/
nature_injury_complete.pdf

*From injury or 
since last report, 
has the worker 
been disabled 
from work?

If the worker has been disabled from work since the injury or the 
last report, click Yes in the drop-down list. Otherwise, click No.

Date of Injury Enter the date of injury or click the Calendar button and double-
click the date.

Field Description
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9.  Click the Return to Work Planning tab and then enter information in the fields. Use the 
following table as a reference. 

As of what date? 
(if known)

Enter the date the injury was known or click the Calendar button 
and double-click the date.

Note: This field is displayed only if you selected Yes for *From 
injury or since last report, has the worker been 
disabled from work?)

Clinical 
Information

This is a text field for the practitioner to describe the worker’s 
current situation in the usual fashion clinical notes are constructed. 
The following information might be included:

 What happened

 Presented injury, disease, complaints, and so on

 Treatments and medications being used

 Subjective symptoms

 Examination finding

 The name and date of specialist referral, if appropriate.

Note: Return-to-work planning is an important reporting component of Form 8 and 
Form 11. The information the practitioner provides, along with practitioner 
participation in the return-to work consultation process assists WorkSafeBC in 
handling each Worker’s claim efficiently and appropriately.

Field Description

*Is the Worker 
now medically 
capable of 
working full 
duties, full time? 

In the drop-down list, click either Yes or No to indicate if the 
Worker can return to their normal pre-injury duties. 

If you click No, elaborate in the "restrictions" area below

*What are the 
current physical 
and/or 
psychological 
restrictions?

Describe the physical and/or psychological restrictions related to 
the injury that are barriers to the patient returning to work. This 
information will be used by the WorkSafeBC case managers and 
medical advisors in working with employers to find suitable 
alternative/modified work.

Field Description
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*Estimated time 
before the worker 
can return to the 
workplace in Any 
Capacity

Estimate the length of time before the worker can return to the 
workplace in any capacity. For example, the earliest possible 
return to the workplace if suitable duties were available. Select one 
of the following options:

 At Work

 1-6 Days

 7-13 Days

 14-20 Days

 > 20 Days

*If appropriate, is 
the worker now 
ready for a 
rehabilitation 
program?

In the drop-down list, click No if the worker is not ready for 
rehabilitation or if a rehabilitation program is not appropriate. If the 
worker is ready for rehabilitation, click Yes, and then select the 
type of rehabilitation program in the additional area that the EMR 
displays (Select Rehabilitation Program).

Select 
Rehabilitation 
Program

If the worker is ready for a rehabilitation program, select Work 
Conditioning or Other.

If you select Other, indicate the type of program (for example, 
occupational rehabilitation program, pain program) in the Clinical 
Information area on the Clinical Information tab.

*Do you wish to 
consult with WCB 
Physician or 
nurse or advisor?

In the drop-down list, click Yes or No to indicate i f you want to 
consult with a WCB physician, nurse, or advisor.

If possible, please 
estimate date of 
Maximal 
Recovery

Maximal medical recovery (full recovery or best possible recovery) 
date. This is sometimes also called date of "maximal medical 
improvement". It refers to the date at which no further 
improvement in condition is expected. At that time the worker may 
still have significant impairment/disability or may be fully recovered. 
It is recognized that the "date" indicated is an estimate only and 
may change if the clinical course changes.

Enter the date of Maximal Recovery or click the Calendar button 
and double-click the date.

Further 
Correspondence 
to Follow?

In the drop-down list, click Yes or No to indicate whether or not 
additional correspondence can be anticipated.

Field Description
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10. (Optional) Click the Billing Status tab to view the billing status of the WCB Form.

11. When you finish entering information on all of the tabs, click . 

The EMR displays a prompt asking you if you want to send the WCB Report to the billing 
program. 

12. Perform one of the following actions:

Attending 
Physician

Displays the attending physician for the patient. 

*Payee Number Enter the payee number issued by MSP that uniquely identifies the 
individual or organization who submits the associated invoice to 
WorkSafeBC and who will be paid by WorkSafeBC. 

Created by (Read-
only)

Displays who created the report (or the practitioner for whom you 
created the report). 

Date and Time 
Created (Read-
only)

Displays the date and time the report was created.

Last Edited (Read-
only)

Displays when the report was last edited.

Last Edited By 
(Read-only)

Displays who edited the report (or the practitioner for whom you 
edited the report)

Note: If the Set Appointment as Finished check box is displayed, the EMR 
marks the encounter as finished. If you do not want this to happen, clear this 
check box (it is selected by default).

Field Description
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 If the report information is complete, click Yes. The EMR sends the report to the Billing 
program, and creates and saves 5 bills: 1 office visit, 1 form, and 3 no charge fees. The 
EMR displays the following prompt: 

Click Yes if you want to print the report now. Click No if you do not want to print the report.

 If the report information is not complete, click No. The EMR saves the form for further 
modification.

The EMR displays the WCB Report twice in the encounter record, to indicate that it is a 
WCB Report as well as to display the Diagnosis. (This is similar to how the EMR displays a 
SOAP record several times in the Encounter List to display several impressions or 
assessments.) 

13.

Starting and completing a WCB Progress Report

You can create WCB Progress Reports after you create and submit a new WCB First Report. 
Create a WCB Progress Report only for completed follow-up visits where relevant changes 
have occurred since the previous report. You must submit a WCB Progress Report if it has 
been more than four weeks since the last Form 11 was sent, or a Form 11 is requested by a 
WorkSafeBC Officer.

When you create a WCB Progress Report, the form pulls in information from the previous claim. 
You can update the information as necessary. 

To start and complete a WCB Progress Report:

1. Open the WCB Report Manager for the patient. See “Opening the WCB Report Manager” 
on page 281.

2. Click the New Reports tab. The EMR displays the New Reports tab.
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3. In the Select Report area, select Form 11: Progress Report.

4. In the Select Claim section, click the claim that you want to update.

5. In the Select Appointment area, perform one of the following actions:

 If the patient was seen in clinic, click the associated appointment.

 If the patient was not seen at your clinic (for example, if the patient was visited in the 
hospital), scroll to the bottom of the appointment list and select Service Not in Clinic, 
and then in the Select Physician drop-down list, select a physician. 

6. Click New Report 11. The EMR displays the WCB Progress Report form. 

7. If you selected (in the Select Appointment area) an appointment that has SOAP 
information, the EMR displays a prompt asking you if you want to use the exam data to 
create a new WCB encounter record. Click Yes. The window now has a Copy from 
existing exam tab which displays the SOAP information. 

8.  Click the tabs as required and update the information in the form. See Step 7.  to Step 9.  in 
“Starting and completing a WCB First Report” on page 282.

9. When you finish updating information on the tabs, click . 

The EMR displays a prompt asking you if you want to send the WCB Report to the billing 
program. 

10. Perform one of the following actions:

Tip: The information on the Copy form existing exam tab does not get sent to 
WCB. 
To get this information into the WCB form(s):

 Select text on the Copy form existing exam tab, press Ctrl + C, then move 
to the appropriate tab of the WCB form, and paste the text (Ctrl + V) into the 
appropriate field.

Note: The original SOAP encounter does not get automatically deleted. 
You have the option to keep it or delete it.

Note: If the Set Appointment as Finished check box is displayed, the EMR 
marks the encounter as finished. If you do not want this to happen, clear this 
check box (it is selected by default).
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 If the report information is complete, click Yes. The EMR sends the report to the Billing 
program, and creates and saves 5 bills: 1 office visit, 1 form, and 3 no charge fees. The 
EMR displays the following prompt: 

Click Yes if you want to print the report now. Click No if you do not want to print the report.

 If the report information is not complete, click No. The EMR saves the form for further 
modification. 

Finishing an incomplete WCB Report for an individual patient

Reports that have been created but not Sent to Billing are listed on the Incomplete Reports 
tab of the WCB Report Manager. You can modify or complete an incomplete report and then 
send it to Billing.

To finish an incomplete WCB Report for an individual patient:

1. Open the WCB Report Manager for the patient. See “Opening the WCB Report Manager” 
on page 281.
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2. Click the Incomplete Reports tab. The EMR displays the Incomplete Reports tab.  

3. Double-click a report to open it for editing.

4. Click the tabs as required and update the information in the form. See Step 7.  to Step 9.  in 
“Starting and completing a WCB First Report” on page 282.

5. When you finish entering information on the tabs, click . 

The EMR displays a prompt asking you if you want to send the WCB Report to the billing 
program. 

6.  Perform one of the following actions:

Note: If the Set Appointment as Finished check box is displayed, the EMR 
marks the encounter as finished. If you do not want this to happen, clear this 
check box (it is selected by default).
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 If the report information is complete, click Yes. The EMR sends the report to the Billing 
program, and creates and saves 5 bills: 1 office visit, 1 form, and 3 no charge fees. The 
EMR displays the following prompt: 

Click Yes if you want to print the report now. Click No if you do not want to print the report.

 If the report information is not complete, click No. The EMR saves the form for further 
modification. 

Tracking and managing incomplete WCB Reports clinic-wide

You can track and manage incomplete WCB reports for every patient in your clinic from one 
convenient location. 

To track and manage incomplete WCB Reports clinic-wide:

1. Open the Workdesk. See “Opening the WorkDesk” on page 153.

2. In the Data Entry area, click WCB e-Forms. The EMR displays the following prompt: 
“Select WCB E-form for an Individual Patient?”

3. Click No. The EMR displays the WCB Report Manager window with the Incomplete 
Reports tab open. The Incomplete Reports tab lists all incomplete WCB reports for every 
patient in your clinic. 

4. Double-click a report to open it for editing. 

5. Click the tabs as required and update the information in the form. See Step 7.  to Step 9.  in 
“Starting and completing a WCB First Report” on page 282.

Tip: To view a list of incomplete WCB reports for a specific practitioner, in the 
Physician drop-down list, select the practitioners name.
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6. When you finish entering information on the tabs, click . 

The EMR displays a prompt asking you if you want to send the WCB Report to the billing 
program. 

7.  Perform one of the following actions:

 If the report information is complete, click Yes. The EMR sends the report to the Billing 
program, and creates and saves 5 bills: 1 office visit, 1 form, and 3 no charge fees. The 
EMR displays the following prompt: 

Click Yes if you want to print the report now. Click No if you do not want to print the report.

 If the report information is not complete, click No. The EMR saves the form for further 
modification. 

8.

Viewing previously billed (old) WCB reports

You can view old WCB reports for an individual patient or for the entire clinic.

Viewing previously billed (old) WCB reports for an individual patient

To view previously billed (old) WCB reports for an individual patient:

Note: If the Set Appointment as Finished check box is displayed, the EMR 
marks the encounter as finished. If you do not want this to happen, clear this 
check box (it is selected by default).
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1. Open the WCB Report Manager for the patient. See “Opening the WCB Report Manager” 
on page 281.

2. Click the Old Reports tab, and then in the Previous Reports area, double-click a report to 
view the details.

3. Click  to close the window.

Viewing previously billed (old) WCB reports for the entire clinic

To view previously billed (old) WCB reports for the entire clinic:

1. On your WorkDesk, in the Data Entry area, click WCB e-Forms. The EMR displays the 
following prompt: “Select WCB E-form for an Individual Patient?”

2. Click No. The EMR displays the WCB Report Manager window with the Incomplete 
Reports tab open. 

3. Click the Old Reports tab, and then in the Previous Reports area, double-click a report to 
view the details.

4. Click  to close the window.

Recording clinical notes for pediatric patients
The following sections describe how to record clinical notes for pediatric patients.

Entering a patient’s birth information

You can enter a patient’s birth information on the Other Demographics tab in the Patient 
Maintenance window. Birth information includes the patient’s place of birth, gestational age, and 
birth measurements.

To enter a patient’s birth information:

1. Open the Patient Maintenance window. See “Opening the Patient Maintenance window” on 
page 17.

2. Click the Other Demographics tab.
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3. Using the following table, enter information in the Birth Information area. 

4. Click Save ( ) and then click Exit.

Viewing a patient’s growth charts 

Growth Charts consist of a series of percentile curves that illustrate the distribution of selected 
body measurements in children. You can display growth charts for patients under the age of 
twenty years. You can view growth charts from the following organizations: 

 World Health Organization (WHO) growth charts adapted for Canada

 Centers for Disease Control and Prevention (CDC)

 Canadian Pediatric Endocrine Group (CPEG) 

To view a patient’s growth charts:

Field Description

City In the drop-down list, click the Municipality or City where the 
patient was born.

Province In the drop-down list, click the Province or State where the 
patient was born.

Gestational Age Enter the number of weeks.

Birth Length Enter a value and then, in the drop-down list, select the units.

Birth Weight Enter a value and then, in the drop-down list, select the units.

Birth Head 
Circumference

Enter a value and then, in the drop-down list, select the units.

Discharge Weight Enter a value and then, in the drop-down list, select the units.
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1. On any window related to the patient’s record (for example, the Vital Entry window or the 
Medical Summary window), right-click and then, in the SMART menu, click View Growth 
Charts > Child Development Charts.

The EMR displays the Growth Charts window. By default, the EMR displays the WHO 
growth chart adapted for Canada, specific to the patient's gender and age. 

Tip: You can set what organization’s growth chart displays by default. For example, 
you can set the CPEG growth charts to display by default:

1. At the top of the window, click Options ( ). The EMR displays the Default 
Display Options window.

2. In the User Options area, clear the Use Defaults check box.

3. in the Your Default Organization drop-down list, select the organization. 

4. Click Save.
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The EMR displays the data points and percentiles in a table format to the right of the chart(s): 

2. To view a different type of chart:

a) In the Organization drop-down list, click an organization.

b) In the list below the Organization field, click a specific graph type. The EMR displays the 
chart in the right part of the window.

3. To adjust the chart/percentiles for an early pregnancy, in the Current Options area, enter 
the number of weeks early in the Adjust age by field, and then press enter. 

4. In the Current Options area, set the various options to change the way the graph looks.  

Tip: If you entered a patient's gestational age in the Patient Maintenance window, 
click the Auto button. The EMR automatically populates the Adjust age by field.

Note: The Auto button is available only if the gestational age you entered is less 
than 38 weeks.

Field Description

Connect data points To connect data points by a line, select this check box. 

Note: This option is selected by default.

Use source chart 
colour style

Charts of a particular type (for example, CDC charts) have 
their own color scheme, which may be different from charts of 
another type.

To display the original color scheme for the chart type, select 
this check box.
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5. To zoom in, hold the Shift key and then click on the area you want to zoom in to.

6. To zoom out, hold the Alt key and then click on the area you want to zoom out from.

7. To re-sort the information in the percentile table, click on one of column headings.

Enable Crosshairs To have a line extend vertically to the edge of the graph when 
you hover your mouse over a data point, select this option.

Note: The vertical line follows the mouse cursor; a 
horizontal line is displayed when you get close to the 
point.

Show Parental 
Heights

To display of the height of the patient's father, and mother, and 
the patient's mid-parental height near the vertical axis (on the 
right side of the graph), select this check box

Note: Exact values display in a popup.

Side-by-side layout 
(for multiple)

To view more than one chart at a time, select this check box.

To view more than one chart at a time, on your keyboard, hold 
the Control key and then click the other charts you want to 
view.

Major Gridlines:
X-axis, Y-axis

To display major gridlines, select these check boxes.

Minor Gridlines:
X-axis, Y-axis

To display of the minor gridlines, select these check boxes.

Units: 
Imperial; Metric; Both

Beside Units, select the units you want to view 
measurements in. 

Note: Metric is selected by default.

Tip: You can set what options are selected by default in the Current Options 
area:

1. At the top of the window, click Options ( ). The EMR displays the Default 
Display Options window.

2. In the User Options area, clear the Use Defaults check box, and then set 
your User Options defaults.

3. Click Save.

Field Description
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8. To hide the percentile table, click the  icon to the right of the chart. 

9. To collapse the patient banner and maximize the growth chart, on the top right of the 

window, click .

10. To add percentiles as exam findings, click Save Percentiles ( ) and then, in the drop-
down list, select which organization's percentiles you want to use. 

11. To print the growth chart(s), perform one of the following actions:

 To print the growth chart(s) on your default printer, click Quick Print ( ).

 To print the growth chart(s) with or without the data point table on a selected printer, click 

Print ( ) and then, in the drop down list, select either Print or Print (with table).

Attaching growth charts to referrals

To attach a growth chart to a referral, you must save the growth chart as a document in the 
patient’s Medical Summary first. You can then attach the growth chart as you do other 
documents. 

To attach a growth chart to a referral:

1. Open the growth chart, and use the view options to make the growth chart look the way you 
want it to look for the referral. See “Viewing a patient’s growth charts” on page 299.

Why save percentiles as exam findings?

 You can graph percentiles together with lab values and other data only if you 
save the percentiles to the patient’s record as exam findings.

 If your clinic uses practice searches and rules that search based on patient 
percentiles, the patient can be identified only if their percentiles are saved as 
exam findings.
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2. Click Save To Chart ( ) and then, in the drop-down list, click one of the following 
options:

 Save To Chart: To save only the growth chart in the Documents area of the Medical 
Summary.

 Save To Chart (with table): To save the growth chart AND a table containing all of the 
data points on the chart in the Documents area of the Medical Summary.

3. Attach the PDF version of the growth chart to the referral. See “Creating referral letters” on 
page 407.

Completing an exam based on the Rourke Baby Records

The Rourke Baby Record (RBR) is the standard examination tool used across Canada for baby 
and child care. It consists of 12 exams (from within one week to five years of age). 

In Wolf EMR, you can access RBR exams on the Vitals Entry window, in the Structured 
Examinations drop-down list. 

You can use the RBR examinations in visit encounters to document each stage of the child’s 
development. Each examination template is broken into sections that correspond to the 
standard 2014 RBR format.   

To record information in a Rourke Baby Record exam::

1. Open the Vital Entry window. See “Using the Vital Entry window” on page 241.

2. Click the Vitals tab.

3. In the Structured Examinations drop-down list, click the appropriate Rourke examination. 

4. Enter the structured examination data and then close the window. Each Rourke examination 
has tabs for <Age from name of exam>, Education and Advice, Development, 

Note: Your administrator must enable the use of RBR examinations for you to use 
the RBR structured examinations.

Tip: The fields in the BIRTH INFORMATION section are synchronized with the 
related fields on the Other Demographics tab in the Patient Maintenance 
window; if you change these fields in RBR structured examinations, the EMR 
updates them in the Patient Maintenance, and vice versa.

Note: The information you enter in a RBR structured examination is visible to the 
practitioner when they open the same RBR structured examination. The 
practitioner can modify the information you entered.
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Physical Exam, Problems/Plans, and Investigations/Immunization. Click each tab 
and enter the associated information.

 

Note: The information you enter in the Investigations/Immunizations tab is not 
reflected in the patient's Vaccination Schedule or on the printed “GUIDE V: 
Immunization” RBR guide. To view the Vaccination Schedule, click the View 
Vaccination Schedule button.
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5. Optionally, perform one or more of the following actions:

 To save RBR exam to the patient’s chart, click Create as a PDF and attach to Chart 

( ). The EMR saves the RBR exam as a PDF in the Documents tab of the patient’s 
Medical Summary. The document's Content Type is Rourke Baby Record.

 To print or fax the RBR to a selected printer or fax, click Print Rourke Baby Record 

( ).

 To print the RBR exam to your default printer, click Quick Print Rourke Baby Record 

( ).

6. Click to save your changes and close the window, click Close ( ).The EMR returns you 
to the Vital Entry window. 

Note: The check boxes on the Education and Advice and the Development 
tabs each support three different states (selected, crossed-out, and clear).

Click a check box to change the state. 

The state of the check box for certain fields is automatically carried over from 
previous visits. This helps to ensure you don't discuss the same subject (for 
example, car seat safety) on each visit. The time period (that is, for how long) that a 
field's state is carried over depends on the specific field.

Tip: You can attach your Rourke Baby Record notes to a referral only if you save 
them as a PDF in the Documents area of the patient’s Medical Summary.
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Chapter 7
Electronic requisitions and forms (SMART 
forms)
In this chapter you learn how to complete electronic versions of requisitions and other forms 
using Wolf EMR SMART forms. SMART forms are Microsoft Word-based form templates. Wolf 
EMR contains hundreds of SMART forms for the most commonly used provincial and local 
forms (including lab and diagnostic imaging requisition forms). You use SMART forms to order 
labs and other investigations.

SMART forms are centralized in the WOLF database, and are available to all Wolf clients. If the 
Wolf development team creates a SMART form, the form automatically becomes available on 
your SMART forms list.

You can define which SMART forms are your favourites, making it easier to access your 
commonly used forms.

Using SMART forms
You can open and fill out a SMART form from almost any window related to a patient. Once 
opened, you “fill-out” the form by selecting check-boxes and entering data in text fields. You 
can then print or fax the form.

Opening SMART forms

To open a SMART form:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, in the SMART menu, click one of the following 
options:

 New Requisition: To select from SMART forms categorized as requisition forms.

 SMART Forms: To select from all available SMART forms in your system.

 Favourite Requisition: To select from SMART forms categorized as requisition forms 
and identified as favourites. See “SMART form favourites” on page 313.

 Favourite Order Set: To select from order set SMART forms identified as favourites. 
See “Order Sets” on page 317.
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The EMR opens the Send to SMART Form window with a list of SMART forms displayed in 
expandable categories. 

2. In the list of SMART forms, expand the category of forms you want to view, (if not expanded 
already), and click the form. The EMR displays the selected form on the right side of the 
window.

3. If you cannot find the form you want:

a) In the Filter field, enter a search term. (For example, “MRI”.) The EMR filters the list of 
SMART forms to display only SMART forms containing your search term.

b) In the filtered list of SMART forms, click the form you want. The EMR displays your 
selected form on the right side of the window.

Tips for entering search criteria

 To find a lab requisition, enter the word “Lab” 

 To find a diagnostic imaging requisitions, enter “DI” or “Imaging”.

 SMART forms are named by region (for example, “AB Cg”), or company/type 
(for example, “CDC”, or “MIC”). Try entering these terms to find a form specific 
to a certain region or company.
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4. If the SMART form is programmed to pull information from the patient's record, but the 
information is not available in the current patient's record, the EMR displays a dialog box 
similar to the following.

and then displays the SMART Form Data tab, where you can enter the missing data.

Enter the missing data in the fields provided, or, to produce the SMART form without the 
missing data, select the Allow Incomplete Data check box.

5. If the SMART form contains an electronic signature, the EMR displays a dialog box with a 
prompt similar to the following.

To insert your signature, click Yes.
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6. Click Send and Close ( ). The EMR opens the form in Microsoft Word. 

Changing the practitioner name on SMART forms

When you open a SMART form, the EMR populates the form with the name of the patient’s 
primary practitioner. However, if the patient’s appointment is not with their primary practitioner, 
you need to change the practitioner name that populates the SMART form. For example, if you 
are completing a Drivers Medical SMART form, and the patient’s primary practitioner is not 
seeing the patient, you can change the practitioner name on the SMART form. You change the 
practitioner name after you select the SMART form, but before you open the form by double-
clicking it or clicking Send and Close.

To change the practitioner name on SMART forms:

1. Find and click the SMART form you want to open. See Step 1  to Step 3  in “Opening 
SMART forms” on page 307.

2. In the right pane, click the SMART Form Data tab or the Requisition Data tab.

3. In the Provider drop-down list, click the practitioner with whom the patient has an 
appointment. 

4. Click Send and Close ( ). The EMR opens the SMART form with the selected 
practitioner populated.

Completing SMART forms

To complete a SMART form:
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1. Open the form. See “Opening SMART forms” on page 307. The EMR opens the SMART 
form in Microsoft Word, with editable check boxes and fields highlighted in grey. 

  

2. Select any check boxes you want, and enter text into fields highlighted in grey.

3. To save the form, click Save ( ), or press Ctrl + S. The EMR saves the completed 
SMART form in the Documents area of the patient’s Medical Summary.

4. To print or fax the form:

a) In the Microsoft Word menu, click File > Print. Microsoft Word displays the print 
properties window.

b) In the printer drop-down list, click the print or fax machine you want.

Note: You cannot edit text or other items on the form that are not highlighted in 
grey. For example, you cannot edit a patient’s address on the SMART form. You 
must edit the address in the Patient Maintenance window.
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c) Click Print ( ).

Referencing previously completed SMART forms
After you complete and save a SMART form, the EMR saves the SMART form in the patient’s 
chart. You can reference or reprint the form as needed.

To view a previously completed SMART form for a patient:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Documents tab. The EMR displays a complete list of all of a patient’s documents 
and SMART forms.

3. In the Search field, enter a word that you know is in the SMART form’s name, (for example, 
“lab”). The EMR filters the list to display only documents and SMART forms that contain the 
search term. 

4. In the filtered Documents list, double-click the form you want. The EMR opens the SMART 
form in Microsoft Word.

5. To print the form:

a) On the Microsoft Windows menu, click File > Print. Microsoft Word displays the print 
properties window.

Tip: At this point, you can add to or edit information in the SMART form if needed. 
If you save your changes, the previous version is overwritten in the patient’s 
Documents.

Note: If the practitioner has an eSignature on the form, the form is saved in the 
Documents tab as an un-editable PDF. You therefore cannot edit forms 
that contain eSignatures.
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b) In the printer drop-down list, click the print or fax machine you want.

a) Click Print ( ).

SMART form favourites

Wolf EMR contains hundreds of SMART forms. With so many forms, it can be difficult to find the 
form you want. To make common SMART forms easy to find, designate these SMART forms as 
favourites. Favourite SMART forms display at the top of your SMART forms list. You can also 
open favourite SMART forms using the Favourite Requisition option on the SMART menu. 

You can add SMART forms to or remove SMART forms from your favourite’s list when you open 
SMART forms for patients (via the Send to SMART form window).

To add a SMART form to or remove a SMART form from your favourites list:

1. Open the Send to SMART form window and then, in the left pane, click the form. See Step 
1  to Step 3 in “Opening SMART forms” on page 307.

2. At the top of the window, click one of the following options:

 Add to Favourites ( )

Note: If you remove a Clinic Favourite from your favourites list, the SMART form will 
still display on the favourites list of other users in the clinic.
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 Remove from Favourites ( )

Using your favourite SMART forms

To use a favourite SMART form:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, in the SMART menu, hover your cursor over 
Favourite Requisition. The EMR displays a list of your Favourite SMART forms.

Tip: You can also add and remove SMART form favourites without having to open 
a SMART form for a patient (via the Wolf EMR Maintenance):

1. On the Wolf EMR Launch page, click the Maintenance tab.

2. Click Configure My SMART Forms ( ). The EMR displays the Configure 
My SMART Forms window, with a list of available SMART forms displayed in the 
left column.

3. Click the form, and then click Add to Favourites ( ) or Remove from 

Favourites ( )
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2. Click the form that you want. The EMR opens the form in Microsoft Word.

3. Complete and print the form. See “Completing SMART forms” on page 310.

Hiding SMART forms
If there are forms in your clinic’s list of SMART forms that you know you will never use (for 
example, forms from another region), you can hide those forms from your list. In hiding these 
forms, it becomes easier to find forms that you do use.

To hide a SMART form:

1. On the Wolf EMR Launch page, click the Maintenance tab.

Tip: Your favourite SMART forms also display at the top of your SMART forms list 
in the Send to SMART Form window. 
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2. Click Configure My SMART Forms ( ). The EMR displays the Configure My SMART 
Forms window, with a list of available SMART forms displayed in the left column.

3. If your list of forms is extensive and you cannot find the form you want:

a) Click Filter Documents ( ). The EMR displays a Filter field above your SMART 
form list.

b) In the Filter field, enter a search term. (For example, “MRI”.) The EMR filters the SMART 
form list to display only SMART forms containing your search term.

4. In the filtered SMART forms list, click the form you want. The EMR previews the form in the 
right pane.

5. In the list of SMART forms, beside the SMART form you want to hide, clear the check box in 
the Enabled column.

6. When you are finished hiding SMART forms, click Close ( ).

Tip: If you later decide that you want the SMART form to display on your list of 
SMART forms, you can enable the SMART form by selecting the Enabled check 
box.
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Order Sets
If you fill out certain requisition forms with similar information for specific groups of patients (for 
example, you select the same core base of lab tests for most diabetic patients), you can create 
customized copies of these SMART forms with check-boxes and text fields pre-populated.

Also, if you commonly complete a set of requisition forms together, you can customize SMART 
forms to combine multiple requisition forms, enabling you to open all forms together in one click.

Customized versions of SMART forms are called Order Sets. You can create as many Order 
Sets as you want for one form. 

Order Sets display as “house forms” (with a house icon) in your list of SMART forms.  

When you open an Order Set SMART form for a patient, you can edit the pre-populated data as 
needed before printing and saving the form.

For more information on how to create an order set, see the Wolf EMR SMART Forms User 
Guide.

Using Order Sets

To use an order set:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, on the SMART menu, click one of the following 
options:

 New Requisition: To view only SMART forms categorized as requisition forms.

 SMART Forms: To view all available SMART forms in your system.

Note: House forms are forms that have been created or modified by your clinic. 
These forms are not maintained or updated by TELUS Health.
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 Favourite Order Sets: To view only order set SMART forms defined as favourites.

The EMR displays the Send to SMART Form Window with a list of available SMART forms 
displayed in the left column.

2. In the list of available SMART forms expand the Order Set folder, and then click the form 
you want. The EMR displays your selected form on the right side of the window.

3. Complete the SMART form. See “Completing SMART forms” on page 310. 

Printing patient labels
After you complete and print a requisition form, you can print a corresponding patient label for 
the accompanying lab sample or for the form itself.

You can print a patient label from the patient’s medical record (via the SMART menu), from the 
patient’s appointment, or from the Patient Maintenance window. See “Printing a patient label” on 
page 43.
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Chapter 8
Clinic communications and tasks
In this chapter you learn how to create and manage messages and tasks. Wolf EMR contains 
an intra-office communication feature similar to e-mail. Using this feature, you can:

 Create messages for yourself and other clinic users

 Create follow-up tasks for yourself and other clinic users

 Manage all of your tasks and messages from a centralized location on your WorkDesk

This chapter also covers how you can manage the following tasks from the Clinical Queues 
area on your WorkDesk: 

 Patients you need to notify for a follow-up appointment 

 Patient Rule Matches 

 Incomplete WCB Reports

 Charts you need to pull 

 Patients who are overdue for a PAP/Mammogram procedures outside of guidelines

 Clinical finding notifications

Creating messages

In Wolf EMR, you create messages primarily to:

 Inform users that they have received calls from patients, patient family members, external 
consultants (specialists), and so on.

 Notify clinic members of upcoming events (such as staff meetings), policy changes, and 
other non-patient related notifications.

You can create a message from your WorkDesk or from a patient’s record. You can create a 
message regarding a specific patient, or you can create a non-patient message.

Messages regarding patients are saved in patient records, both in the Communication tab of 
the Medical Summary, and in the encounter list. The SMART patient banner also displays a 
notification if a patient has any outstanding messages.
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Creating messages regarding patients

To create a message regarding a patient: (If a patient’s chart is not currently open)

1. Perform one of the following actions:

 If you have any window of the patient’s record open (for example, the Vital Entry window 
or the Medical Summary), right-click and then, on the SMART menu, click New 
Message.

 If you do not have the patient’s record open:

a)  On the WorkDesk, in the Messages area, click Enter New Message( ). The EMR 
displays a dialog box with the following prompt: “Patient Message? - SELECT YES, 
Intraoffice Message Not Related to a Patient - SELECT NO”

b)  Click Yes. The EMR displays the Patient Search window. 

c)  Search for and select the patient.

The EMR displays the New Message window with:

 The From field defaulted to Staff and your name selected in the Staff drop-down list.

 The Re field defaulted to Patient.

 The patient’s SMART Patient Banner displayed in the middle of the window..
320 Wolf Front End Staff User Guide - Issue 02.05



Clinic communications and tasks
  

2. In the To area, click the type of recipient you want to send the message to. The EMR 
displays a list of associated users and groups. 

Best practice: Always double check the SMART Patient Banner on the 
message to ensure that you selected the correct patient. Once a message is sent, 
it is permanently associated with the selected patient’s chart (you cannot delete it).

Tip: If you want to view detailed information about the patient, in the middle of the 
New Message window, click on the SMART patient banner. The EMR displays the 
patient’s Medical Summary.
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The following table describes the different user types available in the To list, and how they 
affect the user list you can choose from:

Recipient type Result

Physician All practitioners display.

You can send a message a specific practitioner or to All MD’s.

Note: If you send a message to All MD’s, only one message is 
created. After one of the recipients views and completes 
the message, it disappears from all other users' message 
lists.

Staff All MOAs, and other front end staff display.

You can send a message a specific staff member or to All 
Employees (all staff members).

Note: If you send a message to All Employees, only one 
message is created. After one of the recipients views and 
completes the message, it disappears from all other users' 
message lists.

Patient No user’s receive the message on their message list, so NO users 
display in the list to the right. Instead, the EMR attaches the message 
to the patient’s Medical Summary, and any user can reference and 
complete the message from there.

Tip: Use Patient as the recipient type when you are creating a 
message to document calls made to patients. See “Creating a 
message to document a call made to a patient” on page 328.

Note: Commonly used as “reminders” to perform tests or 
treatments on, or provide council to a patient during their 
next visit.
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3. In the list of users and groups, click the user(s) you want to send the message to.

4. To send the message on behalf of someone else:

a) In the From list, click the type of sender for the message. The EMR displays different 
fields, to the right of the From list, depending on your selection. 

b) In the field to the right of the From list, specify a name or facility. 

Group All messaging groups display.

If you send a message to a group, all users belonging to that group 
can view the message. By default, after one user completes the 
message, the message disappears from the message list of ALL 
group members. (For example, you send a message to all MOAs to 
perform a task, but you only require that one person actually 
completes the task.)

If you want each user in the group to view and complete the 
message individually, select the Resolve groups to individual 
addresses check box. (For example, there is a staff meeting this 
week and you want all clinic members to know.)

For information on how to use and create messaging groups 
(security groups), see Wolf EMR Online Help.

Multiple (AB 
and BC)

All practitioners and front end staff display. Click each user you want 
to send the message to.

Note: The message is sent to the selected users for each to view, 
and complete individually.

Multiple (NWT)) When you click this option, the EMR displays the following:

 Create a copy for each recipient check box (selected by 
default): The functionality of this check box is the same as that of 
the Resolve groups to individual addresses check box (when 
To: “Group” is selected): if this check box is not selected, then 
when any recipient marks the item as completed, it is marked as 
completed for all recipients.

 Address Book button: Use the Address Book to select the 
recipient(s) of the message. See “Using the Address Book (NWT 
only)” on page 326.

Recipient type Result
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The following table describes the From options, and case examples for each option.

Origin type Fields displayed Purpose and case example

Patient The EMR displays a Patient 
Search window.

Search for and select the 
patient.

Indicates that the recipient is to follow 
up with the patient directly.

Example: A patient wants more 
information on diabetic programs 
available in your city. You don’t have 
the information readily available now, 
so send you yourself a message to 
provide the information to the patient 
during their next visit.

Consultant The EMR displays a 
Consultant drop-down list. 

Search for and select a 
consultant’s name.

Indicates that the recipient is required 
to contact a consultant.

Example: A consultant’s office leaves 
you a phone message indicating that 
they require a patient’s diagnostic 
reports before they can book an 
appointment. You send a message to 
yourself as a reminder to fax the 
reports to the consultant’s office.

Family 
member

The EMR displays a Name 
and Phone text field.

Enter the family member’s 
name and phone number.

Indicates that the recipient is required 
to contact a patient’s family member.

Example: A practitioner sends you a 
message, requesting that you contact 
the daughter of one of their geriatric 
patient’s.

Clinic MD The EMR displays a Clinic 
MD drop-down list.

Select a practitioner’s name.

Indicates that a clinic practitioner is the 
message sender, and that any replies 
are to be made to that sender.

Staff The EMR displays a Staff 
drop-down list.

Select a front-end-staff 
member’s name.

Indicates that a front end staff member 
is the message sender, and that any 
replies are to be made to that sender.
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5. In the Re area, click one of the following options:

 Please Call Back

 Will Call Again

 For Your Information

6. In the Priority list, located below the Re line, click one of the following options:

 Routine: The EMR displays the message at the bottom of the recipient’s message list.

 Important: The EMR displays the message in the recipient’s message list in red, with an 
asterisk (*) in the first column, and lists the message above Routine messages in the list.

 Urgent: The EMR displays the message in the recipient’s message list in red, with an 
exclamation mark (!) in the first column, and lists the message at the top of the list.

7. In the Message field, enter the text of your message.

8.  If you have not performed any actions toward the completion of a task requested in the 
message, leave the Notes, and Response fields blank.

Other The EMR displays a Name 
and Phone text field.

Enter the person’s name or 
facility and phone number.

Indicates that the message recipient is 
to contact an individual or facility (that 
is not a consultant, or family member.)

Example: You send a message to 
yourself to follow up with a diagnostic 
imaging centre on the status of a 
report a practitioner is waiting for.

Note: If you select Urgent, the EMR displays an Urgent Message pop-up window 
on the WorkDesk of the recipient. The receiver must have the WorkDesk open in 
order to see the pop-up. This pop-up window re-appears about every 10 minutes 
for front end staff, and every 1 minute for practitioners, until the recipient completes 
the message.

Best practice: Mark a message as Urgent only if the recipient must address the 
message right away.

Note: The Notes and Response fields of the message are generally reserved for 
recipients to add notes on updates and actions they have done to complete a 
task. 

If you do complete actions toward the task, then you can input your actions in the 
Notes and Response fields. The recipient can see and add to these notes.

Origin type Fields displayed Purpose and case example
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9.  Click Save & Close ( ). 

Using the Address Book (NWT only)

When you create a message, you can use the Address Book to specify multiple message 
recipients.

To use the Address Book:

1. Start a message. See Step 1  in “Creating messages regarding patients” on page 320.

2. In the To field, click Multiple. The EMR displays the Create a copy for each recipient 
check box (selected by default), and the Address Book button.  

3. If you want the EMR to mark the message as completed for all recipients when any recipient 
marks the item as completed, clear the Create a copy for each recipient check box. 

Note: If the Create a copy for each recipient check box is selected, each 
recipient views and completes the message individually. 
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Click Address Book. The EMR displays the Address Book window with a list of all the 
active staff and practitioner users. 

4. (Optional) To search for a person, in the Search Name field, enter part of their name (first 
or last) or other information (for example, their specialty). As you enter the text, the EMR filters 
the list to display only matching recipients.

5. Specify the message recipients. Use any of the following methods:

 Click a person and press Enter. Repeat for each recipient.

 Double-click a person. Repeat for each recipient.

 To select more than one person, hold down the Control key, click each person and then 
press Enter.

 To select more than one person, click the first person, hold down the Shift key, click the 
last person and then press Enter.

6. To remove a person from the recipients list, perform one of the following actions in the To 
field: 

 Click a name and then, on your keyboard, press Delete or Backspace.

Tip: After you select your recipients, you can click To ( ) instead of 
pressing Enter.
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 Place your cursor to the right of the person’s name and then, on your keyboard, press 
Delete or Backspace.

7. When you finish adding recipients, click OK. The EMR closes the Address Book window.

8. Complete the message. See Step 4  to Step 9  in “Creating messages regarding patients” 
on page 320. 

9.  Click Yes.

Note: When you use the “To: Multiple” option and you clear the Create a copy for each 
recipient check box, the To column and field show the recipients of the message. 

Creating a message to document a call made to a patient

Since the EMR attaches messages regarding patients to their Medical Summary, you can 
create messages to document calls made to a patient (or any other tasks you completed for the 

Note: If the Create a copy for each recipient check box was selected, the EMR 
displays the following dialog box: 
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patient). You, and other users, can then refer to these completed tasks in the patient’s Medical 
Summary. 

When you create the message, ensure that you select Patient as the recipient type in the To 
field. After you document the call you made (or other tasks you completed), select the 
Completed check box in the Response area of the message. 

To create a message to document a call made to a patient:

1. Start a message. See Step 1  in “Creating messages regarding patients” on page 320.

2. In the list of recipient types in the To field, click Patient.

3. In the Message, Notes and Response areas document the call you made or other tasks 
you completed for the patient.

4. In the Response area, select the Completed check box.

5. Click Save & Close ( ) to save the message to the patient’s Medical Summary.

Creating a message that is not associated with a patient

To send a message that is not associated to a patient:

1. In the Messages area of your WorkDesk, click Enter New Message ( ). The EMR 
displays a dialog box with the following prompt: “Patient Message? - SELECT YES. 
Intraoffice Message Not Related to a Patient - SELECT NO”

2. Click No. The EMR displays the New Message window, with:

 The From field defaulted to Staff and your name in the Staff drop-down list.

 The Re field defaulted to Other.

 For Your Information, selected on the Re line.

Tip: You can easily reference messages that document completed tasks in the 
patient’s Medical Summary under the:

 Current Hx tab, in the Encounters list 

 Communication tab, in the Messages list
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3. In the To area, click the type of recipient you want to send the message to. The EMR 
displays a list of associated users and user groups. 

4. Click the user(s) you want to send the message to. For more information, see the table in 
Step 3  of “Creating messages regarding patients” on page 320. This table describes the 
different user types available in the To list, and how they affect the user list you can choose 
from. 

5. To send the message on behalf of someone else:

a) In the From list, click the type of sender for the message. The EMR displays different 
fields, to the right of the From list, depending on your selection. 

b) In the field to the right of the From list, select or enter a name or facility. 

6. In the Re field, leave Other selected.

7. Complete the message as you would for a patient-related message. See Step 5  to Step 9  
in “Creating messages regarding patients” on page 320.
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Creating follow-up tasks
Follow-up tasks are similar to messages in how they are created and used, however, they are 
created primarily to:

 Instruct or remind a staff member or practitioner to call a patient or schedule a return 
appointment (recall).

 Serve as a reminder in a patient’s record for a practitioner to talk to the patient about a 
particular test result, treatment option, life style advice, or any other matter pertaining to 
the patient’s health.

To create a follow-up task:

1. Perform one of the following actions:

 If you have any window of the patient’s record open (for example, the Vital Entry window 
or the Medical Summary), right-click and then, on the SMART menu, click New Follow-
up.

 If you do not have the patient’s record open:

a)  On the WorkDesk, in the Follow Up Tasks area, click Enter New Follow-up ( ). 
The EMR displays a dialog box with the following prompt: “Patient Follow Up?”

b)  Click Yes. The EMR displays the Patient Search window. 

c)  Search for and select the patient.

Note: Because follow-up tasks serve such a specific function, they have fewer 
options than Messages do. For example:

 You cannot send follow-up tasks to several users at once to complete 
individually. You can send a follow-up task only to a single user or security 
group. As soon as one member of the recipient group views and completes the 
task, the task disappears from the follow-up list of all group members.

 Follow-up tasks have fewer From options, than messages do. You cannot 
indicate that the message is originating from a patient, family member, 
consultant, or any other external source (unless you directly write it in the 
Follow-up Reason field.)
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The EMR displays the Follow-ups window.

The Follow-ups window displays:

 The patient’s SMART patient banner.

 The From option defaulted to Non-Practitioner and your name selected in the drop-
down list.

 The patient’s next booked appointment date/time displayed beside Next Appt.

Note: You can also start a follow-up from a message. At the top of the Message 

window, click Create New Follow Up Based on Message ( ).

Use case: A practitioner sends you a message to contact a patient regarding an 
abnormal lab result. You call the patient, but you discover that the patient has gone 
overseas for three months. On the message, you click Create New Follow Up 

Based on Message ( ) to create a follow-up task. You delay the due date of 
the task to three months from today.

Best practice: Always double check the SMART patient banner on the follow-up 
task to ensure that you selected the correct patient. Once a follow-up task is 
saved, it is permanently associated with the selected patient’s chart (you cannot 
delete it.)
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2. In the To area, click the type of recipient you want to send the follow-up task to. The EMR 
displays a list of associated users or groups. 

3. Click the user or group you want to send the follow-up to.

4. The following table describes the user types available in the To list, and how they affect the 
user list you can choose from:

Tip: If you want to view detailed information about the patient, at the top of the 
Follow-ups window, click the SMART patient banner. The EMR displays the 
patient’s Medical Summary.

Recipient type Result

Practitioner All practitioners display.

Note: You can only select one practitioner.
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5. To send the follow-up on behalf of someone else:

a) Select one of the following options:

  Practitioner: If the sender is a practitioner. 

  Non-practitioner: If the sender is an MOA or other front end staff member.

b) In the drop-down list, select the sender.

6. In the Priority list, click one of the following options:

 Routine: The EMR displays the follow-up at the bottom of the recipient’s follow-up list.

 Urgent: The EMR displays the follow-up in the recipient’s message list in red, with an 
exclamation mark (!) in the first column, and lists the follow-up at the top of the list. 

7. In the Follow-up Reason area, enter the problem and reason for the follow-up.

8. If the due date is a day other than today:

a) In the first Select Follow-up Date field, enter the number of days, weeks, months, or 
years when the follow-up is due.

b) In the Select Follow-up Date drop-down list, select either: days, weeks, months, or 
years. The EMR displays the calculated date, based on the Select Follow-up Date 
fields, in the Date for Follow-up field.

Staff All MOA’s, and other front end staff display.

Note: You can only select one front-end staff 
member.

Group All security groups, programed into your system.

Note: Sending a follow-up to a group

If you send a follow-up to a group, all users belonging to that group can view the 
follow-up, however, once the message is completed by one user, the follow-up 
disappears from the follow-up list of ALL group members. 

If you want each user in the group to view and complete the task individually, then 
create a message instead. See “Creating messages” on page 319.

Best practice: Mark a follow-up as Urgent only if the recipient must address the 
follow-up right away.

Note: You can edit the Date for Follow-up field. Click Calendar ( ) and then 
click the date you want.

Recipient type Result
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9. In the Notes area, enter notes regarding actions you have taken toward completing the 
follow-up task. For example, “Informed patient during their visit that I will contact them to 
book an appointment if results are abnormal”.

10. Click Save & Close ( ). The follow-up displays in the recipient’s Follow-up List.

To Come In tasks
A To Come In task (also known as a Recall list) is a special type of follow-up task that 
practitioners can use to order a patient to come in for a visit. 

Two actions occur when a To Come In task is created:

 You (MOA/Front end staff) receive a notification to contact the patient to book an 
appointment. The notification appears as a task in your patients to notify list in the 
Clinical Queues area of your WorkDesk. See “Managing your Patients To Notify list” on 
page 360.

 The practitioner receives a follow-up task, reminding them which topics to discuss with, 
or actions to perform on the patient when they come in for the follow-up visit. 

As an MOA/Front end staff EMR user, you can create a To Come In type of follow-up task to 
accomplish the following two actions:

 Add patients to your Patients To Notify list, as a reminder to yourself to book the 
appointment. 

 Create a follow-up task to remind the patient's practitioner to talk to the patient about a 
particular result, advice, or treatment options.

Some common instances that you can use To Come In tasks for, include:

 Following up with a patient on an investigation result.

 Following up with a patient on an over-due preventive care text. For example, an overdue 
pap smear, mammogram, or colonoscopy.

Creating To Come In tasks 

To add a patient to your Patients To Notify list, and to create a practitioner follow-up:

1. Start a follow-up task. See Step 1 in “Creating follow-up tasks” on page 331.

2. In the To field, click Practitioner, and then click the practitioner’s name in the list to the right.

Note: The Follow Up Task also displays in the patient's SMART patient banner to 
remind the practitioner of topics to discuss or actions to perform.
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3. Select the priority, reason, and due date for the follow-up. See Step 6  to Step 8  in 
“Creating follow-up tasks” on page 331. 

4. In the Follow-up Type list, on the right side of the follow-ups window, click Patient TCI for 
Follow Up. The EMR displays additional fields in the bottom right of the window.

5. In the Notes area, enter notes on actions you have taken toward completing the follow-up 
task.

6. Below the Notes area, click either Routine or Urgent as the priority. The selection defaults 
to the priority you set for the follow-up. The EMR displays the selected priority in your 
Patients To Notify list with the TCI task.

7. In the Note area, enter notes on any actions you have already taken toward completing the 
patient to notify task. 

Note: Enter a due date only if the follow-up is not due today.
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8. Click Save & Close ( ). The follow-up displays in the following locations:

 On your WorkDesk in the patients to notify list, as a notification to contact the patient to 
book the appointment

 In the practitioner’s Current Follow-up Tasks list

 On the Notification bar of the patient’s Medical Summary, as a reminder to the practitioner 
to address the follow-up item with the patient during their appointment.

Managing your messages and follow-up tasks
You manage your messages and follow-up tasks from your WorkDesk. From here, you can:

 View your active and completed messages and follow-up tasks.

 Update or modify your messages and follow-up tasks.

 Complete your messages and follow-up tasks.

 Redirect your messages and follow-up tasks to other users.

Viewing your messages

You can view your messages from a list ordered by due date and priority. You can also reorder 
your list of messages by patient, sender, and receiver.

If your list of messages is extensive, and you want to minimize your list to only display specific 
types of messages, you can filter your list of messages, by sender, urgency, topic, and so on.

To view your messages:

1. On your WorkDesk, locate the Messages area. Your messages are listed chronologically in 
the following order:

 Top: Urgent messages displayed in red, with an exclamation mark (!) in the first column.

 Middle: Important messages displayed in red, with an asterisk (*) in the fist column.

 Bottom: Routine messages.
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2. In the Messages list, double-click a message. The EMR displays the Message List 
window, with the selected message displayed on the right, and your full list of messages 
displayed on the left. 

3. To re-order your message list, click a column header. The EMR re-orders the list 
alphabetically or chronologically based on the column selected.
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4. To address specific groups of messages at once, filter the messages list to display only the 
messages you want to address. At the top of the Message List window, click Show Filters 

( ). The EMR displays filtering options on the left side of the window.

The following table describes your message filter options:

Filter How to use

Type Select one of the following options:

 Sent: The EMR displays only active messages that you originally 
sent.

 Received: The EMR displays only active messages you received.

 Currently Mine: The EMR displays only active messages that are 
currently assigned to you.

Message Date In the To field, enter a due date (using the format: DD-MMM-YYYY 
H:MM). The EMR displays only messages with due dates earlier than, 
or on the date entered.
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Status In the Status drop-down list, click one of the following options:

 <<All>>: The EMR displays all of your current and historic 
messages.

 Pending: The EMR displays all of your active messages 
(messages not yet marked as complete.)

 Complete: The EMR displays all of your historic messages 
(messages that have been marked as complete.)

Urgency In the Urgency drop-down list, click one of the following options:

 <<All>>: The EMR displays messages with any priority level 
assigned.

 Urgent: The EMR only displays messages with a priority level of 
Urgent.

 Important: The EMR only displays messages with a priority level of 
Important.

 Routine: The EMR only displays messages with a priority level of 
Routine.

From In the From area, select the sender type. The EMR displays only 
messages that have the same sender type defined in their From area. 

The EMR also displays different drop-down lists and input fields to the 
right of the From sender type options, depending on your selection. 
Select and input information into these fields to filter the list even 
further.

Re In the Re area, select one of the following options:

 Patient: The EMR only displays messages regarding a patient.

 Inter office: The EMR only displays messages that do not regard 
a patient.

 Both: The EMR displays both patient and non-patient related 
messages.

To In the To area, select the receiver type. The EMR displays only 
messages that have the save receiver type defined in their To area.

The EMR also displays different drop-down lists and input fields to the 
right of the To receiver type options, depending on your selection. 
Select and input information into these fields to filter the list even 
further. 

Filter How to use
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5. In the filtered message list, click a message. The EMR displays the selected message on 
the right. The message list remains filtered as you select each message. 

6. When you finish viewing your messages, click Save & Close ( ).

Updating or modifying your messages

If you complete some action toward a message, but do not fully complete the task, you can 
update the message to document the actions you take.

Also, if you do not have enough time to address a message, or receive a message that does 
not pertain to you, you can redirect the message to another clinic user.

To update a message:

1. In the Messages area on your Workdesk, double-click the message you want to update. 
The EMR opens the Message List window with the message displayed on the right.

2. In the Notes area, enter the steps you have taken toward completing the task.

Include 
Messages for 
Groups

To view messages that were sent to messaging groups in which you 
are a member of, select the Include Messages for Groups check 
box.

To only view messages that were sent to you directly (not through 
message groups), clear the Include Messages for Groups check 
box.

Show Signed Out To view messages that belong to an absent MOA/Front Desk user 
who you covering for, select the Show Signed Out check box.

Message or 
Notes contain 
text

To view only messages that contain specific text in either the 
Message or Notes area:

 In the Message or Notes Contain Text field, enter a search term.

 In the drop-down list to the right of the text field, click an option 
describing how closely the search term must match the actual 
message text.

Tip: You can specify multiple message list filter criteria simultaneously.

Note: Once you filter the message list, the list remains filtered until you either:

 Change the filter criteria.

 Close the Message List window.

Filter How to use
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3. To indicate that you have called a patient, but did not talk to the patient directly, click one of 
the following options:

 Message Left: The EMR displays the text “Message Left: [your name](current date and 
time)” in the Log area.

 No Answer: The EMR displays the text “No Answer: [your name](current date and time)” 
in the Log area.

4. In the Log area, edit or enter text as necessary, to indicate your actions taken toward 
completing the task.

5. Perform one of the following actions:

 If you are finished updating the message, click Save & Close ( ). The EMR saves 
your changes to the message and the message remains in your Messages list.

 If you want to send the message to another user to complete, follow the steps below:

a) At the bottom of the message, click Redirect. The EMR displays the Redirecting Patient 
Message window.

b) In the To field, click the user or group you want to redirect the message to.

c) In the Notes area, enter any additional notes or instructions to the receiver.

d) Click Save & Close ( ). The EMR removes the message from your Current 
Messages list, and adds the message to the receiver’s Current Messages list.

Completing your messages

To complete a message:

1. In the Messages area on your Workdesk, double-click the message you want to complete. 
The EMR opens the Message List window with the message displayed on the right.

2. In the Notes area, enter any notes on the steps you have taken toward completing the task.

3. Click Completed ( ). If the message is a group-addressed message, the 
EMR displays a dialog box with the following prompt: “Completing this Message will cause 
the message to NOT display for other recipients of this message. Do you still want to 
Complete this message?.”

4. To complete the message, click Yes. The EMR removes the message from your Current 
Messages list. The EMR also removes the message from the Messages list of all group 
members if the message was addressed to a group (without the Resolve groups to 
individual Addressees check box selected).
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Viewing your follow-up tasks

Similar to messages, you can view your follow-up tasks from a list ordered by due date and 
priority. You can also reorder your list of follow-up tasks by patient, sender, and receiver.

If your list of follow-up tasks is extensive, and you want to minimize your list to only display 
specific types of follow-up tasks, you can filter your list of follow-up tasks, by sender, urgency, 
topic, and so on.

To view your follow-up tasks:

1. On your WorkDesk, locate the Follow Up Tasks area. Your follow-up tasks are listed 
chronologically in the following order:

 Top: Urgent messages displayed in red, with an exclamation mark (!) in the first column.

 Bottom: Routine messages displayed in blue.
Wolf Front End Staff User Guide - Issue 02.05 343



Clinic communications and tasks
2. To view detailed information about a follow-up task, double-click a follow-up task. The EMR 
displays the Follow-up List window, with the selected follow-up displayed on the right, and 
your full list of follow-ups displayed on the left.

3. To re-order your Follow-up List, click a column header. The EMR re-orders the list 
alphabetically or chronologically based on the column selected.

4. To address groups of follow-up tasks at once, you can search for and view only specific 
types of follow-ups at a time. At the top of the Follow-ups window, click Show Filters 

( ). The EMR displays filtering options on the left side of the window.

Note: If the selected follow-up originates from a To Come In task, then the EMR 
displays additional fields and check boxes. These fields and check boxes are 
directly linked to the Patients to Notify task on the front end staff’s WorkDesk. 
Any notes and selections you make here reflect on the Patients to Notify list. 

The additional fields for a To Come In task are:

 Response log

 Note (for the TCI)

 Patient Notified check-box

 Cancelled check-box
344 Wolf Front End Staff User Guide - Issue 02.05



Clinic communications and tasks
The following table describes your Follow-up List filter options:

Filter How to use

Type Select one of the following options:

 Sent: The EMR displays only active follow-up tasks that you 
originally sent.

 Received: The EMR displays only active follow-up tasks that you 
have received.

 Currently Mine: The EMR displays only active follow-up tasks 
that are currently assigned to you.
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Follow Up Date In the Type area, select Received or Sent. 
(This enables the To field. The EMR also displays the From field.) 

In the To field, enter a due date (using the format: DD-MMM-YYYY 
H:MM). The EMR displays only follow-up tasks with due dates earlier 
than, or on the date entered.

To view follow-up tasks within a range of dates: In the From field, 
enter the start of the date range. In the To field, enter the end of the 
date range.

From In the From area, select the sender type. The EMR displays only 
follow-up tasks that have the same sender type defined in their From 
area. 

The EMR also displays different drop-down lists and input fields to 
the right of the From sender type options, depending on your 
selection. Select and input information into these fields to filter the list 
even further.

To In the To area, select the receiver type. The EMR displays only follow-
up tasks that have the save receiver type defined in their To area.

The EMR also displays different drop-down lists and input fields to 
the right of the To receiver type options, depending on your 
selection. Select and input information into these fields to filter the list 
even further. 

Include Follow 
Ups for Groups

To view follow-up tasks that were sent to groups in which you are a 
member of, select the Include Follow Ups for Groups check box.

To only view follow-up tasks that were sent to you directly (not to 
groups), clear the Include Follow Ups for Groups check box.

Show Signed 
Out

To view follow-up tasks that are currently being viewed by and are 
signed out by other users, select the Show Signed Out check box.

Note: You can view, but cannot complete, follow-up tasks that are 
currently signed-out by other users.

Tip: You can specify multiple Follow-up List filter criteria simultaneously.

Filter How to use
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5. In the filtered Follow-up List, click a follow-up. The EMR displays the selected follow-up on 
the right. The Follow-up List remains filtered as you select each follow-up. 

6. When you finish viewing your follow-up tasks, click Save & Close ( ).

Updating or modifying your follow-up tasks

If you complete some action toward a follow-up tasks, but do not fully complete the task, you 
can update the follow-up task to document the actions you take.

Also, if you do not have enough time to address a follow-up task, or receive a follow-up task 
that does not pertain to you, you can redirect the follow-up task to another clinic user.

To update a follow-up task:

1. In the Follow Up Tasks area on your Workdesk, double-click the follow-up you want to 
update. The EMR opens the Follow-up List window with the follow-up displayed on the right.

2. In the Notes area, enter the steps you have taken toward completing the task.

3. Perform one of the following actions: 

 If you are finished updating the follow-up, click Save & Close ( ). The EMR saves 
your changes to the follow-up and the follow-up remains in your Follow Up Tasks list.

 If you want to assign the follow-up task to another user to complete, follow the steps 
below:

a) At the bottom of the follow-up, click Redirect. The EMR displays the Redirect Patient 
Follow-up window.

b) In the To area, click the user, or group, you want to redirect the message to.

c) In the Notes area, enter any additional notes or instructions to the receiver.

d) Click Save & Close ( ). The EMR removes the follow-up from your Follow Up 
Tasks list, and adds the follow-up to the receiver’s Follow-up List.

Completing your follow-up tasks

To complete your follow-up tasks:

Note: Once you filter the Follow-up List, it remains filtered until you either:

 Change the filter criteria.

 Close the Follow-up List window.
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1. In the Follow Up Tasks area on your Workdesk, double-click the follow-up you want to 
complete. The EMR opens the Follow-up List window with the follow-up displayed on the 
right.

2. In the Notes area, enter the steps you have taken toward completing the task (optional.)

3. Select the Patient Notified check box (if not selected already.)

4. Click Completed. If the follow-up is a group-addressed follow-up, the EMR displays a 
dialog box with the following prompt: “Completing this task will cause the task to NOT 
display for other recipients of this task. Do you still want to Complete this task?.”

5. Click Yes. The EMR removes the task from your Follow Up Tasks list. The EMR also 
removes the message from the Follow-Up List of all group members if the task was 
assigned to a group (without the Resolve groups to individual Addressees check box 
selected).

Managing messages and follow-up tasks for a specific patient
You can view at-a-glance if a patient has any outstanding active messages or follow-up tasks.

You can also view a patient’s historic messages and follow-up tasks if you need to reference 
them during a visit. If you happen to find that one of a patient’s messages or follow-up tasks are 
marked as complete, but should not be, then you can reactivate the message. 

Viewing a patient’s active messages and follow-ups

From a patient’s Medical Summary, you can see at-a-glance if they have any active messages 
or follow-up items. You can then view, update, and complete a patient’s messages and follow-
up tasks from the Medical Summary.

To view a patient’s active messages and follow-ups:

1. Open the patient’s Medical Summary window. See “Opening a patient’s Medical Summary” 
on page 163.

2. To view active messages pertaining to a particular patient:

a) On the Notification bar, below the SMART Patient Banner, click # Message(s) ( ) 
(where # = the number of active messages for the patient). The EMR displays the 

Note: A patient remains on the Front end staff’s Patients to Notify list, until the 
Patient Notified check box is selected. If you have followed up with a patient on 
a follow-up item, than there is no need for the patient to remain on the Patients to 
Notify list. For this reason, always select the check box if it is not already selected.
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Messages For: [Patient name} window, with a list of the patient’s current (active) 
messages on the left side of the window.

b) If the patient’s list of active messages is extensive, and you want to search for a specific 
message or group of messages, click Show Filters. The EMR displays filter options 
above the list of messages.

c) To view a specific message, in the patient’s Current Messages list, click a message. The 
EMR displays the message details on the right side of the window.

d) To update or modify a message, follow Step 2  to Step 5  in “Updating or modifying your 
messages” on page 341.

e) To complete a message, follow Step 2  to Step 4  in “Completing your messages” on 
page 342.

f) Click Save & Close ( ) when you are finished.

3. To view active follow-ups pertaining to a specific patient:

a) Below the SMART Patient Banner, on the Notification bar, click # Follow Up(s) ( ) 
(where # = the number of active follow-up tasks pertaining to the patient). The EMR 
displays the Follow-ups for: [Patient name} window, with a list of the patient’s current 
(active) follow-ups on the left side of the window.

b) If the patient’s list of active follow-up tasks is extensive, and you want to search for a 
specific follow-up task or group of follow-up tasks, click Show Filters. The EMR displays 
filter options above the list of follow-up tasks.

c) To view a specific follow-up task, in the patient’s Follow-ups list, click a follow-up task. 
The EMR displays the follow-up task details on the right side of the window.

d) To update or modify a follow-up task, follow Step 2  to Step 3  in “Updating or modifying 
your follow-up tasks” on page 347.

e) To complete a follow-up task, follow Step 2  to Step 5  in “Completing your follow-up 
tasks” on page 347.

Note: The filters available are the same as the filters available when you are 
viewing your full list of active messages. For tips on how to use the various list 
filters, see “Viewing your messages” on page 337.

Note: The filters available are the same as the filters available when you are 
viewing your full list of active follow-up tasks. For tips on how to use the various list 
filters, see “Viewing your follow-up tasks” on page 343.
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a) Click Save & Close ( ) when you are finished.

Viewing a patient’s historic messages and follow-ups

To view a patient’s historic messages and follow-ups:

1. Open the patient’s Medical Summary window. “Opening a patient’s Medical Summary” on 
page 163

2. Click the Communications tab. The EMR displays a list of both active (incomplete) and 
historic (completed) messages and follow-up tasks pertaining to the patient. 

3. To view detailed information about a patient’s message:

a) In the Messages list, double-click a message. The EMR displays the Messages For 
[Patient name} window, with the message open on the right and a full list of the patient’s 
messages on the left.

b) If the patient’s list of messages is extensive, and you want to search for a specific 
message or group of messages, click Show Filters. The EMR displays filter options 
above the list of messages.

c) Click Save & Close ( ) when you are finished

4. To view detailed information about a follow-up task:

a) In the Follow Ups list, double-click a follow-up. The EMR displays the Follow-ups for 
<Patient name> window, with the selected follow-up displayed on the right and a full list 
of the patient’s follow-ups on the left.

b) If the patient’s list of follow-up tasks is extensive, and you want to search for a specific 
follow-up task or group of follow-up tasks, click Show Filters. The EMR displays filter 
options above the list of follow-ups.

Note: 

 A C beside the date indicates the message or follow-up task is complete.

 An I beside the date indicates the message or follow-up task is incomplete.

Note: The filters available are the same as the filters available when you are 
viewing your full list of active messages. For tips on how to use the various list 
filters, see “Viewing your messages” on page 337.

Note: The filters available are the same as the filters available when you are 
viewing your full list of active follow-ups. For tips on how to use the various list 
filters, see “Viewing your follow-up tasks” on page 343.
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c) Click Save & Close ( ) when you are finished

Reactivating completed messages and follow-up tasks

To reactivate a completed message or follow-up for a patient:

1. Open the patient’s Medical Summary window. “Opening a patient’s Medical Summary” on 
page 163

2. Click the Communications tab. The EMR displays a list of both active (incomplete) and 
completed messages and follow-up tasks pertaining to the patient. 

3. In the Messages, or Follow Ups list, double-click the completed task you want to 
reactivate. The EMR displays either the Messages for [Patient name} window, or the Follow-
ups for [Patient name} window, with the selected message or follow-up task displayed on 
the right.

4. If you are reactivating a message, clear the Completed check box. The EMR enables an 
option for Redirect.

5. Click Redirect. The EMR displays a new message or follow-up task window with the task 
details duplicated from the original message or follow-up task.

6. In the To area, click either the user or group you want the message or task to be assigned 
to.

7. Edit or add information to any of the message or follow-up fields.

8. Click Save & Close ( ) when you are finished. 

Communicating with patients via the Patient Portal
If your clinic is set up for Patient Portal messaging, you can:

 Send messages to patients

 Delete messages that were sent to patients

Note: 

 A C beside the date indicates the message or follow-up task is complete.

 An I beside the date indicates the message or follow-up task is incomplete.

Note: You can select your own name as a message or task recipient.
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 Track if patients have viewed their messages

 Receive messages from patients (if practitioners redirect Patient Portal messages to you)

Sending messages to patients

Any clinic user can send a message to a patient via the Patient Portal. When you send a 
message to a patient, you are indicated as the sender. You cannot send a message on behalf 
of another user. You send messages to patients using the same messaging system you use to 
send messages to clinic members in Wolf EMR. 

When patients receive a Patient Portal message, they are notified by e-mail. Patients can then 
log into the Patient Portal to view their message(s).

To send a message to a patient via the Patient Portal:

1. Open any window of the patient's chart (for example, the Medical Summary, or Vital Entry 

window). If the patient is a Patient Portal user, the EMR displays a Patient Portal icon ( ) in 
the SMART Patient Banner.

2. Right-click and then, in the SMART menu, click New Message. The EMR displays the New 
Message For: <patient name> window.
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3. In the To area, click Patient. The EMR displays options for publishing the message to the 
Patient Portal. 

4. Select the Publish to Portal check box. The EMR selects your name in the From area and 
changes the From area to be unavailable for editing.

5. In the Regarding field, enter the reason or subject for the message.

6. In the Message area, enter the message body.

7. Click Close & Save Message ( ). The EMR sends an e-mail to the patient indicating 
that a message is available in the Patient Portal. The patient can log into the Patient Portal to 
view the message. See “Viewing messages from patients” on page 355.

Note: If the Patient Portal messaging options do not display, the patient is likely not 

set up as a Patient Portal user. Ensure the Patient Portal icon ( ) is displayed in 
the SMART patient banner.

Note: You cannot send messages on behalf of someone else.
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Verifying that a patient has viewed a message

To verify that a patient has viewed their message:

1. Open the message: 

a) Open the patient's Medical Summary.

b) Click the Communications tab. The EMR displays a list of the patient's completed and 
outstanding messages in the left pane.

c) Double-click the message. The EMR displays the Patient Message for <patient name> 
window, with the selected message's details displayed in the right pane.

2. In the Log area of the message, scroll down to view information on:

 When the message was sent and who sent the message

 The date and time that the message was opened 

Note: All Patient Portal messages are marked as complete as soon as they are 
sent to a patient (as indicated by a C to the left of the message).
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Removing a message from the Patient Portal

If you send a message in error (for example, if you send a message to the wrong member of a 
family), you can remove the message from the Patient Portal.

To remove a message from the Patient Portal:

1. Open the message: 

a) Open the patient's Medical Summary.

b) Click the Communications tab. The EMR displays a list of the patient's completed and 
outstanding messages in the left pane.

c) Double-click the message. The EMR displays the Patient Message for <patient name> 
window, with the selected message's details displayed in the right pane.

2. At the bottom of the message detail area, clear the Publish to Portal check box.

3. Click Close Form ( ).

Viewing messages from patients

At this time, only practitioners can receive Patient Portal messages from patients. When they 
receive a Patient Portal message, the message displays in their Wolf EMR messages list. 

Note: All Patient Portal messages are marked as complete as soon as they are 
sent to a patient (as indicated by a C to the left of the message).
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If the practitioner does not want to manage messages originating from the Patient Portal, they 
can redirect patient portal messages to you.

To view Patient Portal messages that were redirected from a practitioner:

1. Open your outstanding Wolf EMR messages: Open the WorkDesk, and then on the blue 
banner (located at the top of the window), click # Current Messages (where # = the 
number of your outstanding messages). The EMR displays the Message List window.

2. In your list of outstanding messages, click a message that contains a patient name in the 
From column. The EMR displays:

 The message title: Patient Message for <patient name> at the top of the window

 The message contents in the right pane

 Patient Portal" beside Entered by:

3. Perform one of the following actions:

 To redirect the message to another staff member, click ReDirect.

 To mark the message as viewed and to remove the message from your list of 
outstanding messages, click Completed.

Note: If you want to send a reply to the patient, you cannot reply directly from the 
message. Instead, you must compose a new message to the patient. See 
“Sending messages to patients” on page 352.
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Covering absent staff members’ messages and tasks
In the case that you, or another staff member is absent from the clinic (for example, for vacation 
or leave) you and other staff members can easily cover the messages and tasks for the absent 
person using the Sign Out feature. If you sign out another user, you automatically receive the 
users:

 Messages

 Follow-up tasks

 Electronic lab results notifications

 Electronic documents notifications 

Setting up coverage for users

You can Sign Out, or “cover-for”, another staff member for a defined period of time, and vice 
versa. Once set up, coverage starts and ends automatically. 

To set up coverage for a staff member:

1. On the WorkDesk menu, click Sign Out > Sign Out. The EMR displays the SignOut 
window.

2. Under Sign Out Type, leave Non-Practitioner selected.

3. In the User List, click the user to be covered (the user who will be absent).

4. In the Sign Out To list, click the user who will receive the absent user’s messages and 
tasks.
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5. In the Coverage Starts area, click Open Calendar ( ). The EMR displays a calendar.

6. On the Calendar, enter a coverage start time in the HR, MIN, and AM/PM fields.

7. Double-click the date that the coverage is to start (the first day that the user will be absent.) 
The EMR populates the selected date and time into the Coverage Starts field.

8. In the Coverage Ends area, click either:

 Open ended: The EMR forwards the absent user’s messages to the covering user until 
you manually end the coverage.

 Until end of day: The EMR forwards the absent user’s messages to the covering user 
until the end of the Coverage Starts date.

 24 hours: The EMR forwards the absent user’s messages to the covering user for 24 
hours after the Coverage Starts date and time.

 Open Calendar ( ): The EMR displays a calendar. On the Calendar, enter a coverage 
start time in the HR, MIN, and AM/PM fields. Double-click the date that the coverage is 
to start (the first day that the user will be absent.) The EMR populates the selected date 
and time into the Coverage Ends field.

9. In the Notes field, enter any notes regarding the coverage.

10. Click Save & Close ( ). 

Identifying coverage status of staff members 

If you are a Signed out staff member, or are a staff member who has signed out another staff 
member, you can see a notification on your WorkDesk during the time that the coverage is 
active.

To identify if you are either signed-out or have signed out another staff member:

1. In the blue banner on the top of your WorkDesk, identify if either the follow text displays:

 “[staff member} is signed out to you until...”: Indicates that you currently have another 
staff member signed out (you are covering for another staff member.)

 “Currently signed out to [staff member name] until...”: Indicates that you are signed out by 
another staff member.
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 “You are covering multiple persons”: Indicates that you are covering for more than one 
staff member. 

Signing in

If someone else is covering for you, you can sign in to end that coverage. After you sign in, the 
person covering for you no longer receives your messages and tasks. Also, the EMR removes 
the notification from their WorkDesk indicating that they are covering for you. 

To sign in:

1. On the WorkDesk menu, click Sign Out > Sign In. The EMR displays a dialog box asking 
“Do you want to Sign In?”.

2. Click Yes.

Managing your Clinical Queues
Your WorkDesk is the communication centre between practitioners, and staff members. Not 
only can you view all of your messages and follow-up tasks from your WorkDesk, but you can 
also manage other tasks such as patient's to notify and charts to pull.

You can manage the following tasks from the Clinical Queues area on your WorkDesk:

 Patients you need to notify for a follow-up appointment or referral

 Patient Rule Matches 

 Incomplete WCB Reports

 Charts you need to pull 

 Patients who are overdue for a PAP/Mammogram procedures outside of guidelines 

Tip: If you are covering for multiple users and want to view which users you are 
covering for:

 On the WorkDesk menu, click Sign Out > Sign Out History

Tip: If you want to stop covering for another user, you can delete the coverage:

 On the WorkDesk menu, click Sign Out > Sign Out History. Click the line that 

indicates the coverage, and then click Delete Coverage ( ).

Tip: Coverage ends automatically if a Coverage End date is defined. However, if 
you return earlier than the Coverage End date, or the Coverage End date is 
open-ended, you can sign in to receive your messages and tasks.
Wolf Front End Staff User Guide - Issue 02.05 359



Clinic communications and tasks
 Clinical finding notifications 

The following sections describe how to manage these tasks from the Clinical Queues area on 
your WorkDesk. 

Managing your Patients To Notify list

Your Patients To Notify list contains a list of patients who you need to notify for a follow-up 
appointment or a referral. The Patients To Notify list includes patients with:

 To Come in (TCI) follow-ups

 Referrals with appointment dates

To view and manage your Patients To Notify list:

1. On your WorkDesk, in the Clinical Queues area, click <#> patients to notify (where # = 
the number of patients to notify for follow-up appointments). The EMR displays the Patients 
To Notify window.

2. To view only a particular practitioner’s patients, in the Practitioner drop-down list, click the 
practitioner’s name.

3. In the Type drop-down list, click one of the following options to filter the type of items in the 
list:

 All: The EMR displays follow-ups and referrals.

 Referral: The EMR displays only referrals.

 Clinic (default): The EMR displays only follow-ups.

4. In the Group By area, click one of the following: 

 Priority (default): The EMR lists the patients by the urgency of the Follow-up or referral.

 Patient: The EMR lists the patients in alphabetical order by their last name.
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5. In the left pane, click an entry for a patient. The EMR displays the Follow Up Notification or 
Referral Notification to the right.

6. Use the following table to enter information into the Response Log:  

Field Description

Pt Notified Click this button to indicate that you notified the patient. The EMR 
adds the following information to the Response Log: Patient 
Notified (<your name>/MM/DDD/YYYY HH:MM).

Note: After you close the Patients To Notify list, the EMR 
removes the patient from your Patients To Notify list.

Message Left Click this button to indicate that you called the patient and left a 
message. The EMR adds the following information to the 
Response Log: Message Left (<your name>/MM/DDD/
YYYY HH:MM).

No Answer Click this button to indicate that you called the patient, but there 
was no answer. The EMR adds the following information to the 
Response Log: No Answer (<your name>/MM/DDD/YYYY 
HH:MM).

Custom Response Enter a custom response specific to this entry
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7. To book an appointment for the selected patient:

a) In the Follow Up Notification area, click Book Appointment. The EMR opens the 
Appointment Scheduler with the patient’s name selected in the Patient Search area.

b) Book the patient for an appointment. See “Using patient lists (waiting lists)” on page 108.

8. Click Save & Close ( ). 

Printing your Patients To Notify list

To print your Patients to Notify list:

1. Open your Patients To Notify List and filter the list to display the information you want to print. 
See steps Step 1  to Step 4  in “Managing your Patients To Notify list” on page 360.

2. On the top right side of the Patients to Notify List window, click Print ( ). 
The EMR displays the Print Patient Notification window. 

3. In the From and To fields, enter dates.

4. Select the Update Printed List of Patients as Notified check box, if required, 

5. Click one of the following print options:

 Quick Print ( ): To print to your default printer.

 Print ( ): To specify a printer and printing options.

Notification Log Enter any notification notes.

Note: If the notification was entered by mistake, select the Cancelled check box. 
After you close the Patients To Notify window, the EMR removes the patient from 
your Patients To Notify list.

Field Description
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6. Click Save & Close ( ). 

Removing a patient from your Patients To Notify list through a follow-up task 

To remove a patient from the Patients To Notify list through a follow-up task:

1. In the Follow Up Tasks area on your Workdesk, double-click the follow-up you want to 
remove from your Patients To Notify list. The EMR opens the Follow-up List window with the 
follow-up displayed on the right.

2. Perform one of the following actions:

 If you contacted the patient, select the Patient Notified check box.

 if the patient was added to the list in error, select the Cancelled check box.

The EMR removes the patient from your Patients To Notify list.

3. Click Save & Close ( ). 

Managing patient rule matches

Rules are searches that automatically trigger reminders and notifications for practitioners and 
front office staff if a patient matches any rule criteria. For example, an active rule may indicate 
that a patient needs a follow-up scheduled, or a patient’s CDM Hypertension Billing is 
incomplete. You can filter the rule matches results, and then take the appropriate action, 
depending on the rule match. You can learn how to create rules and manage rule matches in 
follow-up training.

To manage rule matches:

Tip: When a To Come in task (TCI) is created, the EMR creates a follow up task 
and adds the patient to the Patients To Notify list. You can therefore remove a 
patient from your Patients To Notify list either through the associated follow-up task 
or through the Patients To Notify list itself. 
Wolf Front End Staff User Guide - Issue 02.05 363



Clinic communications and tasks
1. On your WorkDesk, in the Clinical Queues area, click <#> Rule Matches (where # = the 
number of R). The EMR displays the Rule Matches window.

2. Use the following table to filter the rule match results.  

Filter Description

Service Provider Select the Service Provider from the clinic.

Include Inactive Includes rule matches that have inactive service providers

Matching Rules Select the Rule that you want to match against. The pre-
defined rules are listed.

Show All Rules Show all rules with no filters applied

With an upcoming 
appointment in <x> 
<timeperiod>

Includes only patients who have an upcoming appointment in 
the specified time period. Use the text field and drop-down list 
to specify the number of days, weeks, or months.

Rule Days Count Matches in the last 'x' number of days
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3. In the Rule Matches list click a rule match, and then click one of the actions in the Action 
drop-down list: 

The following table describes each of the rule actions. 

Rule Priorities Level Scale of 1-9, where 1 is the highest, 5 is the default and 9 is 
the lowest. You can set up priority levels using Practice Search.

Note: The selected priority filters Rule Matches by the priority 
number selected and above. For example, if you 
select 4, the rule matches that are displayed have 
priorities 4 and above (1, 2, 3).

Filter by Role Show rules that have a specific security group/role assigned.

Rule Defaults Save the Rule Days Count and the Rule Priority Level 
values as defaults for this practitioner

Note: To have these changes take effect and to appear filtered in the Rule Match 
notifications, you need to close and reopen your WorkDesk.

Action Description

Create Lab Requisition Opens the Requisitions window, where you can select a 
Requisition form and open a lab requisition

Create New Allergy Opens the Clinical Records window, where you can 
create an allergy for this patient

Create New Follow-up Opens the New Follow-ups window, where you can 
create a follow-up

Create New Message Opens the New Message window, where you can 
create a message

Create New Problem Opens the Problems List window, where you can create 
a problem

Filter Description
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4. The Rule Engine Status area, informs you when Rules were last processed, if there were any 
errors and when the Rule engine is scheduled to run.

5. Click Save & Close ( ). 

Managing incomplete WCB reports

You can see, at a glance, how many WCB reports are incomplete from the Clinical Queues 
area on your WorkDesk. 

When you click the <#> Incomplete WCB Reports link, the EMR displays the WCB Manager 
window with the Incomplete Reports tab open. You can then select and finish each 
incomplete WCB report. See “Tracking and managing incomplete WCB Reports clinic-wide” on 
page 296.

Create Rule Exemption Opens the Rule Exemption window, where you can 
create a rule exemption

Refill Medications Opens the Prescriptions window, where you can refill 
the patient's medications

View All Patient Rules Opens the Rule Matches window, where you can view 
all available rule matches. This is the same window 
opened for the Active Rules

View Medical Summary Opens the patient Medical Summary window

View Patient Overdue Opens the CDM Flowsheet window, where you can 
search for any overdue patients.

Action Description
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Managing chart requests

You can see, at a glance, how many paper charts you need to pull from the Clinical Queues 
area on your WorkDesk. 

When you click the <#> charts to pull link, the EMR displays the Chart Requests window. You 
can use the Chart Requests window to keep track of the charts you need to pull. You can also 
send a notification to a practitioner if you are unable to locate the chart.

To manage chart requests:

1. On your WorkDesk, in the Clinical Queues area, click <#> charts to pull (where # = the 
number of charts to pull). The EMR displays the Chart Requests window. For each request, 
you can see the patient's name, paper chart number (if your clinic files charts by number), 
the patient's date of birth, and the requesting practitioner.

2. After you locate the patient's record and give it to the requesting practitioner, select Chart 
Pulled beside the patient's name. The EMR will remove these patients from the Chart 
Request window when you close the window.
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3. Leave the Chart Requests window open and continue to pull charts and mark them as 
pulled.

4. If you cannot locate a chart, click Unable to Locate Chart. The EMR displays the following 
prompt: “Notify Physician that chart cannot be located?”

5. Perform one of the following actions:

 If you want to notify the practitioner, click Yes. The EMR opens a new message window 
for the practitioner. The Message field contains the following text: “Unable to locate this 
patient's paper chart as requested.” Click Save & Close to send the message.

 If you do not want to notify the practitioner, click No and then click Save & Close to 
close the Chart Requests window. 

Managing overdue PAPs and mammograms

You can see, at a glance, how many patients are overdue for PAPs or mammograms from the 
Clinical Queues area on your WorkDesk. When you click the <#> Patients overdue for 
PAPS/Mammograms procedures outside guidelines link, the EMR displays the Patients 
Overdue for Preventive Care Tests Outside P.C. Guidelines window. From this window you can 
see the recommended due date for the procedure, and you can indicate if the follow-up 
procedure has been completed.

To manage overdue PAPs and mammograms:

1. On your WorkDesk, in the Clinical Queues area, click <#> Patients overdue for PAPS/
Mammograms procedures outside guidelines (where # = the number of patients with 
overdue procedures). The EMR displays the Patients Overdue for Preventive Care Tests 
Outside P.C. Guidelines window. You can see the patient's name, the practitioner's name, 
and the patient's home and business phone numbers. The F/U Due field displays the 
recommended date for a follow-up in red text. (This date is calculated based on the 
healthcare guideline.) This date gives you an idea of when to book the patient’s 
appointment. 

2. If a follow up has been completed, select the F/U Done? check box. This patient does not 
appear on the Patients Overdue for Preventive Procedures the next time you open the 
Patients Overdue for Preventive Care Tests Outside P.C. Guidelines window.

3. Click Save & Close ( ). 

Tip: Click the Follow-up button ( ) if you want to send yourself a reminder to 
book an appointment for the procedure. If you select a follow-up type of Patient 
TCI for Follow Up, the EMR adds the patient to your Patients to Notify list.
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Managing clinical finding notifications

When practitioners, such a nurses, enter a New Manual Result and set the status of the result 
as Staff To Call, the item appears as a clinical finding notification on your WorkDesk. When 
you click the clinical finding notifications link, the EMR opens the Manual Results window, 
with a list of patients who you need to phone to notify of test results.

To manage clinical finding notifications:

1. On your WorkDesk, in the Clinical Queues area, click <#> clinical findings notifications 
(where # = the number of clinical findings). The EMR displays the Manual Results window.

2. Perform one of the following actions:

 If you have called the patient and notified them of the results: Document your call in the 
Patient Instructions and Callback field (for example, enter “Called patient”.

 If you have not yet called the patient to notify them of the results: Click Call Patient. The 
EMR opens a new Message window where you can send yourself a message as a 
reminder to call the patient with the result.

3. Click Close Form ( ).
Wolf Front End Staff User Guide - Issue 02.05 369



Clinic communications and tasks
370 Wolf Front End Staff User Guide - Issue 02.05



Chapter 9
Managing incoming documents
Medical reports and other documents may come to your clinic via:

 Mail

 Fax

 and/or Electronic import

When a document comes via mail or paper fax you scan the document, and then link the 
document to the appropriate patient record. When a document comes via electronic fax you 
view and, if needed, edit the document before you link the document to a patient record. When 
a document comes via electronic import , the document is automatically linked to a patient’s 
record, but displays in the ordering provider’s Investigations/Documents In Basket for review. 

Managing incoming electronic faxes 
If your clinic receives faxes electronically, you should first view and, optionally, edit the faxed 
documents before you import them into the EMR. For example, faxes may be irrelevant to 
patients, have upside-down pages, contain cover-pages, or have information relating to more 
than one patient. Using a PDF editing application (for example, Adobe Acrobat), you can edit 
documents before they are linked to patients.  

Finding and opening electronic faxes

The location of the incoming faxes folder is unique to your clinic. Your instructor will show you 
the location of your faxes folder.

The incoming electronic faxes folder typically resides on one computer in the clinic, while other 
computers contain mapped drives to the faxes folder. If this is the case, to open the electronic 
faxes folder, on your Desktop, click the incoming electronic faxes link (S:\Scans\Faxes). 

Best Practice: Review and edit all incoming electronic faxes before you link them 
to a patient’s record.
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Scanning documents (using Fujitsu ScanSnap scanners)

When you scan documents using a ScanSnap scanner, the process you follow depends on 
whether you are scanning single-page documents or multiple-page documents:

 Single-page documents: You place an entire pile of single-page documents into the 
scanner at once. The scanner scans all the documents, and then saves each document as 
a separate PDF file.

 Multi-page documents: You can scan only one multi-page document at a time. The 
scanner scans both sides of each page, and then saves the pages together as a single PDF 
file. Blank pages are removed automatically. 

Scanning single page documents 

To scan a single-page document:

Best Practices:

 Open and review all faxes before importing them into the EMR.

 Delete irrelevant electronic faxes.

 Print electronic faxes that are not related to a patient.

Best Practice: After you scan and import documents into Wolf EMR, retain the 
hard copies for 7 days following the scan date. After 7 days, you can then destroy 
the hard copies.

Tip: Before you start scanning, divide your documents into two separate piles:

 One pile for the single-page documents

 One pile for the multi-page documents. (Attach each multi-page document with 
a paperclip to keep them separated.)

Note: A one-page document with information on both sides is considered a 
multi-page document. 

Note: If you do not have a ScanSnap scanner, follow the instructions provided by 
your IT Hardware provider.
372 Wolf Front End Staff User Guide - Issue 02.05



Managing incoming documents
1. In the lower-right corner of your desktop, click the blue Scan Snap icon ( ) and then in 
the Profile menu, click ONE FILE FOR EACH PAGE (or the equivalent: the profile name 
may differ depending how your Scan Snap profiles are set up).

2. Place up to 10 single page documents in the scanner.

3. On the scanner, press the blue Scan button. Your scanned documents are saved to 
S:\Scans.

Scanning a multi-page document  

To scan a multi-page document:

1. In the lower-right corner of your desktop, click the blue Scan Snap icon ( ), and then 
click ONE FILE FOR ALL PAGES (or the equivalent: the profile name may differ depending 
how your Scan Snap profiles are set up).

2. Place the multi-page document in the scanner.

3. On the scanner, press the blue Scan button. Your scanned document is saved to 
S:\Scans.

Editing faxes and scans using external PDF editing applications
If you want to edit a faxed or scanned document (for example, to remove a fax cover page, or to 
separate a faxed document into multiple documents) using an external PDF editing software 
application (for example, Adobe Acrobat), you must open, edit and save the document from the 
Scans or Faxes folder. You can then attach the document to a patient’s record in Wolf EMR.

Note: Single pages should not have content on both sides. If a page is double-
sided, then scan the page as a multi-page document.

Tip: You do not have to flip over the pages to scan a double-sided document. The 
scanner automatically scans the back pages of the document.

Tip: For instructions on how to edit PDF documents using Adobe Acrobat, 
download the handout for Editing faxes and scans using Adobe Acrobat.
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Linking documents
You can link electronic faxes and scanned documents to a patient’s record. You can also link 
documents to a specific problem as a resource or handout. If you assign effective keywords to 
documents you link to patients, you can easily identify and find the document you are looking 
for in the patient’s Medical Summary. 

Linking documents to patient records

When you link a document to a patient record, that document becomes available under the 
Documents tab in the patient's Medical Summary. 

To link a document to a patient record:

1. On the Wolf EMR Launch page, click Documents ( ). The EMR displays the 
Documents window.

Tip: You can also link an identification photo to a patient’s record.
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2. On the left side of the window, click a document. The EMR displays a preview of the 
document. 

3. In the right pane, in the Attach Options area, select Attach to Patient.

4. In the Patient Search area, enter the Patient's Name, PHN, Chart #, or date of birth. 

Tip: Editing documents from the Documents window

If you do not have an external PDF editing application, and a document is up-side-
down, in the Document’s window, you can rotate the document before you link it to 
a patient’s record:

1. In the left pane, select the document you want to edit. The EMR displays the 
selected document.

2. Above the document preview, click Document > Rotate Pages.

Note: From the Documents window, you cannot use any other document 
editing options unless you have purchased the PDF editing software from 
TELUS Health.
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5. In the search results, click the patient’s name. 

6. In the Attach these Keywords drop-down list, select a keyword to describe the document, 
for example ECG. You can also type a keyword in the field. You can attach a maximum of 
three keywords to describe the document. See “Using keywords” on page 377.

7. In the Document Type drop-down list, select the document type. 

8. To link the document to one of the patient's upcoming visits, in the Link to This Appt drop-
down list, select the visit.

9.  If the document is related to a referral (for example, a consult letter, or appointment 
confirmation), in the Link to this Consultation drop-down list, select the referral.

10. In the Document Date and Note area, enter the date the document was created. Use the 
format: ddmmyy or dd/mmm/yyyy. 

11. To add notes about the document, click the Note icon ( ). The EMR displays a note 
entry window. Type your notes and close the window when finished.

12. The Link to Service Provider check box is selected by default. When this check box is 
selected, the EMR links the document to the patent's primary service provider. If the patient 
does not have a primary service provider, or you want to link the document to another 
service provider:

a) Clear the Link to Service Provider check box and then, in the drop down list below, 
click the service provider who you want to link the document to.

13. In the bottom right corner of the window, perform one of the following actions:

Tip: If there are too many patient names in the search results, or if you want to 
associate the document with an inactive patient, click the Advanced button to 
perform an Advanced Patient Search. The Advanced Patient Search has more 
options to narrow your search.

Tips:

 The document type helps you identify and filter documents in the patient’s 
record.

 If you start to type the Document Type, then the EMR automatically takes you to 
that area of the list. 

Note: You cannot free-type a value into this field.

Note: If you link a document to a referral, the referral status changes from 
Pending to Completed, and reconciles the referral. 
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 Click Link Only to add the document to the patient’s record and to notify the practitioner 
to review the document.

 Click Link and Reviewed to add the document to the patient’s record without notifying 
the practitioner (typically used for scans that the practitioner has already viewed).

Using keywords

When you link a document, you use keywords to describe or categorize the document. These 
keywords help identify, or “label” the document and make it easier for you to find the document 
in a patient’s chart. 

Some keywords result in the document becoming available through a specific link in the EMR. 
Other keywords result in an icon appearing in the EMR. The following table contains some 
examples of keywords and how they affect the EMR.

Keyword Result

Prenatal Form When you link a document with the keyword Prenatal Form, the 
document is available through the Patient Handouts link on the 
Prenatal Record for ALL patients. 

Important: Ensure that the document does not contain any patient-
specific or other confidential information.

Examples of Prenatal handouts might include dietary education or 
breast feeding tips.

Prenatal US When you link a document to a patient, with the keyword Prenatal US, 
the document becomes available through the Ultrasound Images link 
on the Prenatal Record. You can also view the document from the 
Documents tab in the Medical Summary.
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IDPhoto When you link a photo to a patient with the keyword IDPhoto, a 

camera icon ( )appears in the following locations in the EMR:

 Below the patient's name on the Patient tab on the Physician 
WorkDesk (Patient Resources area on the SMART Patient Banner)

 Below the patient’s name in the Medical Summary (Patient 
Resources area on the SMART Patient Banner)

 Under the Documents tab in the Medical Summary

Click the camera icon to display the photo.

Medical 
Summary

When you link documents such as previous important paper chart 
information or previous medical summary information with the keyword 
of Medical Summary, you can view the document from the 
Documents tab on the Medical Summary.

Important: You can link many documents to the patient's Medical 
Summary using this keyword although only the last linked document is 
displayed by clicking the button (with a picture of an open book) that is 
displayed next to the patient's name on the Patient tab on the 
Physician WorkDesk.

Medical Image When you link a document to a patient's Medical Summary with the 
keyword of Medical Image, the document appears on the 
Investigations tab in the Medical Summary.

PAPs or 
Mammogram

When you link scanned documents of previous PAP or Mammogram 
results to a patient's Medical Summary with the keyword of either 
PAPS or Mammogram, the document appears in the Preventive 
Procedure Results section on the Investigations tab, in the Medical 
Summary.

Note: You can select a maximum of three keywords for each document or photo.

Best practice: Although you can free-type keywords in the Attach these 
Keywords field, try to use keywords from the drop-down list instead. This way, 
documents are input with consistent descriptions and are easier to identify and 
search for in patient records.

Keyword Result
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Linking documents to problems as resources or handouts

When you link a document to a problem, then that document is easily accessible directly from 
the SOAP Form when that problem is selected in the Assessment section.

You can link a document to a problem to use as a quick resource either for the practitioner or as 
a handout for the patient.

To view the document, simply click the View Linked Documents link beside the problem. You 
can also print the document if you want. 

To link a document to a problem:

1. On the Wolf EMR Launch page, click Documents ( ). The EMR displays the 
Documents window.

2. In the left pane, click a document. The EMR displays a preview of the document.

3. In the top right corner of the window, in the Attach Options area, select Attach to 
Problem. The EMR displays the Problem Search area and a Problem field.

4. In the Problem field, enter the problem that you want to link the document to, and then on 
your keyboard, press Enter.

5. In the search results list, click a problem. 

6. In the Attach these Keywords drop-down list, click a keyword to describe the document. 
You can also type a keyword in the field, for example Diabetes handout. You can attach a 
maximum of three keywords to describe the document.

7. In the Document Type drop-down list, click a document type. 

8. In the Document Date and Note area, enter the document's date (the date it was created). 
Use the format: ddmmyy or dd/mmm/yyyy.

9.  To add notes about the document, click the Note icon ( ). The EMR displays a note 
entry window. Type your notes and close the window when finished.

10. The Link to Service Provider check box is selected by default. When this check box is 
selected, the EMR links the document to the patent's primary service provider. If the patient 

Note: Only users with Administrative rights can add keywords to the Attach these 
Keywords drop-down list.

Tip: If there are no search results, try entering only one word to describe the 
problem, or the first few letters of the problem.
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does not have a primary service provider, or you want to link the document to another 
service provider:

a) Clear the Link to Service Provider check box and then, in the drop down list below, 
click the service provider who you want to link the document to.

11. Click Link and Reviewed. 

Viewing and modifying documents from a patient’s record
After you link a document to a patient’s record, you can view and modify the document. You 
can modify the document’s properties, for example you can change the keywords or add 
notes. If you add a document to a patient’s Medical Summary in error, you can unlink that 
document (and then link it to another patient), or you can delete the document. If you delete a 
document linked to the patient’s record, you can always retrieve it from the 
DeletedDocuments folder. You can also publish documents from a patient’s record to the 
Patient Portal. 

Viewing all documents linked to a patient

You can view documents linked to a patient from the Documents tab in the patient’s Medical 
Summary. To open and view a document, simply double-click a document in the list.

To view all documents linked to a patient:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. 

2. Click the Documents tab. The Documents tab lists all of the patient’s documents.

3. Double-click the document you want to view.

Modifying a document’s properties

After you link a document to a patient's Medical Summary, you can edit the document’s 
properties to do the following: 
380 Wolf Front End Staff User Guide - Issue 02.05



Managing incoming documents
 Link the document to a referral or to an appointment

 Change the date of the document

 Add keywords and notes to remind you of the contents or purpose of the document as well 
as make the document easier to find in the future.

 Change the document type

To modify a linked document’s properties: 

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. 

2. Click the Documents tab. The Documents tab lists all of the patient’s documents.

3. Click a document, and then click View Document Properties. The EMR displays the 
Document Properties window.
Wolf Front End Staff User Guide - Issue 02.05 381



Managing incoming documents
4. Use the following table to modify the document’s properties.   

Field Description

Link to Referral In the Link to Referral drop-down list, click the referral that you 
want to link the document to. The EMR marks the referral as 
Completed.

Link to Appointment In the Link to Appointment drop-down list, click the 
appointment that you want to link the document to.

Document Date Enter the date the document was received.

Keywords Click a keyword from the Keywords drop-down list or type in a 
keyword in the field. You can enter up to three keywords.

Document Type In the Document Type drop-down list, click a document type. 
Specifying a document type helps you to identify and filter 
documents in the patient’s record.

Notes Add notes to remind you of the contents or purpose of the 
document.

Publish to Portal Select this check box if you want to publish the document to 
the Patient Portal.

For mor information on publishing documents to the Patient 
Portal, see “Publishing documents to the Patient Portal from the 
Medical Summary” on page 385.
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5. Click Save Document Settings and Close Form ( ).

Unlinking a document from a patient's record

If you want to remove a document from a patient’s record, you must unlink the document from 
the patient’s record. When you unlink a document from a patient’s record, you have the choice 
to either:

 Unlink the document and move the document to the UnlinkedDocuments folder, OR

Note: If the document was received via electronic import, the EMR displays 
additional document details and messages in the HL7 Message Details area.

You cannot modify this information.
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 Unlink the document and move the document to the DeletedDocuments folder.  

To unlink a document from a patient’s record:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. 

2. Click the Documents tab. The Documents tab lists all of the patient’s documents.

3. Click a document and then click View Document Properties. The EMR displays the 
Document Properties window.

4. In the Document Properties window, click Cancel Link ( ). The EMR displays the Select 
Action window with the following prompt: 

5. Perform one of the following actions:

 Click Yes to unlink the document and to move the document to the 
UnlinkedDocuments folder.

 Click No to unlink the document and to move the document to the DeletedDocuments 
folder. (You can retrieve the document from the DeletedDocuments folder if necessary. 
See “Retrieving a document from the DeletedDocuments folder” on page 385.)

Note: You can retrieve the document from the DeletedDocuments folder, if 
necessary. See “Retrieving a document from the DeletedDocuments folder” on 
page 385.
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Retrieving a document from the DeletedDocuments folder

To retrieve a document from the DeletedDocuments folder, you simply move the document 
from the DeletedDocuments folder to the UnlinkedDocuments folder. Once the document 
is in the UnlinkedDocuments folder, you can link that document to a patient’s record or to a 
problem.

To retrieve a document from the DeletedDocuments folder:

1. Open the DeletedDocuments folder. In most cases, the DeletedDocuments folder is 
located in Wolf Lair/Data/DeletedDocuments.

2. Click the document you want to retrieve.

3. On your keyboard press Control + C to copy the document.

4. Open the UnlinkedDocuments folder. In most cases, the UnlinkedDocuments folder is 
located in Wolf Lair/Data/UnlinkedDocuments.

5. On your keyboard press Control + V to paste the document into the UnlinkedDocuments 
folder. 

6. Go back to the DeletedDocuments folder.

7. Click the document you retrieved.

8. On your keyboard press Delete to delete the document. 

Publishing documents to the Patient Portal from the Medical Summary

Documents, such as medical reports, that reside in the Documents area of a patient’s Medical 
Summary are not automatically published to the Patient Portal. You must select which 
documents are to be published.

From a patient’s Medical Summary, you can select one document or multiple documents at 
once to publish to the Patient Portal.

To publish documents to the Patient Portal from the Medical Summary: 

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163. 

2. Click the Documents tab.

Note: Ensure that the document is in the UnlinkedDocuments folder before you 
go to the next step.
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3. Click Publish to Portal. The EMR displays the Publish documents to Patient Portal window 
with a complete list of the patient’s documents. 

4. In the list of documents, select the check box beside each document you want to publish to 
the Patient Portal.

5. To add notes to the patient regarding a particular document, in the Notes to Patient 
column, enter your notes to the patient.

6. When you finish selecting documents, click Close ( ). The EMR displays a dialogue box 
with the following message: “Selected document(s) have been published/updated via the 
Patient Portal”.

7. Click OK.
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Managing incoming electronic investigations
In Wolf EMR, you use the Import program to import new electronic investigations and to match 
unrecognized patients to investigations. Once you import electronic investigations, the ordering 
providers are automatically notified to review the investigations.

As a front end staff member you cannot mark imported labs as reviewed. If a provider is 
unavailable to review their investigations, you can redirect electronic investigations to other 
providers in the clinic for review.

Importing investigations and reports
The following sections explain how to:

 Import investigations and reports

 Match patients to investigations

 Manage patients added with an investigations import

Importing new investigations and reports

You can import electronic laboratory results, and other medical reports (depending on which 
feeds your clinic is set up for) for all providers in your clinic at once. Following import, providers 
can review and take action on received investigation results and reports.

To receive the most up-to-date results, import 3 times daily. Wolf EMR imports all electronic 
investigations released since the last import.

To import new investigations and reports:

Note: Any Wolf EMR user can download electronic investigations, no matter their 
role or security access. However, each user who downloads investigations must 
be configured to do so.

Tip: Assign specific users to be responsible for manually downloading lab 
investigations at similar times each day. This way you can ensure that lab 
downloads occur at regular intervals.
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1. On the Wolf EMR Launch page, click Import( ). The EMR displays a dialog box with the 
following prompt: “Are you sure you would like to import new investigations at this time?”

2. Click Yes. The EMR imports investigations and reports from all of the lab and diagnostic 
imaging companies that you are set up to receive electronic imports from, and displays the 
imported investigations in the Import History window.  

The Import History window contains the following information:

 Import Sessions: A list of users who have imported investigations, and on what dates 
and times those imports occurred.

 Session History: A status summary of your imports. Indicates if the current import is 
successful. Also details information on new patients added with the most recent 
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investigation import, including patient names, provincial health numbers, and clinic 
location (if your clinic has more than one clinic location).

3. If the import contains an investigation belonging to a patient who cannot be identified in your 
system, the EMR opens the Patient Match Selection Form window. This window displays 
the imported patient information, and a list of possible patient matches below.

perform one of the following actions:

 To match the investigation to a patient in the Similar Patient Already On File list, 
double-click the patient’s name. 

Viewing investigation import information for multiple locations:

If your clinic has multiple locations, by default you see investigation import 
information only for locations that you are assigned to.

To view import information for all clinic locations:

 On the Import Session header, click the down arrow icon ( ) and then, in 
the list of filter options, click Show All Sessions..
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 To add the patient as a new patient in your system, click Add as New.

Once all unidentified patients are matched, the EMR displays the Import History window 
once more. 

4. In the Session History area of the Import History window, review the status of your import 
to see if your import was successful or not. 

5. To view detailed information for a previous import, in the Import Sessions area, click the 
import. The EMR displays detailed information for the import in the Session History area.

6. To expand the Session History area, click History ( ). The EMR hides the Import 
Sessions area.

7. To display the Import Sessions area, click History ( ) once more.

8. When you finish reviewing the status of your import, click Close ( ).

Note: If your clinic has multiple clinic locations, the patient is automatically 
assigned to the ordering physician’s primary location. You can manually assign 
imported patients to another location if needed. See “Managing patients added 
with investigation imports” on page 391.

Note: If there are any errors, the Session History window provides instructions to 
contact the Wolf EMR Support Team for further assistance.

Tip: If the import you want is not available in the list, click the arrow to the left of 
Older. The EMR displays a complete list of previous imports.
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Managing patients added with investigation imports

If new patients are added to your EMR with an investigation import (for example, if you receive 
labs for patients seen by a provider in hospital), from the Import History window, you can:

 Modify patient demographic information

 Deactivate the patients 

 Assign the patients to a primary MD

 Assign the patients to a location

 Assign the patients to a care team

 Change the patients’ status

 Create follow-up tasks for the patients

To manage patients added with an import:

1. Open the Import History window, see “Importing investigations and reports” on page 387.

2. In the Import Session area, click the import you want to view and manage new patients for. 
The EMR displays information for the selected import in the Session History area, including 
a list of patients added to your system with the import. The list of patients includes:

 Patient names

 Provincial health numbers

Tip: If you want to view the Import History without importing investigations, you can 
access the Import History window from Wolf EMR Maintenance:

 On the Wolf EMR Launch page, and then click the Maintenance tab, and then 
click Import. History.
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 The clinic location the investigation was ordered from (displays only if your clinic has 
multiple clinic locations)

3. To view or modify a patient’s demographic information, double-click the patient’s name. The 
EMR displays the Patient Maintenance window.

4. To manage the imported patients as a group:
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a) In the Session History area, on the New Patients header, click . The EMR opens 
a window displaying the list of new patients.

b) Select the check box beside the patients you want to modify, or to select all patients, 
click Selection > Select All.

c) In the menu, click Selection. The EMR displays a list of actions you can perform on the 
selected patients. 
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d) Using the following table, select an action to perform on the selected patients.

Action Description

Add to 
Followup List

To create a follow-up task for the selected patients:

1. Click Add to Followup List. The EMR displays the New Follow 
Up for Selected Patients window.

2. Enter the following information, and then click OK:

 Follow Up Problem: Enter a description for the follow up task.

 Follow up Type: To assign the follow task(s) to a particular user 
or to a group, click Physician Reminder, or to create a to Come 
In task, click Patient to Come In.

Note: For more information on To Come In (TCI) tasks, see “To 
Come In tasks” on page 335.

 Urgency: Click Routine or Urgent.

 Assigned To: Click the user or group the task(s) are to be 
assigned to.

Assign Primary 
MD

To assign the patients a primary provider, click Assign Primary MD. 

Assign Care 
Team

If your clinic has care teams set up in Wolf EMR, and you want to 
assign the patients to a particular care team, click Assign Care 
Team.

Update Default 
Location

If your clinic has multiple clinic locations, and you want to assign the 
patients to a particular location, click Update Default Location.

Note: By default, patient’s are assigned to the location that their 
investigations were ordered from.
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Printing a list of new patients added during the current import session

You can print a list of new patients added during the current import session:

Update Patient 
Status

To update the patients’ status:

1. Click Update Patient Status. The EMR displays the Change 
Patient Status for Selected Patients window.

2. In the status drop-down list, click the status.

3. Complete the remainder of the fields, and then click OK.

Note: The information required depends on the status selection.

Note: If the status you want is not available on the list, a user with 
administrator authority can add statuses as needed.

Deactivate 
Selected

To deactivate the selected patients, click Deactivate Selected.

Action Description
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1. Open the Import History window. See “Importing investigations and reports” on page 387

2. On the ribbon bar, click Print > Print New Patients. The EMR prints the New Patient 
Summary report.

Redirecting electronic investigations
If a provider receives another provider’s electronic investigation(s) in error, or if a provider is 
covering for another provider, you can redirect investigation(s) to another (in clinic) provider. 

To redirect an electronic investigation to another provider:

1. On your WorkDesk, in the Incoming Results area, click Investigations. The EMR opens 
the Investigation/Document In Basket window with a list of un-reviewed investigations 
displayed. You can filter the list, for example, by provider or by patient.

2. Click the investigation, and then click Redirect. The EMR displays the Select Service 
Provider window.

3. Select the provider you want to redirect the investigation to, and then click OK. The EMR:

 Moves the investigation to the selected provider’s Investigation/Document In Basket.

 Populates the investigation Note field with the following message: “Redirected by <your 
name> on <date>.” 

Note: You can redirect an electronic investigation only if it has not yet been 
reviewed. If you do not see the Redirect button, the investigation has been 
reviewed or was entered manually.
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Moving an investigation to another patient’s chart (Administrators)
If an electronic investigation is linked to the wrong patient’s chart, you can move the 
investigation to the correct patient chart.

To move an electronic investigation to another patient’s chart:

1. On your WorkDesk, in the Incoming Results area, click Investigations. The EMR opens 
the Investigation/Document In Basket window with a list of un-reviewed investigations 
displayed. 

2. Click the investigation, and then click Move to Different Patient Chart. 

The EMR displays the Patient Search window.

3. Search for and select the patient you want to move the electronic investigation to. The EMR 
displays a dialog box asking for your reason for moving the investigation.

Note: 

 Only users with administrative authority in Wolf EMR can move electronic 
investigation results and reports from one patient to another.

 When you move an investigation, if the investigation is an update to a previously 
received investigation, the original investigation is moved to the new patient’s 
record as well.

Tip: Using options in the left pane, you can filter the list of investigations to display 
only a specific provider’s or a specific patient’s investigations. You can also choose 
to display investigations that have been reviewed (by clearing the New check box).
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4. Enter your reason, and then click OK. The EMR:

 Moves the electronic investigation to the selected patient’s chart.

 Sends a message to you and to the ordering provider indicating that the investigation has 
been moved. (The message displays in your Messages List.)
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Sending and managing referrals
In this chapter you learn how to send and manage referrals to external consultants and clinics. 
When you refer a patient to an external consultant, you initiate a referral in Wolf EMR. When you 
initiate a referral:

 Wolf EMR tracks where the patient is in the referral process (for example, if the referral letter 
needs to be completed, or if the patient is waiting for an appointment date/time)

 You create a referral letter from the referral

You have three choices on how you create a referral letter. You can use Basic Referral, you can 
use the Wolf EMR Referral Letter Composer, or you can use a SMART Form letter template. 

Wolf EMR also has an eReferral feature. If your clinic has eReferral set up, you can send and 
receive referrals electronically to and from other Wolf EMR clinics. When you send an eReferral, 
the receiving clinic can import sections of the patient’s Medical Summary that you choose to 
share.

Initiating referrals
Before you create a referral letter, you initiate a referral for the patient first. When you initiate a 
referral, you specify referral details such as the:

 Referral Type

 Consultant, clinic, or facility where you are referring the patient 

 Urgency of the referral

 Referral reason

The referral details you enter automatically populate the referral letter. The referral details also 
help you track and manage actions you take towards a referral.

You can initiate a referral via the SMART menu, or from your WorkDesk. 
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To initiate a referral:

1. Perform one of the following actions:

 If you have any window of the patient’s medical record open (for example, the Vital Entry 
window or the Medical Summary window), right-click and then, in the SMART menu, 
click New Referral.

 If you don’t have the patient’s medical record open:

a)  On your WorkDesk, in the Referrals area, click New Referral. The EMR opens the 
Patient Search window.

b)  Search for the patient and then double-click the patient’s name. 

The EMR displays the New Referral window.
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If a visit note has been created for the patient today, the EMR also displays a dialogue box 
with the following prompt: “Use current visit record to build referral letter?”

2. Perform one of the following actions:

 To include today’s visit notes in the referral letter, click Yes.

 To start a blank referral, click No.
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3. In the Referral Type list, click the type that best describes what the referral is for. The 
selection defaults to Consultation.

4. Search for and select a consultant using the Search field, or categorized consultants list:

To search for a consultant using the Search field:

a) In the Search field, enter the consultant’s last name, or to see a list of consultants for a 
specific specialty, enter the specialty.

b) To add additional search criteria, press the Space bar, and then enter the consultant’s 
first name, specialty, practitioner number, or city (municipality).

c) If you are searching based on a consultants last name only, below the Search field, 
select the Search by Last Name only check box. In the search results, the EMR 
includes only consultants with matching last names.

d) In the drop-down list to the right of the Search field, click one of the following options:

 To search for consultants that contain ALL keywords you enter, click AND.

 To search for consultants that contain ANY of the keywords you enter, click OR.

Note: Based on the Referral Type you select, the EMR filters the consultant list to 
display only consultants categorized under the selected type.

Want more Referral Type options? 

Users with administrative authority can add, modify, or delete referral types.

To add referral types:

1. On the Wolf EMR Launch page, click Configuration ( ).

2. On the Configuration menu, click View > Physicians /Service Providers > 
Referral Types. The EMR displays the Referral Types Maintenance window.

Tip: You can set the Search by Last Name only check box to be selected by 
default:

1. On the WorkDesk menu, click Configure > Configure Workdesk ( ).

2. Click the Referrals tab.

3. Beside Search for Consultant Last Name only, clear the Apply clinic 
Setting check box, and then select the User Setting check box.
402 Wolf Front End Staff User Guide - Issue 02.05



Sending and managing referrals
  

e) In the list of matching consultants, click the consultant you want.

To search for a consultant using the categorized consultants list:

a) In the Choose Consultant area, click one of the following:

  From Favourites (Default): The EMR displays a list of your favourite consultants.

  By Speciality: The EMR displays a list of specialties. Click the specialty you want. The 
EMR displays a list of consultants for the selected specialty.

  By Name: The EMR displays the entire consultants list in alphabetical order.

  Add New Consultant: The EMR displays the Enter New Consultant window. See 
“Adding a new consultant when you are creating a referral” on page 433.)

b) In the resulting consultants list, click the consultant you want. 

Tip: You can set what option is selected by default in the Choose Consultant 
area:

1. On the WorkDesk menu, click Configure > Configure Workdesk ( ).

2. Click the Referrals tab.

3. Beside Default view of Consultants, clear the Apply clinic Setting check 
box and then, in the User Setting drop-down list, select the option you want.

What if I don’t know what consultant is available?

If you do not know the consultant you want (for example, if you do not know which 
specialists are available), you can instead select a generic specialist. Search for 
and select “Next Available Specialist”.

You, or another staff member, can change the consultant’s name in the referral at a 
later time.
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5. To verify that you selected the correct consultant, in the top right corner of the window, click 
...info. The EMR displays the Consultant Information window, with details on the consultant 
you selected.   

6. To set the selected consultant as the primary practitioner to receive the referral, click Set as 
Primary. The EMR displays the consultant’s name in the field below the consultant list.

7. If applicable, enter practitioners to be CC’d on the referral letter:

a) Search for and select a consultant. See Step 4.  to Step 5. .

Tip: If there are notes entered for a consultant (for example, if there are notes on 
booking procedures for a specific consultant), you can view these notes from the 
list of consultants. To view consultant notes:

 In the list of consultants, click the consultant, and then hover your cursor over 
the consultant’s name. The EMR displays any notes for that consultant as a tool 
tip.

What if I set the wrong consultant as the Primary Consultant?

If you set the wrong provider as the Primary Consultant, click another provider from 
the consultants list, and then click Set as Primary again. The EMR replaces the 
Primary Consultant with the new selection.
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b) Click Add to CC. The EMR inserts the selected practitioners name in the CC 
Recipient(s) area.

8.  To define the Priority of the referral, click one of the following options:

 Routine (default)

 Urgent

9.  Use the following table to enter information in the rest of the window:

Tip: To save the primary consultant, ensure you click Set as Primary before you 
add CC’d practitioners. 

Field/Check box Description

Seen Before? Select this check box if the patient was seen by a practitioner 
from your clinic, for the same referral reason.

Note: In the MD drop-down list, click the practitioner that the 
patient saw.

MD Important: 
If the patient was not seen before, you must click the referring 
practitioner’s name in the MD drop-down list.

*Referral Reason Enter the reason and/or diagnosis for the referral.

Note: This field is mandatory.

Current 
Investigations

Enter any investigations you are awaiting results on (including 
investigations that you have ordered today).

Booking Notes Enter notes regarding the appointment booking. Information can 
include:

 Type of specialist you want to refer to (for example, “Refer to 
cardiology”)

 Expected wait times for booking. (for example, “Expected wait 
time is 4mo”).

Note: Information entered here displays in the Notes column in 
your Referral Appointments to be made list.
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10. If you do not want to create a referral letter at this point, under LETTER COMPLETE, select 
the Letter check box. The EMR adds the patient to the practitioner’s Letters to Write list.

11. Click Save & Close Referral ( ). 

Consultant Will 
Notify Patient of 
Appointment

To indicate that the patient will be notified of the appointment time 
from the consultant’s office, select this check box. 

The EMR immediately adds an item to your Patients to Notify 
list. You then know to call the patient to indicate that they can 
expect a call from the consultant’s office.

Note: If this check box is selected, the patient does not display 
in the Appointments to be Made list.

MSP Referral Sent Select this check box if you want to send the referral billing to 
MSP. (This is a no charge fee referral 3333.) When you save the 
referral, the EMR automatically creates a bill in Billing with the 
patient's name, Fee Code, and the Specialist’s name to whom 
the patient is referred.

Note: If you do not send the referral billing to MSP now, you can 
send the referral billing to MSP later, from the Appointments To Be 
Made window:

1. On your WorkDesk, click <x> referral appointments to be 
made. The EMR displays the Appointments To Be Made 
window. 

2. In the list of referral appointments to be made, click the referral 
that you want to send to MSP for billing. The EMR displays the 
referral details in the right pane.

3. In the right pane, select the Billing Referral Sent check box. 
The EMR displays the following prompt “Send Referral to 
MSP?”

4. Click Yes. 

Use Medical Hx This check box is selected by default. When this check box is 
selected, the EMR includes the patient’s medical summary 
information in the referral letter. 

If you do not want to include medical summary information in the 
referral letter, clear this check box.

Field/Check box Description
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If you did not select the MSP Referral Sent check box, the EMR displays a dialog box with 
the following prompt “Send Referral to MSP?”.

12. Perform one of the following actions:

 If you want to bill MSP for the referral, click Yes. The EMR automatically creates a bill in 
Billing with the patient's name, Fee Code and Specialist’s name to whom the patient is 
referred.

 f you do not want ill MSP for the referral at this time, click No. The EMR closes the New 
Referral window. 

Creating referral letters
After you initiate a referral, you can create a referral letter directly from the New Referral window.

You can create referral letters using the following methods:

 Basic Referral: You enter the text of the letter and then print. You can include medical 
summary information in the letter, but you cannot customize the content. You cannot attach 
documents to the letter. (Medical summary information is included in letter, if the Use 
Medical Hx check box is selected.) See “Creating a basic referral letter” on page 407.

 Referral letter Composer: Allows you to add more information from the patient’s medical 
summary and to attach documents to the referral letter. See “Creating a referral letter using 
the Referral Letter Composer” on page 409.

 SMART Form-based Referral letter: Allows you to include a full medical profile and to 
customize the referral letter. You can also format the referral letter using Microsoft Word 
formatting tools. You cannot attach other files or documents to a SMART Form-based 
consult letter as you can when using the Referral Letter Composer. See “SMART Form-
based referral letters” on page 419.

After you create a referral letter you can print the referral or fax the letter to the Specialist.  

Creating a basic referral letter

When you create a basic referral letter, you can include medical summary information in the 
letter, but you cannot customize the content. You cannot attach documents to the letter. 
(Medical summary information is included in letter, if the Use Medical Hx check box is 
selected.) 

To create a basic referral letter:

Note: Referrals received by Specialists have an expiration of six months. If the 
patient needs to be seen by a specialist after six months, you must send another 
referral letter.
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1. Initiate a referral and complete the New Referral details. See “Initiating referrals” on page 399.

2. In the Enter Text of Letter field, enter the content of your letter. 

3. Print the referral letter. Perform one of the following actions:

 Click Quick Print to send the referral letter to your default printer or fax machine.

 Click Print ( ) to select a specific printer or fax machine before printing.

4. Indicate the status of the referral letter. In the LETTER COMPLETED area, select one or 
more of the following check boxes: 

 LETTER COMPLETED: If you have both written the letter and sent it to the consultant.

 Letter: To indicate that a letter needs to be written, but has not been started or finished 
yet. The EMR adds the patient to the practitioner's Letters to Write list on their 
WorkDesk.

 Typed: Indicates that the contents of the letter have been typed. If this check box is 
selected, the EMR adds the letter to the Practitioner’s Letters to Edit list.

 Printed: To indicate that you have printed the letter.

Note: If you want to create a letter based on a previously started referral:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical 
Summary” on page 163.

2. Click the Referrals tab.

3. In the patient’s list of referrals, double-click the referral you want. The EMR 
opens the referral in the Existing Referral From <Date> window.

Tip: If the Enter Text of Letter field is too small for your letter content:

1. Click Expand Area ( ). The EMR expands the text area and hides the lower 
fields of the New Referral window.

2. When you finish entering your letter content, click Minimize Area ( ). The 
EMR minimizes the text area and displays the lower fields of the New Referral 
window again.

Note: Most clinics (who do not have stenographers or transcriptionists) use only 
the Sent check box.

The other check boxes, for example Typed and Printed, are used to go back in 
forth between the stenographer and the practitioner for review.
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 Sent: To indicate that you have sent the letter. 

5.  Click Save & Close Referral ( ).

If you did not select the MSP Referral Sent check box, the EMR displays a dialog box with 
the following prompt “Send Referral to MSP?”.

6.  Perform one of the following actions:

 Click Yes, if you want to send the referral billing to MSP. The EMR automatically creates a 
bill in Billing with the patient's name, Fee Code and Specialist’s name to whom the patient 
is referred.

 Click No if you do not want to send the referral billing to MSP at this time. The EMR 
closes the New Referral window. 

Creating a referral letter using the Referral Letter Composer

The Referral Letter Composer is a letter creation tool. In the Referral Letter Composer, you enter 
the basic letter message, select what medical information from the patient’s record to include, 
and select what documents to attach to the referral letter. The EMR then produces a 
professional letter that includes the information you selected.

To create a referral letter using the Referral Letter Composer:

1. Initiate a referral and complete the New Referral details. See “Initiating referrals” on page 399.

Note: You can indicate the status of the referral later, from the Referrals tab in the 
patient’s Medical Summary:

1. Open the patient’s referral from the Referrals tab in Medical Summary window. 
(If you are not in the Medical Summary window, see “Opening a patient’s 
Medical Summary” on page 163.)

2. Indicate the status of the referral letter.

Note: If you want to create a letter based on a previously started referral:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical 
Summary” on page 163.

2. Click the Referrals tab.

3. In the patient’s list of referrals, double-click the referral you want. The EMR 
opens the referral in the Existing Referral From <Date> window.
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2. In the Enter Text of Letter field, enter the content of your letter. 

3. Click Compose ( ). 

If you did not select the MSP Referral Sent check box, the EMR displays a dialog box with 
the following prompt “Send Referral to MSP?”.

4.  Perform one of the following actions:

 Click Yes, if you want to send the referral billing to MSP. The EMR automatically creates a 
bill in Billing with the patient's name, Fee Code and Specialist’s name to whom the patient 
is referred.

 Click No if you do not want to send the referral billing to MSP at this time. The EMR 
closes the New Referral window. 

The EMR displays the Referral Letter Composer window. 

Tip: If the Enter Text of Letter field is too small for your letter content:

1. Click Expand Area ( ). The EMR expands the text area and hides the lower 
fields of the New Referral window.

2. When you finish entering your letter content, click Minimize Area ( ). The 
EMR minimizes the text area and displays the lower fields of the New Referral 
window again.
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The Referral Letter Composer letter displays the following information sections by default:

Information 
section Information displayed

Author The name, and contact information of the practitioner you selected in 
the MD drop-down list (the practitioner who saw the patient before 
for the same referral reason or the referring practitioner).

Information 
Recipient 

The primary recipient’s name and contact information.

CCed Recipients Name and contact information for any practitioners that are CCed on 
the Referral.

Patient Patient’s name and demographic information.
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5. To include additional medical history information, in the left pane:

Referral Detail The urgency, referral reason, current investigations and referral letter 
text that you entered in the New Referral window.

Note: You can add to or edit this information from the Referral 
Letter Composer window, if necessary. 

To add to or edit the Referral Detail information:

1. In the left pane of the Referral Letter Composer window, right-click 
Referral Detail (displayed with blue text).

2. Click Properties. The EMR displays the Referral Detail window.

3. Add or edit information as necessary.

4. If you change the Primary Consultant, click Set as Primary.

5. Click Save ( ).

Information 
section Information displayed
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a) Select the check boxes beside the Medical Summary categories you want to include in 
the referral letter (for example, Problems, Current Medications, Allergies, or 
Investigations).

b) To include only specific items from a Medical Summary category, expand the category, 
and then select the items you want.    

Tip: Clear any pre-selected Medical Summary check boxes for information you 
want to exclude from the referral letter.

For example, if you select the Current Medications, check box, all of the 
patient’s medications are selected in the expanded list below. You can exclude any 
of the patient’s current medications listed below by clearing the check box beside 
the medication name.
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6. To attach documents to the referral letter:

a) At the top of the Referral Letter Composer window, click Attachment ( ). The EMR 
displays the Attachments window, with a list of files available in the Documents area of 
the patient’s Medical Summary. 

Note: You cannot edit most information in the Referral Letter Composer window 
directly from the Referral Letter Composer window. Instead you must edit the 
information from the source.

For example, you must: 

 Add or edit allergies in the patient’s Medical Summary.

 Edit recipient contact information in the Edit Consultant Information Window.

 Edit patient information in the Patient Maintenance window.

Tip: Items that display in the left pane in blue text are customizable. To customize 
these items, right-click the blue text.

 Referral Detail: You can modify the Primary and CCed consultants, referral 
priority, referral reason, letter text, and current investigations.

 Investigations: You can change the sort order of a patient’s listed 
investigations.

 Other Treatments: You can enter details of the patient’s non-medication 
treatments.
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b) In the Attached column, select the check box beside all documents you want to include 
with your referral letter.

c) When you finish, click Close ( ). The EMR displays the selected document(‘s) 
name(s) in the Referral Detail area in the Referral Letter Composer window.

Note: You can attach only files that are available in the Documents tab of the 
patient’s Medical Summary.

Note: To attach the prenatal form to a referral letter, you must save the prenatal 
form as a PDF in the Medical Summary Documents tab. You can then attach the 
prenatal form as you do other documents.
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7. To preview the referral letter, on the bottom left of the window, select the Letter View check 
box. The EMR displays the letter in the format it will be printed. 

8. To print, fax, or save the referral letter as a PDF:

a) Click Print ( ). The EMR displays the Print Referral window, with the referral 
attachments indicated with selected check boxes.

b) Perform one of the following actions:

Tip: To modify the letter format before it is sent:

1. Click Send to SMART Form ( ). The EMR opens the letter in Microsoft 
Word. 

2. Edit the letter, and then click Save ( ). The EMR saves the edited letter in 
patient’s Medical Summary, in the Documents tab.
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 To send the referral letter to your default printer or fax machine, click Quick Print.

 To select a specific printer or fax machine before printing, click Print.

 To save the referral letter as a PDF file, select the Collate to PDF check box, and then 
click Quick Print. 

9. Click Save & Exit ( ). 

10. Open the patient’s referral from the Referrals tab in Medical Summary window. (If you are 
not in the Medical Summary window, see “Opening a patient’s Medical Summary” on page 
163.)

11. In the Existing Referral window, indicate the status of the referral letter. In the LETTER 
COMPLETED area, select one or more of the following check boxes: 

 LETTER COMPLETED: If you have both written the letter and sent it to the consultant.

 Letter: To indicate that a letter needs to be written, but has not been started or finished 
yet. The EMR adds the patient to the practitioner's Letters to Write list on their 
WorkDesk.

 Typed: Indicates that the contents of the letter have been typed. If this check box is 
selected, the EMR adds the letter to the Practitioner’s Letters to Edit list.

 Printed: To indicate that you have printed the letter.

 Sent: To indicate that you have sent the letter.

12. Click Save & Close Referral ( ).

Referral Letter Composer templates
In the Referral Letter Composer, you can customize which Medical Summary categories are 
pre-selected by default. Default Medical Summary categories can be set for:

 The user who starts the referral letter

Note: If you are printing or faxing the referral letter, ensure that the Collate to PDF 
check box is cleared.

Note: Clinics who do not have stenographers or transcriptionists use only the 
Sent check box.

The other check boxes, for example Typed and Printed, are used to track the 
referral as it is sent back and forth between the stenographer and the practitioner 
for review.
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 Individual consultants whom you refer to

 Specialties of consultants whom you refer to 

To set a Referral Letter Composer template:

1. Start a referral letter for a patient, and in the Referral Letter Composer window, select the 
Medical Summary categories you want to include in the letter template. See “Creating 
referral letters” on page 407. 

2. In the Save Checked Nodes as Template area, click one of the following options in the 
drop-down list:

 User: to indicate that the selected categories are to default for all referral letters that you 
initiate on behalf of this practitioner (or that this practitioner creates).

 Specialty: to indicate that the selected categories are to default only when you refer a 
patient to a consultant with the selected specialty.

 Consultant: to indicate that the selected categories are to default only when you refer a 
patient to the selected consultant.

3. Click Save as Template. 

Tip: After you set default templates for the Referral Letter Composer, you can view 
which template the EMR defaults to for each referral letter you create. The EMR 
displays the Template in Use in the Save Checked Nodes as Template area 
on the Referral Letter Composer window. 
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SMART Form-based referral letters
If you want to include a full medical profile in a referral letter, and you are not attaching any extra 
medical information, other than the medical summary, then you can create the letter using a 
Microsoft Word-based SMART Form.

After initiating a referral, you can automatically populate a SMART Form with the referral 
information. You can then edit the letter using Microsoft Word formatting tools.

Creating a referral letter using a SMART Form

To create a referral letter using a SMART Form:

1. Initiate a referral and complete the New Referral details. See “Initiating referrals” on page 399.

2. On the New Referral (or Existing Referral) window, in the Send to SMART Form area, click 
an appropriate keyword in one or more of the Keyword drop-down lists.

3. To start a referral letter using the clinic’s default SMART Form template, click Send to 

SMART Form ( ). The EMR displays a Microsoft Word-based letter document (SMART 
Form), with the text of your referral letter inserted.

4. To start a referral letter using your own customized referral letter SMART Form:

a) Right-click anywhere in the New Referral (or Existing Referral) window. The EMR displays 
the SMART Menu.

b) On the SMART Menu, click SMART Forms. The EMR displays the Send to SMART 
Form window.

c) In the list of SMART Forms, expand the Letters category.

d) Double click the SMART Form that you want. The EMR displays a Microsoft Word-based 
letter document (SMART Form), with the text of your referral letter inserted.

Note: If you want to create a letter based on a previously started referral:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical 
Summary” on page 163.

2. Click the Referrals tab.

3. In the patient’s list of referrals, double-click the referral you want. The EMR 
opens the referral in the Existing Referral From <Date> window.

Tip: If you select keywords for your referral letter, you can search for your referral 
letter in the patient’s Documents list, using the keywords you select.
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5. Enter your letter text and modify the format of your letter using the various tools available in 
Microsoft Word.

6. To print the referral letter:

a) In the Microsoft Word menu, click File > Print. Microsoft Word displays the print 
properties window.

b) In the printer list, click the printer or fax machine that you want.

Tip: The Referral Letter SMART Form can automatically pull information such as 
patient demographics, and various aspects of the patient’s medical history. You will 
learn how to customize your referral letter later in this module.
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c) Click Print ( ).

7. Click Save ( ), and then click Close ( ). The EMR saves your referral letter in the 
Documents area of the patient’s Medical Summary.   

Customizing your Referral Letter SMART form 

You can create your own customized SMART form referral letters, both for general referrals, or 
for specific types of referrals. For example, you want a referral letter for all cardiology referrals, 
and another for all endocrinology referrals. You can customize a Referral Letter SMART form to:

 Automatically pull information from the patient’s chart, including the patient’s Medical 
Summary 

 Contain headings

 Contain pre-written text

And more... 

For complete instructions on how to customize your referral letter, see the Wolf EMR SMART 
Forms User Guide.

Note: You cannot attach other files or documents to a SMART Form-based 
consult letter as you can when using the Referral Letter Composer. Instead, print or 
fax additional documents separately.

To print or fax attachments with a SMART Form based consult letter:

 On the Documents tab of the patient’s Medical Summary, print or fax each 
document you want to include.

Note: You can create a customized SMART form referral letter for your own use or 
for the entire clinic to use.
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Tracking and managing referrals
You can track and manage new and pending referrals from your WorkDesk. The Referrals area 
contains several links to patient lists, including lists of patients who have:

 letters to transcribe

 letters to print

 referral appointments to be made

 referral notifications (Patients To Notify list)

You can monitor and manage all of your clinic’s un-reconciled referrals from the Referral List. 

You can also view and update a specific patient’s referral information and status in the 
Referrals area of their Medical Summary.

Managing referrals with letters that need to be transcribed

After a practitioner dictates a referral letter and sets the status as Letter and Dictated, the 
EMR adds the letter to your Letters To Transcribe list. You use the letters to transcribe link 
to keep track of letters you need to transcribe, and to indicate that you have typed the letter.

To track and update referrals with letters that need to be transcribed:

1. On the WorkDesk, in the Referrals area, under Referral letters, click <#> letters to 
transcribe. The EMR displays the Letters To Transcribe window. 
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2. Click a patient in the list. The EMR displays the referral details to the right.

3. In the Letter Text field, type the letter. 

4. After you type the letter, perform one of the following actions:

Tip: You can also use the Referral Letter Composer, Word, or a SMART Form to 
type the letter:

 To use the Referral Letter Composer, click Compose Referral Letter ( ).

 To use a Word document, click Run Word ( ).

 To use a SMART Form, click ...edit referral, and then in the Existing Referral 

window, click Send to SMART Form ( ).
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 Select the Typed check box to indicate the letter is ready to be edited. 

 Select the LETTER COMPLETED check box, if you have also printed and/or sent the 
letter.

5. Click Save & Close ( ).

Managing letters that need to be printed or sent

Referral letters that have been marked as Letter, Dictated, Typed, and Edited are ready to 
print and send. The EMR adds these letter to your Letters To Print list. You use the letters to 
print link to keep track of letters you need to print or send, and to indicate that you have printed 
and sent the letter.

To manage letters that need to be printed or sent:

1. On your Workdesk, in the Referrals area, under Referral letters, click <#> letters to 
print. The EMR displays the Letters To Print window. 
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2. In the Letters list, click a patient. The EMR displays the referral details to the right. The 
Linked Documents area lists referral letters that were created using the Referral Letter 
Composer or a SMART Form.

3. In the Linked Documents area, double-click a referral letter. The EMR opens the referral 
letter in the Referral Letter Composer or in Word as a SMART Form.

4. To print the referral letter, perform one of the following actions:

 To send the referral letter to your default printer or fax machine, click Quick Print.

 To select a specific printer or fax machine before printing, Click Print ( ).

5. After you print and/or send the referral letter, select the Printed and Sent check boxes. (You 
can also select the LETTER COMPLETE check box to indicate that all stages of the letter 
are complete.
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6. Click Save & Close ( ).

Indicating that a patient has received a booking date and time for their consult 
appointment 

You use the referral appointments to be made link to track patients who are waiting for 
consult appointments and to indicate that a patient has received a booking date and time for 
their consult appointment.

After you enter the appointment date and time, the EMR removes the patient from your 
Appointments To Be Made list and adds the patient to your Patients To Notify list.

To indicate that a patient has received a booking date and time for their consult appointment:

1. On your WorkDesk, in the Referrals area, click <#> referral appointments to be made. 
The EMR displays the Appointments To Be Made window. 

2. In the left pane, click the patient. The EMR displays the referral details to the right. 

3. In the Appointment Date and Time field, enter the appointment date and time in the 
following format: DD-Mmm-YYYY HH:MM AM/PM.
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4. Click Save & Close ( ). The EMR removes the patient from the Appointments To Be 
Made list and adds the patient to your Patients To Notify list. 

Managing patients who need to be notified of booked appointments

After the patient has received a referral appointment, you indicate when the patient is notified 
about the appointment. The referral notifications link opens the Patients To Notify list. This list 
contains all patients who have an Appointment Date and Time entered into the referral, but the 
patient has not yet been notified. 

Manage patients who need to be notified of booked appointments:

1. On your Workdesk, in the Referrals area, under Referral calls to complete, click <#> 
referral notifications. The EMR displays the Patients To Notify window. 

2. Click a patient in the list. The EMR displays the Referral Notification to the right.  

Note: The EMR also populates the Appt Date/Time field in the patient’s Existing 
Referral.

Note: Patients who have referrals to clinics that call patients directly with booking 
times also display on the Patients to Notify list. You can notify these patients to 
expect a call from the consultant's clinic.
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3. Use the following table to enter information into the Response Log:  

4. Click Save & Close ( ). 

Managing referrals using the Referral List

You can use the Referral List to view and manage outstanding referrals for the entire clinic. You 
can also find a specific patient’s outstanding referrals and then modify the referral's information 
or status. 

To view and manage outstanding referrals:

1. On the WorkDesk menu, click Patients > Referral List. The EMR displays the Detailed List 
of Referrals for All Patients window, with a list of outstanding referrals for all patients. 

Field Description

Pt Notified Click to indicate that you notified the patient. The EMR adds the 
following information to the Response Log: Patient Notified 
(<your name>/MM/DDD/YYYY HH:MM).

Note: After you close the Patients To Notify list, the EMR 
removes the patient from your Patients To Notify list.

Message Left Click to indicate that you called the patient and left a message. 
The EMR adds the following information to the Response Log: 
Message Left (<your name>/MM/DDD/YYYY HH:MM).

No Answer Click to indicate that you called the patient, but there was no 
answer. The EMR adds the following information to the 
Response Log: No Answer (<your name>/MM/DDD/YYYY 
HH:MM).

Custom Response Enter a custom response specific to this entry

Notification Log Enter any notification notes.

Note: If the notification was entered by mistake, select the Cancelled check box. 
After you close the Patients To Notify window, the EMR removes the patient from 
your Patients To Notify list.

Tip: To view a specific patient’s list of outstanding referrals: 

 In the Filter by Patients area, select Specific Patient, and then find and 
select the patient in the Patient Search window. 
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The Referral List displays the following information for each referral:

 Patient

 Patient’s MD

 Date (that referral was created)

 Type (of referral)

 Consultant (name)

 Speciality (of consultant)

 Referral reason

 Consult date (if an appointment is booked)

 Wait (days since referral was initiated)

 Reconciled (status)

 Disposition / Outcome (if available)

2. To re-sort the order of the referral list, click the header of the column you want to sort the list 
by.
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3. If the list of referrals is extensive, you can filter the list using the selections available in the 
Filters for Referral List area. The following table describes the filter options: 

Filter Description

Include Inactive 
Service

To display referrals initiated by a practitioner who is no longer 
active in your clinic, select this check box.

Practitioner To view referrals initiated by a specific practitioner in your clinic, in 
the drop-down list, click the practitioner’s name.

Referral Type To displays only referrals with a specific Referral Type selected, in 
the Referral Type drop-down list, click the Referral Type that you 
want.

Note: All types is selected by default.

Referral Reason To display only referrals with a specific referral reason, enter the 
reason in the Referral Reason field.

Priority To display only referrals with a specific priority level, click either 
Urgent, or Routine in the Priority drop-down list.

Note: All referrals is selected by default.

From Date To limit the displayed referrals to a specific date range, enter the 
earliest date in the From Date field.

To Date To limit the displayed referrals to a specific date range, enter the 
latest date in the To Date field.

Consultant To display only referrals to a specific consultant, click the 
consultants name in the Consultant drop-down list.

Reconciled To display only referrals that are either reconciled or not 
reconciled, click No or Yes in the Reconciled drop-down list.

Note: All referrals is selected by default.

Disp/Outcome To display only referrals that have the same outcome, enter the 
outcome in the Disp/Outcome field.

Specialty To display only referrals that are for a specific Specialty, click a 
specialty in the Specialty drop-down list.

All Patients To display referrals for all patients, in the Filter by Patient area, 
select All Patients.

Note: This option is selected by default.

Specific Patient To display referrals for a specific patient, in the Filter by Patient 
area, select Specific Patient. The EMR prompts you to search 
for the patient.
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4. To view or update a specific referral on the list, double-click the referral. The EMR displays 
the Existing Referral window with all details of the referral displayed.

5. When you finish viewing and managing your referrals, click Close Form ( ).

Managing a patient’s referrals from their Medical Summary

You can view and update a specific patient’s referral information and status in the Referrals 
area of their Medical Summary. 

To view or update a patient’s referral information:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163.

2. Click the Referrals tab. The EMR displays a list of the patient’s outstanding and completed 
referrals.

The Referral List displays the following information for each referral:

 Requesting MD

 Date (that referral was created)

 Type of referral

 Consultant’s name

 Speciality of the consultant

 Referral Reason

 Reconciled status (Yes or No)

Tip: You can enter any updates to the referral on the Existing Referral window.

Note: Any updates you make do not reflect in the Referral List until you close 
and re-open the Detail List of Referrals for All Patients window.
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 Consultation disposition or outcome (if available)

3. To re-sort the order of the patient’s referral list, click the header of the column you want to 
sort the list by.

4. If the patient’s list of referrals is extensive, filter the list:

a) Above the patients referral list, click Show all referrals. The EMR displays the Detail List 
of Referrals window, with the Filters for Referral List area at the top.

b) In the Filters for Referral List area, use the various filters to find the referral(s) you want. 
The table in Step 3.  of “Managing referrals using the Referral List” on page 428 
describes how to use each filter option.

5. To view and or update details of a referral on the list, double-click the referral. The EMR 
displays the Existing Referral window with all details of the referral displayed. 

Reconciling referrals

Depending on your clinics’s workflow, and the consultant you are referring to a referral may be 
considered reconciled:

 After a patient has received an appointment with the specialist

 After the patient has seen the specialist 

 After your clinic receives a report from the specialist

To indicate that a referral is reconciled, enter a date in the Reconcile Date field in the patient's 
referral. 

To reconcile a referral:

1. Open the patient’s referral that you want to reconcile. You can open the referral from the 
Referral list or from the patient’s Medical Summary. See “Managing referrals using the 
Referral List” on page 428 or “Managing a patient’s referrals from their Medical Summary” on 
page 431. The EMR displays the Existing Referral window.

2. In the Reconcile Date field, enter a date to indicate the referral is reconciled.

3. Click Save & Close Referral ( ). The EMR changes the Reconciled status from No to 
Yes. 

Tip: You can enter any updates to the referral on the Existing Referral window.

Note: Any updates you make do not reflect in the Referral tab until you close 
and re-open the Medical Summary window.

Tip: Any updates you make do not reflect in the Referral tab of the Medical 
Summary until you close and re-open the Medical Summary window.
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Managing the external consultant list
You can refer patients only to consultants or clinics that are in your clinic’s consultant list. If the 
consultant you want is not in the consultant’s list, you can add a new consultant as you create 
a referral. 

If you refer to a particular consultant regularly, you can identify the consultant as a favourite. You 
can then quickly select the consultant from your favourite consultants list when you initiate a 
referral.

Adding and editing consultants when creating a referral

If the consultant you want is not available on the consultants list, you can add a consultant 
when you create a referral.

If you find the consultant you want, but see that any of the consultant’s details are incorrect, you 
can also edit a consultant’s details when you create a referral.

Adding a new consultant when you are creating a referral

To add a consultant to your clinic’s consultants list when you are creating a referral:

1. Start a referral. See “Initiating referrals” on page 399.

2. In the Choose Consultant area, click Add New Consultant. The EMR displays the 
ENTER New Consultant window.   
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3. Use the following table to enter the consultant’s information. 

Field Description

Last Name Enter the consultant’s last name.

First Name Enter the consultant’s first name.

Title Enter an appropriate title for the consultant. For example, Dr., Mr., 
Miss. 

Dr. is the default.

General Office Enter the consultant’s office phone number.

Note: You can call this number directly using the TELUS Health 
Mobile App.

Pager Enter the consultant’s pager number

Note: You can call this number directly using the TELUS Health 
Mobile App

Cell/Mobile Enter the consultant’s personal cell phone number.

Note: You can call this number directly using the TELUS Health 
Mobile App

Home Enter the consultant’s home phone number.

Note: You can call this number directly using the TELUS Health 
Mobile App

Fax Enter the consultant’s office fax number.

Prac # Enter the consultant’s Practitioner ID number.

Note: This number is used to identify the consultant when you bill 
for the referral.

Specialty In the Specialty drop-down list, click the consultant’s specialty.

Note: Avoid adding new specialties to the list, unless the entire 
clinic agrees to the addition. This ensures consistency 
when entering and finding consultants.

Address Enter the consultant’s address. If you want to add additional address 
lines, enter this information into the Address (2), and Address (3) 
fields.

City In the drop-down list, click the consultant’s city. If the city you want is 
not available on the list, enter the city name in the City field.

Province The EMR populates the Province field by default.

Organization Enter the consultant’s company or clinic name.

Department Enter the consultant’s department, if applicable.
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4. When you finish, click Save & Close ( ). The EMR adds the consultant to your clinic’s 
consultants list.

Editing a consultant when you are creating a referral

To edit a consultant on the consultant’s list when you are creating a referral:

1. Start a referral and select a consultant. See “Initiating referrals” on page 399.

2. After you select a consultant, click ...info. The EMR displays the Consultant Information 
window.

3. Click ...edit. The EMR displays the Edit Consultant Information window.

4. Edit or add information in the fields as necessary.

5. When you finish, click Save & Close ( ).

Defining your favourite consultants

After you search for and select a consultant for a referral, you can add that consultant to your 
favourites list. The next time you create a referral to the same consultant, you can then select 
the consultant from your favourites list. 

To add a consultant to your favourites list:

1. Initiate a referral, and then search for and select a consultant. See Step 1.  to Step 5.  in 
“Initiating referrals” on page 399.

Email Enter the consultant’s email.

Default Word 
Template

If you have created customized consult letter SMART Forms (for 
example, for specific specialties), enter the name of the SMART 
Form you want to default to for this consultant.

Note: When you click Send to SMART Form on the New 
Referral window, the consult letter SMART form you 
specify here displays.

Notes Enter any notes regarding the consultant, or the consultant’s referral 
policies. For example, “Call before faxing a referral.”

Field Description
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2. In the Manage Favourites area, click Add currently selected consultant to favourite 

list ( ). The EMR displays the Manage Favourite Consultants window, with the selected 
consultant’s name and phone numbers displayed at the top. 

3. In the Specify scope of favourite consultant area, click one of the following options:

 For clinic: The EMR adds the consultant to the Favourite Consultants list of all users in 
the clinic.

 For <your name>: The EMR adds the consultant to your Favourite Consultants list only.

4. Click Save & Close ( ). 

Managing your Favourite Consultants list

When specialists in your area come or go, or when you change your preferred specialists, you 
can easily edit your Favourites list to reflect the changes. You can remove a consultant, or 
change the scope of a consultant on your Favourites list from the New Referral window. 

To manage your Favourite Consultants list:

1. Initiate a referral. See “Initiating referrals” on page 399.

2. In the Choose Consultant area, click From Favourites. The EMR displays your Favourite 
Consultants list.

3. If your list of Favourite Consultants is extensive, and you are having trouble locating the 
consultant you want to delete or modify:

a) In the Search field, enter the consultants name or specialty.
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b) Press Enter. The EMR filters your Consultant Favourites list to display only consultants 
who match your search term. 

4. In the list of favourites, click the consultant you want to delete or modify.

5. In the Manage Favourites area, click Modify favourite consultant list( ). The EMR 
displays the Manage Favourite Consultant window.

6. To change the scope of the favourite, in the Specify scope of favourite consultant area, 
click one of the following options:

 For clinic: The EMR adds the consultant to the Favourite Consultants list of all users in 
the clinic.

 For <your name>: The EMR adds the consultant to your Favourite Consultants list only.

7. To delete the favourite, click Delete consultant from favourites list ( ).

8. Click Save & Close ( ).

eReferrals
You can quickly and securely send electronic versions of referrals using the Wolf EMR eReferral 
messaging system. When you send an eReferral to a consultant, the consultant can open the 
referral in the Referral Letter Composer, import attached patient medical information, and then 
send you a reply through their Wolf EMR. 

You can send eReferrals to consultants who:

 Use Wolf EMR
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 Are set up to receive eReferrals 

Sending eReferrals

To send an eReferral, you start a referral as normal and use the Referral Letter Composer to 
create your letter. When you click Send, the EMR sends the eReferral letter through the secure 
eReferral messaging system, with any attachments that you specified.

To create and send an eReferral:

1. Start a referral as normal. See “Initiating referrals” on page 399.

2. Create the referral letter using the Referral Letter Composer. See “Creating referral letters” on 
page 407.

3. When you finish composing your letter and selecting any attachments, click Send. The 
EMR:

 Displays a dialog box with the following notification: “Sending Message”

Note: If you want to send or receive eReferrals, the eReferral feature must be 
enabled for your clinic. To request access to the eReferral feature, contact the 
TELUS Health EMR Customer Care team using one of the following methods:

 E-mail: accounts.wolfemr@telus.com

 Online Case submission: Available on the Cases page of the Wolf EMR 

Community Portal.

 Phone: 1-866-879-9653 (Option 4)

Important: When you select a consultant for an eReferral, ensure that the 
consultant has an E to the right of their name. The E indicates that the consultant 
accepts eReferrals. 

Note: Consult letters created using SMART forms cannot be sent as eReferrals.
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 Creates a PDF document of the Referral letter and specified attachments, and saves the 
PDF to the Documents tab of the patient’s Medical Summary.

 Sends the referral and attached documents to the consultant.  

4. Click Save & Exit ( ).

Monitoring the status of eReferrals (accepted or declined)

As soon as a consultant’s office accepts or declines your referral, you are notified on your 
WorkDesk. You can view and respond to any accepted or declined eReferrals in the Referrals 
area of your WorkDesk under the headings:

 Incoming Consults: Lists all accepted eReferrals, and eReferrals with new messages and 
attachments from the consultant.

 Declined eReferrals: Lists all declined eReferrals.

Viewing and responding to declined eReferrals

To view and respond to your declined eReferrals:

1. In the Tasks area on your Workdesk, under Incoming Referrals/Consults, click # 
Declined eReferrals (where # = the number of declined referrals). The EMR opens the 
Investigation/Document In Basket window with a list of declined referrals.

2. To view more information about a declined referral, including any messages from the 
consultant, double-click the referral.

3. To respond to the declined referral, click one of the following options:

Note: The consultant views the eReferral in the eReferral Letter Composer (not as 
a PDF document).
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 Redirect: To redirect the declined referral to a practitioner in your clinic.

 To Come In: To assign a task to your Patient to Notify list, and to create a Follow Up 
task for the practitioner.

 Follow Up: To create a Follow Up task for another clinic member that you specify.

 Message: To create a Message for you or for another clinic member that you specify.

Viewing and responding to accepted eReferrals

To view and respond to your accepted eReferrals:

1. In the Tasks area on your Workdesk, under Incoming Referrals/Consults, click # 
Incoming consults (where # = the number of accepted or updated referrals). The EMR 
opens the Investigation/Document In Basket window with a list of accepted referrals 
displayed.

2. To respond to the accepted referral, click one of the following options:

 Redirect: To redirect the referral response to a practitioner in your clinic.

 To Come In: To assign a task to your Patient to Notify list, and to create a Follow Up 
task for the practitioner.

 Follow Up: To create a Follow Up task for you another clinic member that you specify.

 Message: To create a Message for you or for another clinic member that you specify.

Note: If you open a referral in the Referral Letter Composer window, that was 
declined through eReferral, a Status banner displays at the top of the window 
indicating that the referral is declined. The Status area also displays any notes 
included by the consultant’s office.
440 Wolf Front End Staff User Guide - Issue 02.05



Sending and managing referrals
Sending and receiving messages, consult letters, and other documents to and 
from consultants

You can send messages, consult letters, and other documents back and forth to consultants 
through the eReferral Letter Composer.

When you receive eReferral messages or documents from consultants, they display on your 
WorkDesk, in your Incoming Consuls list.

Receiving messages, and other documents 

If, after you send an eReferral, you receive messages or documents from the consultant’s clinic, 
you are notified in the Tasks area of your WorkDesk under Incoming Consults. From here, 
you can view and respond to messages. The EMR attaches messages and attachments to the 
original referral.

To view messages and attachments regarding an eReferral:

1. In the Tasks area of your WorkDesk, under Incoming Referrals/Consults, click # 
Incoming Consults (where # = the number of your accepted referrals and referrals with 
new messages and/or attachments). The EMR opens the Investigation/Documents In-
basket.

Note: If you re-open a referral in the Referral Letter Composer window, that was 
accepted through eReferral, a Status banner displays at the top of the window 
indicating that the referral is accepted. The Status also displays any notes 
included by the consultant’s office.
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2. In the list of pending and updated eReferrals, double-click the eReferral. The EMR displays 
the eReferral in the Referral Letter Composer window, with any messages from the 
consultant displayed under Other Treatments.

3. To view any new attachments from the consultant (for example, a consult letter), click 

Attachment ( ). The EMR displays the Attachment window.

4. Respond to the message if needed. See “Sending messages, and other documents” on 
page 442.

5. When you finish, click Exit ( ).

Sending messages, and other documents

Through the Referral Letter Composer, you can send consultants messages and additional 
documents after you send the original eReferral.

To send messages, and documents to a consultant’s clinic:

1. Open the patient’s Medical Summary.

2.  Click the Documents tab.

3.  In the patient’s list of documents, double-click the eReferral. The EMR displays the referral in 
the Referral Letter Composer window.

4. At the top of the eReferral Letter Composer window, click Create Reply ( ). The EMR 
opens the Referral Letter Composer in send mode.

5. If you want to send a message to the consultant, enter the message as an Other Treatment:

a) In the left pane, select the Other Treatments check box.
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b) Right-click the Other Treatments tag (in blue), and then click Properties. The EMR 
displays the Description window.

c) In the Comments area, enter your message, and then click OK.

6. If you want to send a document to the consultant:

a) Click Attachment ( ). The EMR displays the Attachments window, with a list of files 
available in the Documents area of the patient’s Medical Summary.

Note: You can attach only files that are available in the Documents tab of the 
patient’s Medical Summary.

You can attach letters, growth charts, prenatal records, and WCB forms only if they 
are saved as documents in the patient’s record.
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b) In the Attached column, select the check box beside all documents you want to send.

c) Click Close ( ). The EMR displays the selected document(‘s) name(s) in the 
Referral Detail area on the Referral Letter Composer window.

7. On the Referral Letter Composer window, click Send. 

The EMR sends a notification to the consultant. 

Note: The consultant receives the notification in their Incoming Referrals list. 

When the consultant opens the referral, any messages you entered display under 
Other Treatments.
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Chapter 12
Tracking and managing incoming referrals 
(Specialists)
In this module you learn how to track, manage, and respond to incoming referrals in Wolf EMR. 
Depending on your clinic’s processes you may receive referrals through fax, mail, eReferral, or 
through a combination of these methods. No matter how referrals are received, you can track 
incoming referrals using:

 Incoming Referrals list

 Messages

 Patient lists

Using SMART forms, you can send notifications to referring clinics. Using messages, you can 
track calls made in response to referrals.

Linking incoming referrals to patients
When you receive an incoming faxed or mailed (scanned) referral, your fist step is to link the 
document to a patient record (similar to how you link other documents to patients) and assign 
Incoming Referral as the Document Type. If the patient is not yet added to your system, you 
can add the patient as you are linking the document.

After you define a referral document as an Incoming Referral, the referral displays in the 
provider's Incoming Referrals list.  

To link an incoming referral to a patient:

1. On the Wolf EMR Launch page, click Documents ( ).The EMR displays the Documents 
window.

2. Link the referral letter to a patient as you do other documents. See “Linking documents to 
patient records” on page 374. The following exception applies to referral letters:

 In the Document Type drop-down list, select Incoming Referral.

Note: If you do not define the document as an Incoming Referral, the referral 
letter displays in the practitioner’s New Documents list.
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3. If the patient is not yet in your system, you can add the patient from the Documents window:

a) In the Patient Search area, click Advanced, and then click New Patient ( ) or, on 
your keyboard, press F9.

b) In the Patient Maintenance window, enter the patient’s information. See “Adding patients” 
on page 9.

c) In the Documents window, search for and select the added patient.

4. When you finish entering information in the Documents window, click Link Only. The EMR 
adds the referral to the Incoming Referrals list, and the provider can now review and 
respond to the referral.

Viewing and responding to accepted, declined, and “need more 
information” referrals

When you link a referral letter to a patient’s record, the provider is notified on their WorkDesk via 
the Incoming Referrals list. The provider can then view and respond to the referral. When the 
provider responds to the referral, you receive a message indicating if the referral is accepted, 
declined, or requires more information. From the message, you can perform a number of 
actions.

To view and respond to your referral-related messages:

1. On your WorkDesk, in the Messages area, double-click the message. The EMR displays 
the message details. See “Viewing your messages” on page 337.

2. From the message, you can perform one or more of the following actions:

 Modify the patient’s demographic information (for example, if the provider declined the 
referral, you can change the patient’s Status to Inactive): On the message, in the SMART 

patient banner, click View patient demographic information ( ). See “Managing 
declined referrals” on page 452.

Tips for adding referred patients:

 In the Patient Maintenance window, ensure you record the patient’s referring 
provider, and the referral expiry date.

 If the referring provider you want is not on the consultants list, you can add 
the referring provider to the consultants list from the Appointment Scheduler:

1. On the Appointment Scheduler menu, click Configure > New Referral 
Consultant (Quick Add).

2. Enter the referring provider’s information, and then click Save.
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 Add the patient to a patient list (appointment waiting list). See “Tracking referred patients 
using Patient Lists” on page 447.

 Record any calls made or notifications sent to the referring clinic or patient. See 
“Recording what notifications have been sent to referring clinics” on page 452.

Tracking referred patients using Patient Lists
Wolf EMR patient lists are running lists of patients, where you manually add, remove, and 
restore patients as needed. You can use patient lists to track patients waiting for appointment 
bookings, and to track patients at different stages in the referral process.

For listed patients, you can:

 Enter notes

 Assign a category and priority

 Book an appointment. See “Booking an appointment for a patient on a patient list” on page 
118.

 Search for patients and view information such as the number of days the patient has been 
on the list and if the patient is overdue or near-due for an appointment booking. See 
“Viewing patient lists” on page 112.

When you book a patient who is on a list for an appointment, you can choose to remove the 
patient from the patient list automatically. 

Your clinic can create as many patient lists as you want, and tailor the lists to suit your referral 
workflow. For example, you can have an appointment waiting list for Priority 2 patients, an 
appointment waiting list for Priority 3 patients, a cancellations list, a list tracking patients who 
have been called (with no answer), and so on.
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Adding patients to referral-related patient lists

You can add a patient to a patient list either from the Appointments Scheduler or from the 
Patient Maintenance window. Most often, you add a patient to a waiting list after you receive a 
provider’s response message to the referral. For example, the provider sends a message 
indicating that the referral is accepted and that the patient is a Priority 2. You can then add the 
patient to your Priority 2 waiting list from the message itself (via the Patient Maintenance 
window).

To add a patient to a patient list:

1. Perform one of the following actions:

 If you are adding a patient to the waiting list in response to a message, from the message 
open the patient’s Patient Maintenance window: On the message, in the SMART patient 

banner, click View patient demographics information ( ) or, on your keyboard, 
press F9.

 If you do not have a patient message open, on the Appointment Scheduler, in the 
Patient Search area, search for and select a patient.

2. On your keyboard, press Ctrl+ G. The EMR displays the Assigned Lists window for the 
patient.

3. Enter the patient’s list information, and then close the window. See “Adding patients to 
patient lists” on page 110.
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Sending and recording notifications to referring clinics and patients
Depending on your clinic’s workflow for managing incoming referrals, you may notify the 
referring clinic when:

 You receive the referral 

 You require additional patient information before the referral can be accepted

 The referral is accepted or declined

 An appointment is booked

If you send notifications via fax, you can fax a letter using a SMART form. 

You can track that you have sent notifications and updates to a clinic by updating the original 
message or follow-up task sent by the provider in response to the referral. In a patient 
message, you can document that the clinic was called and what was said.

Sending notifications to referring clinics

You can use SMART form letter templates to send referral notification letters to referring clinics. 
When a SMART form letter is sent, it is saved in the patient’s Medical Summary, in the 
Documents tab. This way, you can track what letters were sent and when. You can also re-
send a letter if needed.

To send a notification using a SMART form letter template:

1. On any window related to a patient’s record (for example, the Medical Summary window or 
Vital Entry window), right-click and then, in the SMART menu, click SMART Forms. The 
EMR opens the Send to SMART Form window.

Tip: You can start a SMART form letter right from a patient message via the 
SMART menu (right-click menu). For example, if a provider sends you a message 
indicating that the referral is rejected, you can create a rejection letter right from the 
message.
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2. In the list of SMART forms, expand the Letter category, and then click the letter template 
you want to use. The EMR displays the selected letter template on the right side of the 
window.

3. If the SMART form is programmed to pull information from the patient's record, but the 
information is not available in the current patient's record, the EMR displays a dialog box 
similar to the following.
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and then displays the SMART Form Data tab, where you can enter the missing data.

Enter the missing data in the fields provided, or, to produce the SMART form without the 
missing data, select the Allow Incomplete Data check box.

4. If the SMART form contains an electronic signature, the EMR displays a dialog box with a 
prompt similar to the following.

To insert your signature, click Yes.

5. Click Send and Close ( ) or, in the list of SMART forms, double-click the form. The 
EMR opens the letter in Microsoft Word, with some of the patient and provider’s information 
populated.

6. Enter or modify information in the letter as needed.

7. To save the letter, click Save ( ), or press Ctrl + S. The EMR saves the completed 
SMART form in the Documents tab of the patient’s Medical Summary.
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8. To print or fax the letter, in the Microsoft Word menu, click File > Print.

Recording what notifications have been sent to referring clinics

When a provider responds to an incoming referral, you receive a message. In the message’s 
Log and Notes areas, you can record any phone calls you made or messages you left with the 
patient and/or referring clinic. You can also create numerous follow up tasks from the message. 
See “Managing your messages and follow-up tasks” on page 337.

When you have completed your tasks for the accepted or rejected referral, you can then 
Complete the message. The message and all actions you documented in the message are 
saved in the patient’s record.

Managing declined referrals
When you decline a referral, you first notify the referring clinic and/or patient (see “Sending and 
recording notifications to referring clinics and patients” on page 174). You can then change the 
patient’s status to inactive. It is important that you deactivate the patient so that they do not 
appear as part of the provider’s panel.

To change a patient’s status to inactive:

1. Open the patient’s Patient Maintenance window, and then click the Patient Status tab.

2. Click New Status.

3. In the Status drop-down list, select an inactive-type status.

4. (Optionally) Enter a Reason and any Notes regarding the status change.

5. Click Save Status.

Recording that letters have been faxed

When you fax a notification letter, you can record that the letter was successfully 
faxed in the SMART form Document properties:

1. Open the patient’s Medical Summary, and then click the Documents tab.

2. In the Documents list, click the SMART form letter, and then click View 
Document Properties.

3. In the Document Properties window, in the Notes area, enter “Letter faxed” with 
the date and time.

Note: The Status options are customized by your clinic. For example, you may 
have an inactive status called “Refused” or “Declined”.
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Monitoring incoming referrals
You can view incoming faxed or mailed referrals and eReferrals from the Incoming Referrals 
link on your WorkDesk.   

To view incoming Referrals:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. In the Referrals area, click <#> Incoming Referrals (where # = the number of new 
Referrals (This number includes faxed or mailed referrals with the Document Type of 
Incoming Referral, and eReferrals). The EMR opens the Investigation/Documents In-
basket window a list of un-reviewed incoming referrals displayed.

3. To review incoming referrals for a specific practitioner, in the Practitioner drop-down list, 
click the practitioner’s name.

4. To filter the list of documents, use one or more of the filter options described in the following 
table:

Note: You must select Incoming Referral as the Document Type on incoming 
faxed or mailed referral documents for them to display in the Incoming Referrals list.

Filter option Description

New (default 
selection)

Select this option to display only new incoming referrals that are not 
marked as Reviewed.

Reviewed Select this option to display only reviewed incoming referrals.

All Documents Select this option to display both new and reviewed incoming 
referrals.
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5. In the list of incoming referrals, double-click a referral. The EMR displays the referral in: 

 The PDF x-Change viewer: If the referral came in the form of fax or mail (scan).

 The Referral Letter Composer window: If the referral is an eReferral. 

eReferrals
Using the TELUS Health eReferral feature, other clinics can send you referrals directly from their 
EMR. Incoming eReferrals appear in your Incoming Referrals list along with your faxed and 
mailed referrals.

With eReferrals, you can:

 Import a patient’s medical information into your EMR

 View and import referral attachments into your EMR

 Accept, or reject a referral at the click of a button, with the referring clinic being notified 
immediately. Your front end staff does not have to call or send a letter to the referring clinic.

 Send messages and documents to, and respond to messages from, the referring clinic.

 Link the referral to an appointment.

Search 
Keywords

Enter word(s) in the Search Keywords field and press Enter. The 
EMR displays only incoming referrals containing the word(s) you 
entered in the Search Keywords field.

Date Select this check box and enter a date or click the Calendar icon 

( ) to select a date. The EMR displays incoming referrals for that 
date. 

Patient Select this check box and Search for a patient. Use the Patient 
Search window or select a patient name from the list of documents. 
The EMR displays incoming referrals only for that patient. 

Note: If you want to send or receive eReferrals, you must be enabled to do so. To 
request access to the eReferral features, contact the TELUS Health EMR 
Customer Care team using one of the following methods:

 E-mail: accounts.wolfemr@telus.com

 Online Case submission: Available on the Cases page of the Wolf EMR 

Community Portal.

 Phone: 1-866-879-9653 (Option 4)

Filter option Description
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Opening and viewing eReferrals

To open and view an Referral:

1. Open the referral as you do for regular referrals. See “Monitoring incoming referrals” on page 
453. The EMR displays the eReferral and any associated attachments and medical 
information in the eReferral Letter Composer window.

2. To view attachments that came with the referral, click Attachment ( ). The EMR 
displays the Attachment window.

3. Complete one of the following actions:

 To close the eReferral without responding, click Exit ( ).

 To redirect the eReferral to another practitioner in your clinic, see “Redirecting eReferrals” 
on page 456.

 To accept the eReferral, see “Accepting eReferrals” on page 456.

 To decline the eReferral, see “Declining eReferrals” on page 458.

 To request more information, see “Requesting more information from the referring 
practitioner” on page 459.
Wolf Front End Staff User Guide - Issue 02.05 455



Tracking and managing incoming referrals (Specialists)
 To send a message back to the clinic (without accepting or declining the eReferral), see 
“Sending messages, and documents” on page 461.

Responding to eReferrals

You can accept or decline an eReferral and the referring clinic is notified immediately. You do 
not have to call or send a letter to the referring clinic to let them know about the status of the 
referral. Through your EMR you can also send a message to the referring clinic, for example, to 
request more information about the patient, or you can redirect an eReferral to another 
practitioner in your clinic.

Redirecting eReferrals

A practitioner may receive a consult request, but does not have the availability to accept the 
referral. However, if another practitioner in your clinic has room to take the patient, you can 
redirect the referral to them. When you redirect a referral, the EMR moves the referral to the 
other practitioner’s Incoming Referrals list and removes the referral from the practitioner’s 
Incoming Referrals list who first received the referral.

To redirect an eReferral:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. In the Referrals area, click <#> Incoming Referrals. The EMR opens the Investigation/
Documents In-basket window a list of un-reviewed incoming referrals displayed.

3. Click a referral in the list.

4. Click Redirect. The EMR displays the Select Service Provider window.

5. Click the practitioner’s name who you want to redirect the referral to.

6. Click OK. The EMR moves the referral to the Incoming Referrals list of the practitioner you 
specified. The EMR adds the following note to the referral “Redirected by <your name> on 
<date>”.

Accepting eReferrals

To accept an eReferral:

1. Open and view the referral. See “Opening and viewing eReferrals” on page 455.

2. On the top of the Referral Letter Composer window, click Accept ( ). The EMR 
displays the Accept Referral window.
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3. In the Notes field, enter a message to the referring practitioner if desired

4. Click OK. The EMR displays an Accepted status header both on your view and on the 
referring practitioner’s view in the Referral Letter Composer.

5. Click Create Reply ( ). The EMR opens the eReferral Letter Composer in Send mode.
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6. Click Send ( ). The EMR sends your response to the referring practitioner’s Incoming 
Consults list. The EMR displays an Accepted status header on the referring practitioner’s 
view of the Referral Letter Composer. 

Declining eReferrals

To decline an eReferral:

1. Open and view the referral. See “Opening and viewing eReferrals” on page 455.

2. On the top of the Referral Letter Composer window, click Decline ( ). The EMR displays 
the Decline Referral window.

3. In the Reason drop-down list, click your reason for declining the referral, or if the reason you 
want is not available in the Reason drop-down list, enter the reason.

4. In the Notes area, enter a message to the referring practitioner if desired

Important: You must create a reply when you accept an eReferral, in addition to 
clicking Accept. This way, the referring clinic receives a notification. If you do not 

click Create Reply ( ) and enter a message, the referring clinic does not 
receive a notification regarding the accepted eReferral.
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5. Click OK. The EMR:

 Displays a Declined status header in your Referral Letter Composer window. 

 Sends your response to the referring practitioner’s Declined eReferrals list. 

 Displays a Declined status header on the referring practitioner’s view of the Referral 
Letter Composer. 

Requesting more information from the referring practitioner

You can send messages to the referring practitioner if needed. For example, if a referring 
practitioner has not attached enough information for you to accept the referral, you can request 
more information from the referring practitioner.

To request more information from the referring practitioner:

1. Open and view the referral. See “Opening and viewing eReferrals” on page 455.

2. On the top of the Referral Letter Composer window, click Accept ( ). The EMR displays 
the Accept Referral window.

3. In the Notes area, enter a message to the referring practitioner, detailing what information 
you require.

4. Click OK. The EMR:

 Displays an Accepted status header both on your view and on the referring practitioner’s 
view of the Referral Letter Composer, with your message requesting more information 
displayed. 

 Sends a notification to the referring practitioner. This notification displays in the referring 
practitioner’s Incoming Consults list.
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Importing a patient’s clinical information from an eReferral

If the referring clinic attaches clinical information such as the patient’s problem list, family history, 
current medications, and allergies to an eReferral, you can import this clinical information 
directly into the patient’s Medical Summary in your EMR. Also, if the referring clinic attaches 
documents such as diagnostic imaging reports, WCB reports, or prenatal records, you can 
import these documents into the Documents tab of the patients Medical Summary.

To import the patient’s clinical data into your EMR at a later time:

1. Open the eReferral:

 If you are viewing and responding to the eReferral for the first time, see “Responding to 
eReferrals” on page 456.

 If you are importing the patient’s medical information at a later time (for example, during 
the patient’s first visit):

a) Navigate to the Documents tab of the patient’s Medical Summary.

b) In the patient’s list of documents, double-click the eReferral. The EMR displays the 
referral in the Referral Letter Composer window.

2. On the top of the Referral Letter Composer window, click Import ( ). The EMR displays 
the Import Patient Clinical Data window, with a list of clinical information that the referring 
clinic attached to the referral. 

3. Select the check box beside items you want to import into the patient’s chart.

4. Click Import ( ). The EMR does the following:
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 Displays a dialogue box with the following message: “# records saved to the database 
successfully” (where “#” = the number of imported items).

 Imports the selected clinical data into the appropriate areas of the patient’s Medical 
Summary. 

Sending messages and documents back and forth to referring practitioners

You can send messages, consult letters, and other documents back and forth to referring 
clinics through the eReferral Letter Composer.

Sending messages, and documents

To send messages, and documents to the referring clinic:

1. Open the eReferral:

a)  Navigate to the Documents tab of the patient’s Medical Summary.

b) In the patient’s list of documents, double-click the eReferral. The EMR displays the 
referral in the Referral Letter Composer window.

2. At the top of the eReferral Letter Composer window, click Create Reply ( ). The EMR 
opens the eReferral Letter Composer in send mode.

3. If you want to send a message to the referring clinic, enter the message as an Other 
Treatment:

a) In the left pane, select the Other Treatments check box.

b) Right-click the Other Treatments tag (in blue), and then click Properties. The EMR 
displays the Description window.

Note: The EMR does not import any Encounters attached in the eReferral into the 
patient's Medical Summary.
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c) In the Comments area, enter your message, and then click OK.

4. If you want to send a document to the referring clinic:

a) Click Attachment ( ). The EMR displays the Attachments window, with a list of files 
available in the Documents area of the patient’s Medical Summary.

b) In the Attached column, select the check box beside all documents you want to send.

c) Click Close ( ). The EMR displays the selected document(‘s) name(s) in the 
Referral Detail area on the Referral Letter Composer window.

Note: You can attach only files that are available in the Documents tab of the 
patient’s Medical Summary.

You can attach consult letters, prenatal records, and WCB forms only if they are 
saved as documents in the patient’s record.
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5. On the Referral Letter Composer window, click Send. 

The EMR sends a notification to the referring practitioner. 

Receiving messages, and other documents 

If, after you receive an eReferral, you receive other related messages or documents from the 
referring clinic, you are notified in the Tasks area of your WorkDesk under Incoming Referrals. 
From here, you can view and respond to messages. The EMR also attaches the messages and 
attachments to the original referral.

To view messages and attachments regarding an eReferral:

Note: The referring practitioner receives the notification in their Incoming 
Consults list. 

When the referring practitioner opens the referral, any messages you entered 
display under Other Treatments.
Wolf Front End Staff User Guide - Issue 02.05 463



Tracking and managing incoming referrals (Specialists)
1. In the Tasks area of your WorkDesk, in the Referrals area, click # Incoming Referrals 
(where # = the number of your pending incoming referrals and referrals with new messages 
and/or attachments). The EMR opens the Investigation/Documents In-basket.

2. In the list of pending and updated eReferrals, double-click the eReferral. The EMR displays 
the eReferral in the eReferral Letter Composer window, with any messages from the referring 
practitioner displayed under Other Treatments.

3. To view any new attachments, click Attachment ( ). The EMR displays the Attachment 
window.

4. Respond to the message if needed. See “Sending messages, and documents” on page 
461.

5. When you finish, click Exit ( ).

Linking an eReferral to an appointment

You can link an eReferral to an upcoming booked appointment. Then during the appointment, if 
the practitioner is using the Consult Letter Examination form, they can click the Respond to 
eReferral link to quickly access and reply to the eReferral.

To link a referral to an appointment:

1. Open the Documents tab of the patient’s Medical Summary.

2. In the list of documents, click the eReferral.

3. Click View Document Properties. The EMR displays the Document Properties window.
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4. In the Link to Appointment drop-down list, click the appointment that you want to link the 
document to. 

5. Click Save and Close ( ).

Note: You can only link a referral to an appointment if you have already booked the 
appointment. If you have not booked the appointment, the appointment will not 
appear in the drop-down list.
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Chapter 13
Medications and prescriptions
In this chapter, you learn how to record a patients medications in the Medical Summary. You 
also learn how to manage prescription refill requests from pharmacies, and how to manage the 
pharmacy list.

Adding medications to a patient’s Medical Summary
The following sections explain how to add medications to a patient’s Medical Summary using 
two different methods:

 Adding medications using the New Medications window

 Adding medications using the Quick Entry Form 

Workflow examples of when you would add medications include:

 When a new patient joins the clinic, you would enter the patient’s current medications.

 When an external practitioner prescribes a medication for a patient, you would add that 
medication as a reference. 

Adding medications using the New Medications window

The following sections describe the main steps you would perform to add medications using 
the New Medications window:

 Opening the Add New Medications window

 Searching for and selecting the medication to add

 Entering medication details 
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Opening the Add New Medications window 

You can also open the Add New Medications window from the Current Medications area in 
the patient’s Medical Summary; simply double-click <<Add New Medication>>.

To open the Add New Medications window:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary”. The 
EMR displays the Medical Summary window with the Current Hx tab open.

3. In the Current Medications area, double-click <<Add New Medication>>. The EMR 
opens the Add New Medications window. 

Searching for and selecting a medication to add

To search for and select a medication to add:

Tip: You can use the SMART Menu to open the Add New Medications window: 

 On any window related to the patient (for example, the Medical Summary 
window or Vital Entry window) right-click and then, in the SMART menu, click 
Enter New Medication.
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1. Open the Add New Medications window. See “Opening the Add New Medications window” 
on page 468.

2. In the Search field, enter the name or partial name of a medication, and then on your 
keyboard, press Enter. The EMR displays a list of medications in the bottom pane.     

3. In the medication list, click the medication you want. The EMR displays the medication name 
in the blue RX field.

Entering medication details 

After you select the medication you want to add, the EMR usually pre-populates the Dosage, 
Units, Frequency, Route, Duration, and Date Prescribed fields. You can edit these fields if 
necessary. 

Best Practice: If you are not sure how to spell a particular medication name, then 
in the Search field, enter only the first three or four letters of that name.

This Best Practice saves time and minimizes the chance of spelling errors.

Tips for searching for medications:

 By default, the EMR displays a list of medications that contain the letters or 
words you entered in the Search field. To view a list of medications that start 
with the letters or words you entered in the Search field, select the Starts with 
option.

 Wolf provides an enhanced search where you can add a second or third string 
to the search. For example, to search for amoxicillin in capsule form, select 
CAP in the Dose form drop-down list. The search results return all amoxicillin 
options available in capsule form.

 To exclude generic medication names from the search results, clear the 
Include Generic check box.

 To include over-the-counter medications in the search results, select the 
Include OTC check box.

 To include intravenous medications in the search results, select the Include IV 
check box.

 If there are several medications in the search results with the same name, this 
means that there are various dosage types available for that medication. To 
view the dosage type and size: In the medication list, click the medication 
name, then hover your curser over the medication name. The EMR displays the 
dosage type and size as a pop-up message.
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You can also associate the medication with a medical problem. After you make this association, 
when you view the details of the problem, the EMR displays the medication in the Medications 
For This Problem area.

To enter medication details:

1. Open the Add New Medications window. See “Opening the Add New Medications window” 
on page 468.

2. Search for and select the medication you want to add. See “Searching for and selecting a 
medication to add” on page 468.

3. Edit the Dosage, Units, Frequency, Route, Duration, and Date Prescribed fields if 
necessary.

4. If the medication is an anti-coagulation medication that requires regular INR testing, select 
the Anticoagulant check box. 

5. To associate the medication with a medical problem, in the Problems drop-down list, click a 
problem. You can also add a new problem by clicking <Add New>.

6. Perform one of the following actions:

 If you want to add another medication, click Enter New Medication ( ), and then 
repeat Step 1.  to Step 6. .

 If you are finished adding medications, click Save and Close ( ). The EMR adds the 
medication(s) to the patient’s Current Medications list in their Medical Summary. 

Adding medications using the Quick Entry Form 

You can access the Quick Entry Form by clicking the Quick Entry button on your WorkDesk. 
The Quick Entry method can be the quickest way to add a new medication, as you have less 
information to enter. After you select a medication to add, the EMR populates many of the fields 
with default values (although you can change these fields or leave them blank if you want). 

To add a medication using the Quick Entry method:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. Click Quick Entry. The EMR opens the Patient Search window.

Note: One of the limitations of the Quick Entry form is the lack of additional levels 
of search criteria. For example, if you need to enter a specific dose form, it may be 
quicker to add the medication in the Add New Medication window, as you can filter 
by Dose form.
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3. Search for the patient and then double-click the patient’s name. The EMR displays the Quick 
Entry Form window.

4. Click the Medications tab.

5. In the Search field, enter the name or partial name of a medication, and then on your 
keyboard, press Enter. The EMR displays a list of medications in the lower pane.

6. In the medication list, click the medication you want. The EMR displays the medication name 
in Rx field in blue text and also displays the medication details fields.

7. (Optional) Edit the Dosage, Units, and Frequency fields if necessary.

8. (Optional) To associate the medication with a medical problem, in the Problems drop-
down list, click a problem. You can also add a new problem by clicking <Add New>.

9. (Optional) In the Default Pharmacy drop-down list, click the main pharmacy that the 
patient uses.

10. Click Select >>. The EMR adds the medication to the Current Medications list.

11. Perform one of the following actions:

 If you want to add another medication, repeat Step 5.  to Step 11. .
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 If you are finished adding medications, click Close and Save ( ). The EMR adds the 
medication(s) to the patient’s Current Medications list in their Medical Summary. 

Managing prescription refill requests from pharmacies
The following sections explain how to:

 Send a prescription refill request to a practitioner

 Manage pharmacy callbacks using the Pharmacies to Call list

 View the Refill Log

 Reprint a prescription 

Sending a prescription refill request to a practitioner 

You can send a prescription refill request to a practitioner from your WorkDesk. When you 
create a refill request with the status of Pending, the practitioner receives a notification on their 
WorkDesk to approve the refill. The refill request appears on the practitioner’s WorkDesk on the 
Tasks tab under the heading Refill Requests.

To send a prescription refill request to a practitioner:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk.

2. In the Data Entry area, click Refill Request. The EMR opens the Patient Search window.

3. Search for the patient and then double-click the patient’s name. The EMR displays the 
Medication Refills window. 
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4. In the Pharmacy drop-down list, click the pharmacy that called to request a refill for the 
patient.

5. In the Medications list, click the requested medication to refill. The Refill History area 
displays refill information for the medication.  

6. Click Refill. The EMR displays the Prescriptions window. 

7. Enter the Quantity and then ensure that Duration and Start Date are appropriate.

8. Click Close and Save ( ). The EMR displays a window prompting you to confirm that 
you want to save the prescription. 

9. Click Yes. The EMR displays a window asking you if you want to print the prescription.

10. Perform one of the following actions:

 If you want to print the prescription for the practitioner to sign, click Yes.

 If you do not want to print the prescription, click No.

Tip: If you do not see the requested medication in the list, you can click ( ) to 
add the medication to the list.
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The EMR returns you to the Medication Refills window.

11. Click Close Form. ( ). 

Managing pharmacy callbacks using the Pharmacies to Call list

After you send a refill request to a practitioner, you must wait until they approve the refill before 
you call the pharmacy. You can keep track of which pharmacies to call using the Pharmacies to 
Call list. The pharmacies to call link on your WorkDesk displays the number of pharmacies 
you need to call. Click the pharmacies to call link to open the Pharmacies to Call list to see 
which refill requests are approved.

To manage pharmacy callbacks using the Pharmacies to Call list:

1. On your WorkDesk, in the Clinic Tasks area, click <#> pharmacies to call (where # = the 
number of pharmacies you need to call). The EMR displays the Pharmacies to Call list. The 
Pharmacies To Call area lists all pharmacies that have patients who require prescription 
callbacks.

2. Under the Pharmacies To Call area, click a pharmacy name. The Prescription Refills 
pane to the right displays the patients requiring refills and their prescription information. The 
status of the refill request appears in red text. A status of Okayed, means the practitioner 
has approved the refill request. 

Tip: You can click the Edit/Print button to return to the Prescription screen and 
edit or print the prescription.
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3. If the status of the refill is Okayed, call the pharmacy to refill the prescription and then click 
Done. The EMR removes the patient from the list and indicates the patient was called in the 
Refill Log. 

4. Click Close ( ). 

Viewing and updating the Refill Log

The Refill Log lists all refill requests in the last four days. You can view the status of the refill 
requests and indicate if the pharmacy was called.

To view and update the Refill Log:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk. 

2. In the Clinic Tasks area, click Refill Log. The EMR displays the Refill Log.
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3. To indicate that you called the pharmacy, select the check box beside Not Called. The 
EMR changes Not Called to Called.

4. When you are finished, click Close ( ). 

Reprinting a prescription 

To reprint a prescription:

1. Open the patient’s Medical Summary. See “Opening a patient’s Medical Summary” on page 
163.
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2. Right-click anywhere in the patient’s Medical Summary, and then click Refill Medications. 
The EMR displays the Prescriptions window. 

3. In the Default Pharmacy field at the top of the window, click the pharmacy that the 
prescription will be going to. This Pharmacy will be automatically selected when you print 
prescriptions in the future for this patient. 

4. In the Medications list, click the medication for the prescription you want to reprint.

5. Click the calendar icon beside the Rx Date field and then double-click a date in the 
calendar.

6. In the Prescribing MD field, click a practitioner’s name.

7. Click Quick Print.

8. Save and Close ( ).

Note: You can select a Default Pharmacy only if Pharmacies are configured in the 
EMR.
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Managing the pharmacy list
The pharmacy list is a handy reference of all of the pharmacies that your clinic uses. You can 
access this list to look up pharmacy contact information, such as a fax number. You can also 
add a pharmacy to the list or edit the information for a pharmacy on the list if necessary. 

Adding a pharmacy to the pharmacy list

To add a pharmacy to the pharmacy list:

1. On the WorkDesk menu, click Reference > Pharmacy/Facility List. The EMR displays 
the Facility Information window.

2. In the Facility Type drop-down list, click Pharmacy. The EMR changes the Choose 
Facility drop-down list to the Choose Pharmacy drop-down list.

3. Click Add ( ). The EMR displays an empty pharmacy form. 
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4. Enter the pharmacy’s information. At minimum, enter information in the Name, City, and 
PhFax (fax number) fields.

5. Perform one of the following actions:

 To add another pharmacy, click Add ( ). 

 If you are finished adding pharmacies, click Close and Save ( ). 

Viewing and editing a pharmacy on the pharmacy list

To view and edit a pharmacy on the pharmacy list:

1. Open your WorkDesk: On the Wolf EMR Launch page, on the Wolf Programs menu bar, 
click WorkDesk. 

2. On the WorkDesk menu, click Reference > Pharmacy/Facility List. The EMR displays 
the Facility Information window.

3. In the Facility Type drop-down list, click Pharmacy. The EMR changes the Choose 
Facility drop-down list to the Choose Pharmacy drop-down list.
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4. In the Choose Pharmacy drop-down list, click the pharmacy that you want to view or edit. 

The EMR displays the pharmacy information. 

5. Edit the information as necessary and then click Close and Save ( ).
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Chapter 14
Patient billing
This chapter introduces you to patient billing for uninsured services. You learn how to create a 
bill, how to record a payment (or a partial payment), and how to reverse a payment.

Creating a bill for a patient 
To create a bill for a patient:

1. On the Wolf EMR Launch page, click Billing ( ). The EMR displays the Billing window.

2. In the practitioner drop-down list (located in the top left corner), click a practitioner.

3. If you are creating a bill for a day other than today, click Calendar, and then click the Service 
Date.

4. Click New Bill. The EMR displays the Patient Search window.

5. Search for the patient and then double-click the patient’s name. The EMR displays the 
patient’s name in the New Bill Patient field.

6. In the Bill To drop-down list, select Patient, if not already selected. 

7. Use the following table to enter information in the rest of the fields.

Tip: This module covers only basic information about billing patients directly. For 
detailed information on billing in Wolf EMR, see the Wolf EMR Billing User Guide 

for BC.

Field Description

Bill To In the Bill To drop-down list, select Patient. 
Wolf Front End Staff User Guide - Issue 02.05 481

www.wolfmedical.com/helpfiles/Billing_User_Guide_BC.pdf 
www.wolfmedical.com/helpfiles/Billing_User_Guide_BC.pdf 


Patient billing
8. Click Save. The EMR displays the following prompt: “Are all services entered for this bill?”

9. Perform one of the following actions:

 If all services are entered for this bill, click Yes. An Invoice Detail window is displayed, 
where you can mark the bill as paid or not paid and fill in the appropriate payment details. 

 To add more services to the bill, click No. The EMR inserts another line into the original 
bill to allow you to add a second item to same invoice. Repeat Step 7.  and Step 8. .

10. In the Invoice Detail window, perform one of the following actions:

 If the patient has paid the bill at the time of the visit, click the payment method in the 
Method drop-down list, click Save, and then click Exit.

 If the patient paid part of the bill, enter the partial payment in the Amount field, click the 
payment method in the Method drop-down list, click Save and then click Exit.

 If the patient has not paid the bill, click NOT PAID. You can take a payment at a later time 
and record it in the EMR. See “Recording a payment to a patient’s invoice” on page 483.

Fee Code/
Desc

1.   In the Fee Code/Desc field, enter the fee code or service description, 
and then press Enter. 

2.   In the drop-down list below, click a fee code.

Note: Before you can bill for a service, the service must be entered in 
Wolf EMR as a fee code. You typically create custom fee codes 
for services and products you charge to patients. See “Managing 
service fee codes and fee schedules” on page 197.

Units Enter the number of services performed or products provided. For 
example, if the service fee is for vitamins, and the patient is purchasing 3 
containers of vitamins, in the Units field, enter 3. 

The EMR multiplies the Rate by the number of Units and displays the total 
billed amount in the Bill $$ column in the billing list.

Rate (field 
to the right 
of Fee 
Code/
Desc)

If you want to charge a different rate than the default, in the Rate field, 
modify the amount. 

Field Description
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The EMR displays a prompt asking if you want to print the invoice. 

11. Perform one of the following actions:

 If you want to print the invoice or receipt, click Yes. 
Note: Another way to print an invoice is to click the bill in the Billing list, and then on the 
Billing menu click File > Print Invoice. 

 If you do not want to print the invoice or receipt, click No.

Recording a payment to a patient’s invoice
If you do not receive complete payment at the time you bill a patient (for example, if you bill a 
patient for missing an appointment and send the bill by mail), you can record a partial or 
complete payment at a later time when you receive payment. 

It is important that you always record a payment as soon as you receive it because the EMR 
cannot report which bills were paid and or not paid unless you record them in the system.

To record a payment to a patient’s invoice:

1. Open the Patient Maintenance window for the patient:
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a) Open the Scheduler: On the Wolf EMR Launch page, click Scheduling ( ).

b) In the Family Name /Portion field, enter the patient’s last name, and then on your 
keyboard press Enter. Your cursor moves to the Given (first name) field.

c) In the Given field, enter the patient’s first name, and then on your keyboard press Enter.

d) In the search results list, click the patient name, and then, on your keyboard, press F9. 
The EMR displays the Patient Maintenance window. 

2. Click the Billing tab. 

3. In the patient’s list of bills, click the bill you want to record a payment for. 

4. On the Patient Maintenance menu, click View > Invoice Payment or, on your keyboard, 
press Ctrl + P. The EMR opens the Invoice Detail window. 

5. Perform one of the following actions:

 If the patient has paid the full amount, ensure that the correct payment amount is in the 
Amount field and then click the payment method in the Method drop-down list.

 If the patient made a partial payment, enter the partial payment amount in the Amount 
field, and then click the payment method in the Method drop-down list. 

6. Click Save. The EMR displays the payment in the lower pane of the Invoice Detail window.

7. Click Print.The EMR displays Print Report window

8. In the Copies field, enter number of copies to print and then click Print. 

9. Click Exit. The EMR displays the payment in the Paid column in the Billing window.

Tip: You can also access the Patient Maintenance window from your WorkDesk 
and from Billing:

 Workdesk: On your WorkDesk, click Demographics.

 Billing: On the Billing menu, click View > Patient Maintenance.

The EMR displays the Patient Search window. 
Search for the patient and then double-click the patient’s name.
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Reversing payments 
If you record a payment for a bill in error, you can reverse the payment. You reverse a payment 
from the patient’s Invoice Detail window, which you can access from the Billing program, or from 
the Billing tab on the Patient Maintenance window.  

 To reverse a payment:

1. Perform one of the following actions:

 Open the Billing program: On the Wolf EMR Launch page, click Billing ( ). The EMR 
displays the Billing window.

 Open the Patient Maintenance window, and then click the Billing tab. See Step 1.  to 
Step 2.  in “Recording a payment to a patient’s invoice” on page 483.

2. Click the invoice you want to reverse a payment for. 

3. Perform one of the following actions:

 If you are in the Billing program: On the Billing menu click File > Enter Invoice 
Payment. 

 If you are on the Billing tab of the Patient Maintenance window: On the Patient 
Maintenance menu, click View > Invoice Payment. (You can also press Ctrl + P.)

The EMR displays the Invoice Detail window.

4. In the lower pane of the Invoice Detail window, click the payment you want to reverse.

5. Click Reverse Pmt. The EMR displays the following prompt: 

Note: You can only revers a payment if a deposit has NOT been run for that bill. If 
the deposit has been done, you must refund the payment.
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6. Click Yes. The payment is then treated as unpaid. If you scroll to the right of the payment 
row, you can see the Payment Reversal Date. 

7. Click Exit. 
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Questions?

WolfEMR.Support@telus.com 

1-866-879-9653 (Option 1)

Wolf EMR Community Portal at 
https://telushealthcommunity.force.com/wolfcommunity 

https://telushealthcommunity.force.com/wolfcommunity
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